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Preface

Audience

This manual describes the different options available for publishing reports with
Oracle Reports Services, as well as how to configure the Oracle Reports Services
software for publishing reports.

Note: For the portable document format (PDF) version of this
manual, when a URL breaks onto two lines, the full URL data is not
sent to the browser when you click it. To get to the correct target of
any URL included in the PDF, copy and paste the URL into your
browser’s address field. In the HTML version of this manual, you can
click on a link to directly display its target in your browser.

This manual is intended for anyone who is interested in publishing reports with
Oracle Reports Services. To configure Oracle Reports Services, it is useful to have a
solid understanding of the following technologies:

= Your operating system

= Java

= Databases

= CORBA

m JSP files

= XML and DTD files

= Web server configuration
= HTTP

This manual will guide you through configuring components related to these
technologies.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact .html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Related Documentation

For more information about Oracle Reports, refer to the following resources:

s Oracle Technology Network (OTN) Oracle Reports page
(http://www.oracle.com/technology/products/reports/index.html

)

»  Oracle Reports Tutorial
»  Oracle Reports Building Reports

»  Oracle Reports online Help, which you can access from Reports Builder in any of the
following ways:

— Choose Help > Help Contents.
- Click Help or press F1 in any dialog box.

— In the Property Inspector, click a property, then press F1 to display the
property's help topic.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

monospace italic Monospace italic type indicates variables or user-supplied names.

[] Brackets enclose optional clauses from which you can choose one or
none.
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Part |

Getting Started

Part I contains information about Oracle Reports and Oracle Reports Services to get
you ready to start publishing your reports:

Chapter 1, "Introduction”

Chapter 2, "Understanding the Oracle Reports Services Architecture"
Chapter 3, "Verifying Your Installation"

Chapter 6, "Starting and Stopping Oracle Reports Services"






1

Introduction

This chapter provides an overview of Oracle Reports, the reporting component of
Oracle Fusion Middleware:

s Introduction to Oracle Reports

s What's New In This Release?

1.1 Introduction to Oracle Reports

Oracle Reports is Oracle's award-winning, high-fidelity enterprise reporting tool. It
enables businesses to give immediate access to information to all levels within and
outside of the organization in an unrivaled scalable and secure environment.

Using Oracle Reports, you can rapidly develop and deploy sophisticated Web and
paper reports against any data source (including an Oracle database, JDBC, XML, and
text files). Leveraging Java EE technologies such as JSP and XML, you can publish
your reports in a variety of formats (including HTML, XML, PDF, Enhanced
Spreadsheet, Spreadsheetdata, delimited text, delimiteddata, PostScript, and RTF) to
any destination (including e-mail, Web browser, WebDayv, FTP, Oracle Portal, and file
system) in a scalable, efficient manner.

Oracle Reports consists of Oracle Reports Developer (a component of the Oracle
Developer Suite) and Oracle Reports Services (a component of Oracle Fusion
Middleware).

Oracle Reports Developer includes the following component:
s Oracle Reports Builder

Oracle Reports Services is the focus of this manual. It executes, distributes, and
publishes your reports for enterprise wide reporting. Using Oracle Reports Services to
deploy your reports results in gains of flexibility, time savings, and processing
capacity. It includes the following components:

s Oracle Reports Bridge

s Oracle Reports Client

s Oracle Reports Runtime
s Oracle Reports Servlet

s Oracle Reports Server

For more resources for information about Oracle Reports, refer to "Related
Documentation" in the Preface.
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1.1.1 Oracle Reports Builder

As its name implies, Oracle Reports Builder (rwbuilder) is the report-building
component of Oracle Reports. Report developers use the Oracle Reports Builder
design-time user interface to create and maintain report definitions, using;:

= user-friendly wizards that guide you through the report design process

= pluggable data sources (PDSs), such as JDBC and XML, that provide access to data
from any source for your reports

= aquery builder with a graphical representation of the SQL statement to obtain
report data

s default report templates and layout styles that can be customized if needed
= alive editor that enables you to modify paper report layouts in WYSIWYG mode

= the ability to add dynamic report output to an HIML page by embedding custom
JSP tags within an HTML document

= anintegrated graph builder to graphically represent report data
= the ability to generate code to customize how reports will run
= tools that dynamically generate Web pages based on your data

= standard report output formats such as HTML, HTMLCSS, XML, PDE, RTF,
spreadsheet, PCL, PostScript, and ASCII

= client-side parameter validation using JavaScript

= the ability to execute dynamic SQL statements within PL/SQL procedures
= support for Oracle database objects

= event-based reporting (report execution based on database events)

= seamless integration of Oracle Reports with Oracle Portal for administering report
security and publishing report output to portlets

For more information, refer to the Oracle Reports online Help (select Help > Contents in
Oracle Reports Builder), and the Oracle Reports Building Reports manual.

1.1.2 Oracle Reports Bridge

Oracle Reports Bridge (rwbridge) provides functionality for discovering a Reports
Server across farms. For more information, see Section 2.3.4.1.2, "Server Discovery
Across Subnets".

1.1.3 Oracle Reports Client

Oracle Reports Client (rwclient) provides a command-line interface to send a report
to a remote Reports Server (rwserver).

1.1.4 Oracle Reports Runtime

rwrun (Reports Runtime) runs a report by starting its own in-process server (not to be
confused with the default in-process Reports Server), which runs in the same JVM as
the rwrun process. The configuration file for this in-process server is

rwbuilder. conf and trace files are saved in the rep_machinename-rwbuilder
directory.
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Note: It is recommended that you use rwrun for testing purposes
only. Use rwservlet and rwclient in your production
environment to take full advantage of the power of Oracle Reports
Services.

1.1.5 Oracle Reports Servlet

Oracle Reports Servlet (rwservlet) is a component of Oracle Reports Services that
translates and delivers information between either a Web Server or a Java EE
Container (for example, Oracle WebLogic Server) and the Reports Server, enabling
you to run a report dynamically from your Web browser.

1.1.6 Oracle Reports Server

Oracle Reports Server (rwserver) is a component of Oracle Fusion Middleware that
provides reporting services to execute, distribute, and publish your reports for
enterprise-wide reporting. This component processes client requests, including user
authentication, scheduling, caching, and report distribution. Use Oracle Reports clients
such as Oracle Reports Servlet (rwservlet), Reports JSP, and Oracle Reports Client
(rwclient) to send a report to Oracle Reports Server (generally referred to as Reports
Server).

1.2 What’s New In This Release?

Oracle Reports 11g Release 1 (11.1.1) provides many new features and enhancements.
The primary themes of this release are:

»  Tighter integration with Oracle Fusion Middleware platform and services.
= Enhancements in top supportability areas with architectural changes.
= New features in key enterprise reporting areas.

Table 1-1 details the new functionality in Oracle Reports 11g Release 1 (11.1.1), along
with the equivalent 10g Release 2 (10.1.2) functionality, when applicable. The new
features and enhancements are grouped into the following categories:

= Install and Upgrade

= Monitoring and Management

= Job Administration and Scheduling

= Security

= High Availability

= Font Management and Support

= Distribution and Bursting

= ENHANCEDSPREADSHEET Output Format
s Graphing

= Diagnosability

= Forms-Reports Integration

= Server Stability

s Service-Oriented Architecture (SOA) Integration: Oracle BPEL Process Manager
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s Enhanced Printing Support Based on Common UNIX Printing System (CUPS)

Table 1-1 11g Functionality vs. 10g Functionality

11g New Features and Enhancements Equivalent 10g Functionality
Install and Upgrade
Flexible Install types. In Oracle Fusion Predefined install types only.

Middleware 11g, the install type contains Oracle
Reports, Forms, Portal, and Discoverer. In the
installer, you can selectively install any one of
these products or all of them.

Separate installation of binaries from configuration, | Single ORACLE_HOME installation including both
allowing shared binaries across servers. Oracle binaries and configuration.

Installer allows for install only and then
configuration only as two separate steps.

For more information, see Section 3.2,
"Understanding the Oracle Fusion Middleware
Installation Structure".

New and improved management screens in Oracle Oracle Enterprise Manager Application Server (AS)
Enterprise Manager. Oracle Enterprise Manager | Control, and modifying configuration files.
provides enhanced usability for all the
administration, monitoring, and diagnosability
operations. For more information, see

Chapter 7, "Administering Oracle Reports
Services Using Oracle Enterprise Manager".

Fully automated upgrade from 10g Release 2 Not Applicable (N/A)
(10.1.2.x). For more information, see Section 3.6,
"Upgrading from the Prior Release".

For more information about installation, see Chapter 3, "Verifying Your Installation".

See Also: Oracle Fusion Middleware Quick Installation Guide for Oracle Portal, Forms, Reports, and Discoverer

Monitoring and Management

New rich and customizable Oracle Enterprise Enterprise Manager Application Server (AS) Control
Manager user interface, providing: and manually editing configuration files.

= Navigation pane showing hierarchical
view of complete Farm and all
components.

= New pages for Oracle Reports to perform
comprehensive administration,
management, configuration, tuning, and
diagnostics of complete reporting
environment.

=  Large number of metrics for monitoring
and tuning.

= Administration dashboard for instant
access to start, stop, restart, grouping,
servlet, plug-in registration, and more.

= Significant reduction of configuration
parameters, and categorization.

N Extensive real-time and historical
performance metrics.

= Reports Server auditing
= Oracle Internet Directory reassociation

= Portal metadata repository discovery and
association.

= Direct access to documentation and
collateral from Oracle Enterprise Manager.

For more information, see Chapter 7,
"Administering Oracle Reports Services Using
Oracle Enterprise Manager".
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Table 1-1 (Cont.) 11g Functionality vs. 10g Functionality

11g New Features and Enhancements

Equivalent 10g Functionality

New trend graphs, key statistics.

Anticipation of common problems with early
symptoms.

N/A

Job Administration and Scheduling

Advanced job queue administration.
Comprehensive job queue management user
interface in Oracle Enterprise Manager (search
and filters, resubmit the job, view errors, and
more).

Basic job queue user interface.

Rich calendar-based scheduling user interface.
Comprehensive Reports Server job scheduling
in Oracle Enterprise Manager.

Reports job scheduling done through Oracle Reports
Queue Manager (rwram), Oracle Portal user interface,
or command line only.

For more information about job administration and scheduling, see Chapter 7, "Administering Oracle
Reports Services Using Oracle Enterprise Manager".

Security

A standards-based Java EE security model through
Oracle Platform Security Services. This provides a
flexible, simple to administer, and high
performance security mechanism.

Reports Server authentication restricted to use only
Oracle Internet Directory. Authorization of Reports
Server required OracleAS Portal-based security model
(using Portal metadata repository for checking
authorization).

Oracle Enterprise Manager advanced user interface.
Administrators can use Oracle Enterprise
Manager to more easily define and manage
granular security policies for reports, Web
commands, and folder access.

For more information, see Section 7.8, "Securing
Oracle Reports Services" in Chapter 7,
"Administering Oracle Reports Services Using
Oracle Enterprise Manager"

Basic Ul in OracleAS Portal for defining the policies.
Hard-coded Web command access to the Oracle
Reports seeded roles. Access policies at file (report)
level only, not folder level.

Read/write access to directories at Reports Server
level. Administrators can control the input
folders from which reports can be served and
output folders to which the output of reports
servers can be pushed. This ensures there is no
security vulnerability.

REPORT_RESTRICT_DIRECTORIES as an interim
feature.

Database proxy authentication. Support for
database authentication using proxy users:

= Additional security through control of
users that are allowed to connect to the
database through Oracle Reports.

»  Scalability, through reuse of a single
database connection.

N/A

Security check for distribution destinations. Ability
to define security policies for distribution jobs.
For example, you can define a security policy
that specifies report output may not be burst to
ENHANCEDSPREADSHEET format; if the
distribution XML file specifies
ENHANCEDSPREADSHEET format, the attempt to
generate a report to this output format displays
an error.

No security check performed for destinations specified
in the distribution XML file.

Security check for system parameters. A security
check is performed for all system parameters,
including those specified in the report definition
as well as on the command line.

No security check performed for system parameters.

Security auditing. Audit authentication and
authorization on the Reports Server.
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Table 1-1 (Cont.) 11g Functionality vs. 10g Functionality

11g New Features and Enhancements

Equivalent 10g Functionality

Security for report output from Oracle Forms
Services. With no configuration required,
support for intermediate-level security even
when Oracle Forms Services and Oracle Reports
Services are not secured.

Anyone is able to see anyone else’s report output by
"guessing" the job ID based on sequential job ID
assignment.

For more information about security, see Chapter 15, "Securing Oracle Reports Services"

High Availability

Database-backed job queue repository. Use of the
database as the job repository provides the
following High Availability (HA) benefits:

= Ability to view consolidated jobs for the
complete group of Reports Servers in
Oracle Enterprise Manager, and perform
operations on this consolidated jobs See
Section 7.15.2, "Displaying a Consolidated
Job Queue".

s Scheduled jobs do not get lost even if the
Reports Server where the jobs are
scheduled goes down.

The administrator must view the job queues for each
Reports Server separately.

If the Reports Server where a job is scheduled goes
down, the job is left waiting until that Reports Server
comes back up to start executing the job again.

Oracle Reports Server cluster with shared job
repository and cache, including Java Object Cache.
Reports Servers communicate via peer-to-peer
mechanisms for job management, to minimize
manual administration and for automatic
failover of jobs. Access to cached output even
when the Reports Server that processed the
master job is not available.

Use of Oracle Reports caching mechanism. Cache not
shared among Reports Servers. Cached output is not
available to other servers if the Reports Server where it
is cached goes down.

Proprietary clustering and HA mechanism.

For more information about High Availability, see Section 2.5, "Setting Up a High Availability

Environment".

Font Management and Support

Cross-platform support for TrueType Fonts (TTF)
and TrueType Collections (TTC). Report output is
in most cases identical on UNIX as on
Windows, allowing for simplified
cross-platform deployment.

Oracle Reports reads the font metrics from the
appropriate TTF files to correctly format the
report output. This eliminates the issue of text
misalignment due to font metrics mismatches.
Fonts for which TTF files are available are found
automatically. Note that if a TTF font file is not
found, then the font lookup mechanism reverts
to the pre-11g implementation.

New environment variables REPORTS _
ENHANCED_FONTHANDLING and
REPORTS_FONT_DIRECTORY.

Possible mismatches between fonts in report output on
UNIX and Windows due to different font mechanisms
on Windows and UNIX. Font aliasing was required,
along with PDF font subsetting.

Support for older font file types (for example, AFM)
supported. Difficult to get these font types for all fonts.
Conversion of TTF to AFM required in many cases, but
even these files did not provide the exact output as on
Windows.

Support for all character sets in PDF. With the new
font model, no misalignment will be seen in the
PDF subsetted report output. Support for
Unicode font subsetting in PDF on UNIX.

Only multibyte reports supported. PEM and PFA files
must be created to resolve text misalignments in UNIX
output. Dependence on AFM files.

Variable width font output was especially problematic,
because Reports was unable to get width of characters
beyond the first 256 characters in the file, and assumed
fixed width for all these characters, resulting in
misalignment.

Simplified font management and configuration
through Oracle Enterprise Manager. Use Oracle
Enterprise Manager to modify aliasing and
subsetting entries in uifont.ali (such as
global aliasing, PDF aliasing, and PDF
subsetting), printer resolution, and the default
font used.

Configure fonts in uifont.ali and configuration file.
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What's New In This Release?

Table 1-1 (Cont.) 11g Functionality vs. 10g Functionality

11g New Features and Enhancements

Equivalent 10g Functionality

PDF, password protection, and security. Specify
new command line arguments to
password-protect PDF reports generated from
Oracle Reports. You can also suppress certain
permissions to provide security for the
generated PDF reports.

No capability to encrypt PDF reports or specify security
permissions.

Font diagnostics. Easy to understand tracing for
diagnosis of font issues. Reporting of fonts used,
and other debugging tools.

Difficult to diagnose issues.

For more information about fonts in Oracle Reports, see Chapter 9, "Managing Fonts in Oracle Reports"

and Chapter 11, "Using PDF in Oracle Reports".

Distribution and Bursting

Full support for bursting and distribution to all
destinations and output formats, including:

= all out-of-the-box and pluggable
destinations

. data-driven formats such as XML and
DELIMITEDDATA, as well as layout-based
formats such as the new
ENHANCEDSPREADSHEET format.

Limited destinations and output formats for bursting
and distribution.

System parameters in report definition honored for
distribution. Distributed output honors the
DESTYPE, DESFORMAT, and DESNAME system
parameters specified in the report definition.

For example, if you define system parameters in
the report:

DESTYPE=FILE, DESFORMAT=PDF, and
DESNAME=/tmp/a.pdf

the report output is generated and distributed
using these values without the parameter values
needing to be specified in the distribution XML
file or on the command line.

Additionally, if users change the values of
DESTYPE, DESFORMAT, or DESNAME on the
Runtime Parameter Form during runtime, or if
Oracle Reports sets the value of these system
parameter based on a runtime calculation, the
parameter values are honored when the report
is distributed.

Values for system parameters DESTYPE, DESFORMAT,
and DESNAME specified in the report definition are not
honored for distributed output; to change the default
values of these system parameters for distributed
reports, they must be specified in the distribution file or
on the command line.

Security check for distribution destinations. Ability
to define security policies for distribution jobs.
For example, you can define a security policy
that specifies report output may not be burst to
ENHANCEDSPREADSHEET format; if the
distribution XML file specifies
ENHANCEDSPREADSHEET format, the attempt to
generate a report to this output format displays
an error.

No security check performed for destinations specified
in the distribution XML file.

Other improvements such as tolerance support for
burst jobs and improved diagnostics.

N/A

For more information about distribution and bursting, see Chapter 20, "Creating Advanced Distributions".

ENHANCEDSPREADSHEET Output Format

Support for large data sets output to spreadsheets.
Significantly enhanced support for large data
sets (up to 75,000 rows) and matrix reports with
new ENHANCEDSPREADSHEET output format.

For more information, see the Oracle Reports
online Help and the Oracle Reports Building
Reports manual.

Failed attempts to generate output for large data sets to
SPREADSHEET output format.
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Table 1-1 (Cont.) 11g Functionality vs. 10g Functionality

11g New Features and Enhancements

Equivalent 10g Functionality

Graphing

New graph types: New funnel and curved line
graph types allow for more variety in graphing.

N/A

Enhancements for existing graph types.

Support for number formatting in the Graph
Wizard (independent of the Data Model), and
plotting irregular time periods on the time-axis.

Restrictions on plotting time data.

Scalable Vector Graphic (SVG) image support. SVG
provides for high resolution and smaller file
size in graph output. Graph image output scales
up better without losing resolution.

Support for only PNG, JPG, and GIF output formats.

For more information, see the Oracle Reports online Help and the Oracle Reports Building Reports manual.

Diagnosability

Log files in ODL format. All Oracle Reports log
files follow Oracle Diagnostic Logging (ODL)
format, the standard across Oracle Fusion
Middleware, for log format, message types, and
log management directives. The log file entries
are in Text format (default) or XML format.
Searching of log files from Oracle Enterprise
Manager is easy and effective

N/A

More comprehensive choices for tracing:

= Multiple tracing levels for fine-grained
control.

= New tracing options: NOTIFICATION,
WARNING, ERROR (standardized across
Oracle Fusion Middleware components).

= Better naming convention, mechanism to
control file size.

N/A

Enhanced trace viewer and search. New tracing
options, levels, log file sizes, and so on can all be
specified, viewed, and searched using Oracle
Enterprise Manager.

Tracing options specified in configuration files or on
command line.

Extensive diagnostic enhancements. Improved
actionable errors with cause and action,
job-level tracing, critical errors logged even
when tracing is off, better health check
mechanisms, and hyperlinks to contextual help
and error message registry.

N/A

For more information about diagnosibility, see Chapter 24, " Diagnosing and Tuning Oracle Reports"
(Section 24.3.2, "Log Files" and Section 24.3.7, "Tracing Report Execution").

Forms-Reports Integration

Forms-Reports non-SSO security. With no
configuration required, support for
intermediate-level security even when Oracle
Forms Services and Oracle Reports Services are
not secured. Other users are not able to see the
report output, as job IDs can be random
non-sequential numbers.This setting is optional.

For more information, see Section 17.6, "Oracle
Forms Services Security Considerations".

Anyone is able to see anyone else’s report output by
"guessing" the job ID based on sequential job ID
assignment.
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Table 1-1 (Cont.) 11g Functionality vs.

10g Functionality

11g New Features and Enhancements

Equivalent 10g Functionality

Pluggable destinations support from Oracle Forms
Services. Report requests can be submitted to all
destinations, including any Oracle
Reports-registered pluggable destinations from
Oracle Forms Services using RUN_REPORT_
OBJECT.

For more information, see Section 13.1.1,
"Pluggable Destinations from Oracle Forms
Services.".

Report requests can be submitted to a fixed specific set
of destinations, so newly defined destinations can not
be used for report output from Oracle Forms Services.

JVM pooling. Oracle Forms Services uses the
shared JVM controller for all Oracle Reports
requests, reducing memory consumption.

Server Stability

Database-backed job queue repository. Use of the
database as the job repository helps to avoid
Reports Server DAT file corruption, and also
ensures no loss of scheduled jobs. It is also
easier to manage jobs in the database.

Only file system-based DAT file repository.

New command line argument: JOBRETRY. When
specified, this value takes precedence over the
retry attribute of the job element. Jobs are
retried for all unexpected errors. For more
information, see Section A.6.15, "JOBRETRY".

Number of times to retry a failed job can be specified in
the server configuration file using the retry attribute
of the job element, or on the command line for
scheduled jobs only Jobs are retried only in the case of
engine crash failures.

For more information about Reports Server, see Chapter 2, "Understanding the Oracle Reports Services

Architecture".

Service-Oriented Architecture (SOA) Integration: Oracle BPEL Process Manager

Oracle BPEL Process Manager integration. Users
can submit Oracle Reports jobs using the Oracle
BPEL Process Manager to automate and
monitor reporting requirements.

For more information, see Section 18.9,
"Running Reports Using Oracle BPEL Process
Manager".

Enhanced Printing Support Based on Common UNIX Printing System (CUPS)

CUPS Support

Standard and modularized printing system that
can process numerous data formats on the print
server and also supports Internet Printing
Protocol (IPP).

For more information, see Section 10.5,
"Enhanced Printing on Linux Using CUPS".

Others

Internet Protocol Version 6 (IPv6) Support

IPv6 support is available out-of-the-box. For
more information about IPv6, see Request for
Comments (RFC) 2460 at

http:/ /www.ietf.org/rfc/rfc2460.txt.

For more information about IPv6 Support in
Oracle Fusion Middleware 11g Release 1
(11.1.1), see Oracle Fusion Middleware
Administrator’s Guide.
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Understanding the Oracle Reports Services

Architecture

This chapter describes the architecture of Oracle Reports Services and its components.
It also outlines considerations when setting up your Reports Server environment.

This chapter includes the following sections:

What's New In This Release?

Oracle Fusion Middleware Platform

Oracle Reports Services

Setting Up Your System

Setting Up a High Availability Environment

2.1 What’s New In This Release?

Oracle Reports 11g Release 1 (11.1.1) is integrated with Oracle Fusion Middleware and
Oracle WebLogic Server, which provide the architectural enhancements listed in
Table 2-1 (a subset of Table 1-1, " 11g Functionality vs. 10g Functionality"):

Table 2-1 11g Architecture Features vs. 10g Functionality

11g New Features Equivalent 10g Functionality

Server Stability

Database-backed job queue repository. Use of the Only file system-based DAT file repository.
database as the job repository helps to avoid
Reports Server DAT file corruption, and also
ensures no loss of scheduled jobs. It is also
easier to manage jobs in the database.

New command line argument: JOBRETRY. When | Number of times to retry a failed job can be specified in

specified, this value takes precedence over the the server configuration file using the retry attribute
retry attribute of the job element. Jobs are of the job element, or on the command line for
retried for all unexpected errors. For more scheduled jobs only Jobs are retried only in the case of
information, see Section A.6.15, "JOBRETRY". engine crash failures.

High Availability
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Table 2-1 (Cont.) 11g Architecture Features vs. 10g Functionality

11g New Features Equivalent 10g Functionality

Database-backed job queue repository. Use of the The administrator must view the job queues for each
database as the job repository provides the Reports Server separately.

following High Availability (HA) benefits:

A scheduled job is lost if the Reports Server where the
= Ability to view consolidated jobs for the job was scheduled goes down.
complete group of Reports Servers in
Oracle Enterprise Manager, and perform
operations on this consolidated jobs. See
Section 7.15.2, "Displaying a Consolidated
Job Queue".

= Scheduled jobs do not get lost even if the
Reports Server where the jobs are
scheduled goes down.

Oracle Reports Server Cluster with shared job Use of Oracle Reports caching mechanism. Cache not
repository and cache, including Java Object Cache. shared among Reports Servers. Cached output is not
Reports Servers communicate via peer-to-peer available to other servers if the Reports Server where it
mechanisms for job management, to minimize is cached goes down.

manual administration and for automatic
failover of jobs. Access to cached output even
when the Reports Server that processed the
master job is not available.

Proprietary clustering and HA mechanism.

For more information about High Availability, see Section 2.5, "Setting Up a High Availability
Environment".

2.2 Oracle Fusion Middleware Platform

Oracle Reports 11g Release 1 (11.1.1) is integrated with Oracle Fusion Middleware and
Oracle WebLogic Server, which results in simpler administration of complex topology
and deployments. You can manage and monitor Oracle Reports components using
either:

s Oracle Enterprise Manager, included with Oracle Fusion Middleware
(recommended). Refer to Chapter 7, "Administering Oracle Reports Services Using
Oracle Enterprise Manager".

= Oracle Process Manager and Notification Server (OPMN)

For complete overview and conceptual information about Oracle Fusion Middleware,
refer to the following manuals:

»  Oracle Fusion Middleware Concepts

" Oracle Fusion Middleware Administrator’s Guide

2.3 Oracle Reports Services

Oracle Reports Services is the reports publishing component of Oracle Fusion
Middleware. It is an enterprise reporting service for producing high quality
production reports that dynamically retrieve, format, and distribute any data, in any
format, anywhere. You can use Oracle Reports Services to publish in both Web-based
and non-Web-based environments.

Read this section to learn more about Oracle Reports Services:
m  Section 2.3.1, "Overview"

»  Section 2.3.2, "Oracle Reports Services Components"

»  Section 2.3.3, "Oracle Reports Services Runtime Process"

»  Section 2.3.4, "Oracle Reports Services Communication Architecture'
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2.3.1 Overview

Oracle Reports Services provides a scalable, flexible architecture for the distribution
and automated management of report generation engines on the same server and
across multiple servers. Additionally, it caches report output for reuse on similar
requests. It integrates into standard Web environments with JSPs, Java servlets, and
Web Services. It enables you to run reports on both local and remote application
servers and to implement a multitiered architecture for running your reports.

When used in conjunction with JSPs, Java servlets, or Web Services, Oracle Reports
Services enables you to run reports on any platform from a Web browser using a
standard URL syntax. For Oracle Reports Servlet (rwservlet) implementations, the
in-process Reports Server is available for faster response and easier administration.
The in-process Reports Server cuts down on the communication expense between
processes and consequently shortens response times.

Oracle Reports Services handles client requests to run reports by entering all requests
into a job queue. When one of the server's engines becomes available, the next job in
the queue is dispatched to run. As the number of jobs in the queue increases, the
server can start more engines until it reaches the maximum limit specified in your
server configuration. Similarly, engines are shut down automatically after having been
idle for a period of time that you specify (see Chapter 8, "Configuring Oracle Reports
Services").

Oracle Reports Services keeps track of all jobs submitted to the server, including jobs
that are running, scheduled to run, finished, or failed. The showjobs Web command
(through rwservlet), the Web Services interface, the Oracle Reports Services pages
in Oracle Enterprise Manager, the Reports Queue Manager (Windows), and the
Reports Queue Viewer (UNIX) enable you to view information on when jobs are
scheduled, queued, started, finished, and failed, as well as the job output and the final
status of the report.

With Oracle Reports Services, job information is persistent. This means that if the
Reports Server is shut down then restarted, all jobs are recovered,' not just scheduled
jobs.

When used in a Web environment, the Oracle Reports Services architecture consists of
four tiers:

Note: The term tier refers to the logical location of the components
that comprise the Oracle Reports Services architecture. Each of the
tiers, though, can reside on the same machine or on different
machines.

s The client tier (a Web browser)

»  The Web server tier

»  The Oracle Reports Services tier

»  The data tier, including databases and all other data sources

When used in a non-Web environment, there are three tiers (a Web server being
unnecessary):

s The client tier

= Oracle Reports Services tier

1 Only synchronous jobs and jobs that are currently running are lost in this case.
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s The data tier, including databases and pluggable data sources
The client software could be:

= Arwclient

= Abrowser

The way you set up the tiers can range from having all of them on one machine to
having each of them on a separate machine. Additionally, you can have multiple Web
servers on multiple machines as well as multiple application servers on multiple
machines. Refer to the Oracle Fusion Middleware Installation Planning Guide for more
information on sample topologies.

If you choose to have your Web server on multiple machines, you can cluster and load
balance multiple Oracle Fusion Middleware instances for a highly available, fail-safe
environment.

Note: Do not use "server=clustername" statements while calling
jobs from an HA Reports Sever. For calling jobs from an HA Reports
server, you must use a load balancer.

Refer to the Oracle Fusion Middleware Installation Planning Guide for
information on load balancing. Refer to the Oracle Fusion Middleware
Enterprise Deployment Guide for Java EE and Oracle Fusion Middleware
High Availability Guide for information on enterprise deployment
architectures and high availability.

Oracle Reports Services provides event-based reporting. This uses database events to
trigger the generation of a report. For example, you can define an event that signals a
change in revenue levels above or below a particular watermark. If the change occurs
in the database (the event), a report is automatically generated. This feature is
discussed in detail in Chapter 21, "Using Event-Driven Publishing".

Oracle Reports Services includes a distribution module that uses XML to define
unique configurations for the distribution of reports. Call the desired XML file from
the runtime command line or URL to generate one report, and let the server handle
diverse outputs and destinations. Processing time is significantly reduced and
configuration changes can all be handled within the XML file. This feature is discussed
in detail in Chapter 20, "Creating Advanced Distributions".
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2.3.2 Oracle Reports Services Components

Figure 2—1 Oracle Reports Services Components
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Figure 21 illustrates the components of a working Oracle Reports Services
environment. This includes:

1.

The Oracle HTTP Server, a Web server provided by Oracle Fusion Middleware. It
incorporates an OpenSSL module to provide support for Secure Sockets Layer
(SSL) and HTTP Secure Sockets Layer (HTTPS). It also provides a servlet engine to
support the running of Java servlet applications.

The module mod_weblogic, used by the Oracle HTTP Server to redirect requests
from servlets and JSPs to Oracle WebLogic Server. WebLogic Server provides a
complete Java EE environment that includes a JSP translator, a JSP servlet engine
(OJSP), and an Enterprise JavaBeans (E]JB) container. It provides a fast,
lightweight, highly scalable, easy-to-use, complete Java EE environment. It is
written entirely in Java and executes on the standard Java Development Kit (JDK)
Virtual Machine (JVM).

The module mod_osso, used by the Oracle HTTP Server to connect to Single
Sign-On Server. The Single Sign-On Server, in turn, uses Oracle Internet Directory.

Oracle Reports Servlet (rwservlet), a component of Oracle Reports Services that
runs inside the Web server's servlet engine. Oracle Reports Servlet (rwservlet)
translates and delivers information between HTTP and Reports Server. It uses
Single Sign-On Server for authentication. Oracle Reports Servlet includes:
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s The in-process Reports Server, which reduces the maintenance and
administration of the Reports Server by providing a means for starting the
server automatically, whenever it receives the first request from the client
through rwservlet or a Reports JSP.

5. The Custom Tag Handler, which processes custom Oracle Reports tags included
in a JSP file. In a JSP file, Oracle Reports-related custom tags are identified by the
prefix rw:; other custom tags using other prefixes may also be present.

6. The Reports Server (rwserver), which processes client requests, including
ushering them through its various services, such as security (authentication and
authorization, job scheduling, caching, publishing, and bursting and distribution
(including distribution to custom—or pluggable—output destinations).

The security service offers authentication based on the following methods:
s Oracle Internet Directory

s Java Platform Security (JPS) Oracle Internet Directory

= Any LDAP-based ID Store using Java Platform Security (JPS)

The security service offers authorization based on the following methods:
s Java Platform Security (JPS) Oracle Internet Directory

s XML file-based

= Portal-based

The bursting and distribution service enables the distribution of reports to
multiple destinations, such as wireless, printer, FTP server, Portal, WebDAYV,
browser, and e-mail. The publishing service publishes Reports into multiple
output formats, such as PDE, HTML, XML, and spreadsheet.

The Reports Server also spawns runtime engines for generating requested reports,
fetches completed reports from the Reports Server cache, and notifies the client
that the job is ready. Reports output can be stored in the Reports cache or on a
physical disk.

7. The Reports Server Cache, which securely stores completed job outputs.

8. The Reports Engine, which includes components for running SQL-based and
pluggable data source-based reports. It fetches requested data from the data
source, formats the report, sends the output to cache, and notifies the Reports
Server that the job is complete. The Reports engine also includes pluggable data
sources, which are custom data sources like text, database, JDBC, OLAP, XML,
and web services.

9. The pluggable data sources, a set of design-time and runtime Java APIs that
provide openness to Reports by enabling data input from numerous sources
through the implementation of the PDS Java Interface. The PDS feature enables
developers to leverage Reports’ aggregation, summarization, formatting, and
scheduling capabilities not only on data that is accessed through SQL, but also on
data that is available elsewhere.

10. The pluggable engines, which are custom engines that use Java APIs to pass jobs
to the Reports Server, as well as leverage the server's other features, such as
scheduling, distribution, notification, and caching. Oracle Reports Services
provides an out-of-the-box pluggable engine called the URL engine. The URL
engine enables you to distribute content from any publicly available URL to
destinations such as e-mail, Oracle Portal, and WebDAV.

In addition to the Reports Services components, Figure 2-1 depicts the following:
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s Integration of Oracle Reports with Service Oriented Architecture (SOA)
through the web services module of the Reports J2EE application.

»  Communication between Oracle Forms and Oracle Reports.

= Reports-specific modules in Enterprise Manager that enable you to administer
and manage tasks, such as monitoring, scheduling, security policies, font
setup, and configuration.

Additionally, the Oracle Reports Bridge provides functionality for discovering a
Reports Server across Farms. The Oracle Reports Bridge acts as a gateway for packets
that are broadcast by Reports Server/Reports Client across Farms. The Oracle Reports
Bridge mechanism is not shown in Figure 2-1; for more information, see

Section 2.3.4.1.2, "Server Discovery Across Subnets".

2.3.3 Oracle Reports Services Runtime Process

The various components of Oracle Reports Services contribute to the process of
running a report as follows:

1. The client requests a report by contacting a server through either a URL (Web) or a
non-Web, Oracle Reports-related command, such as rwclient.

s The URL goes to JSP or rwservlet, both associated with the Oracle HTTP
Server. The requests go to mod_weblogic. (For jobs that run as JSPs, mod_
weblogic uses OJSP to translate the JSP into a servlet.)

The URL may contain runtime parameters or a keyword that refers to a
runtime parameter configuration section within the cgicmd. dat key map file
file (for more information, see Section 18.13, "Using a Key Map File"), or it may
contain both, though parameters explicitly named in the URL must not also be
present in the relevant keyword section of cgicmd. dat.

= rwclient goes directly to the Reports Server.

The command line may contain runtime parameters. If you have a lot of
runtime parameters, you can create a batch file or shell script that contains the
rwclient command along with a string of parameters.

2, The rwservlet component translates and delivers information between either a
Web server or a Java EE Container (for example, Oracle WebLogic Server) and the
Reports Server:

Server requests from Reports JSP or rwservlet can be run by the in-process
Reports Server or as a standalone Reports Server process (recommended),
whichever is specified in the Oracle Reports Servlet (rwservlet) configuration
file (DOMAIN_HOME/config/fmwconfig/servers/<WLS_SERVER_
NAME>/applications/reports_
<version>/configuration//rwservlet.properties). Anin-process
Reports Server requires less maintenance than a standalone Reports Server
because, unlike the standalone Reports Server, it starts automatically in response
to requests from the client. An in-process Reports Server cuts down on the
communication between processes. A standalone server, on other hand, provides
better control outside the rwservlet process with the ability to separate out
server process from the WebLogic Server instance. For information about
specifying an in-process Reports Server and default naming, see Section 8.3,
"Oracle Reports Servlet Configuration File".

3. The Reports Server processes the request:
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If the request includes a TOLERANCE option, then the Reports Server checks its
cache to determine whether it already has output that satisfies the request. If it
finds acceptable output in its cache, then it immediately returns that output rather
than rerunning the report.

Note: For any job request that you send to the Reports Server, you
can include a TOLERANCE option. TOLERANCE defines the oldest
output that the requester would consider acceptable. For example, if
the requester specified five minutes as the TOLERANCE, the Reports
Server would check its cache for the last duplicate report output that
had been generated within the last five minutes. An EXPTRATION
option defines the point in time when the report output should be
deleted from the cache (for example, EXPTRATION might equal a
specific date and time for when the output should expire). For more
information, see Section A.8.23, "TOLERANCE" and Section A.6.6,
"EXPIRATION".

If the request is the same as a currently running job, then the request will reuse the
output from the current job rather than rerunning the report.

If neither of these conditions is met, then:

a. If Oracle Reports Servlet (rwservlet) is SSO-enabled, it checks for
authentication. A secure Reports Server then authorizes the user using Oracle
Internet Directory. If Oracle Reports Servlet (rwservlet) is not SSO-enabled,
a secure Reports Server authorizes and authenticates the user.

b. If the report is scheduled, the Reports Server stores the request in the
scheduled job queue, and the report is run according to schedule. If the report
is not scheduled, it is queued in the current job queue for execution when a
Reports Engine becomes available.

Note: When you configure the Reports Server (in rwserver. conf),
you can specify the maximum number of the Report Engines it can
use. If the Reports Server is under this maximum, then it can send the
job to an idle engine or start a new engine to handle the request.
Otherwise, the request must wait until one of the current Oracle
Reports Engines completes its current job.

c. Atruntime, the Reports Server spawns a Reports Engine and sends the
request to that engine to be run.

The Reports Engine retrieves and formats the data.
The Reports Engine populates the Reports Server cache.
The Reports Engine notifies the Reports Server that the report is ready.

The Reports Server accesses the cache and sends the report to output according to
the runtime parameters specified in either the URL, the command line, or the
keyword section in the cgicmd. dat file (URL requests only).

Another way to create a report is through event-driven publishing. With event-driven
publishing, the client is the database (rather than the end user). Events are defined
through the Event-Driven Publishing APIL The event invokes a database trigger, an
advanced queuing application, or a PL/SQL package that calls the Event-Driven
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Publishing API to submit jobs to the Reports Server. Event-driven publishing is
discussed in detail in Chapter 21, "Using Event-Driven Publishing".

For information about running reports with Oracle BPEL Process Manager, refer to
Section 8.10, "Configuring Oracle Reports to Communicate with Oracle BPEL Process
Manager".

2.3.4 Oracle Reports Services Communication Architecture

Oracle Reports replaces the use of Borland's VisiBroker with Sun Microsystems'
industry-standard Java Developer's Kit Object Request Broker (JDK ORB), providing
support for Reports Server requests from clients across subnets, and using the
broadcast mechanism for dynamic Reports Server discovery both within a subnet and
across subnets.

With Oracle Reports 11g Release 1 (11.1.1), you can use the built-in broadcast
mechanism, available out-of-the-box, for dynamic discovery of Reports Servers. You
can also choose to use the Common Object Service (COS) naming service orbd,
provided by Sun Microsystem's JDK ORB, for Reports Server discovery.

Note: Itis recommended that you use the built-in broadcast
mechanism for dynamic discovery of Reports Servers. Use the
Common Object Service (COS) naming service for Reports Server
discovery only when the built-in broadcast mechanism is not suitable
for your environment, as in the following scenarios:

= You plan to install Oracle Reports on a machine that is connected
to a network using VPN.

= You want to avoid broadcast traffic on your network.

This section discusses the two methods of Reports Server discovery
= Server Discovery Using the Broadcast Mechanism

= Server Discovery Using the COS Naming Service

Note: Oracle Reports 11g Release 1 (11.1.1) contains rwdiag
executable to provide diagnosis for the JDK ORB implementation.
Using rwdiag, you can replace the functionality of osfind available in
the prior VisiBroker implementation, providing information about
which ORB applications are running and options for logging
ORB-related network traffic

2.3.4.1 Server Discovery Using the Broadcast Mechanism

With the broadcast mechanism, Reports Server discovery can occur within a subnet or
across subnets:

= Server Discovery within a Subnet

= Server Discovery Across Subnets
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Note: The Oracle Reports built-in broadcast mechanism requires the
host machine to be inside a network. Thus, following are two
scenarios in which the broadcast mechanism may not work, including
the solutions for each scenario:

1. If the host machine is not in a network (that is, it is a standalone
machine).
Solution for Windows platform: Install the MS loopback adapter,
as described on the Microsoft Web site
(http:\\microsoft.support.com). Then, specify an IP address for
your machine (either XP or Windows 2000), as follows:

1. On your desktop, right-click My Network
Places, and choose Properties.

2. Right-click the MS loopback adapter, and
choose Properties.

3. In the Properties dialog box, select Internet
Protocol (TCP/IP), and click Properties.

4. Select Use the following IP address, and
enter a valid IP address. The subnet mask
field will automatically populate. Do not use
the local host IP (that is, 127.0.0.1). For
example, enter: 198.162.1.1.

5. Click OK, and follow the instructions
displayed.

Solution for UNIX platform: Configure the discovery mechanism
to disable the built-in broadcast mechanism and enable the COS
naming service instead, by replacing the multicast element
with the namingService element in the network configuration
file (rwnetwork.conf).

2. If the host machine is connected to a network through VPN.

Solution for both Windows and UNIX platform: Configure the
discovery mechanism to disable the built-in broadcast mechanism
and enable the COS naming service instead, by replacing the
multicast element with the namingService element in the
network configuration file (rwnetwork. conf), as described in
Section 2.3.4.1, "Server Discovery Using the Broadcast
Mechanism".

2.3.4.1.1 Server Discovery within a Subnet

Within a subnet, the client broadcasts a packet with the name of the Reports Server to
which it wants to connect. A Reports Server with that name will respond if it exists in
the network. The client then connects to the Reports Server to run the report request.
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Figure 2-2 Server Discovery within a Subnet
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Using the example of running a report request with server=rep_server, the

following numbered steps map to the numbers in Figure 2-2:

1. getServerRef

The Oracle Reports client (for example, rwclient, rwservlet, or rwrgm)
broadcasts a packet containing the name of the server to which it wants to
connect. In this case, the packet contains the name rep_server.

The server with name rep_server in the network responds back with its

Interoperable Object Reference (IOR).

The client converts the IOR to an object reference.

2. runReport

The Oracle Reports client sends a request to the remote object reference to run

the report (IIOP call).

3. executeReport

Reports Server executes the report and returns either report or status.

2.3.4.1.2 Server Discovery Across Subnets

Oracle Reports provides the Oracle Reports Bridge mechanism for connecting two or
more non-secured subnets. An Oracle Reports Bridge running in one subnet will
contact Oracle Reports Bridge running in another subnet to obtain Reports Server
references. For configuration details, refer to Oracle Reports Bridge Configuration
Elements.
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Figure 2-3 Server Discovery Across Subnets
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Using the example of running a report request with server=rep_server, the
following numbered steps map to the numbers in Figure 2-3:

1. getServerRef

s The Oracle Reports client (for example, rwclient, rwservlet, or rwrgm)
broadcasts a packet containing the name of the server to which it wants to
connect. In this case, the packet contains the name rep_server.

2. Dbridgel intercepts the packet and passes it to bridge?2.
3. registerServerRef

= bridge2 broadcasts the packet in dom2, and rep_server in dom2 responds
back with the Interoperable Object Reference (IOR).

= bridge2 passes the IOR back to bridgel, and bridgel passes it to the
client using the broadcast mechanism.

s The Oracle Reports client converts the IOR to an object reference.
4. runReport

»  The Oracle Reports client sends a request to the remote object reference to run
the report (IIOP call).

5. executeReport

= Reports Server executes the report and returns either report or status.

Note: Numbers in blue color in Figure 2-3 are shown for the case
where the Oracle Reports client is in dom2 and Reports Server is in
doml.

2.3.4.2 Server Discovery Using the COS Naming Service

Alternatively, you can use the JDK-provided Common Object Service (COS) naming
service to access a Reports Server in the same subnet, as well as across a non-secured
subnet. To configure the naming service, refer to Section 8.5.1, "Network Configuration
Elements".
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Note: Itis recommended that you use the built-in broadcast
mechanism for dynamic discovery of Reports Servers. Use the
Common Object Service (COS) naming service for Reports Server
discovery only when the built-in broadcast mechanism is not suitable
for your environment, as in the following scenarios:

= You plan to install OracleAS Reports Services on a machine that is
connected to a network using VPN.

= You want to avoid broadcast traffic on your network.

To control the COS naming service through OPMN, refer to Section 8.8.1.4, "COS
Naming Service Specification"

Figure 2-4 Server Discovery Using the COS Naming Service
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Using the example of running a report request with server=rep_server, the following

numbered steps map to the numbers in Figure 24

1.

registerServer

= When rep_server is started, it registers itself with the naming service, which
must be up and running for the server to start. Now a request is run with

Server=rep_server.

getServerRef

»  The Oracle Reports client contacts the naming service and requests a reference

to server rep_server.

= The naming service returns the reference to server rep_server.

runReport

»  The Oracle Reports client sends a request to the remote object reference to run

the report (IIOP call).

executeReport

= Reports Server executes the report and returns either report or status.

Understanding the Oracle Reports Services Architecture 2-13



Setting Up Your System

Note: Numbers in blue color in Figure 2—4 are shown for the case
where the Oracle Reports client is in dom2 and Reports Server is in
doml.

2.4 Setting Up Your System

The way you set up Oracle Reports Services can vary widely depending upon the
requirements of your system. Before you set up Oracle Reports Services, you must
make some decisions based upon your requirements. By making these decisions
beforehand, you can greatly simplify the setup process.

The following subsections discuss some of the decisions involved in:
= Choosing the Types of Requests You Will Service

s Choosing Oracle Reports Servlet, JSP, or Web Services

s Choosing Single or Multiple-Machine Configurations

2.4.1 Choosing the Types of Requests You Will Service

Oracle Reports Services can be configured to accept both Web and non-Web job
requests.

In the Web case, you can run reports by clicking or typing a URL in a Web browser.
Depending on the URL, the report output is then served back to you in your browser
or sent to a specified destination (for example, a printer). To enable users to launch
reports from a browser, you will use either Oracle Reports Servlet (rwservlet) or a
JSP with your Web server. One or the other of these components must be present on
the Web server to enable communications between it and Oracle Reports Services and
to enable the processing of report requests from Web clients.

Note: For more information, refer to Section 2.4.2, "Choosing Oracle
Reports Servlet, JSP, or Web Services".

In non-Web cases, you can send job requests using the rwclient component,
installed on each of your user's machines.

From the perspective of configuration, these are the key differences between enabling
Web and non-Web requests:

= Enabling Web requests requires that you choose between Oracle Reports Servlet
(rwservlet) or JSP for the server side, but eliminates the need to install any client
software beyond a standard Web browser.

= Enabling non-Web requests requires that you install client software on each
machine that will be used to run requests. This introduces the need to administer
client software on each client machine.

The client software could be:

= An Oracle Developer Suite installation, which can be used to submit reports
requests through rwclient or rwrun.

= A utility such as the Oracle Reports Java EE Thin Client, which is available on
the Oracle Technology Network (OTN). Note that this utility is supported
only through Discussion Forums on OTN.
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The Web case is clearly the most cost effective because it reduces client maintenance
costs. But there might be cases where launching non-Web requests is a necessity.
Oracle Reports Services supports the implementation of both Web and non-Web
requests in a single deployment environment.

2.4.2 Choosing Oracle Reports Servlet, JSP, or Web Services

To use Oracle Reports Services in a Web environment, you must use Oracle Reports
Servlet (rwservlet), Reports Web Services, or Reports JSP.

Between Oracle Reports Servlet (rwservlet) and Reports JSP there are additional
considerations. A JSP-only implementation means that you can publish a layout that is
optimized for Web delivery (that is, the Oracle Reports Web Layout). Oracle Reports
Servlet (rwservlet) enables you to include paper layouts in your report publishing
solution and fully leverage the distribution features of Oracle Reports Services.

Using Oracle Reports Servlet (rwservlet) does not imply that you cannot also use
JSP files, because JSP files can contain both Web and paper layouts. When you run a
report stored in a JSP, you specify the servlet in the URL and call the JSP with the
command line option report=myreport. jsp. In this case, report output is created
based on the paper layout.

For more information on running reports, see Chapter 18, "Running Report Requests".

2.4.3 Choosing Single or Multiple-Machine Configurations

You can place Oracle Reports Services on the same machine as your Web server or on
a different machine. Both scenarios have pros and cons.

For example, while it's true that having Oracle Reports Services and the Web server on
the same machine requires more of the machine's memory and disk space, it's also true
that such an implementation reduces network traffic. This is because requests
traveling between the Web server and the application server do not have to travel
across a network, only incoming requests must do so.

If you are using the in-process Reports Server (available only with Oracle Reports
Servlet (rwservlet) implementations) you can further amplify the performance
advantages of a single machine. The in-process Reports Server speeds up processing
time by allowing for faster and more efficient communication between Oracle Reports
Services components. We recommend that you use the in-process Reports Server
unless you will not use Oracle Reports Servlet (rwservlet) to deploy reports.

On the other hand, if you have a single machine configuration and that machine fails,
everything fails.

While there is a greater amount of network traffic when the Web server and the
application server are on different machines, you also benefit from the increase in
system resources, in the form of additional CPUs, more disk space, and more available
memory. Even in a multiple machine configuration, the in-process Reports Server will
aid performance by speeding communication between Oracle Reports Services
components.

Another possibility is placing your Web server and your application server each on
multiple machines. This will require additional configuration, but it enables you to
implement load balancing on the Web server.

By using the environment switching feature it is possible to spawn Reports Engines
with different environment settings, including language, in the same Reports Server.
Refer to Section 8.2.2, "Dynamic Environment Switching" for more information.
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2.5 Setting Up a High Availability Environment

11g Release 1 (11.1.1) provides numerous high availability (HA) enhancements, as
listed in Table 2-1 in Section 2.1, "What’s New In This Release?".

This section discusses the following topics pertinent to establishing a high availability
environment:

=  Maintaining High Availability
= Configuring the rwservlet.properties file

= Configuring Reports Server for High Availability

2.5.1 Maintaining High Availability

Oracle Fusion Middleware consists of many components that can be deployed in
distributed topologies. The underlying paradigm used to enable high availability for
Oracle Fusion Middleware is clustering, which unites various Oracle Fusion
Middleware components in certain permutations to offer scalable and unified
functionality, and redundancy should any of the individual components fail.

Note: Refer to the Oracle Fusion Middleware Enterprise Deployment
Guide for Java EE and Oracle Fusion Middleware High Availability Guide
for more information on the various solutions and techniques to
achieve high availability in Oracle Fusion Middleware.

2.5.2 Configuring the rwservlet.properties file

Perform the following steps to configure the rwservlet.properties file:

1. Make sure that the in-process server has a unique name. You can check the server
sub-element of the rwservlet.properties to verify the unique server name.

2. Configure cluster in the rwservlet.properties file.
<cluster clustername="ha_cluster" clusternodes="ha_server2"/>
cluster name should be same in all rwservlet.properties files. Cluster nodes

should include in-process server names which are part of the cluster except the
current one. More than one server should be separated by a colon.

3. Save the servlet configuration file.
Alternatively, you can configure a cluster through Oracle Enterprise Manager:
1. Navigate to the Reports Application Home Page in Enterprise Manager.
2. From the Reports menu, select System MBean Browser.

The System MBean Browser page is displayed.

3. From the left content pane, expand Application Defined MBeans >
oracle.reportsApp.config > Server: WLS_REPORTS > Application: reports >
ReportsApp.

4. Select rwservlet from the list.

The Application Defined MBeans: Report sApp:rwservlet page is displayed.
5. Click the Operations tab.
6. Select addCluster.
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7.

The Operation:addCluster page is displayed.

Enter valid values in the Cluster Name and Node fields.

8. C(Click Invoke.

For more information about the rwservlet.properties file, refer to Section 8.3.1.1,
"rwservlet"

2.5.3 Configuring Reports Server for High Availability

To configure Reports Server for high availability by using the database as the job
repository, perform the following steps for each instance:

1.

Configure the database job repository for in-process Reports Servers in all
instances in the rwserver. conf file of all Reports Servers.

Note that in 11g Release 1 (11.1.1) the server configuration file must correspond to
the rwserverconf . xsd file (refer to Section 8.2.1, "Reports Server Configuration
Elements"), which means that the order in which different entries appear inside
the server configuration file is no longer random, but fixed by the XSD. As a result,
the following element must be added immediately before the <connection>
element in the server configuration file:

<jobRepository>

<property name="dbuser" value="dbuser"/>

<property name="dbpassword" value="csf:reports:dbpasswdKkey"/>
<property name="dbconn" value="dbconn"/>

</jobRepository>

For information about adding a password key in the credential store, see
Section 15.1.4, "Credential Store".

Save the server configuration file.

Alternatively, you can configure the database job repository through Oracle
Enterprise Manager:

a. Navigate to the Reports Application home page in Enterprise Manager.

b. From the Reports menu, select Administration > Advanced Configuration.
The Reports Application Advanced Configuration page is displayed.

c. Locate the Job Repository content pane in the Advanced Configuration page.

d. Select the Enable Job Repository DB checkbox.

e. Enter valid values in the Username, Password Key and Database fields.

f. Click Apply.

Configure a folder to which all instances have access (write access is needed, read
access is not enough) by adding the CacheDir or JOCCacheDir property to the
<cache> element of each of the server configuration files,

For example,
on Windows:

<property name="JOCCacheDir" value="folder name"/>
<property name="CacheDir" value="folder_name"/>

on UNIX:

<property name="JOCCacheDir" value="/net/machine_name/usrs/tmp"/>
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<property name="CacheDir" value="/net/machine_name/usrs/tmp"/>

where, " /usrs/tmp" is a shared location when Reports Server is running on
different machines and has write privileges.

Note: w=Along with JOCCache Dir, CacheDir can also be used for high
availability for sharing the cache.

= Ina case where the in-process Reports Servers are running on
different machines, the configuration can be done by sharing a
folder to the other machine or user. For example, on Windows,
configure the shared cache for both in-process Reports Servers by
adding the following property to the <cache> element of each of
the server configuration files:

<property name="JOCCacheDir" value="\\host\shared"/>

where host is the machine where the shared folder is available,
and shared is the folder name

Alternatively, you can specify the value for JOC Cache directory through Oracle
Enterprise Manager:

a. Navigate to the Reports Application Home page in Enterprise Manager.
b. From the Reports menu, select Administration > Advanced Configuration.

The Reports Application Advanced Configuration page is displayed.

Note: You can use the System MBean Browser to add JOC Cache
directory for the first time.

The High Availability parameters section in Enterprise Manager is
displayed only when the server is part of the HA cluster and the
in-process server is running.

c. Locate the High Availability Parameters section in the content pane.
d. Enter a valid folder name in the Cluster Cache Directory field.
e. Click Apply.

For information about the J0CCacheDir and CacheDir properties (new in
Oracle Reports 11g Release 1 (11.1.1), refer to Chapter 8, "Configuring Oracle
Reports Services".

4. Load the rw_server.sql file to a database (this file is included with your Oracle
Reports Services installation: ORACLE_HOME\reports\admin\sqgl)

This creates a schema that owns the report queue information and has execute
privileges on the server queue APL

5. Restart the Reports Server.

6. Set the Environment variables TNS_ADMIN and ORACLE_HOME in the shell and
start the node manager (SFMW_HOME /wlserver_
10.3/server/bin/startNodeManager . sh). This is required for the reports
in-process server to connect to the database.

For more information, see "TNS_ADMIN".
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You can use Oracle WebCache as a load balancer. For more information, see Oracle
Fusion Middleware Administrator’s Guide for Oracle Web Cache

2.5.3.1 Configuring Oracle Enterprise Manager for High Availability

When High Availability is setup across two different domains in Oracle Enterprise
Manager, you need to configure the Enterprise Manager settings. This enables both the
domains to access the data from all the servers.

1.

2
3.
4

6.

Navigate to your Domain Home Page in Enterprise Manager.
From the WebLogic Domain menu, select Security > Credentials.
Select the Reports map and edit EMServerPasswordKey and enter a password.

Repeat the steps from one to three for the other domain and enter the same
password.

Restart the Enterprise Manager Agent in both the domains.
In ORACLE_INSTANCE/bin of each domain

./opmnctl stopproc ias-component=<emagent_name>
./opmnctl startproc ias-component=<emagent_name>
./opmnctl restartproc ias-component=<emagent_name>

Restart the Reports Server in both the domains.

When you have finished configuring the Enterprise Manager settings for both the
domains, the Enterprise Manager console monitors and manages jobs in the job
queues of all the HA servers.
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After installing Oracle Reports 11¢ Release 1 (11.1.1), read through the section in this
chapter to verify you are ready to use Oracle Reports Services to publish your reports:

3.1 What'sN

What’s New In This Release?

Understanding the Oracle Fusion Middleware Installation Structure

Verifying OOTB Installation

Verifying the Reports Server Environment

Confirming Security with Oracle Portal-Based Security

Upgrading from the Prior Release
Granting Access to RWbuilder

ew In This Release?

Oracle Reports 11¢g Release 1 (11.1.1) provides the installation and upgrade
enhancements listed in Table 3-1 (a subset of Table 1-1, " 11g Functionality vs. 10g
Functionality"):

Table 3—1

11g Install Features vs. 10g Functionality

11g New Features

‘ Equivalent 10g Functionality

Install and Upgrade

Flexible install types. In Oracle Fusion
Middleware 11g, install type contains Oracle
Reports, Forms, Portal, and Discoverer. In the
installer, you can selectively install any one of
these products or all of them.

Predefined install types only. For example, you can not
install Oracle Reports alone or Oracle Reports and
Oracle Portal alone.

Separate installation of binaries from configuration,
allowing shared binaries across servers. Oracle
Installer allows for install only and then
configuration only as two separate steps.

For more information, see Section 3.2,
"Understanding the Oracle Fusion Middleware
Installation Structure".

Single ORACLE_HOME installation including both
binaries and configuration.

New and improved management screens in Oracle
Enterprise Manager. Oracle Enterprise Manager
provides enhanced usability for all the
administration, monitoring, and diagnosability
operations. For more information, see

Chapter 7, "Administering Oracle Reports
Services Using Oracle Enterprise Manager".

Oracle Enterprise Manager Application Server (AS)
Control, and modifying configuration files.
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Table 3—-1 (Cont.) 11g Install Features vs. 10g Functionality

For more information, see Section 3.6,
"Upgrading from the Prior Release".

11g New Features Equivalent 10g Functionality
Fully automated upgrade from 10g Release 2 Not Applicable (N/A)
(10.1.2).

3.2 Understanding the Oracle Fusion Middleware Installation Structure

In prior releases, Oracle Reports Services was installed in a single Oracle home
(ORACLE_HOME), including all files (both binaries and configuration). Oracle Fusion
Middleware 11g Release 1 (11.1.1) introduces the option to split installation into an
Oracle home (ORACLE_HOME) and an Oracle instance (ORACLE_INSTANCE) to
separate binaries from configuration, and allow shared binaries across servers.

The new Oracle Fusion Middleware installation option provides several advantages:

ORACLE_HOME contains binary files, which can be shared across multiple
ORACLE_INSTANCES, reducing the footprint and management of each ORACLE_
INSTANCE.

It is easier to apply patches and maintain the binary ORACLE_HOME without
needing to reconfigure.

Install of each ORACLE_INSTANCE is easier and lightweight.
Easier backup, restore, and cloning.

Support for Reports-only install.

For complete information about the new installation structure, including how to create
a new Oracle instance, refer to Oracle Fusion Middleware Administrator’s Guide.

3.3 Verifying OOTB Installation

Make sure Oracle Reports components are created out-of-the-box (OOTB), and are
available and ready to use after installation and configuration in the following way:

Using Oracle Enterprise Manager

3.3.1 Using Oracle Enterprise Manager

In Oracle Enterprise Manager, navigate to the following pages to manage and view
Oracle Reports components:

Reports Server Home Page, along with Basic Configuration and Advanced
Configuration pages

Forms/Reports Common Component Configuration Page
Reports Tools Component Configuration Page

Reports New Job Scheduling Page

Reports Bridge Home Page, along with configuration pages

Reports Application Home Page, along with Basic Configuration and Advanced
Configuration pages

Reports Security Policies Page

Reports Security Configuration Page
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= Reports Log Configuration Page
= Reports Jobs Page (Finished /Scheduled /Current/Long Running/Failed)

Use these pages to perform checks and verifications, start a standalone Reports Server,
shut down the standalone Reports Server, and run a report using rwservlet and the
in-process Reports Server.

For more information, see Chapter 7, "Administering Oracle Reports Services Using
Oracle Enterprise Manager".

3.4 Verifying the Reports Server Environment

Oracle Reports Services report requests flow from the Oracle HTTP Server component,
to Oracle Reports Servlet, to Reports Server. Before sending report requests to Reports
Server, verify that the environment is up and running:

s Checking Oracle HTTP Server
»  Checking Oracle Reports Servlet
»  Checking Reports Server

3.4.1 Checking Oracle HTTP Server

Before starting Reports Server through Oracle Enterprise Manager, you must verify
that your Oracle HTTP Server is running. For more information about performing this
task in Oracle Enterprise Manager, refer to your Oracle Enterprise Manager
documentation.

Alternatively, you can verify that the Oracle HTTP Server is running by navigating to
the following URL:

http://server_name.domain:port_number/

3.4.2 Checking Oracle Reports Servlet

To verify that Oracle Reports Servlet (rwservlet) is running, navigate to the
following URL:

http://host:port/reports/rwservlet/help

where
host is the server that is allotted.
port is either the OHS port or the WebLogic Server port.

Note that the URL is case-sensitive. If this URL executes successfully, you should get a
help page describing the rwservlet command line arguments

3.4.3 Checking Reports Server
To verify that Reports Server is running, navigate to the following URL:

http://host:port/reports/rwservliet/getserverinfo?server=server._name

where

host and port are as described in Section 3.4.2, "Checking Oracle Reports Servlet".
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server=server._name is not required if you are using the default Reports Server
name (rep_machine_name) or the Reports Server specified in the Oracle Reports
Servlet configuration file (rwservlet.properties).

If this URL executes successfully, you should see a listing of the job queue for the
specified Reports Server.

Note: For more information about the Oracle Reports Servlet
configuration file (rwservlet.properties ), see Section 8.3,
"Oracle Reports Servlet Configuration File".

3.5 Confirming Security with Oracle Portal-Based Security

In Oracle Reports 11g Release 1 (11.1.1), by default Reports Server is secure
out-of-the-box using Oracle Portal-based Security Services. During installation, you
can specify any LDAP server (including Oracle Internet Directory) to be used as the
policy store. Confirm that security is enabled in either of the following ways:

= Using Oracle Enterprise Manager

= Using the Command Line

3.5.1 Using Oracle Enterprise Manager

In Oracle Enterprise Manager, select Reports > Administration > Advanced
Configuration to display the Reports Server Advanced Configuration Page:

s In the Reports Security region, check Enable Security.

3.5.2 Using the Command Line

On the command line, navigate to the following directory to open the in-process
Reports Server configuration file to verify it is configured with the RWJAZN security:

FMW_HOME /user_projects/domains/domain_name/servers/WLS_
REPORTS/stage/reports/reports/configuration

Presence of "<security id="rwSec"
class="oracle.reports.server.RWSecurity"/>"in the configuration file
confirms that RWSecurity is enabled.

3.6 Upgrading from the Prior Release
Upgrading from Oracle Reports 10.1.2.x to 11¢ Release 1 (11.1.1) is fully automated:
» Integrated with Oracle Fusion Middleware Upgrade framework.
= Automated configuration reduction mapping.
= Extensive logging and diagnostics.

= No loss of functionality.

3.6.1 Backward Compatibility and Interoperability

Oracle Reports 11g Release 1 (11.1.1) is fully backward compatible and interoperable
with 10.1.2.x:

= 10.1.2.x server/client compatible with 11¢ Release 1 (11.1.1) server/client.
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Note: This interoperability scenario requires the Patch 7597820 to be
installed. You can download this patch from the following URL:

http:/ /updates.oracle.com/download /7597820.html.

This patch is required to address the CORBA IDL changes between
the two releases for the Job Status information. If you want to use
rwservlet of Reports 10g Release 2 (10.1.2.3) with the Reports 11g
Release 1 (11.1.1) Server, ensure that you install this patch on your
10.1.2.3 installation. You can download this patch from

http:/ /metalink.oracle.com.

= 10.1.2.x reports can be run without any changes or loss of functionality.

= Support for Oracle Portal and Oracle Internet Directory based security along with
new Java EE security.

= Support for 10.1.2.x Toolkit-based font model along with new Java-based font
model.

= Support for interoperability with 10.1.2.x Oracle Forms Services, Oracle Portal,
and Oracle Internet Directory.

3.7 Granting Access to RWhuilder

A user who installed the Oracle Reports components can access them, by default. If
you want to allow other users to run rwbuilder, run the following commands at the
command prompt:

chmod 750 $SORACLE_HOME/bin

chmod 750 $ORACLE_HOME/bin/rwbuilder

chmod 750 $COMMON_COMPONENTS_HOME/modules/oracle.dms_11.1.1/*.jar
chmod 750 $COMMON_COMPONENTS_HOME/modules/oracle.odl_11.1.1/*.jar
chmod 750 $ORACLE_INSTANCE

chmod 750 $ORACLE_INSTANCE/bin

chmod 750 $ORACLE_INSTANCE/config

chmod 750 $ORACLE_INSTANCE/config/reports

chmod 750 $SORACLE_INSTANCE/config/reports/bin

chmod 750 S$SORACLE_INSTANCE/config/reports/bin/*

chmod 750 $ORACLE_INSTANCE/config/FRComponent

chmod 750 $ORACLE_INSTANCE/config/ReportsToolsComponent

chmod 750 $ORACLE_INSTANCE/config/ReportsToolsComponent/ReportsTools
chmod 750 $ORACLE_INSTANCE/config/ReportsToolsComponent/ReportsTools/*
chmod 770 $ORACLE_

INSTANCE/config/ReportsToolsComponent /ReportsTools/rwbuilder.conf
chmod 750 $ORACLE_INSTANCE/reports

chmod 750 $ORACLE_INSTANCE/reports/reports_install.properties

chmod 750 $DOMAIN_HOME/servers/WLS_REPORTS/tmp/_WL_user/

chmod 770 $DOMAIN_HOME/servers/WLS_REPORTS/tmp/_WL_user/reports_<version>/
chmod 770 $SDOMAIN_HOME/servers/WLS_REPORTS/tmp/_WL_user/reports_<version>/<random_
name>/war

chmod 750 <the directory that is mentioned in REPORTS_TMP>

Then you can change the location of logs to a user-readable and writable location in
SORACLE_
INSTANCE/config/ReportsToolsComponent/ReportsTools/logging.xml
by changing the "path" property of runtime_trace_handler and zrcclient_
trace_handler.
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Upgrading Oracle Reports

This chapter summarizes the process of upgrading Oracle Reports.

4.1 Overview of the Oracle Fusion Middleware Upgrade Assistant

The Oracle Fusion Middleware Upgrade Assistant automates the upgrade of many
aspects of Oracle Application Server 10g environment. The Oracle Fusion Middleware
Upgrade Assistant is installed automatically into the bin directory of Oracle Fusion
Middleware Oracle home.

The Oracle Fusion Middleware upgrade Assistant guides you through the process of
upgrading from previous versions of Oracle Application Server instance to Oracle
Fusion Middleware 11g Release 1 (11.1.1) instance.

4.2 Overview of the Upgrade Process

The following table summarizes the steps in the process of upgrading Oracle Reports
from Oracle Application Server 10g instance to Oracle Fusion Middleware 11g Release

1 (11.1.1) instance.

Table 4-1

Upgrade Process Overview

Step

Description

Review Upgrade Concepts
in the Oracle Fusion
Middleware Upgrade
Planning Guide

Understand the upgrade
starting points

Decide upon an Oracle
Reports Topology

Install New 11¢g Middle
Tiers

Run Upgrade Assistant for
Each Middle Tier

The Oracle Fusion Middleware Upgrade Planning Guide
provides a high-level overview of how to upgrade your entire
Oracle Application Server environment to Oracle Fusion
Middleware, including compatibility information and
instructions for upgrading any databases that support your
middleware components

Before planning your upgrade, you should be familiar with the
supported starting points for an Oracle Portal, Forms, Reports,
and Discoverer upgrade.

With the introduction of Oracle WebLogic Server, the topologies
for Oracle Portal, Forms, Reports, and Discoverer have changed
somewhat. Before you begin an upgrade, make sure you are
familiar with the basic topologies in Oracle Fusion Middleware
11g.

Use the Oracle Portal, Forms, Reports, and Discoverer installer

to install your new Oracle Fusion Middleware middle tiers.

The Oracle Fusion Middleware Upgrade Assistant copies
configuration data from your existing Oracle Application Server
middle tiers to the newly installed Oracle Fusion Middleware
middle tiers.
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Table 4-1 (Cont.) Upgrade Process Overview

Step Description

Perform Any Required The Upgrade Assistant automates many of the upgrade tasks,
Post-Upgrade Manual Steps but there are cases where you must manually modify the

for Each Middle Tier configuration settings after running the Upgrade Assistant.
Use Upgrade Assistant to The Upgrade Assistant provides a feature that will verify the
Verify Upgraded upgraded environment to make sure specific components and
Environment URLs are functional.

Upgrading Oracle Reports using Upgrade Assistant involves the following steps:

1. Specifying an operation, such as Upgrading the middle tier instance, Upgrading
metadata repository, or Verifying the instance. The Upgrade Middle Tier Instance
option is selected by default.

Specifying the Source Home.
Specifying the Destination Instance.

Specifying the details of the WebLogic Server.

o » w0 Db

Specifying an Upgrade option. The Stop source components before upgrade
option is selected by default.

6. Examining the components. The Upgrade Assistant tool provides a list of the
components that are already examined and ready for upgrade.

7. Reviewing the settings and choices before proceeding with the upgrade. The
Upgrade Assistant tool displays the summary of the middle-tier upgrade to be
performed in the Upgrade Summary screen.

8. Clicking the Upgrade button on the Upgrade Summary screen completes the
upgrade process.

Note: For more information on upgrading Oracle Reports using
Upgrade Assistant, see "Task 6: Use the Upgrade Assistant to Upgrade
the Required Schemas and Middle Tiers" in Oracle Fusion Middleware
Upgrade Guide for Oracle Portal, Forms, Reports, and Discoverer.

4.3 What is Upgraded?

The following Oracle Reports Components and elements are upgraded to the new
Oracle Fusion Middleware 11g Release 1 (11.1.1) environment.

= Configuration files for Reports Runtime components like rwbuilder, rwrun,
rwclient, and in-process server.

= All the Reports Servers created in 10g instance are created and migrated to 11g
instance.

= Reports Bridge created in 10g instance is created and migrated to 11g instance.
= All the dependent Reports components are migrated to 11g instance.

= Registry entries in 10g instance are migrated to 11¢ instance on windows platform.

4-2 Publishing Reports to the Web with Oracle Reports Services



Summary of the Upgraded Files

4.4 Summary of the Upgraded Files

Table 4-2 summarizes Oracle Reports files, including the configuration files, which are
upgraded during the upgrade process, as described in Table 4-1.

Table 4-2 Upgraded Oracle Reports Files

11g Target Flle
Name

11g Target Configuration Path

Upgrade Modification

<stand_alone_
server_
name>.conf

<in-process_
server_
name>.conf

rwnetwork.conf

xmlpds.conf

SORACLE_
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/rwserver.conf

SDOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER__
NAME>/applications/reports_
<version>/configuration//rwserv
er.conf

J2SE: SORACLE_
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/rwnetwork.conf

J2SE: SORACLE__
INSTANCE/config/ReportsToolsCom
ponent/ReportsTools/rwnetwork.c
onf

J2SE: SORACLE_
INSTANCE/config/ReportsBridgeCo
mponent; /<bridge_
name>/rwnetwork.conf

J2EE: $SDOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER__
NAME>/applications/reports_
<version>/configuration/>/rwnet
work.conf

J2SE: SORACLE_
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/xmlpds.conf

J2SE: SORACLE_
INSTANCE/config/ReportsToolsCom
ponent/ReportsTools/xmlpds.conf

J2EE: $DOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER_
NAME>/applications/reports_
<version>/configuration//xmlpds
.conf

Migration of Standalone
Server configuration.

Exception: <rwsec>
element is not migrated.

Migration of configuration
for in-process server.

Exception: <rwsec>
element is not migrated.

Migration of network
configuration to
Standalone Server, Reports
Bridge, Reports tools and
In-process Server.

Exception: Channel and
port attributes in
<multicast> element are
not migrated.

Migration of configuration
to Standalone Server,
Reports tools and
In-process Server.
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Table 4-2 (Cont.) Upgraded Oracle Reports Files

11g Target Flle

Name

11g Target Configuration Path

Upgrade Modification

textpds.conf

Jdbcpds.conf

proxyinfo.xml

rwservlet.prope

rties

<bridge_
name>.conf

J2SE: SORACLE_
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/textpds.conf

J2SE: SORACLE_
INSTANCE/config/ReportsToolsCom
ponent/ReportsTools/textpds.con
f

J2EE: SDOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER__
NAME>/applications/reports_
<version>/configuration/textpds
.conf

J2SE: $ORACLE_
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/jdbcpds.conf

J2SE: $SORACLE_
INSTANCE/config/ReportsToolsCom
ponent/ReportsTools/jdbcpds.con
f

J2EE: $DOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER__
NAME>/applications/reports_
<version>/configuration/jdbcpds
.conf

J2SE: SORACLE__
INSTANCE/config/ReportsServerCo
mponent/<server_
name>/rwserver.conf

J2SE: SORACLE_
INSTANCE/config/ReportsToolsCom
ponent/ReportsTools/rwserver.co
nf

J2EE: SDOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER_
NAME>/applications/reports_
<version>/configuration/rwserve
r.conf

$DOMAIN
HOME/config/fmwconfig/servers/<
WLS_SERVER_
NAME>/applications/reports_
<version>/configuration/rwservl
et .properties

SORACLE_
INSTANCE/config/ReportsBridgeCo
mponent /<bridge_
name>/bridge.conf
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Migration of configuration
to Standalone Server,
Reports tools and
In-process Server.

Migration of configuration
to Standalone Server,
Reports tools and
in-process server.

Migration of configuration
to Standalone Server,
Reports tools and
In-process Server.

Migration of configuration
to in-process server.

Exception:
<singlesignon> element
is not migrated.

Migration of configuration
to Reports Bridge.



Summary of the Upgraded Files

Table 4-2 (Cont.) Upgraded Oracle Reports Files

11g Target Flle
Name

11g Target Configuration Path

Upgrade Modification

Cgicmd.dat

*.res
*.dat

Opmn . xm1

Uifont.ali

Uiprint.txt

uiscreenprint.t
xt

ulscreenprint.p
pd

* . ppd
*.afm
* . hpd
*.tfm

*.rgb

Cauprefs.ora
(Windows only)

Cagprefs.ora
(Windows only)

Prefs.ora (Linux

only)

$DOMAIN_
HOME/config/fmwconfig/servers/<
WLS_SERVER__
NAME>/applications/reports_
<version>/configuration/cgicmd.
dat

SORACLE_HOME/reports/res

SORACLE_
INSTANCE/config/reports/server

SORACLE_
INSTANCE/config/OPMN/opmn/opmn .
xml

On Windows: ORACLE_
INSTANCE\config\FRComponent\frc
ommon\ tools\common

On UNIX: ORACLE_
INSTANCE/config/FRComponent/frc
ommon/guicommon/tk/admin

SORACLE_
INSTANCE/config/FRComponent/frc
ommon/guicommon/tk/admin

SORACLE_
INSTANCE/config/FRComponent/frc
ommon/guicommon/tk/admin

SORACLE_
INSTANCE/config/FRComponent/frc
ommon/guicommon/tk/admin

SORACLE_
HOME/guicommon/tk/admin/PPD

SORACLE_
HOME /guicommon/tk/admin/AFM

SORACLE_
HOME/guicommon/tk/admin/HPD

SORACLE_
HOME /guicommon/tk/admin/TFM

SORACLE_

HOME/ frcommon/templates/tk/conf
ig/

SORACLE_

INSTANCE/config/FRComponent/frc
ommon/tools/admin

SORACLE_
INSTANCE/config/FRComponent/frc
ommon/tools/admin

$ORACLE_
INSTANCE/config/FRComponent/frc
ommon/tools/admin

Migration of configuration
to In-process Server.

Copy all files to target
location.

Copy all files to target
location.

Migration of Reports
specific entries.

Copy file to target location.

Copy file to target location.

Copy file to target location.

Copy file to target location.

Copy all files in source
location to target location.

Copy all files in source
location to target location.

Copy all files in source
location to target location.

Copy all files in source
location to target location.

Copy all files in source
location to target location.
Copy file to target location.

Copy file to target location.

Copy file to target location.
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Table 4-2 (Cont.) Upgraded Oracle Reports Files

11g Target Flle

Name 11g Target Configuration Path Upgrade Modification
Windows Windows Registry Migration of Windows
Registry registry entries. Only

Reports specific registry
entries are migrated.

4.5 Post- Upgrade Tasks

After you upgrade to OracleAS Reports Services 11g, review the following sections,
which provide information about typical post-upgrade tasks for OracleAS Reports
Services users:

s Configuring Security After Upgrade to Oracle Reports 11g
= Additional Oracle Reports Post-Upgrade Tasks

4.5.1 Configuring Security After Upgrade to Oracle Reports 11g

When you upgrade to Oracle Reports 11g, the security configuration is not upgraded.
As a result, the security configuration of Oracle Reports 11g remains the same as it was
before the upgrade.

For information about the security features available in Oracle Reports 11g and how to
configure them, see Chapter 15, "Securing Oracle Reports Services".

4.5.2 Additional Oracle Reports Post-Upgrade Tasks

The following sections describe some other common post-upgrade tasks to complete
after upgrading to OracleAS Reports Services 11g:

= Modifying Oracle Reports Shell Scripts After Upgrade
= Modifying Oracle Reports DAT Files After Upgrade

= About the In-process Server Target After Upgrade

s Viewing Cached Reports Output Files After Upgrade

4.5.2.1 Modifying Oracle Reports Shell Scripts After Upgrade

Any shell scripts that are stored in the bin directory of the Oracle Reports 10g Oracle
home, such as reports.sh, rwrun.sh, and rwserver. sh are not upgraded
automatically during the upgrade process. Instead, you must change these scripts
manually, as needed. After the upgrade, you can find these scripts in the following
Oracle Fusion Middleware 11¢ directory:

ORACLE_INSTANCE/config/reports/bin

4.5.2.2 Modifying Oracle Reports DAT Files After Upgrade

OracleAS Reports Services DAT files are upgraded during the upgrade process.
However, if job command entries in the DAT files contain references to old Oracle
Home path names or invalid path names, then those jobs will fail. Therefore, you must
reschedule any such report jobs.
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4.5.2.3 About the In-process Server Target After Upgrade

In OracleAS Reports Services 10g, the in-process server target appears in the Oracle
Enterprise Manager Application Server Control as Reports Server.

However, after you upgrade to OracleAS Reports Services 11g, the in-process server
does not appear as Reports server in Oracle Enterprise Manager Fusion Middleware
Control. Instead, it appears as a Reports application, called reports, and you can
manage the in-process server target and the Reports servlet on the Reports application

page.

4.5.2.4 Viewing Cached Reports Output Files After Upgrade
Cached Reports output files are not upgraded to Oracle Reports 11g.

4.6 For More Information
For more information about the upgrade process, see:
»  Oracle Fusion Middleware Upgrade Planning Guide.

»  Oracle Fusion Middleware Upgrade Guide for Oracle Portal, Forms, Reports, and
Discoverer.
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Interoperability Scenarios and
Considerations

This chapter discusses interoperability scenarios and considerations for Oracle Reports
11g Release 1 (11.1.1).

It includes the following sections:
= Interoperability with Previous Versions of Oracle Reports

s Interoperability with Other Oracle Components

5.1 Interoperability with Previous Versions of Oracle Reports

Oracle Reports 11¢g Release 1 (11.1.1) interoperates with Oracle Reports 10.1.2.3. If you
are using Oracle Reports 10.1.2.3 client with Oracle Reports 11g Release 1 (11.1.1)
server, you must install a patch. For more information about this interoperability
scenario and patch requirements, see Oracle Fusion Middleware Release Notes for
Microsoft Windows.

5.2 Interoperability with Other Oracle Components

Oracle Reports 11g Release 1 (11.1.1) interoperates with other Oracle components, such
as Oracle Portal, Oracle Internet Directory, Oracle Forms, OracleAS Single Sign-On
(550), Oracle BPEL Process Manager, and Oracle Application Server WebCache.

Table 5-1 describes those interoperability scenarios.
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Table 5-1 Interoperability with Other Components

Scenario

Related Information

Oracle Reports 11¢ Release 1 (11.1.1)
Server/Servlet with Oracle Portal 10.1.4

Oracle Reports 11¢ Release 1 (11.1.1)
Server/Servlet with Oracle Internet Directory
10.1.4.3

Oracle Reports 11g Release 1 (11.1.1) Server with
Oracle Forms 10.1.2.3 Client

Oracle Reports 11g Release 1 (11.1.1) with
Oracle Portal 11 Release 1 (11.1.1)

Oracle Reports 11g Release 1 (11.1.1) with
Oracle Internet Directory Release 1 (11.1.1) and
Oracle Single Sign-on 10.1.4.3

Oracle Reports 11g Release 1 (11.1.1) Server with
Oracle Forms 11g Release 1 (11.1.1)

Oracle Reports 11g Release 1 (11.1.1) Server with
Oracle BPEL Process Manager 11g Release 1
11.1.1)

Oracle Reports 11g Release 1 (11.1.1) with
Oracle WebCache 11¢ Release 1 (11.1.1)

Oracle Reports 10.1.2 with Oracle Internet
Directory 11¢g Release 1 (11.1.1) and Oracle
Single Sign-on 10.1.4.3

Oracle Reports 11¢ Release 1 (11.1.1) with
Oracle Internet Directory 10.1.2.3 and Oracle
Single Sign-on 10.1.2.3

For related information, see the following documents:

»  Oracle Fusion Middleware Upgrade Guide for Oracle
Portal, Forms, Reports, and Discoverer

s Oracle Fusion Middleware Installation Guide for
Oracle Portal, Forms, Reports and Discoverer
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Starting and Stopping Oracle Reports

Services

This chapter provides information on starting and stopping Oracle Reports Services. It
includes the following main sections:

Starting and Stopping Reports Server

Starting and Stopping Oracle Reports Bridge

Starting Reports Components After Shutting Down an Instance
Starting and Stopping the COS Naming Service

Starting, Stopping, and Restarting Oracle Reports Components Using Oracle
Enterprise Manager

Starting and Stopping the In-process Reports Server Using Oracle Reports Servlet
Verifying that the Oracle HTTP Server Is Running
Verifying that the Reports Servlet and Server are Running

Note: The examples in this chapter use ORACLE_HOME to denote
where Oracle Fusion Middleware is installed. This includes Oracle
Reports Services.

6.1 Starting and Stopping Reports Server

The best way to run Reports Server is through the Oracle Process Manager and
Notification Server (OPMN). OPMN provides a centralized mechanism for initializing,
maintaining, and shutting down your Oracle HTTP Server, Oracle WebLogic Server
processes, and OracleAS Reports Services. For more information on configuring
Reports Server through OPMN, see Section 8.8, "Configuring Reports Server with the
Oracle Process Manager and Notification Server and Oracle Enterprise Manager"
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Important: You must start or stop a Reports Server registered with
Oracle Enterprise Manager only through Oracle Enterprise Manager
11g or OPMN. OPMN automatically restarts Reports Server if it stops
responding for some reason. OPMN runs as a Windows service on
Windows.

In Oracle Reports, running Reports Server as Windows service is no
longer supported (rwserver -install server_name). Asa
result, the related command line keywords INSTALL and UNINSTALL
are obsolete. If you start or stop a Reports Server that is managed by
OPMN running as a Windows service or through the command line,
you may face the following issues:

s Oracle Enterprise Manager may not accurately reflect the status of
Reports Server and metrics information.

= Oracle Enterprise Manager 11¢ may display errors when starting
or stopping Reports Server.

For more information about the obsolescence of running Reports
Server as a Windows service, see A Guide to Functional Changes Between
Oracle Reports 6i and 10g on the Oracle Technology Network (OTN).

6.1.1 Starting, Stopping, and Restarting Reports Servers from Oracle Enterprise
Manager

When the standalone Reports Server is configured through OPMN, you can start, stop,
and restart it through Oracle Enterprise Manager

Note: The in-process server is available as part of wls_reports and
thus registered with Oracle Enterprise Manager during installation of
Oracle Application Server. If you add any Reports Servers after
installing Oracle Application Server, you must register the new
server(s) in the Oracle Enterprise Manager’s targets.xml file and
the Oracle Process Manager and Notification Server's opmn . xm1 file.
For more information, see Section 8.8, "Configuring Reports Server
with the Oracle Process Manager and Notification Server and Oracle
Enterprise Manager"

To start, stop, or restart a Reports Server:

1. From the Reports Server main page, navigate to Reports > Control menu, and
select:

= Start Up to start the server.
= Shut Down.. to stop the server.

= Restart... to restart the server.

6.1.2 Starting, Stopping, and Restarting Reports Servers from the Oracle Process
Manager and Notification Server

Before you start the Oracle Reports Server with Oracle Process Manager and
Notification (OPMN), you must add the Server to OPMN, as shown in the following
example:
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ORACLE_INSTANCE/bin/opmnctl createcomponent -adminUsername weblogic -adminHost
<host_name> -adminPort <port> -oracleHome <oracle_home -oracleInstance <instance_
home> -instanceName <instancename> -componentName <bridge_name> -componentType
ReportsServerComponent

You can use the following command lines to start, stop, and restart Reports Server if it
was configured through the Oracle Process Manager and Notification Server:

ORACLE_INSTANCE/bin/opmnctl startproc ias-component=reports_server_name
ORACLE_INSTANCE/bin/opmnctl startproc process-type=ReportsServerComponent
ORACLE_INSTANCE/bin/opmnctl stopproc ias-component=reports_server_name
ORACLE_INSTANCE/bin/opmnctl restartproc ias-component=reports_server_name

The Reports Server name must match the name in the ias-component id in the
opmn . xml file.

You can also query the status of the Oracle Process Manager and Notification Server,
by using the following command:

ORACLE_INSTANCE/bin/opmnctl status

For more information on configuring Reports Server through the Oracle Process
Manager and Notification Server, see Section 8.8, "Configuring Reports Server with the
Oracle Process Manager and Notification Server and Oracle Enterprise Manager"

6.1.3 Alternative Methods of Starting and Stopping Reports Server

If you choose not to run Reports Server through OPMN and maintain it through
Oracle Enterprise Manager, you can use these older methods of running Reports
Server:

= Starting the In-process Server (Windows and UNIX)
= Starting Reports Server from a Command Line (Windows and UNIX)
= Stopping Reports Server

Important: Beginning with Oracle Reports 10g Release 2 (10.1.2),
running Reports Server as a Windows service is no longer supported,
as mentioned at the beginning of this section.

6.1.3.1 Starting the In-process Server (Windows and UNIX)

If you are using Reports Server as an in-process server (the default configuration),
sending a run report request starts the in-process server; however, if you are sending a
request through a command line, the servlet must be invoked first using either the run
report URL or the Web command URL. When you have successfully started the
servlet, this also means you have successfully started the in-process server.

To directly start the in-process server from a URL, enter the following from your Web
browser:

http://your_machine_name:your_port_num/reports/rwservlet/startserver

6.1.3.2 Starting Reports Server from a Command Line (Windows and Linux)

Before you start the Reports Server from command line, you must set the
COMPONENT_CONFIG_DIRECTORY environment variable as follows:

COMPONENT_CONFIG_DIRECTORY=0ORACLE_
INSTANCE/config/ReportsServerComponent/<reports_server_name>
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To start Reports Server as a standalone server on Windows, use the following
command:

rwserver server=server_name
Add the BATCH command line keyword to start up the server without displaying
dialog boxes or messages.

rwserver server=server_name batch=yes
You can run this command on UNIX using the following syntax:

rwserver.sh server=server_name

Or:

rwserver.sh server=server_name batch=yes

Important: If DISPLAY is not set, you must start Reports Server in
batch mode (batch=yes).

Refer to Section 10.8, "Removing DISPLAY and Printer Dependencies
on UNIX" for more information on the removal of DISPLAY and
printer dependencies on UNIX.

Refer to Appendix B.1.41, "REPORTS_DEFAULT_DISPLAY" for more
information on the REPORTS_DEFAULT_DISPLAY environment
variable.

You can run this command from any directory as long as the shell script can be
reached in your PATH environment variable.

6.1.3.3 Stopping Reports Server

There are several ways to stop Reports Server on Windows and UNIX, as follows:

= If Reports Server is running on Windows through the rwserver executable, or on
UNIX through a shell script, rwserver. sh, click Shutdown in the Reports Server
dialog box.

s If you are not running Reports Server from the command line, launch Oracle
Enterprise Manager, and navigate to the Reports Server home page and from the
Reports menu select Control > Shut Down...

s If Reports Server is running as an in-process server through the Reports Servlet,
issue the following URL:

http://your_host_name:port_number/reports/rwservlet/stopserver?authid=admin
user/admin password

= If Reports Server is running from a command line on Windows or UNIX, use any
of the following commands, depending on how you want to shut down the
Reports Server.

Note: On UNIX, use rwserver.sh instead of rwserver.

Before you shut down the server, you must set the COMPONENT_CONFIG_
DIRECTORY environment variable as follows:

COMPONENT_CONFIG_DIRECTORY=0ORACLE_
INSTANCE/config/ReportsServerComponent/<reports_server_name>

To shut down the server normally (that is, finish pending jobs and then stop):
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rwserver server=server shutdown=normal authid=username/password

To shut down the server immediately (that is, stop without finishing pending
jobs):

rwserver server=server shutdown=immediate authid=username/password

To shut down the server without displaying any related messages:

rwserver server=server shutdown=normal authid=username/password batch=yes
The keywords used with the rwserver command are described in Appendix A,
"Command Line Keywords"

Note: authidis Reports Server's administration user name and
password. In Oracle Reports 11g Release 1 (11.1.1), the default security
is based on standards-based Java EE security model through Oracle
Platform Security Services. For a non-secure Reports Server, this user
is defined in the identifier element. The following bullet contains more
information on how to stop a non-secure Reports Server using the
command line.

When you stop or shut down a non-secure Reports Server from the command line
using either rwserver . sh or rwrgv. sh, you must provide a valid authid, which
must match the value set in the identifier element in the server configuration
file. However, the identifier element is set during Reports configuration while
installing Oracle Application Server and encrypted by Reports Server. You can
reset the identifier element to any value. If you have registered this Reports Server
with Oracle Enterprise Manager and OPMN, you must also change the
corresponding properties in targets.xml for Oracle Enterprise Manager
integration to work. Perform the following steps:

1. In the non-secure Reports Server's configuration file, server_name. conf,
modify the identifier element to specify the username/password and set the
encrypted attribute to no. For example:

<identifier encrypted="no">scott/tiger</identifier>
2. Stop and restart Reports Server manually for the changes made to the server_
name.conf file to take effect.

Note: You must restart Reports Server for any configuration changes
to take effect.

Reports Server will now encrypt the username/password value of the
identifier element. After Reports Server reads the changes made in the server_
name.conf, the following commands should execute successfully (with
scott/tiger as the username/password):

./rwserver.sh server=server_name shutdown=normal authid=scott/tiger

./rwrqv.sh server=server_name shutdown=normal authid=scott/tiger

3. For Oracle Enterprise Manager integration, edit the targets . xm1 file (in
SORACLE_INSTANCE/EMAGENT/emagent_asinst_1/sysman/emd ) using
any text editor, as follows:

- Search for target with TYPE="oracle_repserv" and DISPLAY_
NAME="Reports Server: server_name".

Starting and Stopping Oracle Reports Services 6-5



Starting and Stopping Oracle Reports Bridge

— In the entry, set the UserName property and the Password property to
the same user name and password as in the identifier element in the
server_name.conf file. Set the ENCRYPTED attribute to FALSE for these
two properties.

— Restart Oracle Enterprise Manager for the changes to take effect.

You should now be able to stop and shut down a non-secure Reports Server
using Oracle Enterprise Manager.

Note: These steps are required only for a non-secure Reports Server
and not for secure Reports Servers.

6.2 Starting and Stopping Oracle Reports Bridge

The Oracle Reports bridge is used to connect two subnets. It acts as a gateway between
Oracle Reports components running in different subnets.

Note: In Oracle Reports 11¢ Release 1 (11.1.1), the Oracle Reports
bridge is integrated with Oracle Enterprise Manager 11g. Therefore,
you can see the Oracle Reports bridge status or start and stop it from
the Oracle Enterprise Manager.

For troubleshooting scenarios and diagnosis, see Appendix D.8, "Diagnosing Oracle
Reports Bridge Problems".

6.2.1 Starting, Stopping, and Restarting the Oracle Reports Bridge from the Oracle
Process Manager and Notification Server

Before you can start the Oracle Reports bridge with Oracle Process Manager and
Notification (OPMN), you must add the bridge to OPMN, as shown in the following
example:

ORACLE_INSTANCE/bin/opmnctl createcomponent -adminUsername weblogic -adminHost
<host_name> -adminPort <port> -oracleHome <oracle_home -oraclelnstance
<instance_home> -instanceName <instancename> -componentName <bridge name>
-componentType ReportsBridgeComponent

To start the Oracle Reports bridge if it was configured through the Oracle Process
Manager and Notification (OPMN) Server, use either of the following commands:

ORACLE_INSTANCE/bin/opmnctl startproc ias-component=bridgename
ORACLE_INSTANCE/bin/opmnctl startproc process-type=ReportsBridgeComponent

To stop the Oracle Reports bridge, use the following command:

ORACLE_INSTANCE/bin/opmnctl stopproc ias-component=bridgename

To restart the Oracle Reports bridge, use the following command:
ORACLE_INSTANCE/bin/opmnctl restartproc ias-component=bridgename

The Oracle Reports bridge name must match the name in the ias-component id in
the opmn . xm1 file.

You can also query the status of the Oracle Process Manager and Notification bridge,
using the following command:
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ORACLE_INSTANCE/bin/opmnctl status

For more information on configuring the Oracle Reports bridge through the Oracle
Process Manager and Notification Server, see Section 8.8.1.3, "Oracle Reports Bridge
Specification”

6.2.2 Starting and Stopping the Oracle Reports Bridge from the Command Line

It is recommended that you use Enterprise Manager or OPMN to start and stop Oracle
Reports components.

You must set the following environment variable before you start or stop the Reports
Bridge component:

COMPONENT_CONFIG_DIRECTORY=0ORACLE_
INSTANCE/config/ReportsBridgeComponent/<reports_bridge_name>

To start the Oracle Reports bridge from the command line, use the following
commands:

On Windows:

rwbridge.bat name=bridgename

On UNIX:

rwbridge.sh name=bridgename

For example, to start an Oracle Reports bridge named foo on Windows, use the
following command:

rwbridge.bat name=foo
For more information about the rwbridge executable, see Section A.2.7, "rwbridge"

Oracle Reports creates a configuration file, rwbridge.conf when the Oracle Reports
bridge is started for the first time. This file is generated based on the settings in the
rwbridge. template file and is located in the ORACLE_
INSTANCE\config\ReportsBridgeComponent\bridge_name directory. Edit the
rwbridge. conf file to specify remote Oracle Reports bridges to connect to other
subnets.

Note: You must restart the Oracle Reports bridge for any
configuration changes to take effect.

To stop an Oracle Reports bridge, use the following command:
On Windows:

rwbridge.bat name=bridgename shutdown=normal authid=username/password

On UNIX:

rwbridge.sh name=bridgename shutdown=normal authid=username/password
For example, to stop an Oracle Reports bridge named foo on UNIX, use the following
command:

rwbridge.sh name=foo shutdown= normal authid=scott/tiger

In the configuration file, repbrg_bridgename.conf, modify the identifier element to
specify the username/password and set the encrypted attribute to no. This is to
indicate that the password is not encrypted. This password will be encrypted once the
Oracle Reports bridge is started.
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For example:

<identifier encrypted="no">scott/tiger</identifier>

Usage Notes

»  If the identifier element is commented, then it is possible to stop the Oracle
Reports bridge without specifying authid

= Itis not possible to stop the Oracle Reports bridge remotely.

For more information see, Section 8.2.1.19, "identifier"

6.3 Starting Reports Components After Shutting Down an Instance

When a Reports instance is shut down, you can bring up the Reports components as
follows.

6.3.1 Starting Reports Servlet

To start Reports Servlet in an expand cluster, complete the following steps:
1. Start the Node Manager.
a. From your present working directory, run the following command:
cd S$SFMW_HOME/wlserver_10.3/server/bin
b. Setthe ORACLE_HOME environment variable to your Oracle Home directory
c. Set the TNS_ADMIN environment variable to your TNS_ADMIN directory.

d. Setthe LD_LIBRARY_PATH environment variable on the command line as
follows:

setenv LD_LIBRARY PATH S$ORACLE_
HOME/Jjdk/jre/1ib/1386: SORACLE_
HOME/jdk/jre/lib/1386/server: SORACLE_
HOME/jdk/jre/lib/i386/native_threads: SORACLE_
HOME/1ib32:SORACLE_
HOME/lib:/usr/X11R6/1ib:/usr/openwin/lib:

e. Run the following command:
. /startNodeManager.sh
2. Start the Admin Server.
a. From your present working directory, run the following command:
cd $FMW_HOME/user_projects/domains/<domain_name>/bin
b. Run the following command to start the admin server:
./startWebLogic.sh
3. Start WLS_REPORTS from the WebLogic Server Administration Console.

a. Log in to the WebLogic Server Administration Console.
(http://host:7001/console).

b. From the Domain Structure section in the left navigation pane, select
Environment > Servers.The Summary of Servers screen is displayed. Click
the Control tab.

c. Select the WLS_REPORTS check box and click Start.
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d. From the Domain Structure section in the left navigation pane, select
Deployments.

The Summary of Deployments screen is displayed.
e. Click Next to navigate to the screen that lists the Reports Application.
f. Click Start.

6.3.2 Starting Reports Standalone Server
To start the Reports standalone server, complete the following steps:
1. From your present working directory, run the following command:
cd SORACLE_INSTANCE/bin.
2. Enter the following command:
opmnctl startall

All Reports components, including the Reports Standalone server, are started.

6.4 Starting and Stopping the COS Naming Service

The Common Object Service (COS) naming service orbd, provided by Sun
Microsystem's JDK, can be used for Reports Server discovery instead of the default
broadcast mechanism. Refer to the JavalDL page on Sun Microsystem's Web site
(http://java.sun.com) for more details on the orbd executable.

To start the naming service, use the following commands:
On Windows:

namingservice.bat port_number

On UNIX:

namingservice.sh port_number
To use OPMN to control the naming service, refer to Section 8.8.1.4, "COS Naming
Service Specification"

6.5 Starting, Stopping, and Restarting Oracle Reports Components Using
Oracle Enterprise Manager

All start and stop operations on Oracle Reports components can be performed using
Oracle Enterprise Manager. Refer to Section 7.4, "Starting, Stopping, and Restarting
Oracle Reports Components".

6.6 Starting and Stopping the In-process Reports Server Using Oracle
Reports Servlet

If you are using Reports Server as an in-process Reports Server (the default
configuration), sending a run report request starts the in-process Reports Server.
However, if you are sending a request through a command line, Oracle Reports
Servlet (rwservlet) must be started first using either the run report URL or the Web
command URL. When you have successfully started rwservlet, you have
successfully started the in-process Reports Server.

You can also start an In-process Reports server through Enterprise Manager:

1. Navigate to the Reports application page in Oracle Enterprise Manager
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2. From the Reports menu, select Monitoring > Start Reports Application.
The Reports application is started.

3. From the Reports menu, select Administration > Start In-process Reports Server.
The In-process Reports server is started.

To directly start or stop the in-process Reports Server using a URL, enter the following
in your Web browser:

http://machine_name:port/reports/rwservlet/startserver
http://machine_name:port/reports/rwservlet/stopserver

6.7 Verifying that the Oracle HTTP Server Is Running

OracleAS Reports Services depends upon the Oracle HTTP Server component. Before
starting Reports Server through Oracle Enterprise Manager or OPMN, you must verify
that your Oracle HTTP Server is running. For more information about performing this
task in Oracle Enterprise Manager, refer to your Oracle Enterprise Manager
documentation.

Alternatively, you can verify that the Oracle HTTP Server is running, in your browser,
by navigating to the following URL:

http://server_name.domain:port_number/

6.8 Verifying that the Reports Servlet and Server are Running
To verify that the Reports Servlet is running, navigate to the following URL:

http://your_machine_name.domain_name:your_port_number/reports/rwservlet/help
Note that the URL is case sensitive. If this URL executes successfully, you should get a
help page describing the rwservlet command line arguments.

To verify that Reports Server is running, navigate to the following URL:

http://your_machine_name.domain_name:your_port_
number/reports/rwservlet/getserverinfo?server=server_name

The server=server. name argument is not required if you are using the default
Reports Server name (rep_machine_name) or the Reports Server specified in the
servlet configuration file, rwservlet.properties ($DOMAIN_
HOME/config/fmwconfig/servers/<WLS_SERVER_
NAME>/applications/reports_<version>/configuration). If this URL
executes successfully, you should see a listing of the job queue for the specified
Reports Server.

Note: You'll find more information about the servlet configuration
file in Section 8.3, "Oracle Reports Servlet Configuration File".
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Part II provides information about administering Oracle Reports Services:

»  Chapter 7, "Administering Oracle Reports Services Using Oracle Enterprise
Manager"

s Chapter 8, "Configuring Oracle Reports Services"
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Administering Oracle Reports Services
Using Oracle Enterprise Manager

Oracle Reports 11¢g Release 1 (11.1.1) is integrated with Oracle WebLogic Server, which
results in simpler administration of complex topology and deployments. You can
manage and monitor Oracle Reports components using either:

Oracle Enterprise Manager, included with Oracle Fusion Middleware
(recommended).

Oracle Process Manager and Notification Server (OPMN)

This chapter describes how to manage and monitor Oracle Reports components using
Oracle Enterprise Manager. It includes the following main sections:

What's New In This Release?

Configuring Reports Server for Oracle Enterprise Manager

Viewing the Component Topology

Starting, Stopping, and Restarting Oracle Reports Components
Configuring Oracle Reports Components

Defining Oracle Enterprise Manager Administration Roles
Administering and Scheduling Jobs

Securing Oracle Reports Services

Managing Fonts

Monitoring Performance

Managing Log Files

Modifying Reports Server Audit Configuration

Registering Pluggable Destinations with Reports Server

Configuring Proxy Information

Managing and Monitoring a Reports High Availability (HA) Solution
About the Oracle Fusion Middleware System MBean Browser
Modifying Reports Configuration Settings Using the System MBean Browser

Diagnosing Issues
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Note: Where needed, Oracle Reports Services pages in Oracle
Enterprise Manager include context-sensitive Help topics that
provide more information about the items on those pages. Click the
Help icon to display the corresponding help topic.

See Also: For more information on Oracle Enterprise Manager,
refer to the Oracle Fusion Middleware Administrator’s Guide, available
on the Oracle Fusion Middleware documentation CD.

7.1 What’s New In This Release?

Oracle Reports 11g Release 1 (11.1.1) provides significant enhancements to Oracle
Enterprise Manager, including pages to administer and configure Oracle Reports
Services through the Oracle Enterprise Manager user interface, rather than by editing
configuration files, as summarized in Table 7-1 (a subset of Table 1-1, " 11g
Functionality vs. 10g Functionality"):

Table 7-1

11g Oracle Enterprise Manager Features vs. 10g Functionality

11g New Features

‘ Equivalent 10g Functionality

Monitoring and Management

New rich and customizable Oracle Enterprise
Manager user interface, providing:

Navigation pane showing hierarchical
view of complete Farm and all
components.

New pages for Oracle Reports to perform
comprehensive administration,
management, configuration, tuning, and
diagnostics of complete reporting
environment.

Large number of metrics for monitoring
and tuning.

Administration dashboard for instant
access to start, stop, restart, grouping,
servlet, plug-in registration, and more.

Significant reduction of configuration
parameters, and categorization.

Extensive real-time and historical
performance metrics.

Reports Server auditing.

Oracle Internet Directory reassociation

Portal metadata repository and association.

Direct access to documentation and
collateral from Oracle Enterprise Manager.

Enterprise Manager Application Server (AS) Control
and manually editing configuration files.

New trend graphs, key statistics. Anticipation of
common problems with early symptoms.

N/A

Job Administration and Scheduling

For more information, see Section 7.7, "Administering and Scheduling Jobs".

Advanced job queue administration.
Comprehensive job queue management user
interface in Oracle Enterprise Manager (search
and filters, resubmit the job, view errors, and
more).

Basic job queue user interface.
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Table 7-1 (Cont.) 11g Oracle Enterprise Manager Features vs. 10g Functionality

11g New Features Equivalent 10g Functionality

Rich calendar-based scheduling user interface. Reports job scheduling done through Oracle Reports
Comprehensive Reports Server job scheduling Queue Manager (rwram), Oracle Portal user interface,
in Oracle Enterprise Manager. or command line only.

Security

For more information, see Section 7.8, "Securing Oracle Reports Services".

commands, and folder access.

Oracle Enterprise Manager advanced user interface. | Basic Ul in OracleAS Portal for defining the policies.

Administrators can use Oracle Enterprise Hard-coded Web command access to the Oracle
Manager to more easily define and manage Reports seeded roles. Access policies at file (report)
granular security policies for reports, Web level only, not folder level.

7.2 Configuring Reports Server for Oracle Enterprise Manager

Reports Server is automatically registered with Oracle Enterprise Manager during
installation of Oracle Fusion Middleware. If you add any Reports Servers or other
Oracle Reports components after installing Oracle Fusion Middleware, refresh the
Oracle Enterprise Manager page to register and make available the new Oracle
Reports components in Oracle Enterprise Manager.

7.3 Viewing the Component Topology

Oracle Reports 11¢g Release 1 (11.1.1) provides better framework to view the topology
of the components.

To view the topology of the instance in Oracle Enterprise Manager:

1.

In the target navigation pane, view the complete Farm and all components in a
hierarchical view.

In the target navigation pane, under the Farm node, expand Farm_ClassicDomain
> Reports and click the Reports Application, Reports Bridge, Reports Server, or
Reports Tools component nodes to display their home pages.

When you select a target, such as a Reports component, the target's home page is
displayed in the content pane and the target's menu is displayed at the top.
Alternatively, you can right-click on the target to view its menu.

7.4 Starting, Stopping, and Restarting Oracle Reports Components

To start, stop, and restart Oracle Reports components:

1.

Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").

From the Reports menu, select Control to view the status history of the
component, and activate Start Up, Shut Down.., or Restart...

To start, stop, and restart in-process servers:

Navigate to the component’s home page and select reports (Managed_Server_
Name) > Administration > Start /Stop /Restart In-process Reports Server.

7.5 Configuring Oracle Reports Components

Beginning in Oracle Reports 11g Release 1 (11.1.1), it is recommended that
configuration should be done only through Oracle Enterprise Manager.
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Using Oracle Enterprise Manager and JMX Console, you can view and update
configuration using the following menu selections in Oracle Enterprise Manager:

Table 7-2 Configuration Menu Selections

Select

To Display

Reports > Administration > Basic Configuration

Reports Server Basic Configuration page.

Reports > Administration > Advanced Configuration

Reports Server Advanced Configuration
page. Includes Help icon for detailed page
information.

Reports > Administration > Forms/Reports Common
Configuration

Forms Reports Common Component
Configuration page (rwbuilder,
rwserver, rwrun, and font/printer related
information).

In target navigation pane, Farm_ClassicDomain >
Reports > Reports Tools component node

Reports Tools Component Configuration
page (rwbuilder, rwrun, rwclient,
rwconv, rwram configuration file info,
rwnetwork configuration file info, and PDS
info).

Reports Bridge > Administration > Bridge
Configuration

Reports Bridge Configuration page.

On Reports Application page, for example reports (WLS_
REPORTS): Reports > Administration > Basic
Configuration

Reports Application Basic Configuration
page.

On Reports Application page, for example reports (WLS_
REPORTS): Reports > Administration > Advanced
Configuration

Reports Application Advanced
Configuration page. Includes Help icon for
detailed page information.

On Reports Server home page:

Reports > Logs > Log Configuration

Reports Server Log Configuration page.

On Reports Tools home page:

Reports > Logs > Log Configuration

Reports Tools Log Configuration page.

On Reports Application home page:
Reports > Logs > Log Configuration

Reports Application Log Configuration page.

On Reports Bridge home page:
Reports Bridge> Logs > Log Configuration

Reports Bridge Log Configuration page.

Note:

For those pages that include a Help icon, click the Help icon to

access the page-level help. Complete the elements on the page using
the descriptions in the Help topic for the page.

While you are accessing the Reports application configuration pages
in Enterprise Manager, if an application is shut down from Enterprise
Manager, you may see an error message that states that the Reports
configuration Mbeans are not found. This message is displayed

because the Reports configuration Mbeans are not available when an
application is down. When you refresh the page or return to the page
again, Enterprise Manager displays a user-friendly message about the
Reports application being down and the inability of Enterprise
Manager to edit the configuration of the applilcation. When you start
the Reports application again, the editing of its configuration becomes
possible.

Starting with the Oracle Fusion Middleware 11.1.1.3.0 release, the
version of the Reports application in Enterprise Manager is shown as
reports (11.1.1.2.0) (WLS_REPORTS).
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7.5.1 Configuring a Mail Server

Oracle Reports 11g Release 1 (11.1.1) provides the option to configure the Mail Server
element from Enterprise Manager. To configure the Mail Server element, complete the
following steps:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home Page.

3. From the Reports menu, select Administration > Basic Configuration
The Reports Server Basic Configuration page is displayed.

4. In the Reports Server Parameters content pane, enter the name of the mail server
in the Mail Server field.

5. If the mail server is secured, enter the SSL port number in the Mail Server Port
field.

6. Select the Enable SSL for Mail Server checkbox if the mail server is secure.

7. Enter the mail server username and CSF key of the password in the Mail Server
Username and Mail Server Password fields, respectively.

8. Click Apply.

7.6 Defining Oracle Enterprise Manager Administration Roles

In 11g Release 1 (11.1.1), Oracle Enterprise Manager supports three kinds of
administration roles: Administrator, Operator, and Monitor. An Administrator role
has full privilege for performing any operations, including security-related operations.
Whereas, an Operator has a few privileges and the monitor has a limited set of
privileges. If a user doesn’t have permission, the functionality is either invisible or
greyed out.

7.7 Administering and Scheduling Jobs

The improved user interface in Oracle Enterprise Manager provides advanced job
queue management (search and filters, resubmit the job, view errors, and more), as
well as rich calendar-based scheduling for Reports Server jobs.

= Displaying Jobs
= Displaying a Consolidated Job Queue
= Performing Operations on Jobs

= Scheduling Jobs

7.7.1 Displaying Jobs

To retrieve information about one or more jobs (for example, status, errors for failed
jobs, trace information):

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Reports Jobs > Jobs Page.

The Jobs page displays for the category of jobs selected in the Show list.
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4. From the Show list, select the category of jobs you want to view (for example,
Failed Jobs).

5. Enter desired information in the Owner, Output Type, and Output Format fields
to customize the list of jobs displayed.

7.7.2 Displaying a Consolidated Job Queue

New in Oracle Reports 11g Release 1 (11.1.1) is the database-based shared job
repository, which provides the ability to display a consolidated view of job queues
using Oracle Enterprise Manager:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home page of any Reports Server that participates
in a high availability (HA) group.

3. From the Reports menu, select Reports Jobs > Jobs Page.
The Jobs page displays for the category of jobs selected in the Show list.
4. From the Show list, select Finished Jobs.

5. From the Output Format list, select either a Reports Server name (to view the jobs
for that Reports Server), or the group name (to view the jobs for all Reports
Servers in the group.

You can also use rwservlet and the SHOWJOBS Web command to display a
consolidated job queue, as shown in Section A.8.9, "SHOWJOBS".

Note:

= By default, the jobs of all the nodes that are participating in the
high availability (HA) configuration are shown. This makes it easy
to administer the consolidated job queue (for example, for killing
a particular job, or getting the information about a job). The
administrator does not have to view the job queues for each
Reports Server separately.

= Itis possible to see the jobs of a particular Reports Server by
choosing the server name in the drop-down list. It does not matter
which node the load balancer directs the request to, you can
always see the job information of any Reports Server participating
in the group, even if one or more of the Reports Servers in the
group are down. This is made possible by the database-based
shared job repository. Additionally, each of the Reports Servlets
(corresponding to each in-process Reports Server) contains the list
of the other in-process Reports Servers that are part of the HA
scenario.

7.7.3 Performing Operations on Jobs

To perform operations on jobs, such as resubmitting (retrying) a job:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Reports Jobs > Jobs Page.
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The Jobs page displays for the category of jobs selected in the Show list.

Select Finished Jobs to list all the finished jobs with full information about the
finished job.

Perform any available operation on any job.

For example, select a finished job and click Rerun Report to rerun the job.

Note: When you try to perform a Reports operation from Oracle
Enterprise Manager, ensure that the id store used by the Reports
server contains the same user name/password that you used to log in
to Enterprise Manager.

7.7.4 Scheduling Jobs

To define job scheduling options:

1.
2.

5.

Log in to Oracle Enterprise Manager.

Navigate to Reports Server Home page (see Section 7.3, "Viewing the Component
Topology").
From the Reports menu, select Reports Jobs > Schedule New Job.

The Reports Job Scheduler page displays.

Complete the elements using the descriptions in the Help topic for the page. Click
the Help icon on the page to access the page-level help.

Note: For elements that specify a time, the time will automatically
adjust for Daylight Savings Time (DST), if necessary. For example, if a
job is scheduled to run daily at 5:00 a.m., it will run at that time
beginning with the scheduled start date, and adjusting when DST
begins or ends so that it will continue to run at 5:00 a.m. as expected.

Time entries in past jobs queue are not modified (for example, job
enqueue time, start time, finish time).

Click Submit to schedule a job.

6. Navigate to the Scheduled Jobs page (see Section 7.7.1, "Displaying Jobs") and

notice the newly scheduled job in the list.

Note: If you select a scheduled job and click Edit, you can change the
options for the scheduled job. When you click Submit, the message
Job Idnnnhas been re-scheduled successfully displays.
Oracle Enterprise Manager cancels the original scheduled job and
moves it to the Failed Jobs queue, and creates a new scheduled job
with the modified parameters. The new job has a different job ID than
the original job.

7.8 Securing Oracle Reports Services

In 11g Release 1 (11.1.1), Reports Server is secure out-of-the-box using the Oracle
Platform Security Services, which accomplishes both authentication and authorization.
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Oracle Reports uses this Java EE-based security model to allow you to create security
policies for running report jobs and Web commands.

In prior releases, Reports Server authentication was restricted to use only Oracle
Internet Directory. Authorization of Reports Server required an Oracle Portal-based
security model (using Portal metadata repository for checking authorization). If you
want to revert to the security mechanism of prior releases, refer to Section 7.8.1.1,
"Switching to Oracle Portal Security".

In Oracle Reports 11g Release 1 (11.1.1), administrators can use Oracle Enterprise
Manager to more easily define and manage granular security policies and file system
access:

= Enabling and Disabling Security

= Defining Security Policies for Reports

= Defining Security Policies for Directories

s Defining Security Policies for Web Commands
s Defining Read /Write Access to Directories

= Enabling and Disabling Single Sign-On

= Managing Credentials

7.8.1 Enabling and Disabling Security
To enable or disable security for the Reports Server or Reports Application:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").
3. From the Reports menu, select Administration > Advanced Configuration.

The Advanced Configuration page is displayed.

4. Inthe Reports Security region, check or uncheck Enable Security.

7.8.1.1 Switching to Oracle Portal Security

The steps for deploying reports in Oracle Portal is the same in 11g Release 1 (11.1.1) as
in prior releases, as described in Chapter 16, "Deploying Reports in Oracle Portal".
However, the security mechanism underlying the deployment has changed. In that,
authorization is enabled out of the box, but during installation if only Oracle Internet
Directory is specified and Portal is not installed, authorization using Oracle Portal is
disabled. The default installation of 11¢ Release 1 (11.1.1) accomplishes both
authentication and authorization through Oracle Platform Security Services

You can continue to use the security features in Oracle Portal from prior releases for
backward compatibility. To switch from the new 11g Release 1 (11.1.1) Oracle Platform
Security Services to pre-11g Oracle Portal metadata repository-based security:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Administration > Advanced Configuration.

The Reports Server Advanced Configuration page is displayed.
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4.

5.

In the Reports Security section, check Enable Security, then select Security
features available through Oracle Portal.

Click Apply.

Note: If you enable Oracle Portal security features, then Oracle
Portal must also be configured during installation for authorization to
occur:

»  If Oracle Portal is configured during installation, authentication is
accomplished using the Oracle Internet Directory and
authorization is accomplished using Oracle Portal (which stores
authorization policies).

»  If Oracle Portal is not configured during installation,
authentication is accomplished using the Oracle Internet Directory
and authorization does not occur.

7.8.2 Defining Security Policies for Reports

As administrator, you can specify the reports to which a particular user/role has
access by creating security policies for each report. In the security policy, you can also
specify the server, destination name (desname), destination type (destype), and
other parameters. An authenticated user is authorized against these security policies.

To define security policies for reports for Reports Server or Reports Application
(in-process Reports Server):

1.
2

Log in to Oracle Enterprise Manager.

Navigate to the component Home page (see Section 7.3, "Viewing the Component
Topology").

From the Reports menu, select Administration > Manage Reports Security
Policies > Reports Policies.

Click Create or Edit.
The Security Policy Configuration for Reports page is displayed.

Enter appropriate values for the elements on the page to define a security policy
for directory access using the descriptions in the Help topic for the page.

Click the Help icon on the page to access the page-level help.
Perform the following to complete the elements on the page,

s From the Server Name parameter checkbox, select one or more servers to
which the security policy has to be applied. If you want to apply the security
policy to all servers, select All.

s In the Reports Definition Files or Directories parameter, enter one or more
report definition file names or the directories for which you are defining
security policies. For example, to specify a directory, enter:
/myreports/runtime/reports/*. Separate multiple entries with a
comma (,).

= Click OK.

All fields on this page require a restart to take effect.
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6. Run a report as the specified role and other roles to test that security policies for
authentication and authorization are enforced as you have defined. For example,
run a report from your browser using the following URLs:

http://host:port/reports/rwservlet?report=report_
name.rdf&destype=cache&desformat=html&userid=user/passwordémydb&server=ReportsS
erver_instancename

http://host:port/reports/rwservlet?report=report_
name.rdf&userid=user/passwordeémydb&destype=file&desformat=pdf&desname=report_
name.pdf

where
host is the machine where the Oracle Instance is set up

port is the OHS main port

Note: The security policies defined in Oracle Enterprise Manager are
stored in the policy store configured by the user. The idstore contains
information on the users and the policy store contains the security
policies configured by the user.

7.8.3 Defining Security Policies for Directories

In certain cases, you will want to give a particular user access to multiple related
reports. Rather than specify a security policy for each report, you can collect all the
reports in a single directory, then specify a security policy for the directory. Again, the
security policy is checked when the user provides the user name and password.

As an example, imagine that there are 15 finance reports, for which you want to give
access to the FINANCE role, and there are 12 Human Resources reports for which you
want to give access to the HR role. Rather than specify 15 security policies for
FINANCE role, and 12 policies for HR role (one policy per report), you can collect all
finance reports in one directory, and collect all the HR reports in another directory,
then specify only 2 policies (one per directory). Instead of specifying the report name,
you will specify the directory name in the security policy.

To define a security policy for directories:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Administration > Manage Reports Security
Policies > Reports Policies.

4. Click Create or Edit.
The Security Policy Configuration for Reports page is displayed.

5. Enter appropriate values for the elements on the page to define a security policy
for directory access using the descriptions in the Help topic for the page.

Click the Help icon on the page to access the page-level help.
Perform the following to complete the elements on the page,

»s  From the Server Name parameter checkbox, select one or more servers to
which the security policy has to be applied. If you want to apply the security
policy to all servers, select All.
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= In the Reports Definition Files or Directories parameter, enter one or more
report definition file names or the directories for which you are defining
security policies. For example, to specify a directory, enter:
/myreports/runtime/reports/*. Separate multiple entries with a
comma (,).

s Click OK.
All fields in this page require a restart to take effect.

Now, to use the defined directory access control at the Reports Server level, refer to
Section 7.8.1, "Enabling and Disabling Security" to confirm that security is turned on.

Note: The security policies defined in Oracle Enterprise Manager are
stored in the policy store configured by the user. The idstore contains
information on the users and the policy store contains the security
policies configured by the user.

7.8.4 Defining Security Policies for Web Commands

You can also specify the Web commands to which a particular user/role has access by
creating security policies for each Oracle Reports Servlet (rwservlet) Web
command. The security policy is checked when the user provides the user name and
password.

To define security policies for Web commands:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Application Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Administration > Manage Reports Security
Policies > Web Command Policies.

4. Click Create or Edit to enter appropriate values for the elements on the page.
The Security Policy Configuration for Web Commands page is displayed.

5. Enter appropriate values for the elements on the page to define a web command
security policy using the descriptions in the Help topic for the page.

Click the Help icon on the page to access the page-level help.
Perform the following steps to complete the elements on the page,

s From the Server Name parameter checkbox, select one or more servers to
which the security policy has to be applied. If you want to apply the security
policy to all servers, select All.

s From the Web Commands parameter checkbox, select one or more Web
commands authorized for the specified servers and grantees. If you want to
specify all Web commands, select All

» Click OK.
All fields on this page require restart to take effect.

6. Run a report as the specified role and other roles to test that security policies for
authentication and authorization are enforced as you have defined. For example,
run the showjobs Web command from your browser using the following URL:

http://host:port/reports/rwservlet/showjobs?server=ReportsServer_instancename
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where,
host is the machine where the Oracle Instance is set up.

port is the OHS port.

Note: The security policies defined in Oracle Enterprise Manager are
stored in the policy store configured by the user. The idstore contains
information on the users and the policy store contains the security
policies configured by the user.

7.8.5 Defining Read/Write Access to Directories

As an administrator, you can specify read /write access for Reports Server, Reports
Application (in-process Reports Server), or Oracle Reports Runtime to directories. This
feature only checks whether Reports Server, Reports Application, or Oracle Reports
Runtime is authorized to read from or write to a specified directory, and is unrelated
to security policies that check the user name and password.

Read access. To avoid the security issue of exposing sensitive content of files, you
can specify the directories from which Reports Server, Reports Application, or
Oracle Reports Runtime is allowed to read.

For example, a malicious user may specify the following keywords to run a report
on Windows:

distribute=yes&destination=C:\Temp

This would generate an error stating that there was an error in the syntax of the
file. To avoid this, enable file system access control to specify read directories that
do not include system directories.

Write access. To avoid the security issue of a malicious user potentially
overwriting a system file by sending report output to a system directory, you can
specify the directories to which Reports Server, Reports Application, or Oracle
Reports Runtime is allowed to write. Attempts to write to other directories will
return an error.

For example, a user may run a report to the following destination on Windows:

desname=C: \Temp

This would overwrite a system file unless file system access control was enabled to
specify write directories that do not include system directories.

To define read /write access to directories for Reports Server, Reports Application, or
Oracle Reports Runtime:

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").
From the Reports menu, select Administration > Advanced Configuration.

The Advanced Configuration page displays.

In the File System Access Control section, check Enable File System Access
Control, then enter the names of the Read Directories and Write Directories to
which Reports Server, Reports Application, or Oracle Reports Runtime should
have access. These entries set the read and write sub-elements of the
folderaccess element in the configuration file.
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Read Directories: To avoid the security issue of exposing sensitive content of files,
enter the names of the directories from which Reports Server is allowed to read.
Separate directory names with a semicolon (;).

Write Directories: Enter the names of the directories to which Reports Server is
allowed to write. Attempts to write to other folders will return an error.

7.8.6 Enabling and Disabling Single Sign-On

If you plan to take advantage of Oracle Application Server Single Sign-On, you can
use Oracle Enterprise Manager to set the SINGLESIGNON parameter in the
rwservlet.properties configuration file. SINGLESIGNON=YES by default on
installation. For more information about Single Sign-On, refer to Chapter 17,
"Configuring and Administering OracleAS Single Sign-On'".

To enable Single Sign-On:

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the Reports Application Home page (see Section 7.3, "Viewing the
Component Topology").

From the Reports menu, select Administration > Advanced Configuration.
The Reports Application Advanced Configuration page displays.

In the Reports Security section, check Enable Single Sign-On.

Click Apply.

7.8.7 Managing Credentials

This section explains how to use the oracle Enterprise Manager to manage credentials
in a domain credential store.

1.

Log in to Oracle Enterprise Manager and navigate to WebLogic Domain >
Security > Credentials, to display the Credentials page.

Use the button Delete to remove a selected item (key or map) in the table. Note
that deleting a credential map, deletes all keys in it. Similarly, use the button Edit
to view or modify the data in a selected item.

To display credentials matching a given key name, enter the string to match in the
box Credential Key Name, and then click the blue button to the right of it. The
result of the query is displayed in the table.

To redisplay the list of credentials after examining the results of a query, select
WebLogic Domain > Security > Credentials.

To add a new key to a credential map:

1.
2.
3.

Click Create Map to display the Create Map dialog.
In this dialog, enter the name of the map for the credential being created.

Click OK to return to the Credentials page. The new credential map name is
displayed with a folder icon in the table.

Note: In CSF, the Reports Server can access credentials only from the

Reports folder, hence you must create credentials under the Reports
folder.
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To add a new key to a credential map:

1.
2.

Click Create Key to display the Create Key dialog.

In this dialog, select a map from the pull-down list Select Map where the new key
will be inserted, enter a key in the text box Key, select a type from the pull-down
list Type (the appearance of the dialog changes according to the type selected),
enter the required data.

Click OK when finished to return to the Credentials page. The new key is shown
under the map icon corresponding to the map you selected.

For more information about Reassociating the Credential Store, see Oracle Fusion
Middleware Security Guide.

7.9 Managing Fonts

In Oracle Reports 11¢ Release 1 (11.1.1), administrators can use Oracle Enterprise
Manager to simplify configuring fonts and diagnosing font issues:

Configuring Fonts

Diagnosing Font Issues

For more information about fonts, refer to Chapter 9, "Managing Fonts in Oracle
Reports".

7.9.1 Configuring Fonts

To configure font subsetting and aliasing information:

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").

From the Reports menu, select Administration > Forms/Reports Common
Configuration.

The Forms Reports Common Component Configuration page displays.

Use the Screenprinter Definition Parameters (Default Resolution and Default Font)
to modify the screenprinter.ppd file.

Use the Printer Configuration and Font Configuration sections to modify the
uifont.ali.

For more information about fonts, refer to Chapter 9, "Managing Fonts in Oracle
Reports".

7.9.2 Diagnosing Font Issues

To diagnose issues with fonts in your report output:

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").
From the Reports menu, select Administration > Advanced Configuration.

The Reports Advanced Configuration page displays.
In the Diagnostics section, change the Log Options to TRACE: 1 and click Apply.
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5. Run your report again.

6. From the Reports menu, select Log > View Log Messages to view the log
messages.

7.10 Monitoring Performance

Oracle Enterprise Manager uses Dynamic Monitoring Service (DMS) metrics service to
allow you to easily monitor the performance metrics and Reports Server information:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").

3. Examine the Reports Engines statistics table for detailed information about the
engines that are running in Reports Server. This table provides information about
the number of jobs that are running in that engine, process ID, running and idle
time, and remaining life of the engine. The Reports Engines statistics table is
shown on the Reports Server Home page and the Reports Application Home page.

4. Examine the Response and Load chart for an overall picture of the load.
5. To view scheduled jobs status:

s From the Reports menu, select Reports Jobs > Jobs Page.

» In the Show list, select Scheduled Jobs.

= Examine the page for additional information about the scheduled jobs.
6. To view Oracle Reports performance:

s From the Reports menu, select Monitoring > Performance Summary.

The Performance Summary page displays, showing metrics such as Average
Response Time, Job Load, and Failed Jobs Ratio.

»  Click Show Metric Palette to display all metrics available.

Additionally, many new metrics are available in Oracle Reports 11¢ Release 1 (11.1.1).
Refer to the online help for detailed descriptions of each of the available metrics.

7.10.1 Problems Viewing Reports Metrics When Reports is Configured for Secure
Sockets Layer (SSL)

When you use Oracle Enterprise Manager to monitor an instance of Oracle Reports
that has been configured to use Secure Sockets Layer (SSL), some performance metrics
for Oracle Reports may not display.

To correct this problem, you must allow Oracle Enterprise Manager to recognize the
Certificate Authority that was used by the website to support HTTPS. You must add
the Certificate of that Certificate Authority to the list of Certificate Authorities
recognized by Oracle Enterprise Manager.

To configure Oracle Enterprise Manager to recognize the Certificate Authority:
1. Obtain the Certificate of the Web Site's Certificate Authority, as follows:

a. In Microsoft Internet Explorer, connect to the HTTPS URL of the application
server you are attempting to monitor.

b. Double-click the lock icon at the bottom of the browser screen, which indicates
that you have connected to a secure website.
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The browser displays the Certificate dialog box, which describes the
Certificate used for this website. Other browsers offer a similar mechanism to
view the Certificate detail of a web Site.

Click the Certificate Path tab and select the first entry in the list of certificates.

a o

Click View Certificate to display a second Certificate dialog box.
e. Click the Details tab on the Certificate window.

=h

Click Copy to File to display the Certificate Manager Export wizard.

g. In the Certificate Manager Export wizard, select Base64 encoded X.509 (.CER)
as the format you want to export and save the certificate to a text file with an
easily-identifiable name, such as reports_certificate.cer.

h. Open the certificate file using your favorite text editor.

The content of the certificate file will look similar to the content shown in
Example 7-2.

2. Update the list of Certificate Authorities, as follows:
a. Locatetheb64InternetCertificate.txt filein the following directory:

ORACLE_INSTANCE/EMAGENT/<emagent__
name>/sysman/config/b64InternetCertificate. txt

This file contains a list of Base64 Certificates.

b. Edit the b64InternetCertificate.txt file and add the contents of the Certificate
file you just exported to the end of the file, taking care to include all the Base64
text of the Certificate including the BEGIN and END lines.

3. Copy the text file that contains the certificate to any location. You must specify this
location when running the orapki utility.

4. Use the orapki utility to update the monwallet Oracle wallet by using the
following command:

ORACLE_HOME/bin/orapki wallet add
-pwd <password>

-wallet ORACLE_INSTANCE/EMAGENT/<emagent_
name>/sysman/config/monwallet

-trusted_cert
-cert certificate_location

When you are prompted for a password, enter the password for the monwallet
wallet. The default password is welcome.

In the example, replace certificate_location with the full path to the text file that
contains the certificate you saved earlier in this procedure. For example:

/dual/oracle/reports_certificate.cer

5. Inthe ORACLE_INSTANCE/EMAGENT/emagent_
name/sysman/emd/targets.xml file, for oracle_repapp, oracle_repserv
targets, change http references to https and http port references to https port, as in
Example 7-1.

Example 7-1 Changing HTTP References
Change:
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<Property NAME="HTTPPort" VALUE="<http port>"/>

<Property NAME="HTTPProtocol" VALUE="http"/>

<Property NAME="Servlet"
VALUE="http://host.domain.com:<httpport>/reports/rwservlet"/>

to the following;:

<Property NAME="HTTPPort" VALUE="<https port>"/>

<Property NAME="HTTPProtocol" VALUE="https"/>

<Property NAME="Servlet"
VALUE="https://host.domain.com:<httpsport>/reports/rwservlet"/>

6. Bounce Enterprise Manager Agent by running the following commands:
./opmnctl stopproc ilas-component=emagent_name
./opmnctl startproc ilas-component=emagent_name

7. Restart Enterprise Manager.

After you restart Oracle Enterprise Manager, it detects your addition to the list of
Certificate Authorities, and you can successfully monitor the Oracle Reports
metrics using the secure Oracle Enterprise Manager Console.

Example 7-2 Example Content of an Exported Certificate

MIIDBzCCANCgAwWIBAgIQTs4NcIMNY3JAs5edi/5RkTANBgk

. base64 certificate content ...

7.11 Managing Log Files

Oracle Reports 11¢ Release 1 (11.1.1) provides improved diagnosability through
logging and tracing enhancements.

All Oracle Reports log files follow Oracle Diagnostic Logging (ODL) format, the
standard across Oracle Fusion Middleware, for log format, message types, and log
management directives. The log file entries are in Text format (default) or XML format.
For detailed information, refer to Oracle Fusion Middleware Administrator’s Guide.

For information about log file enhancements, see Section 24.3.2, "Log Files"

Note: If you change the log path for the in-process server engine
(that is, oracle.reports.engine logger), ensure that you make similar
changes in the logmetadata.xml file. This file resides in the same
directory as logging.xml.

7.11.1 Viewing and Searching Log Files

To view and search log files in Oracle Enterprise Manager:

1. Log in to Oracle Enterprise Manager.
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2. Navigate to the desired component’s home page (see Section 7.3, "Viewing the
Component Topology"): Reports Server, Reports Application, Reports Bridge, or
Reports Tools.

3. From the Reports menu, select Logs > View Log Messages.
The Oracle Enterprise Manager Log Messages page is displayed.

4. View the trend metrics; that is, how many errors of each type (Incident Error,
Error, Warning, Notification, Trace) have been logged in the log files for the
component.

5. Use the search options available in the page to search inside log files with various
parameters, such as specific message type or time duration.

To modify the information logged in log files to diagnose issues, see Section 7.18.1,
"Specifying Logging Information".

7.11.2 Configuring Log Levels

To configure Log Levels in Oracle Enterprise Manager:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the component’s home page (see Section 7.3, "Viewing the Component
Topology").

3. From the Reports menu, select Logs > Log Configuration.
The Log Configuration page is displayed.

4. Select the Log Levels tab

5. Select the appropriate log level for each Logger Name from the ODL Level
drop-down list.

6. Click Apply

7.11.3 Editing Log Files

To edit the log files in Oracle Enterprise Manager:
1. Log in to Oracle Enterprise Manager.
2. Navigate to the component’s home page
3. From the Reports menu, select Logs > Log Configuration
The Log Configuration page is displayed
4. Select the Log Files tab
5. From the list of log files that is displayed, select the file which you want to edit
6. Click Edit Configuration...
The Edit Log File pop-up window is displayed
7. Edit the required parameters.

8. C(Click OK
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Note: If you change the Log File Format in the Edit Log File window,
you must change the file extension in the *Log Path field, or manually
delete the existing content from the log file. Therefore, the same
diagnostic log file does not contain messages of different formats.

7.12 Modifying Reports Server Audit Configuration

To modify Reports Server Audit Configuration in Oracle Enterprise Manager:

1.

2
3
4.
5

Log in to Oracle Enterprise Manager.

Navigate to Domain Home page

From the WebLogic Domain menu, click Security > Audit Policy.
From the Audit Level drop-down list, select Custom.

Select ReportsServer and click the plus (+) symbol to expand the User Sessions
and Authorization node to edit the corresponding configuration settings.

7.13 Registering Pluggable Destinations with Reports Server

To register a pluggable destination with Reports Server:

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the Reports Server Home page (see Section 7.3, "Viewing the
Component Topology").

From the Reports menu, select Administration > Advanced Configuration.
The Reports Server Advanced Configuration page displays.

In the Reports Pluggable Destinations section, enter appropriate Name and Class
values for the new pluggable destination.

For example, to register the SecurePDF pluggable destination:
Name: SecurePDF

Class:
oracle.reports.plugin.destination.securepdf.SecurePdfDestinat
ion

Click Add Destination, then click Apply.

This adds the new destination element to the Reports Server configuration file
(rwserver. conf), which adds the specified destination to the Report Server’s list
of valid destinations for report output.

You can also click Add to add the properties for the destination in the Registered
properties.

Note: The jars where pluggable destination classes are available
must be available in the REPORTS_CLASSPATH environment
variable, or in the WebLogic Server classpath (in case of in-process
servers)
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7.14 Configuring Proxy Information

Some features of Oracle Reports Services support retrieving or sending information
through a firewall. For example, the URL engine, the XML data source, the Text data
source, and the mail destination features all retrieve or send information through the
firewall. For these features to function properly, Reports Server requires certain proxy
information.

To specify proxy information:
1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Server or Reports Application Home page (see Section 7.3,
"Viewing the Component Topology").

3. From the Reports menu, select Administration > Advanced Configuration.
The Advanced Configuration page displays.

4. On the Advanced Configuration page, set proxy hosts and ports available for
various protocols, such as http, https, £tp, or £ile. You can also specify the
addresses for which proxies can be bypassed.

7.15 Managing and Monitoring a Reports High Availability (HA) Solution

Oracle Fusion Middleware consists of many components that can be deployed in
distributed topologies. The underlying paradigm used to enable high availability for
Oracle Fusion Middleware is clustering, which unites various Oracle Fusion
Middleware components in certain permutations to offer scalable and unified
functionality, and redundancy should any of the individual components fail. For more
information, see Section 2.5, "Setting Up a High Availability Environment".

7.15.1 Configuring Reports Server for High Availability
Refer to Section 2.5.3, "Configuring Reports Server for High Availability".

7.15.2 Displaying a Consolidated Job Queue
Refer to Section 7.7.2, "Displaying a Consolidated Job Queue".

7.15.3 Specifying a Shared Cache Directory
To specify a shared cache directory for high availability (HA):

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Application Home page (see Section 7.3, "Viewing the
Component Topology").

3. From the Reports menu, select Administration > Advanced Configuration.
The Reports Application Advanced Configuration page displays.

4. Inthe High Availability Parameters section, in the Cluster Cache Directory field,
enter the path to the shared cache directory for HA, then click Apply.

To see the changes, reload the WLS node.
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7.16 About the Oracle Fusion Middleware System MBean Browser

The Oracle Fusion Middleware System MBean Browser is a part of Oracle Fusion
Middleware Control, and it is used to update configuration settings for middle tier
components.

This section contains the following topics:
= When should I use the Oracle Fusion Middleware System MBean Browser?

= About Reports Configuration MBeans

7.16.1 When should | use the Oracle Fusion Middleware System MBean Browser?

You use the System MBean Browser to enter or modify Oracle Reports configuration
settings that are not available in Fusion Middleware Control Oracle Reports pages.

Note: You should not use the System MBean Browser unless you are
an advanced middle tier administrator.

7.16.2 About Reports Configuration MBeans

Configuration MBeans are defined for each of the Oracle Reports configuration files.
Table 7-3 lists the configuration MBeans for Oracle Reports.

Table 7-3 Reports Configuration MBeans

Configuration MBeans Associated Configuration File

ServerConfigMXBean rwserver.conf/rwbuilder.conf
JDBCPDSConfigMXBean jdbepds.conf

DiscoveryServiceConfigMX rwnetwork.conf
Bean

TextPDSConfigMXBean textpds.conf
XMLPDSConfigMXBean xmlpds.conf
CgicmdConfigMXBean cgicmd.dat
RWServletConfigMXBean  rwservlet.properties
BridgeConfigMXBean rwbridge.conf

ScreenprinterConfigMXBea screenprinter.ppd
n

Note: All Reports environment variables that are set in the registry
are not exposed using MBeans. However, if they are specified in the
server configuration file ENVID, the environment variables are
exposed by ReportsServerConfigMXBean. Similarly, all
environment variables used in server start/stop shell scripts are not
exposed using MBeans.

7.17 Modifying Reports Configuration Settings Using the System MBean
Browser

To modify Oracle Reports configuration settings using the System MBean Browser:
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Start Oracle Enterprise Manager Fusion Middleware Control and display the Farm
Home page.

Select Fusion Middleware > ReportsDomain > WLS_REPORTS. The WLS_
REPORTS page is displayed.

From the WebLogic Server menu, choose System MBean Browser. Fusion
Middleware Control displays the System MBean Browser page.

Click the plus (+) symbol in the left column to expand a node in the navigation
tree and drill down to the MBean you wish to access. The navigation tree expands
to display links for viewing or updating settings. Each node in the navigation tree
represents settings in a configuration file.

Click a node in the navigation tree, and click the Attributes tab to display the
details for a group of attributes. Attribute details include name, description of each
attribute, access details and its current value.

Update an attribute value in one of the following ways:

= Using the current page:

*  Enter a new attribute value into the Value field for the appropriate row.

*

Click Apply to apply the changes.
= Displaying a page to view or update the setting:

*  Click the link in the Name column to display a new page.

*  Enter a new attribute value in the Value field.

*

Click Apply to apply the changes.
*

Click Return to close the page and display the navigation tree.

Repeat the previous steps to view or update another attribute value.

Note: Only attribute values with write or read-write permissions can
be modified.

7.18 Diagnosing Issues

To help diagnose issues, you can use the Oracle Enterprise Manager logging
functionality:

Specifying Logging Information

Diagnosing Font Issues

7.18.1 Specifying Logging Information

To specify information to be saved in log files for Reports Server or Reports
Application (in-process Reports Server):

7-22

1.
2.

Log in to Oracle Enterprise Manager.

Navigate to the component Home page (see Section 7.3, "Viewing the Component
Topology").
From the Reports menu, select Logs > Log Configuration.

Alternatively, from the Reports Menu, click Administration > Advanced
Configuration.
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From the Reports Application Diagnostics window, click the link to Advanced
Log Configuration.

The Log Configuration page is displayed.
4. Select the Log Levels tab.

5. In the Oracle Diagnostic Logging Level (Java Level) section, change the log levels
as desired (see Table 24—4, " 11g ODL Message Types vs 10.1.2 Trace Options").

6. Select the Log Files tab.

7. Select the log handler that you want to modify and click the Edit Configuration
tab

8. Enter a new path in the Log Path field to change the log file location, if necessary.

9. Change the Maximum Log File Size (MB) and Maximum Size of all Log Files
(MB) properties as desired.

In Oracle Enterprise Manager, the rotation policy for log files can be set by
specifying the Max Log size and Max number of files properties. For example, if
Max Log size is set to 10MB and Max number of files is set to 10, log file rotation
automatically takes place when the first log file (diagnostics.log) reaches 1
MB (Max Log size / Max number of files = 10MB/10). ODL then renames this file
todiagnosticl.log and starts logging to a new diagnostics.log. When it
reaches a size of 1 MB, it is renamed to diagnostics2.log and logging
continues in diagnostics.log. When the number of files reaches 10, the earliest
log file is purged (diagnosticsl.log) and a new diagnosticsll.logis
created. In this example, the maximum size of all log files is limited to 10 MB and
the maximum number of files to 10, removing the risk of creating huge log files of
arbitrary size and the machine running out of space, bringing the production
system down.

10. Restart the component (see Section 7.4, "Starting, Stopping, and Restarting Oracle
Reports Components") for the changes to take effect.

To observe the effects of these changes in the Oracle Enterprise Manager log viewer,
see Section 7.11.1, "Viewing and Searching Log Files".

7.18.2 Diagnosing Font Issues

Refer to Section 7.9.2, "Diagnosing Font Issues".
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Configuring Oracle Reports Services

When you install Oracle Fusion Middleware, Oracle Reports is configured
automatically for you. There will likely be adjustments you wish to make to customize
your environment, but you will not be required to set up the entire environment, or
even most of it.

This chapter is included largely for reference, should you wish to have a better
understanding of the default configuration. It lists services-related configuration files
and describes in detail the content of most of them. It includes the following main
sections:

»  Oracle Reports Services Configuration Files
= Reports Server Configuration File

s Oracle Reports Servlet Configuration File

»  Oracle Reports Bridge Configuration File

s Network Configuration File

s Configuring the URL Engine

» Entering Proxy Information

»  Configuring Reports Server with the Oracle Process Manager and Notification
Server and Oracle Enterprise Manager

s Configuring Oracle Reports to Communicate with Oracle BPEL Process Manager
= Optimizing the Deployment of Reports

= Sample system-jazn-data.xml File

= Configuring Reports Managed Server

Another aspect of configuration is the setting of environment variables. These are set
for you automatically during installation. For reference, environment variables are
described in Appendix B, "Environment Variables".

8.1 Oracle Reports Services Configuration Files

This section identifies the configuration files associated with Oracle Reports Services.
In most cases, you can leave these files untouched. Because they control many aspects
of your server environment, you could put that environment at risk if you change a
file in some unsupported way. Always keep a back-up of the current version of any
configuration file you plan to change.
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Note: Reports application is deployed in No stage mode in following
location:

SDOMAIN_HOME/servers/<WLS_SERVER_NAME>/tmp/_WL_
user/reports_<version>/<random_string>

Though you can see Reports application configuration files in the
configuration directory in the above specified location, they are
stale files. Hence, do not edit them. Any modifications done to the
Reports application configuration files through Oracle Enterprise
Manager or System MBean browser are not reflected in the files
located under the configuration directory.

The correct location of Reports application configuration file is:

SDOMAIN_HOME/config/fmwconfig/servers/<WLS_SERVER_
NAME>/applications/reports_<version>/configuration.

The configuration files associated with Oracle Reports Services are listed and
described in Table 8-1.

Note: The paths specified in Table 8-1 are the same for both
Windows and UNIX environments, though they are expressed here
using the Windows backslash convention (\).

Table 8—1 Oracle Reports Services Configuration Files

Component Configuration File
Reports Server ORACLE_HOME\reports\dtd\rwserverconf.xsd
(rwserver)

For Standalone servers:

ORACLE_INSTANCE\config\ReportsServerComponent\server_
name\rwserver .conf

For In-process servers:

SDOMAIN_HOME/config/fmwconfig/servers/<WLS_SERVER_
NAME>/applications/reports_
<version>/configuration/rwserver.conf

The rwserverconft . xsd file contains data type definitions for
rwserver.conf and rwbuilder. conf elements and attributes.

The rwserver . conf file defines initial values for the Reports Server
Cache, the Oracle Reports engine, and security; registers valid
destination types; and sets other server-related values. This file is
automatically created when you start up the server.

For more information, see Section 8.2, "Reports Server Configuration
File".
Reports Server network configuration file: ORACLE_

INSTANCE\config\ReportsServerComponent\
server_name\rwnetwork.conf

ORACLE_HOME\reports\dtd\rwnetworkconf.xsd

The rwnetworkconf . xsd contains data type definitions for
rwnetwork. conf elements and attributes.

For more information, see Section 8.5, "Network Configuration File".
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Table 8-1 (Cont.) Oracle Reports Services Configuration Files

Component Configuration File

Oracle Reports ORACLE_HOME\reports\dtd\rwserverconf.xsd

Builder ORACLE_

(rwbuilder) INSTANCE\config\ReportsToolsComponent\ReportsTools\rwbuilder.c
Oracle Reports onf

Runtime (rwrun)

Oracle Reports
Servlet
(rwservlet)

The rwserverconft . xsd file contains data type definitions for
rwserver.conf and rwbuilder. conf elements and attributes. See
Section 8.2.1, "Reports Server Configuration Elements".

The rwbuilder. conf file configures the Reports Server that is
embedded in Oracle Reports Builder and Oracle Reports Runtime. All
run requests must go through Reports Server, meaning that Oracle
Reports Builder requires a server to run reports. Oracle Reports Builder
automatically starts a Reports Server to handle its requests. When you
run a report from Oracle Reports Builder, this file provides the
configuration for the in-process Reports Server instance that is invoked.
Like the rwserver. conf file, this file relies on the

rwserverconf . xsd file for its data type definitions, though the
following elements do not apply: persistFile and security.

Reports Builder network configuration file: ORACLE_
INSTANCE\config\ReportsToolsComponent\ReportsTools\rw
network.conf

ORACLE_HOME\reports\dtd\rwnetworkconf.xsd

The rwnetworkconf . xsd contains data type definitions for
rwnetwork. conf elements and attributes.

For more information, see Section 8.5, "Network Configuration File".

ORACLE_HOME\reports\dtd\rwservlet.xsd
SDOMAIN_HOME\config\fmwconfig\servers\<WLS_SERVER_
NAME>\applications\reports_
<version>\configuration\rwservlet.properties

The rwservlet.xsd file contains data type definitions for
rwservlet.properties parameters.

For more information, see Section 8.3, "Oracle Reports Servlet
Configuration File".

Reports Servlet network configuration file: SDOMAIN_
HOME\config\fmwconfig\servers\<WLS_SERVER_
NAME>\applications\reports_
<version>\configuration\rwnetwork.conf

ORACLE_HOME\reports\dtd\rwnetworkconf.xsd

The rwnetworkconf . xsd contains data type definitions for
rwnetwork. conf elements and attributes.

For more information, see Section 8.5, "Network Configuration File".
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Table 8—-1 (Cont.) Oracle Reports Services Configuration Files

Component Configuration File

Oracle Reports ORACLE_HOME\reports\dtd\bridgeconfig.xsd
Bridge (rwbridge) ORACLE_INSTANCE\config\ReportsBridgeComponent\bridge_
name\rwbridge.conf

The bridgeconfig.xsd file contains data type definitions for
rwbridge.conf elements and attributes.

For more information, see Section 8.4, "Oracle Reports Bridge
Configuration File".

Reports Bridge network configuration file: ORACLE_
INSTANCE\config\ReportsBridgeComponent\bridge_
name\rwnetwork.conf

Note: The directory, ORACLE_
INSTANCE\config\ReportsBridgeComponent is not created by default.
Instead, it is created when a user creates a Reports Bridge through
opmnctl.

ORACLE_HOME\reports\dtd\rwnetworkconf.xsd

The rwnetworkconf . xsd contains data type definitions for
rwnetwork.conf elements and attributes.

For more information, see Section 8.5, "Network Configuration File".

8.2 Reports Server Configuration File

The configuration settings for the Reports Server component of Oracle Reports
Services are stored in the XML file rwserver.conf and rwbuilder.conf, located
in the directories specified in Table 8-1.

Both files are supported by the rwserver. template file in ORACLE_
HOME\reports\conf, which contains default server configuration values on both
Windows and UNIX.

The rwserver.conf file is the default server configuration file. The
rwbuilder.conf file configures the server instance used in-process by Oracle
Reports Builder.

The rwserver.conf and rwbuilder. conf files are nearly identical. The only
difference between them is that rwbuilder. conf does not use the persistFile or
security configuration elements, described later in this section.

Both of these files are created automatically, under the following circumstances:

s The rwserver. conf file is created when a new Reports Server component is
created.

s The rwbuilder. conf file is pre-configured out-of-the-box.
This section describes:
= Reports Server Configuration Elements

= Dynamic Environment Switching

8.2.1 Reports Server Configuration Elements

The rwserverconf . xsd file provides the following data type definitions for
configuring rwserver.conf and rwbuilder. conf elements and attributes:

»  ORBPorts
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s pluginParam
= cache

» cluster

= connection

= destination

= environment
= envVariable

= engine

= job

= jobRecovery

= jobStatusRepository
= log

= jobRepository
= notification

= oidconnection
s orbClient

» persistFile

= identifier

= property

= queue

s folderAccess

= security

= proxyServer

= domain

= bypassProxy
= proxyServers
= proxylnfo

= webLayout

= dbProxyKey

= dbProxyConnKeys
s jobThresholds
= server

These elements along with their related attributes and sub-elements are discussed in
the following subsections.

Note that these are XML elements, and XML is case-sensitive. Additionally, when you
add any of these elements to the rwserver.conf or rwbuilder.conf configuration
file, you must follow the order of elements as described in rwserverconf.xsd.
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8.2.1.1 ORBPorts

The ORBPorts element is defined in rwserverconf .xsd as follows:

<xs:element name="ORBPorts">
<xs:complexType>
<xs:attribute name="value" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the ORBPorts element may be specified as shown in this
example:

To specify a port range:

<ORBPorts value="17000-17010"/>

To specify specific ports:
<ORBPorts value="17000,17010,17020,17030,17040"/>

Required/Optional

Optional. By default, CORBA objects use any available port for communication. Since
Reports Server uses CORBA for communication, it will use any available free port for
communication. If you want Reports Server to use predefined ports instead of random
ports, you must include the ORBPorts element in the server configuration file.

Description

The ORBPorts element specifies either a range of ports or specific ports for CORBA
communication. When ORBPorts is specified, Reports Server will choose one of the
ports from the list specified for ORB internal communication. One port is needed for
Reports Server and one for each engine.

Note: The ORBPorts element is used to assign specific ports to
Reports Server and engines for running report and other requests.
Do not confuse these ports with those you see in Oracle Enterprise
Manager through the Ports link, which are ports reserved for
Reports Server discovery mechanism and the Oracle Reports Bridge
component.

You cannot specify port numbers for individual engines. Each engine picks up the next
port number in the list. Suppose you have the maxengine attribute of the engine
element set to 5 for rwEng, and URLEng is also enabled, then you must specify a
minimum of 7 ports in the ORBPorts element (1 for Reports Server + 5 for rwEng + 1
for rwURLENQ).

The ORBPorts element attribute is described in Table 8-2.

Table 8-2 Attribute of the ORBPorts Element

Attribute Valid Values Description
value Range of values The port range that can be used for Reports Server and
or engine communication through CORBA.
Numbers
separated by
commas
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Note: The ORBPorts element should be defined only if you have
enabled TCP port filtering on your server where Reports Server is
running. If port filtering is enabled, you can open few ports for
Reports Server, then use ORBPorts to specify them in the server
configuration file for Reports Server/engine communication. If any
of the ports are not available, Reports Server or engines may fail to
start and an error displays.

8.2.1.2 pluginParam

The pluginParam element is defined in rwserverconf .xsd as follows:

<xs:element name="pluginParam">
<xs:complexType mixed="true">
<XS:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded" />
</Xs:sequence>
<xs:attribute name="name" use="required" type="xs:ID"/>
<xs:attribute name="value" use="required" type="xs:string"/>
<xs:attribute name="type" default="text">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="text"/>
<xs:enumeration value="file"/>
<xs:enumeration value="url"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the pluginParam element may be specified as shown in this
example:
<pluginParam name="mailServer" value="mail.oracle.com">
<property name="enableSSL" value="yes"/>
<property name="mailUserName" value=%MAILUSER%">
<property name="mailPassword" value=%xyz%">
</pluginParam>

Required/Optional
Optional. You can have as many pluginParam elements as you require.

Description

The pluginParam element provides a means of specifying plug-ins that can be used
by several built-in destinations such as e-mail, JDBC pluggable data source (PDS), Text
PDS, and so on. It is not used by the FTP and WebDAYV built-in destinations, and is not
available to custom pluggable destinations, such as fax. Now every server has its own
textpds.conf, jdbcpds.conf and xmlpds.conf files.

You can specify any plug-in parameter and name it in any way as long as it is
supported or required by the built-in destination.

The pluginParam element attributes are described in Table 8-3.
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Table 8-3 Attributes of the pluginParam Element

Attribute Valid Values Description

name string The name of the plug-in parameter.

Set for an e-mail See Properties below for information about specifying
destination in Oracle the enableSSL property when

Enterprise Manager name="mailServer".

on the Reports Server
Basic Configuration
page: Mail Server.

value. string The value of the specified plug-in parameter.
type text Default: text
file Describes the type of plug-in being specified.
url For text, specify the string that is required to identify

the named plug-in parameter, for example, the name
of a mail server. Text means the content of the
pluginParam element is text, so the
getPluginParam () method will return the exact
content specified in the element.

For file, specify the directory path and filename of
the plug-in parameter file. Use the standards for
specifying directory paths appropriate to Reports
Server's host machine (either Windows or UNIX).
File means that the content of the pluginParam
element is a filename, and the getPluginParam ()
method will return the content read from the file
specified.

For url, specify the full, absolute URL required by
the plug-in parameter, for example, the full URL to an
FTP site. url means the content of the pluginParam
element is a URL, and the getPluginParam /()
method will return the content read from that URL.
The URL you use must reside on the same side of the
firewall as Oracle Reports Services.

Note that when you have a default type (text), itis
not necessary to specify it in the pluginParam string.
The example that heads this section does not specify a
type because the plug-in parameter, a mail server
name, is the default type, text.

Properties

You can also optionally enter multiple property sub-elements for the pluginParam
element. The only requirement is that they be name/value pairs recognized by the
specified plug-in parameter. For example:

<pluginParam name="mailServer" value="$MAILSERVER%">

<property name="enableSSL" value="yes"/>
</pluginParam>

In this example, the property sub-element specifies the enableSSL property, which
is only applicable to mailServer. If the specified mailServer is SSL-enabled, it
rejects plain connection requests, so it is necessary to use SSL Sockets to establish a
connection with the specified mailServer and send emails, by default, the value of
enableSSL is no for compatibility with prior releases.

8.2.1.3 cache

The cache element is defined in rwserverconf . xsd as follows:
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<xs:element name="cache">
<xs:complexType>
<Xs:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</Xs:sequence>
<xs:attribute name="class" default="oracle.reports.cache.RWCache"
type="xs:string"/>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the cache element may be specified as shown in this example:

<cache class="oracle.reports.cache.RWCache">

<property name="cacheSize" value="50"/>

<property name="cacheDir" value="D:\orawin\reports\server\cache"/>
</cache>

Required/Optional

Optional. You can have a maximum of one cache element in your server
configuration file. If no cache element is specified, the default is used
(oracle.reports.cache.RWCache).

Description

The cache element specifies the Java class that defines the server's cache
implementation. You can use the default cache Java class or develop your own
implementation through the Oracle Reports Services Cache API.

Note: For more information on the cache API, refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The cache element attribute is described in Table 8—4.

Table 8—4 Attribute of the cache Element

Attribute Valid Values Description
class See the Description Default: oracle.reports.cache.RWCache
column

A fully qualified Java class that implements the
oracle.reports.cache.Cache interface.

Properties

You can also optionally enter multiple property sub-elements for the cache element.
The only requirement is that they be name/value pairs recognized by the
implementation class you register under cache. For example, if you use the default
cache Java class that is provided with Oracle Reports Services, your configuration
entry might look like this:

<cache class="oracle.reports.cache.RWCache">

<property name="cacheSize" value="50"/>

<property name="cacheDir" value="D:\orawin\reports\server\cache"/>
</cache>
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In the preceding example, cacheSize is measured in megabytes, and cacheDir,
which points to the location of the cache, is specified for a Windows platform. On
UNIX, use UNIX standards, for example:

<property name="cacheDir" value="home/john/HRInstance/reports/server/cache"/>

The default cache Java class also provides the following properties:

= JOCCacheDir uses the Java object cache. For example:
<property name="JOCCacheDir" value="\\host\shared"/>

s maxCacheFileNumber is the maximum number of files allowed in the cache. For
example:
<property name="maxCacheFileNumber" value="250"/>
Specify this property value in Oracle Enterprise Manager on the Reports Server
Advanced Configuration page: Maximum Cached Files.

s ilgnoreParameters lists any report parameters you want to be ignored when
Reports Server constructs the cache key. (The cache key is used by Reports Server
to determine if an incoming job request matches existing output in the cache.)

<property name="ignoreParameters" value="paraml,param2"/>

= To configure the Java Object Cache (JOC) Cache Directory, use the following:

<cache class="oracle.reports.cache.RWCache">
<property name="JOCCacheDir" value="\\host\shared"/>
</cache>

Where host is the machine where the shared folder is available, and shared is
the folder name.

8.2.1.4 cluster

Note: In Oracle Reports 11g Release 1 (11.1.1), Reports Server
clustering was deprecated (see A Guide to Functional Changes
Between Oracle Reports 6i and 11g for more details), and the cluster
element is not valid.

For information about Oracle Fusion Middleware techniques for
high availability, refer to Section 2.5, "Setting Up a High Availability
Environment".

8.2.1.5 connection
The connection element is defined in rwserverconf . xsd as follows:

<xs:element name="connection">
<xs:complexType>
<Xs:sequence>
<xs:element ref="orbClient" minOccurs="0" maxOccurs="unbounded"/>
</Xs:sequence>

<xs:attribute name="idleTimeOut" default="15">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
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</xs:simpleType>
</xs:attribute>

<xs:attribute name="maxConnect" default="50">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>

</xs:complexType>
</xs:element>

Example
In rwserver. conf, the connection element may be specified as shown in this
example:

<connection idleTimeOut="20" maxConnect="50" >
<orbClient id="RWClient" publicKeyFile="clientpub.key"/>
</connection>

Required/Optional

Optional. If you do not specify a connection element in your server configuration
file, default values will be used (see Table 8-5). You can have a maximum of one
connection element in your server configuration file.

Description

The connection element defines the rules of engagement between the server and the
clients connected to it.

The connection element attributes are described in Table 8-5.

Table 8-5 Attributes of the connection Element

Attribute Valid Values Description

idleTimeOut Number Default: 15

Set in Oracle Allowable amount of time in minutes the connection
Enterprise Manager can be idle.

on the Reports
Server Advanced
Configuration page:
Connection Idle
Timeout (min).

maxConnect Number Default: 50

Set in Oracle The maximum number of requests that Reports Server
Enterprise Manager can service simultaneously. Requests in excess of the
on the Reports maxConnect value return a Java exception.

Server Advanced
Configuration page:
Maximum
Connections.

The connection element also includes the orbC1lient sub-element, described in
Section 8.2.1.17, "orbClient".
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8.2.1.6 destination

The destination element is defined in rwserverconf . xsd as follows:

<xs:element name="destination">
<xs:complexType>
<Xs:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="class" use="required" type="xs:string"/>
<xs:attribute name="destype" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the destination element may be specified as shown in this
example:

<destination destype="oraclePortal" class="oracle.reports.server.DesOraclePortal">
<property name="portalUserid"
value="portal_db username/portal_password@portal_db_connection"
encrypted="no"/>
</destination>

Required/Optional

Optional. If you do not enter a destination element in the server configuration file,
the provided destination classes will be used (printer, e-mail, file, cache, and Oracle
Portal—which is an exception in that it requires an entry in the server configuration
file so that you may specify the userid and password the server will use to log in to the
portal). You can have from zero to multiple destination elements in your server
configuration file.

Description
Use the destination element to register destination types with the server.

You need not register the following default destinations:

s Cache

s E-mail

»  Printer

= File

= FIP

= WebDAV

You may want to register the following default destination:

= Oracle Portal: The entry for this destination is created by default in the server
configuration file, but it is commented out. To start using this destination, you
must uncomment the destination entry, and also provide appropriate property
values (for example, the value for the portalUserid property).

You must register any new destination types you create through the Oracle Reports
Services Destinations APIL
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Note: For more information on the destination API, refer to
the Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

Configuring destinations is discussed in detail in Chapter 13,
"Configuring Destinations for Oracle Reports Services".

The destination element attributes are described in Table 8-6.

Table 8-6 Attributes of the destination Element

Attribute Valid Values Description

class string A fully qualified Java class that is a subclass of Reports
Server Destination Java class
(oracle.reports.server.Destination).
Allowable values include:

oracle.reports.server.DesMail
oracle.reports.server.DesFile
oracle.reports.server.DesPrinter

oracle.reports.server.DesOraclePortal

destype strin Identifies the destination type; for example:
g yp p

destype="printer"

Properties

You can also optionally enter multiple property sub-elements for the destination
element. The only requirement is that they be name/value pairs recognized by the
Java class that is a subclass of the Reports Server Destination Java class. For example:

<destination destype="oraclePortal"
class="oracle.reports.server.DesOraclePortal">
<property name="dbuser" value="$S$SPORTAL_DB_USERNAMESS"/>
<property name="dbpassword" value="csf:$S$SCSF_ALIASSS:S$SSPORTAL_DB_PASSWORD_
KEYSS" />
<property name="dbconn" value="$$PORTAL_DB_TNSNAMESS"/>
</destination>

In this example, the property sub-element provides connect information to enable
Reports Server to access Oracle Portal. The encrypted attribute is included to
automatically invoke encryption on the portalUserid value the next time Reports
Server is started.

Note: For portalUserid database connection strings, both the
thin (scott/tiger@testhost.mydomain.com:1521:iasdb)
and Oracle Call Interface (scott/tiger@ordb) JDBC formats are
supported.

Should your destination implementation require additional information, specify the
information in the pluginParam element.
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8.2.1.7 environment

The environment element is defined in rwserverconf . xsd as follows:

<xs:element name="environment">
<xs:complexType>
<xs:sequence>
<xs:element ref="envVariable" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="id" use="required" type="xs:ID"/>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the environment element may be specified as shown in this
example:

<environment id="JP">
<envVariable name="NLS_LANG" value="Japanese_Japan.JA16SJIS"/>
<envVariable name="NLS_CURRENCY" value="¥"/>
<envVariable name="DISPLAY" value="MyServer.MyCompany.com:0.0"/>
</environment>

Required/Optional
Optional. You can have as many environment elements as you require.

Description

The environment element defines the characteristics (that is, environment variables)
that you want to use to establish a particular runtime environment. You may include
as many environment elements as you need (for example, one for each
language/territory you must support). Inside an environment element, you can add
as many envVariable elements as required.

By referencing the environment element's id, you invoke its settings. You can
reference an environment element id from:

s The defaultEnvId attribute of the engine element in the Reports Server
configuration file, to apply the corresponding environment settings to that engine
when it starts up. For more information, refer to Section 8.2.1.9, "engine".

s The command line keyword, ENVID, of your report's job request, which makes the
environment settings only effective for that particular report job request.

The environment element attribute is described in Table 8-7.

Table 8-7 Attribute of the environment Element

Attribute Valid Values Description

id string The name of the environment.

Set in Oracle
Enterprise Manager
on the Reports Server
Basic Configuration
page: Default Env ID.

The environment element includes one or more envvVariable sub-elements,
described in Section 8.2.1.8, "envVariable".
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8.2.1.8 envVariable
The envvVariable element is defined in rwserverconf .xsd as follows:
<xs:element name="envVariable">
<xs:complexType>
<xs:attribute name="name" use="required" type="xs:string"/>
<xs:attribute name="value" use="optional" type="xs:string"/>

</xs:complexType>
</xs:element>

Example

In rwserver. conf, the envvariable element may be specified as shown in this
example:

<envVariable name="NLS_LANG" value="Japanese_Japan.JA16SJIS"/>
<envVariable name="NLS_CURRENCY" value="¥"/>
<envVariable name="DISPLAY" value="MyServer.MyCompany.com:0.0"/>

Required/Optional
Optional.

Description

Each envVariable is specified as a name—value pair. They can be either standard
environment variables or user-defined environment variables.

envVariable is a sub-element of the environment element.

The envVariable element attributes are described in Table 8-8.

Table 8-8 Attributes of the envvariable Element

Attribute Valid Values Description

name string The name of the environment you wish

Set in Oracle Enterprise to use (for example, NLS_LANG).

Manager on the Reports
Server Basic Configuration
page: Add.

value string The value you want to assign to the
environment variable identified with the
name attribute (for example, Japanese_
Japan.JA16S]IS).

Set in Oracle Enterprise
Manager on the Reports
Server Basic Configuration
page: Add.

8.2.1.9 engine

The engine element is defined in rwserverconf .xsd as follows:

<xs:element name="engine">
<xs:complexType>
<XS:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>

<xs:attribute name="id" use="required" type="xs:string"/>
<xs:attribute name="class" use="required" type="xs:string"/>

<xs:attribute name="maxEngine" use="required">

<xs:simpleType>
<xs:restriction base="xs:integer">
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<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>

<xs:attribute name="minEngine" use="required">

<xs:simpleType>

<xs:restriction base="xs:integer">
<xs:minInclusive value="0"/>

</xs:restriction>

</xs:simpleType>

</xs:attribute>

<xs:attribute name="engLife" wuse="required">
<xs:simpleType>

<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>

</xs:simpleType>

</xs:attribute>

<xs:attribute name="maxIdle" default="30">

<xs:simpleType>

<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>

</xs:restriction>

</xs:simpleType>

</xs:attribute>

<xs:attribute name="callbackTimeOut" default="90000">

<xs:simpleType>

<xs:restriction base="xs:integer">
<xs:minInclusive value="60000"/>

</xs:restriction>

</xs:simpleType>

</xs:attribute>

<xs:attribute name="engineResponseTimeOut">

<xs:simpleType>

<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>

</xs:restriction>

</xs:simpleType>

</xs:attribute>

<XS:
<XS:
:attribute

<Xs

<Xs:

attribute
attribute

attribute

name="initEngine" type="xs:integer"/>
name="JjvmOptions" type="xs:string"/>
name="classPath" type="xs:string"/>
name="defaultEnvId" type="xs:string"/>

</xs:complexType>
</xs:element>

Example
In rwserver.conf, the engine element may be specified as shown in this example:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="5" minEngine="1" engLife="50" maxIdle="15" callbackTimeOut="90000">
<property name="sourceDir" value="D:\orawin\reports\myReport"/>
<property name="tempDir" value="D:\orawin\reports\myTemp"/>
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</engine>

Required/Optional
Required. You must have at least one engine element in your configuration file.

Description

The engine element identifies the fully qualified Java class that starts an engine and
provides a number of attributes that set operational controls on the engine. You can
use the default engines provided with Oracle Reports Services or develop your own
implementation through the Oracle Reports Services Engine API. As an example of a
custom engine, you may have developed an engine to execute an operating system
command should an event occur in your database.

Note: For more information on the engine API, refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The engine element attributes are described in Table 8-9.

Table 8-9 Attributes of the engine Element

Attribute Valid Values Description

id string A keyword, unique within a given configuration
XML file that identifies a particular engine
element. This can be a text string or a number, for
example:

id="rwEng"

class string Default:
oracle.reports.engine.EngineImpl

A fully qualified Java class that implements two
interfaces: oracle.reports.engine.Engine
and
oracle.reports.engine.EngineInterface

maxEngine number Default: 1
Set in Oracle Enterprise The maximum number of this type of engine that
Manager on the Reports can run on the server.

Server Basic Configuration
page: Maximum Engines.

minEngine number Default: 0
Set in Oracle Enterprise The minimum number of this type of engine that
Manager on the Reports is maintained by the server.

Server Basic Configuration
page: Minimum Engines.

engLife number Default: 50

Set in Oracle Enterprise The number of jobs the engine can run before the
Manager on the Reports engine is terminated, and, if necessary, a new
Server Basic Configuration engine is started. This feature is available to
page: Maximum Job Before thwart memory leaks.

Restart.
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Table 8-9 (Cont.) Attributes of the engine Element

Attribute Valid Values Description

maxIdle number Default: 30

Set in Oracle Enterprise The number of minutes of allowable idle time

Manager on the Reports before the engine is shut down However, the

Server Basic Configuration current number of engines should be higher than

page: Maximum Idle minEngine.

Before Shutdown (min). For example, if minEngine is 0, maxIdleis 30,
and one engine has been running but unused for
30 minutes, that engine will shut down. If, under
the same conditions, minEngine is 1, the active
engine will not shut down, even if it has been idle
for 30 minutes.

callbackTimeOut number Default: 90000

engineResponseTimeOut number

Set in Oracle Enterprise
Manager on the Reports
Server Advanced
Configuration page: Engine
Response Timeout (min).

initEngine number

jvmOptions string

Set in Oracle Enterprise
Manager on the Reports
Server Basic Configuration
page: JVM Options.

The number of milliseconds of allowable waiting
time between when the server launches an engine
and the engine calls the server back.

If the machine that hosts the server is very fast,
you can reduce this number for faster
performance.

Default: null (no timeout)

The maximum amount of time (in minutes) for an
engine to update the status of the job while
running a report in your environment. If it takes
longer than this amount of time to update the job
status for some reason (for example, due to the
engine hanging or a long blocking SQL query),
Reports Server terminates the job.

Default: 1

The number of engines you want Reports Server
to start at initialization.

When running a report using rwrun, retain the
default value of initEngine="1". Because
rwrun can run only one report at a time, any
other setting may result in the report not being
run.

The Java Virtual Machine (JVM) options to be
used by Reports Server when it starts an engine in
the JVM. For example, you can use this attribute
to specify the starting heap size and maximum
heap size for the JVM, additional classpath
entries, and so on.

If this attribute is not specified, the engine
running in the server environment uses the JVM
options specified by the value of the REPORTS_
JVM_OPTIONS environment variable. For more
information, see Section B.1.52, "REPORTS_JVM_
OPTIONS".
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Table 8-9 (Cont.) Attributes of the engine Element
Attribute

Valid Values Description

classPath string

defaultEnvId string

Set in Oracle Enterprise
Manager on the Reports
Server Basic Configuration
page: Default Env ID.

The directory path to the Java class specified in
the class attribute. To specify the directory, use
the conventions required by the server platform,
for example:

Windows:

classPath=
"$ORACLE_HOME%\myEngine.jar"

UNIX:
classPath="$ORACLE_HOME/myEngine.jar"

(Optional attribute) The default environment
within which Reports Server starts an engine. The
attribute takes an ID associated with an
environment element in the server configuration
file.

When defaultEnvIdis specified, Reports Server
starts an engine with the environment variables
specified in the referenced environment element
plus whatever environment variables that Reports
Server is running under.

If defaultEnvIdis not specified, Reports Server
spawns engines with the environment settings in
force at startup time.

For more information, refer to Section 8.2.2,
"Dynamic Environment Switching".

Properties

You can also optionally enter multiple property sub-elements for the engine
element. The only requirement is that they be name/value pairs recognized by the
Java class that implements the Oracle Reports engine.

Table 8—-10 Properties of the engine Element

Property Valid Values Description
sourceDir directory The default directory you will use for report
Set in Oracle Enterprise path defir}ition. files. It overrides path information
Mana the R N specified in the REPORTS_PATH environment
BET 0N the Reports variable.
Server Advanced
Configuration page: The directory specified by sourcedir is not
Reports Source given access by default. It used only to search for
Directory. files, and Oracle Reports handles any associated
security settings separately if and when the target
files are located.
See the example that follows this table.
tempDir directory The name and location of the temporary
path directory Oracle Reports Services will use for its

Set in Oracle Enterprise
Manager on the Reports
Server Advanced
Configuration page:
Reports Temp Directory.

temporary files. If this value is unspecified for a
default engine, Oracle Reports Services uses the
temporary directory specified in the REPORTS_
TMP environment variable. If REPORTS_TMP is

not specified, Oracle Reports Services uses your
operating system's default temporary directory.

See the example that follows this table.
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Table 8-10 (Cont.) Properties of the engine Element

Property Valid Values Description

keepConnection YES |NO Default: YES

Set in Oracle Enterprise Used by the default runtime engine

Manager on the Reports implementation (that is,

Server Advanced oracle.reports.engine.EngineImpl).

Configuration page: YES The default runtime engine retains the

Keep Database o .o .

. existing database connection information.

Connection.
NO The default runtime engine discards the
existing database connection information and
reconnects with the userid specified for the job.
The keepConnection property does not affect
reports deployed using either rwbuilder or
rwrun.
This property will be migrated if a
rwserver . conf file used in previous releases
(for example, 9.0.2.x) runs in the current
environment.

diagnosis YES |NO Introduced in Oracle Reports 11¢ Release 1

Set in Oracle Enterprise
Manager on the Reports
Server Advanced
Configuration page:
Enable Engine
Diagnostics.

(11.1.1) for engine logging. Diagnoses whether or
not a specific function in a report run completed
successfully. The diagnostic log provides
information on important checkpoints or tasks in
the engine during a report run. This information
is useful in cases where the engine stops
responding, resulting in "hanging" jobs.

YES Diagnostic information is written to the
diagnostic. log file.

The engine diagnosis option provides more
detailed information than report tracing, which is
typically used to debug the execution of a report
to provide information such as the file currently
formatting, or report trigger currently running.

See the example that follows this table.

Example of sourcedir and tempDir properties: If you use the default engine Java
class that is provided with Oracle Reports Services, your engine configuration entry

might look like this (in a Windows environment):

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"

maxEngine="5" minEngine="1" engLife="50" maxIdle="15" callbackTimeOut="90000">

<property name="sourceDir" value="D:\orawin\reports\myReport"/>
<property name="tempDir" value="D:\orawin\reports\myTemp"/>

</engine>

The classPath attribute is not specified because this configuration uses the default

engine class.

Example of diagnosis property: To enable the engine diagnosis option, your
engine configuration element might look like this:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="2"
maxEngine="8" minEngine="1" engLife="1" maxIdle="3" callbackTimeOut="90000">
<property name="diagnosis" value="yes"/>

</engine>
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8.2.1.10 job

The job element is defined in rwserverconf . xsd as follows:

<xs:element name="job">
<xs:complexType>
<xs:attribute name="engineId" use="required" type="xs:string"/>
<xs:attribute name="jobType" default="report" type="xs:string"/>
<xs:attribute name="securityId" type="xs:string"/>
<xs:attribute name="retry" default="0">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="0"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the job element may be specified as shown in this example:

<job jobType="report" engineld="rwEng" securityId="rwSec" retry="3"/>

Required/Optional
Required. You must have at least one job element.

Description

The job element works in collaboration with the engine and security elements. Use
job to identify a job type and specify which engine and which security
implementation should be used with that type of job. For example, you may have
developed an engine to execute an operating system command should an event occur
in your database. Using Oracle Reports Services's event-driven publishing API, you
identify the event as a specific job type. When the event occurs, the job type
information is sent to Reports Server, which looks up the job type under the job
element in its configuration file, and follows the direction provided in the element's
attributes to the engine (and, if applicable, security implementation) specified for that
type of job.

The job element attributes are described in Table 8-11.

Table 8—11 Attributes of the job Element

Attribute Valid Values Description

engineId string References the ID entered for the engine that will
process this job type. Available IDs are specified
under the engine element in the server
configuration file using the id attribute. The id is
a unique keyword (that you devise) within a given
configuration XML file that identifies a particular
engine.
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Table 8-11 (Cont.) Attributes of the job Element

Attribute Valid Values Description

jobType string Default: report

Describes the type of job to be processed by the
server. You can enter any type of job, as long as
Reports Server has an engine to process it.

The database authentication functionality
provided in Oracle Reports is available only when
jobType=report. This is the job type of the
default engine (rwEng) provided with Oracle
Reports Services. The database authentication
functionality is not implemented when jobType
specifies a different value (for example, for a
custom engine that you develop yourself). This is
because a custom engine may require a different
format for the connect string, while the Oracle
Reports database authentication functionality
limits the connect string to the Oracle Reports
format user /password@dbname used for the
default engine.

securityId string References the ID entered for the security
mechanism that will be applied to this job type.
Available IDs are specified under the security
element in the server configuration file.

retry integer Default: 0

Set in Oracle When jobType="report", specifies the number
Enterprise Manager of times to retry a job after the initial run, if the job
on the Reports Server fails due to an engine crash or unexpected error.
Advanced The job is resubmitted to another engine the
Configuration page: number of times specified.

Job Retries. This attribute is ignored if the job is explicitly

cancelled or when jobType="rwurl" (URL
engine).

If an invalid value is specified, this attribute is
ignored and the default value of 0 is used.

If JOBRETRY is specified on the command line, it
takes precedence, and the retry attribute is
ignored.

8.2.1.11 jobRecovery

The jobRecovery element is defined in rwserverconf .xsd as follows:

<xs:element name="jobRecovery">
<xs:complexType>
<xs:attribute name="auxDatFiles" default="no">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="yes"/>
<xs:enumeration value="no"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>
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Example

In rwserver. conf, the jobRecovery element may be specified as shown in this
example:

<jobRecovery auxDatFiles="yes"/>

Required/Optional

Optional. To enable the job recovery mechanism, add the jobRecovery element to
the server configuration file. The job recovery mechanism is disabled by default.

Description

The jobRecovery element includes the auxDatFiles attribute. When
auxDatFiles=yes, Oracle Reports enables a more resilient job recovery mechanism
for maximal retrieval of jobs in case the original . dat file is corrupt due to some
reason. When auxDatFiles=yes, Reports Server creates the following two auxiliary
files in addition to server_name.dat (the main.dat file):

s datfilename _offset.dat contains the auxiliary information of jobs in the
main. dat file, which helps in retrieving jobs from the main. dat file.

» datfilename_sc.dat contains all scheduled jobs information (in addition to the
information stored in main . dat file).

If the job recovery mechanism is enabled, Reports Server on startup reads the

main . dat file with the help of the datfilename offset.dat file using the
auxiliary information stored in it. If the main . dat file is corrupt and Reports Server
cannot retrieve all the jobs information, it starts reading the dat filename_sc.dat
file and recovers the scheduled jobs for this file. Thus, datfilename_sc.dat serves
as a backup file, which results in maximum possibility of recovery of scheduled jobs in
case of corruption of the main . dat file.

If Reports Server fails to find the dat filename_offset.dat file (for example, when
the jobRecovery element is enabled for first time) when the job recovery mechanism
is enabled, it reads the jobs from the main . dat file and creates the other two auxiliary
files from scratch.

The server_name.dat, datfilename_offset.dat,and datfilename_sc.dat
files form a unique triplet, and the auxiliary files are valid only when the job recovery
mechanism is enabled. If the auxiliary files are found when the job recovery
mechanism is disabled, Reports Server deletes these files from the file system to
maintain the integrity between these files. For this reason, you must always handle
these three files together (for example, if you are copying a file from one machine to
another, you must copy these three files together).

The jobRecovery element attribute is described in Table 8-12.

Table 8-12 Attribute of the jobRecovery Element

Attribute Valid Values Description
auxDatFiles ves Default: no
no See above.

8.2.1.12 jobStatusRepository

The jobStatusRepository element is defined in rwserverconf . xsd as follows:

<xs:element name="jobStatusRepository">
<xs:complexType>
<Xs:sequence>
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<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="class" default="oracle.reports.server.JobRepositoryDB"
type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the jobStatusReposity element may be specified as shown in
this example:

<jobStatusRepository>

<property name="dbuser" value="<dbuser>"/>

<property name="dbpassword" value=csf:reports:"<dbkey>"/>
<property name="dbconn" value="<dbconn>"/>
</jobStatusRepository>

Required/Optional
Optional. You can have a maximum of one jobStatusRepository element in your
server configuration file.

Description

The jobStatusRepository element specifies the Java class that implements a job
status repository. It provides an additional means (over the persistFile element) of
storing job status information.

The persistFile is a binary file and, therefore, cannot be used to publish job status
information within your application. The jobStatusRepository element provides
a means of including status information in your application by providing additional
ways of storing it.

The default class, oracle.reports.server.JobRepositoryDB, stores
information in a database. Use the Oracle Reports APIs to create your own
implementation of the Reports Server Job Repository interface
(oracle.reports.server.JobRepository) that stores information wherever you
wish.

The jobStatusRepository element attribute is described in Table 8-13.

Table 8-13 Attribute of the jobStatusRepository Element

Attribute Valid Values Description

class string Default:

Set to the default oracle.reports.server.JobRepositoryDB
value in Oracle A fully qualified Java class that implements the
Enterprise Manager Reports Server Job Repository Java class

on the Reports Server (oracle.reports.server.JobRepository).
Advanced

Configuration page:

Enable Job

Repository DB.

Properties

You can also optionally enter multiple property sub-elements for the
jobStatusRepository element for passing options into the repository. The only
requirement is that they be name/value pairs recognized by the class you specify in
the server configuration file.
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The jobStatusRepository element might look like this in your server
configuration file:

<jobStatusRepository>

<property name="dbuser" value="<dbuser>"/>

<property name="dbpassword" value=csf:reports: "<dbkey>"/>
<property name="dbconn" value="<dbconn>"/>
</jobStatusRepository>

Note: Oracle Reports uses the dbconn property of the
jobstatusrepository element to connect to the database when
updating the log information about job queues.

8.2.1.13 log

The 1og element is defined in rwserverconf .xsd as follows:

<xs:element name="log">
<xs:complexType>
<xs:attribute name="option" default="noJob">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="allJobs"/>
<xs:enumeration value="succeededJobs"/>
<xs:enumeration value="failedJobs"/>
<xs:enumeration value="noJob"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example
In rwserver. conf, the 1og element may be specified as shown in this example:

<log option="allJobs"/>

Required/Optional

Optional. You can have a maximum of one 1og element in your server configuration
file.

Description

The 1og element is available for backward compatibility. It invokes the generation and
population of a reports log file. The log file is automatically generated and stored in
the following path (the path is the same for Windows and UNIX):

SORACLE_INSTANCE/diagnostics/logs/ReportsSeverComponent/<reports_server_
name>/rwserver_diagnostic.log

The 1og element attribute is described in Table 8-14.
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Table 8-14 Attribute of the 10g Element

Attribute Valid Values Description

option allJobs Default: noJgob

succeededJobs  Describes the type of jobs that are logged. This is
failedTobs in addition to the default server activities that
are logged. Choose from the following options:

noJob = allJdobs: Alljobs will be logged

= succeededJobs: Only jobs that ran
successfully will be logged

s failedJobs: Only jobs that failed will be
logged

= noJob: No jobs will be logged

8.2.1.14 jobRepository

The jobRepository elementis defined in rwserverconf .xsd as follows:

<xs:element name="jobRepository">
<xs:complexType>
<XS:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the jobRepository element may be specified as shown in this
example:

<jobRepository>

<property name="dbuser" value="dbuser"/>

<property name="dbpassword" value="csf:reports:dbpasswdKey" />
<property name="dbconn" value="dbconn"/>

</jobRepository>

Required/Optional

Required in a high availability (HA) environment. Optional in a non-HA environment.
You can have a maximum of one jobRepository element in your server
configuration file.

Description

The jobRepository element enables you to store all job information in the database
instead of the file system (that is, in DAT files). This element is mandatory if you want
to use high availability (HA), because Reports Servers in the group share job
information, which is possible only if the job information is stored in the database, and
not individual DAT files.

The jobRepository element has no attributes.

Properties

jobRepository requires only one property sub-element, repositoryconn. and the
jobRepository element enables you to store all job information in the database or the
file system (that is, in DAT files).
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8.2.1.15 notification

The notification element is defined in rwserverconf .xsd as follows:

<xs:element name="notification">
<xs:complexType>
<Xs:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="class" use="required" type="xs:string"/>
<xs:attribute name="id" default="mailNotify" type="xs:string"/>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the notification element may be specified as shown in this
example:

<notification id="tellMe02" class="oracle.reports.server.MailNotify"/>

Required/Optional

Optional. If you do not enter a notification element in the configuration file, the
notification function is disabled. You can have from zero to multiple notification
elements in your configuration file.

Description

Use the notification element to specify a Java class that defines the type of
notification that should be sent when a job succeeds or fails. You can use the default
notification class, which provides for notification through e-mail, or design your own
with the Oracle Reports Notification APIL.

Note: For more information on the notification API, refer to
the Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The notification element attributes are described in Table 8-15.

Table 8-15 Attributes of the notification Element

Attribute Valid Values Description

id string Default: mailNotify

A keyword, unique within a given configuration
XML file, that identifies a particular
notification element. This can be a text string
or a number, for example:

id="tellMeO1"

class See the Default:
Description oracle.reports.server.MailNotify
column

A fully qualified Java class that implements the
Reports Server Notification Java class
oracle.reports.server.Notification.
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If you use the default email notification implementation, use the pluginParam element
to specify the outgoing SMTP mail server to be used to send the mail. Use the
command line keyword notifysuccess and notifyfailure to specify the email
address where notification should be sent (for more information, see Appendix A,
"Command Line Keywords"). For example, you can include these commands in your
runtime URL:

notifysuccess=recipient's e-mail address&notifyfailure=recipient's e-mail address

With the default e-mail implementation, you can specify only one address for each
type of notification. You can specify one or both types of notification. You
can send notification each to the same address or each to a different addresses.

A notification element in the server configuration file might look like this:

<notification id="mailNotify" class="oracle.reports.server.MailNotify">
<property name="succNoteFile" value="succnote.txt"/>
<property name="failNoteFile" value="failnote.txt"/>

<notification/>

The succNoteFile and failNoteFile properties are set in Oracle Enterprise
Manager on the Reports Server Advanced Configuration page: Email notification file
for success and Email notification file for failure.

Some mail servers may validate the sender's domain name. If the notification fails
because of this domain name validation, then you must add the following property as
part of the notification element:

<property name="sender" value="valid email address"/>

With the default notification implementation, it's not necessary to specify a path to the
success or failure text files, provided they're in the default location: ORACLE_
HOME\reports\templates. Otherwise, enter the directory path along with the
filenames according to the requirements of the platform that hosts the server.

8.2.1.16 oidconnection
The oidconnection element is defined in rwserverconf . xsd as follows:
<xs:element name="oidconnection">
<xs:complexType>
<xs:attribute name="increment" default="10" type="xs:integer"/>
<xs:attribute name="init" default="10" type="xs:integer"/>
<xs:attribute name="timeout" default="0" type="xs:integer"/>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the oidconnection element may be specified as shown in this
example:

<oidconnection init="10" increment="10" timeout="600"/>

Required/Optional
Optional.

Description

The oidconnection element specifies Oracle Internet Directory connection pooling
parameters for Reports Server. In a production environment, you can use this
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parameter to provide granular control over Oracle Internet Directory connection
pooling of Reports Server, namely:

s The number of connections to keep open in the pool when Reports Server is
initialized.
= Upon exhausting the available connections, the number of new connections to be

added to the pool when a new request arrives.

= The timeout for closing idle open Oracle Internet Directory connections to reduce
the resource usage.

The oidconnection element attributes are described in Table 8-16.

Table 8-16 Attributes of the oidconnection Element

Attribute Valid Values Description

init number Default: "10"

Initial number of Oracle Internet Directory
connections to be created when Reports Server
is initialized.

increment number Default: "10"

Number of connections to be incremented when
all connections are used up.

timeout number Default: "0" (which specifies no
timeout)

Time in seconds for which a connection can be
idle before it is closed.

Note: Setting much lower or higher values than the default values
for these attributes can have a performance impact on Oracle
Reports Services. In a typical production environment, the default
values are recommended.

For Oracle Reports Servlet (rwservlet), you can specify Oracle Internet Directory
connection pooling parameters using the oidconnection element in the
rwservlet.properties file.

8.2.1.17 orbClient

The orbClient element is defined in rwserverconf .xsd as follows:

<xs:element name="orbClient">
<xXs:complexType>
<xs:attribute name="id" use="required" type="xs:string"/>
<xs:attribute name="publicKeyFile" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the orbClient element may be specified as shown in this
example:

<orbClient id="RWClient" publicKeyFile="clientpub.key"/>
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Required/Optional

Optional. If you do not specify the orbClient element in your server configuration file,
the default values will be used.( see Table 8-17)

Description

The orbClient element specifies the name of the public key file that the client will
use to connect to Reports Server. Reports Server uses the public key to verify the
signature sent by the client when it tries to connect to Reports Server. Reports Server
only accepts clients whose signature can be verified through this public key. You can
have from zero to multiple orbClient elements in your server configuration file.

orbClient is a sub-element of the connection element

The orbClient element attributes are described in Table 8-17.

Table 8-17 Attributes of the orbClient Element

Attribute Valid Values Description

id string Default: RWClient
Identifies the Reports Client to be served by the
public and private key.

publicKeyFile filename.key  Default:clientpub.key

Identifies the public key file that the client will use
to connect to Reports Server. Reports Server uses
the public key to verify the signature sent by the
client when it tries to connect to Reports Server.
Reports Server only accepts clients whose signature
can be verified through this public key. The default

file is stored in the rwrun. jar file.

Oracle Reports Services provides default client public and private key files,
clientpub.key and clientpri.key. These key files are in place for all
components of Oracle Reports Services You can regenerate public and private key files
to replace the default key pair. To do this, at the command prompt use the following
command:

On Windows:
rwgenkey.bat path_and client_public_key file name path_and_client_private key

file name

On UNIX:

rwgenkey.sh path_and client_public_key file _name path_and_client_private_key file
name

If you regenerate these keys, you can specify the public key file locations with the
publicKeyFile attribute, and replace the private key file in ORACLE_
HOME\jlib\zrclient.jar. To do this, you must unjar the file, place the
regenerated private key into it, and rejar the file.

8.2.1.18 persistFile

The persistFile element is defined in rwserverconf .xsd as follows:

<xs:element name="persistFile">
<xs:complexType>
<xs:attribute name="fileName" type="xs:string"/>
</xs:complexType>
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</xs:element>

Example
In rwserver.conf, the persistFile element may be specified as shown in this
example:

<persistFile fileName="neptune.dat"/>

Required/Optional

Optional. If you do not specify a file, the server will create one of its own with the
default name server name.dat. You can have a maximum of one persistFile
element.

Description

The persistFile element identifies the file that records all job status. It is used by
Reports Server to restore the server to the status it held before shutdown.

It is named persistFile because the file remains intact, or persists, even when the
server is brought down and restarted.

The server persistent file is created automatically the first time you start the server or
the first time you start the server after the current server persistent file has been
deleted or renamed. If you want to rename this file but continue using it, enter the new
name in the server configuration file before you actually rename the file, then restart
the server.

The persistFile element attribute is described in Table 8-18.

Table 8—18 Attribute of the persistFile Element

Attribute Valid Values Description

fileName string Default: server_name.dat

The name and, optionally, the path of the server
persistent file. You can leave the path off if the file is
kept in its default directory:

ORACLE_INSTANCE\reports\server\
The path is the same for Windows or UNIX.

8.2.1.19 identifier

The identifier element is defined in rwserverconf . xsd as follows:

<xs:element name="identifier">
<xs:complexType mixed="true">
<xs:attribute name="encrypted" default="no">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="yes"/>
<xs:enumeration value="no"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the identifier element may be specified as shown in this
example:
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<identifier encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>

Required/Optional
Optional. You can have a maximum of one identifier element in your server
configuration file.

Description

The identifier element is automatically written to the configuration file by the
Reports Configuration Assistant when you first install Oracle Reports. The Reports
Configuration Assistant sets the values in the form
SERVERACCESSKEY/12312312313, where SERVERACESSKEY is the user name and
the random generated number (12312312313) is the password. This user name and
password is then encrypted and written to rwserver. template and targets.xml
during the time of configuring Oracle Reports Services. Any Reports Server started
after the installation will have this identifier information stored in its configuration
file.

For a non-secured Reports Server, the values of the identifier element is used
when:

= Connecting to a Reports Server through the Reports Queue Manager.
s Shutting down a Reports Server through the command line.

In either of these cases, you must provide the authid in the command line that
matches the values specified in the identifier element. To provide a specific
password (as the password is a pseudo random number), you must do the following:

1. Edit the server configuration file, rwserver.conf.

2. Replace the encrypted username/password values generated with custom
values.

3. Setencrypted=no.
For example:

<identifier encrypted="no">username/password</identifier>

4. Restart Reports Server. Reports Server sets encrypted=yes when it restarts.

5. Edit the targets.xml file and specify the same username and password values
that were included in the rwserver . conf file.

You should restart Reports Server, immediately, after making this change. Reports
Server automatically encrypts the user name and password and resets encrypted to
ves. The values should now read as follows:

<identifier encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>
For a secure Reports Server, the authentication is done by the security infrastructure;
that is, by using the Oracle Internet Directory repository. Thus, you cannot pass the

values in the identifier element to shut down a Reports Server or launch Reports
Queue Manager through the console window.
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Note: This user name and password is also used for accessing
Web commands, such as getjobid, getserverinfo, showjobs,
and showenv when DIAGNOSTIC=NO in the
rwservlet.properties file. When DIAGNOSTIC=NO, Web
commands are disabled for everyone except those administrators
who have this user name and password.

For more information on Reports Queue Manager, see the Reports Queue Manager
online Help. For more information on rwservlet.properties, refer to Section 8.3,
"Oracle Reports Servlet Configuration File".

8.2.1.20 property

The property element is defined in rwserverconf .xsd as follows:

<xs:element name="property">
<xs:complexType>
<xs:attribute name="name" use="required" type="xs:string"/>
<xs:attribute name="value" use="required" type="xs:string"/>
<xs:attribute name="encrypted" type="xs:string"/>
</xs:complexType>
</xs:element>

See the following element descriptions for information about specifying the property
element in rwserver.conf:

s  Section 8.2.1.3, "cache"
s Section 8.2.1.6, "destination"
= Section 8.2.1.9, "engine"

= Section 8.2.1.12, "jobStatusRepository"

8.2.1.21 queue

The queue element is defined in rwserverconf .xsd as follows:

<xs:element name="queue">
<xs:complexType>
<xs:attribute name="maxQueueSize" default="1000">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="100"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the queue element may be specified as shown in this example:

<queue maxQueueSize="1000"/>

Required/Optional

Optional. You can have a maximum of one queue element in your server
configuration file. If you have no queue element, the default maxQueueSize, 1000,
will remain in effect.
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Description

Use the queue element to specify the maximum number of jobs that can be held in a
completed job queue. Oracle Reports Services has three queue components:

= aqueue of scheduled jobs

= aqueue of jobs in progress

= aqueue of completed jobs

The queue element provides the allowable value for each of these components.

This element is applicable only to the completed job queue. Thus, if the number of jobs
exceeds the specified maximum value, that completed job queue will automatically
purge its oldest jobs. The scheduled job queue and the in-progress job queue remain
unaffected.By default reports server queue size is 1000 jobs.

If you increase the queue size to more than 3000, and use Reports Queue Manager
(rwrgm. exe) to monitor the queue, Queue Manager may fail. When a queue size of
3000 or greater is required, use Oracle Enterprise Manager or Oracle Reports Servlet
(rwservlet) to manage and monitor the Reports Server jobs queue.

Note: For more information, see the Reports Queue Manager online
Help.

The queue element attribute is described in Table 8-19.

Table 8-19 Attribute of the queue Element

Attribute Valid Values Description

maxQueueSize Number Default: 1000

Set in Oracle The maximum number of jobs that can be held in a
Enterprise given reports job queue.

Manager on the
Reports Server
Basic
Configuration
page: Queue Size.

8.2.1.22 folderAccess

The folderAccess element is defined in rwserverconf .xsd as follows:

<xs:element name="folderAccess">
<xXs:complexType>
<XS:sequence>
<xs:element name="read" type="xs:string"/>
<xs:element name="write" type="xs:string"/>
</Xs:sequence>
</xs:complexType>
</xs:element>

Example

In rwserver.conf, the folderAccess element may be specified as shown in this
example:

<folderAccess>
<read>c:\myreports;c:\orawin\reports\samples<\read>
<write>c:\myoutputs<\write>
<\folderAccess>
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Required/Optional
Optional.

Description

The folderAccess element defines read and write access to file system folders for
both secured and non-secured Reports Server, Reports Application (in-process Reports
Server), or Oracle Reports Runtime.

The folderAccess element has no attributes. It includes two sub-elements:

» read: specifies the folder(s) to which the Reports Server, Reports Application
(in-process Reports Server), or Oracle Reports Runtime has read access only. The
value of this sub-element is set in Oracle Enterprise Manager on the Advanced
Configuration page: Enable File System Access Control > Read Directories.

=  write: specifies the folder(s) to which the Reports Server can write. The value of
this sub-element is set in Oracle Enterprise Manager on the Advanced
Configuration page: Enable File System Access Control > Write Directories.

In the example above, the report definition files located in ¢ : \myreports and
c:\orawin\reports\samples are allowed to run only. Similarly, when
destype=£file, the output file can be created only in c¢: \myoutputs
(desname=c: \myoutput\test.pdf).

Note: Blank or * in the read or write sub-element specifies global access. Separate
directory names with a semicolon (;).

8.2.1.23 security

The security element is defined in rwserverconf .xsd as follows:

<xs:element name="security">
<xs:complexType>
<XSs:sequence>
<xs:element ref="property" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="class" use="required" type="xs:string"/>
<xs:attribute name="id" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the security element may be specified as shown in this
example for 11g:

<security id="rwJaznSec" class="oracle.reports.server.RWJAZNSecurity"/>

For backward compatibility, the security element may be specified as:

<security id="rwSec" class="oracle.reports.server.RWSecurity">
<property name="oidAppEntity" value="$$Self.oidAppEntitys$s"/>
<property name="o0idUrl" value="$$Self.oidUrl$S$" />

<property name="oidPasswdKey" value="$$Self.oidPasswdKeyS$S"/>
<property name="portalUserName" value="$$Self.portalUserName$$"/>
<property name="portalConnection" value="$$Self.portalConnection$s"/>
<property name="portalPasswdKey" value="$$Self.portalPasswdkey$s"/>
</security
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Required/Optional

Optional. If you do not enter a security element in the configuration file, Reports
Server is not secure. You can have from zero to multiple security elements in your
configuration file.

Description

The security element identifies the fully qualified Java class that controls server
access. You can use the default security class provided with Oracle Reports Services, or
develop your own implementation through the Reports Server Security APL

Note: For more information on the security API, refer to the
Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The security element attributes are described in Table 8-20.

Table 8-20 Attributes of the security Element

Attribute Valid Values Description

id string A keyword, unique within a given
configuration XML file that identifies a
particular security element. This can be a text
string or a number, for example for 11g:

id="rwJaznSec"
For backward compatibility,

id="rwSec"

class See the Description Default for 11g:
column oracle.reports.server.RWIJAZNSecurit
Y

Default for backward compatibility:
oracle.reports.server.RWSecurity

A fully qualified Java class that implements
Reports Server Security Java interface
(oracle.reports.server.Security). The
default relies on security features available
through Oracle Portal.

You can associate multiple properties with the security element. The only
requirement is that they be name/value pairs recognized by the Java class that
implements Reports Server security.

The value of all the properties is set by the Installer upon installation. Reports Server
uses this entity to connect to Oracle Internet Directory and Portal. Components of the
Oracle Fusion Middleware can all connect to Oracle Internet Directory and Oracle
Portal, but each component may have different privileges in the directory. Hence, each
component needs to identify itself through its own entity name to Oracle Internet
Directory when it connects. The Oracle Reports Services entity is of the following
format:

reportsApp_hostname_GUID

For example:
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reportsApp_testhost.mydomain.com_BBEFDCDAC2343600E0340800020C7BBCC

8.2.1.24 proxyServer

The proxyServer element is defined in rwserverconf .xsd as follows:

<xs:element name="proxyServer">
<xs:complexType>
<xs:attribute name="name" type="xs:string" use="required"/>
<xs:attribute name="port" type="xs:string" use="required"/>
<xs:attribute name="protocol" default="all">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="http"/>
<xs:enumeration value="https"/>
<xs:enumeration value="ftp"/>
<xs:enumeration value="file"/>
<xs:enumeration value="all"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the proxyServer element may be specified as shown in this
example:

<proxyServer name="www-proxy.us.oracle.com" port="80" protocol="all"/>

Required/Optional
Optional.

Description

Element that specifies the name, port and protocol of proxy server to be used in order
to connect to external network.

The proxyServer element attributes are described in Table 8-20.

Table 8-21 Attributes of the proxyServer Element

Attribute Valid Values Description
name string the host name of the proxyserver. example.
port string the port where the proxyserver is listening on.
protocol th/hﬁps/ﬁp/ﬁb/ the protocol used by the proxyserver.

a

8.2.1.25 domain

The domain element is defined in rwserverconf .xsd as follows:

<xs:element name="domain">
<xs:complexType mixed="true">
</xs:complexType>
</xs:element>

Example
In rwserver . conf, the domain element may be specified as shown in this example:
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<bypassProxy>
<domain><localhost</domain>
<domain>127.0.0.1</domain>
</bypassProxy>

Required/Optional
Optional.

Description

Element that specifies the name of the proxy server for which proxy setting should not
be used. The domain element has no attributes.

8.2.1.26 bypassProxy

The bypassProxy element is defined in rwserverconf .xsd as follows:

<xs:element name="bypassProxy">

<xs:complexType>
<Xs:sequence>
<xs:element ref="domain" minOccurs="0" maxOccurs="unbounded"/>
</Xs:sequence>

</xs:complexType>

</xs:element>

Example

In rwserver. conf, the bypassProxy element may be specified as shown in this
example:

<bypassProxy>
<domain>localhost</domain>
<domain>127.0.0.1</domain>
</bypassProxy>

Required/Optional
Optional.

Description

The element that provides a list of domains which specifies name of the proxy server
for which proxy setting should not be used

The bypassProxy element has no attributes. It includes the domain sub-element (see
Section 8.2.1.25, "domain").

8.2.1.27 proxyServers

The proxyServers element is defined in rwserverconf . xsd as follows:

<xs:element name="proxyServers">
<xs:complexType>
<xXs:sequence>
<xs:element ref="proxyServer" minOccurs="0" maxOccurs="unbounded"/>
</Xs:sequence>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the proxyServers element may be specified as shown in this
example:
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<proxyServers>

<proxyServer name="xyz.abc.com" port="80" protocol="http"/>
<proxyServer name="www-proxyl.xyz.abc.com" port="80" protocol="ftp"/>
<proxyServer name="www-prox2l.xyz.abc.com" port="80" protocol="https"/>
</proxyServers>

Required/Optional
Optional.

Description
Element that specifies a list of proxy servers used by reports server.

The proxyServers element has no attributes. It includes the proxyServer
sub-element (see Section 8.2.1.24, "proxyServer").

8.2.1.28 proxylinfo

The proxyInfo element is defined in rwserverconf .xsd as follows:

<xs:element name="proxyInfo">
<xs:complexType>
<Xs:sequence>
<xs:element ref="proxyServers"/>
<xs:element ref="bypassProxy"/>
</xs:sequence>
</xs:complexType>
</xs:element>

Example
In rwserver.conf, the proxyInfo element may be specified as shown in this
example:

<proxyInfo>
<proxyServers>
<proxyServer name="www-proxy.us.oracle.com" port="80" protocol="all"/>
</proxyServers>
<bypassProxy>
<domain>localhost</domain>
<domain>127.0.0.1</domain>
</bypassProxy>
</proxyInfo>

Required/Optional
Optional.

Description

Element specifying proxy servers used by reports and the bypass hosts for which
proxy should not be used.

The proxyInfo element has no attributes. It includes two sub-elements:
m proxyServers: see Section 8.2.1.27, "proxyServers"

= bypassProxy: see Section 8.2.1.26, "bypassProxy"

8.2.1.29 webLayout

The webLayout element is defined in rwserverconf . xsd as follows:

<xs:element name="webLayout">
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<xs:complexType>
<xs:attribute name="port" type="xs:string"/>
<xs:attribute name="docroot" type="xs:string"/>
</xs:complexType>
</xs:element>

Example

In rwserver . conf, the webLayout element may be specified as shown in this
example:

<webLayout port="8888" docroot="$SDOMAIN_HOME/servers/WLS_REPORTS/tmp/_WL_
user/reports_11.1.1.2.0/slfytf/war"/>

Required/Optional
Optional.

Description
webLayout element is required to run a report to weblayout using Reports Builder.

The webLayout element attributes are described in Table 8-22.

Table 8-22 Attributes of the webLayout Element

Attribute Valid Values Description
port string the OHS main port.
docroot string the location of the web.war where Reports

Application is deployed

8.2.1.30 dbProxyKey

The dbProxyKey element is defined in rwserverconf . xsd as follows:

<xs:element name="dbProxyKey">

<xs:complexType>
<xs:attribute name="name" type="xs:string" use="required"/>
<xs:attribute name="database" type="xs:string" use="required"/>
</xs:complexType>

</xs:element>

Example
In rwserver. conf, the doProxyKey element may be specified as shown in this
example:

<dbProxyConnKeys>
<dbProxyKey name=keyl database=dbl/>
<dbProxyKey name=key2 database=db2/>
</dbroxyConnKeys>

Required/Optional
Optional.

Description

The dbProxyKey consists of the name and database parameters. It is obtained from
the server configuration file based on the database mentioned in the userid
commandline parameter.

The dbProxyKey element attributes are described in Table 8-23.
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Table 8-23 Attributes of the dbProxyKey Element

Attribute Valid Values Description
name string the name of the key.
database string the name of the database.

8.2.1.31 dbProxyConnKeys

The dbProxyConnKeys element is defined in rwserverconf . xsd as follows:

<xs:element name="dbProxyConnKeys">
<xs:complexType>
<Xs:sequence>
<xs:element ref="dbProxyKey" minOccurs="0" maxOccurs="unbounded" />
</xXs:sequence>
</xs:complexType>
</xs:element>

Example

In rwserver. conf, the dbProxyConnKeys element may be specified as shown in
this example:

<dbProxyConnKeys>
<dbProxyKey name=keyl database=dbl/>
<dbProxyKey name=key2 database=db2/>
</dbProxyConnKeys>

Required/Optional
Optional.

Description

The dbProxyConnKeys element has no attributes. It includes the dbProxyKey
sub-element (see Section 8.2.1.30, "dbProxyKey").

8.2.1.32 jobThresholds

The jobThresholds element is defined in rwserverconf .xsd as follows:

<xs:element name="jobThresholds">
<xs:complexType>
<xs:attribute name="longRunning" default="180">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="potentialRunAway" default="180">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>
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Example

In rwserver.conf, the jobThresholds element may be specified as shown in this
example:

<jobThresholds longRunning="180" potentialRunAway="180"/>

Required/Optional
Optional.

Description

jobThreshold consists of two attributes, longRunning and PotentialRunAway. For
more information, See Table 8-24.

Table 8-24 Attributes of the jobThresholds Element

Attribute Valid Values Description

longRunning seconds the cut-off time for a job after which it is
considered a long run job.

a job that takes relatively longer time.

potentialRunAway seconds the cut-off time for a currently running job after
which it is considered as a potential runaway
job.

a job which has relatively lesser chance of
successful completion.

8.2.1.33 server

The server element is defined in rwserverconf . xsd as follows:

<xs:element name="server">
<xs:complexType>

<xSs:sequence>
<xs:element ref="cache" minOccurs="0" maxOccurs="1"/>
<xs:element ref="engine" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="environment" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="security" minOccurs="0" maxOccurs="unbounded" />
<xs:element ref="oidconnection" minOccurs="0" maxOccurs="1"/>
<xs:element ref="destination" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="job" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="notification" minOccurs="0" maxOccurs="unbounded"/>
<xs:element ref="log" minOccurs="0" maxOccurs="1"/>
<xs:element ref="jobStatusRepository" minOccurs="0" maxOccurs="1"/>
<xs:element ref="jobRepository" minOccurs="0" maxOccurs="1"/>
<xs:element ref="trace" minOccurs="0" maxOccurs="1"/-->
<xs:element ref="connection" minOccurs="0" maxOccurs="1"/>
<xs:element ref="ORBPorts" minOccurs="0" maxOccurs="1"/>
<xs:element ref="queue" minOccurs="0" maxOccurs="1"/>
<xs:element ref="folderAccess" minOccurs="0" maxOccurs="1"/>
<xs:element ref="persistFile" minOccurs="0" maxOccurs="1"/>
<xs:element ref="jobRecovery" minOccurs="0" maxOccurs="1"/-->
<xs:element ref="identifier" minOccurs="0" maxOccurs="1"/>
<xs:element ref="proxyInfo" minOccurs="0" maxOccurs="1"/>
<xs:element ref="pluginParam" minOccurs="0" maxOccurs="unbounded" />
<xs:element ref="webLayout" minOccurs="0" maxOccurs="1"/>
<xs:element ref="dbProxyConnKeys" minOccurs="0" maxOccurs="1"/>
<xs:element ref="jobThresholds" minOccurs="0" maxOccurs="1"/>

</Xs:sequence>

<xs:attribute name="version" type="xs:string"/>
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</xs:complexType>
</xs:element>

Example
In rwserver. conf, the server element may be specified as shown in this example:
<server>

one or more element specifications
</server>

Required/Optional

Required. You can have a maximum of one server element in a given configuration
file.

Description

The server element opens and closes the content area of the server configuration file.
In terms of the file's hierarchy, all the other elements are subordinate to the server
element.

The server element attribute is described in Table 8-25.

Table 8-25 Attribute of the server Element

Attribute Valid Values Description

version string the version of the Reports Server

8.2.2 Dynamic Environment Switching

Dynamic environment switching enables you to dynamically change the environment
after Reports Server is started, or for a specific job request. This means that one
instance of Reports Server can serve reports with any arbitrary environment settings,
such as language, currency, and display settings.

To enable dynamic environment switching, you must add an environment element to
your Reports Server configuration file to establish a particular runtime environment.
Once you have an environment element established, you can switch to its settings in
either of the following ways:

s Set the value of the defaul tEnvId attribute of the engine element in the
Reports Server configuration file to the 1d of the environment element, to apply
the environment settings to that engine when it starts up. For more information,
refer to Section 8.2.1.9, "engine".

= Set the value of the ENVID command line keyword to the id of the environment
element, to make the environment settings effective for the current report job
request. For more information, refer to Section A.6.5, "ENVID".

8.2.2.1 Examples

The following examples illustrate the use of dynamic environment switching.

Example 1

Suppose that you want to run reports in Japanese from your Reports Server. An
environment conducive to running reports in Japanese would include:

s NLS_LANG = Japanese_Japan.JAl6SJIS

s The currency unit (NLS_CURRENCY) would be set to Yen (¥), the currency of Japan.
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= If Reports Server is running on UNIX, then DISPLAY must be set.

To begin, you would have to add an environment element to your Reports Server
configuration file that looks something like the following:

<environment id="JP">
<envVariable name="NLS_LANG" value="Japanese_Japan.JA16SJIS"/>
<envVariable name="NLS_CURRENCY" value="¥"/>
<envVariable name="DISPLAY" value="MyServer.MyCompany.com:0.0"/>
</environment>

Once the environment element is in place, you could request a report with Japanese
output in either of the following ways:

n  Use the defaultEnvId attribute of the engine element in the Reports Server
configuration file as follows:

<engine id="rwEng" initEngine="1" minEngine="0" maxEngine="10" engLife="50"
maxIdle="30" defaultEnvId="JP"/>

The value JP identifies the environment element in the Reports Server
configuration file. The initial engines will be spawned with the environment
settings specified in this environment element.

= Set the ENVID command line keyword, as follows:

http://machine_name:port/reports/rwservlet?SERVER=server._name
&REPORT=Japanese.rdf&USERID=username/passwd@db&DESFORMAT=htmlcss
&DESTYPE=cache&ENVID=JP

When the URL is submitted to Reports Server, it detects the optional ENVID
keyword and matches the specified id (in this case, JP) to the corresponding id of
the environment element in its configuration file. If Reports Server already has
an engine running with these characteristics, it will reuse the existing engine to
process the job. If not, then it spawns an engine using the current environment
plus the three environment variables specified in the JP environment element. If
spawning a new engine would cause Reports Server to exceed its maxEngine
setting, Reports Server shuts down an engine before starting a new one. An engine
may be shut down even though it has not exceeded its engLi fe setting. Once
Reports Server has an engine with the correct environment running, the job is
processed by that engine and the output is routed to the specified DESTYPE.

If you do not pass ENVID with the job, Reports Server processes the request using
an engine started with the defaultEnvId environment. If defaultEnvIdis not
specified for the engine element in your Reports Server configuration file, then
the engine will inherit the settings with which the Reports Server instance was
started.

Example 2

The following example illustrates how to use this environment switching feature to
run an Arabic report on the same Reports Server that was used to run the Japanese
report in Example 1.

Add another environment element to the Reports Server configuration file as shown
below:

<environment id="AR">

<envVariable name="NLS_LANG" value="Arabic_United Arab Emirates.AR8IS08859P6"/>
<envVariable name="NLS_CALENDAR" value="Arabic Hijrah "/>

</environment>
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The Arabic report has to be submitted to Reports Server with the following command
line:

http://machine_name:port/reports/rwservlet ?SERVER=server_name
&REPORT=arabic.rdf&USERID=username/passwd@db&DESFORMAT=htmlcss
&DESTYPE=cache&ENVID=AR

Since the job is submitted with ENVID=AR, Reports Server finds or starts an engine
with the environment specified by element AR in the Reports Server configuration file.
The job is processed by the new engine and the output is distributed to the specified
destination.

Example 3

The following example illustrates how the environment switching feature could be
used in conjunction with a JSP report; that is, without Oracle Reports Servlet
(rwservlet).

Suppose that you have the following environment elements in the Reports Server
configuration file:

<environment id="UK">
<envVariable name="NLS_LANG" value="AMERICAN_UNITED KINGDOM.WE8ISO8859P1"/>
</environment>

<environment id="US">
<envVariable name="NLS_LANG" value="AMERICAN AMERICA.WE8ISO8859P1"/>
</environment>

If your JSP report uses a format mask such as the following, it means the currency,
grouping, and decimal symbols can change according to the environment:

<rw:field id="sal" src="sal" formatMask="1.999G999D999"/>

To run the report using the UK symbols for currency, grouping, and decimal, you
would use the following URL:

http://myserver:port/test/myjsp?USERID=scott/tiger@orcl&ENVID=UK

Note: You could place ENVID=UX into a key in the cgicmd. dat key map file (for
more information, see Section 18.13, "Using a Key Map File").

8.2.2.2 Usage Notes

= Although this feature is ideal for handling reports of various languages, its
application can be much broader. You could use it in any situation where a report
requires a particular environment to execute correctly.

»  Reports Server will start one or more engines per environment id as and when it
gets requests for specific environments. The total number of engines, however,
cannot exceed the maxEngine specified for that engine type. It is recommended
that you set maxEngine to a value greater or equal to the number of environment
elements specified in the Reports Server configuration file.

s defaultEnvId can also be applied to pluggable engines other than rwEng.
Reports Server will spawn the pluggable engine with the specified environment
id.

= For engines used by the in-process Reports Server, the order of precedence for
environment variables from highest to lowest is as follows:

s reports.sh (UNIX only)
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Note: If you have modified your current reports. sh file, you
should save it and, after installing Oracle Reports, merge your
modifications into the version of reports. sh installed with the
latest version. The latest reports. sh contains some required
changes.

= environment element in the Reports Server configuration file

= Go to the WebLogic Administration Console, navigate to the Server Start tab
and specify the oracle.home and oracle. instance parameters.

»  The system settings and registry (Windows only)

= For engines used by the standalone server, the order of precedence for
environment variables from highest to lowest is as follows:

s reports.sh (UNIX only)

Note: If you have modified your current reports. sh file, you
should save it and, after installing Oracle Reports, merge your
modifications into the version of reports . sh installed with the
latest version. The latest reports. sh contains some required
changes.

» environment element in the Reports Server configuration file
= The environment set in the console where you start rwserver. sh
»  The system settings and registry (Windows only)

s If the same environment variable that is set in ENVID is also set in reports.sh
(ORACLE_INSTANCE/config/reports/bin/reports. sh), Reports Server
obtains the environment variable value from reports. sh and not from ENVID.

For example, say you want to set the REPORTS_PATH environment variable to a
different engine by using the environment switching feature. However, the
reports. sh file also has the same REPORTS_ PATH environment variable set.
Reports Server will now use only REPORTS_PATH set by reports. sh and not the
REPORTS_PATH set in ENVID when you pass any request.

To work around this issue, you must:

1. Open reports. sh and comment the environment variable value. For
example, comment the REPORTS_PATH value set in the reports. sh file.

2. Open the rwserver. conf file.

3. Copy the environment variable value in the reports. sh file to the
rwserver . conf file. For example:

<environment id="default">
<envVariable name=REPORTS_PATH value="$SORACLE_
HOME/reports/templates: SORACLE_
HOME/reports/samples/demo: SORACLE_HOME/reports/integ: SORACLE_
HOME/reports/printers"/>

</environment>

<environment id="testenv">

<envVariable name="REPORTS_PATH"
value="/private/file_path:$SORACLE_HOME/reports/templates:SORACLE_
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HOME/reports/samples/demo: SORACLE_HOME/reports/integ: SORACLE_HOME/
reports/printers"/>
</environment>

4. Add the defaultEnvId value to the appropriate tag in the rwserver. conf
file.For example, add the defaultEnvId attribute to the engine element so
that the engine starts with the default REPORTS_PATH.

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"
callbackTimeOut="90000" defaultEnvId="default">

5. Now run the report.

8.3 Oracle Reports Servlet Configuration File

The configuration settings for the Oracle Reports Servlet (rwservlet) component of
Oracle Reports Services are stored in the XML file rwservlet.properties, located
in the directory specified in Table 8-1.

For Windows, note that rwservlet.properties uses double backslashes (\\)
instead of single backslashes to specify a directory path. The first slash "escapes" the
second, which would otherwise have another meaning in this file. For example, in a
Windows-based rwservlet.properties file, the path:

d:\InstanceHome\config\ReportsServerComponent\ServerName\filename.ext

becomes:

d:\\InstanceHome\\config\\ReportsServerComponent\\ServerName\\filename.ext

For UNIX, use that platform's standard for specifying directory paths, for example:

InstanceHome/config/ReportsServerComponent /ServerName/filename.ext

8.3.1 Oracle Reports Servlet Configuration Elements

The rwservlet.xsd file provides the following data type definitions for configuring
rwservlet.properties elements:

s rwservlet
- server
- singlesignon
— inprocess
- reports_servermap
— cookie
— defaultcharset
— webcommandaccess
- allowhtmltags
- helpurl
- imageurl
- reloadkeymap
— dbauth
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sysauth

diagtags

cluster

errortemplate

oidconnection
allowauthid

enabledbproxy

These elements along with their related attributes and sub-elements are discussed in
the following subsections.

Note that these are XML elements, and XML is case-sensitive. Additionally, when you
add any of these elements to the rwservlet.properties configuration file, you
must follow the order of elements as described in rwservlet.xsd.

8.3.1.1 rwservlet

The rwservlet element is defined in rwservlet .xsd as follows:

<xs:element name="rwservlet">

<xs:complexType>

<XS:sequence>
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
<xs:element
<xs:element
<xs:element
maxOccurs="1"/>
<xs:element
maxOccurs="1"/>

</Xs:sequence>

name="server" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="singlesignon" type="xs:string" minOccurs="0"

name="inprocess" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="reports_servermap" type="xs:string" minOccurs="0"

ref="cookie" minOccurs="0" maxOccurs="1"/>
name="defaultcharset" type="xs:string" minOccurs="0"

ref="webcommandaccess" minOccurs="0" maxOccurs="unbounded" />
name="allowhtmltags" type="xs:string" minOccurs="0"

name="helpurl" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="imageurl" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="reloadkeymap" type="xs:string" minOccurs="0"

name="dbauth" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="sysauth" type="xs:string" minOccurs="0" maxOccurs="1"/>
name="errortemplate" type="xs:string" minOccurs="0"

ref="diagtags" minOccurs="0" maxOccurs="1"/>
ref="cluster" minOccurs="0" maxOccurs="1"/>
ref="oidconnection" minOccurs="0" maxOccurs="1"/>
name="allowauthid" type="xs:string" minOccurs="0"

name="enabledbproxy" type="xs:string" minOccurs="0"

</xs:complexType>

</xs:element>

Example

In rwservlet.properties, the rwservlet element may be specified as shown in

this example:
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<rwservlet>
one or more element specifications
</rwservlet>

Required/Optional

Required. You can have a maximum of one rwservlet element in a given
configuration file.

Description

The rwservlet element opens and closes the content area of the Oracle Reports
Servlet (rwservlet) configuration file. In terms of the file's hierarchy, all the other
elements are subordinate to the rwservlet element.

The rwservlet element includes the following sub-elements in its definition:
= server

= singlesignon

= inprocess

= reports_servermap

= cookie

s  defaultcharset

= webcommandaccess
= allowhtmltags

= helpurl

= imageurl

= reloadkeymap

= dbauth

= sysauth

= errortemplate

= diagtags

m cluster

= oidconnection

= enabledbproxy

8.3.1.1.1 server
The server sub-element of rwservlet is defined in rwservlet .xsd as follows:

<xs:element name="server" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the server element may be specified as shown in this
example:

<server>myserver</server>
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Description

The server element specifies the name of the in-process server. If a Reports Server
name is not specified, for example, in the runtime URL, rwservlet starts the
in-process server (if not started already) with the name specified by the server
element, and submits the job to it.

If the server element is not specified, the default in-process server name is: rep_
hostname.

When the inprocess element specifies no, rwservlet tries to bind to an external
server with the name specified by the server element.
8.3.1.1.2 singlesignon

The singlesignon sub-element of rwservlet is defined in rwservlet.xsd as
follows:

<xs:element name="singlesignon" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the singlesignon element may be specified as shown
in this example:

<singlesignon>yes</singlesignon>

Description

The singlesignon element specifies whether or not OracleAS Single Sign-On is
enabled:

»  yes (default): OracleAS Single Sign-On is enabled.

= no: OracleAS Single Sign-On is not enabled.

For more information about OracleAS Single Sign-On, refer to Chapter 17,
"Configuring and Administering OracleAS Single Sign-On".

8.3.1.1.3 inprocess

The inprocess sub-element of rwservlet is defined in rwservlet.xsd as
follows:

<xs:element name="inprocess" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the inprocess element may be specified as shown in
this example:

<inprocess>yes</inprocess>

Description

The inprocess element specifies whether or not to run Reports Server within the
same process as Oracle Reports Servlet (rwservlet):

= yes (default): Reports Server run within the same process as Oracle Reports
Servlet (rwservlet).

= no: Reports Server does not within the same process as Oracle Reports Servlet
(rwservlet).
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Note: The pros and cons of running an in-process server are
explored in Chapter 2, "Understanding the Oracle Reports Services
Architecture".

For troubleshooting printing and font issues when using the in-process server, see
Section D.1.10, "Printing and Font Errors When Using In-process Reports Server".

8.3.1.1.4 reports_servermap

The reports_servermap sub-element of rwservlet is defined in rwservlet.xsd
as follows:

<xs:element name="reports_servermap" type="xs:string" minOccurs="0"
maxOccurs="1"/>

Example

In rwservlet.properties, the reports_servermap element may be specified as
shown in this example:

<reports_servermap>
dev_cluster:dev_server;prd _cluster:prd_server;ga_cluster:ga_server
</reports_servermap>

Description

In Oracle Reports 11¢ Release 1 (11.1.1), Reports Server clustering was deprecated. An
Oracle Forms Services application from prior releases that includes a Reports Server
cluster name will fail to bind to the Reports Server cluster it references.

To resolve this issue, the reports_servermap element maps a cluster name to a
Reports Server name. This avoids the necessity to change the cluster name in all Oracle
Forms Services applications.

An Oracle Forms Services application can call Oracle Reports in the following ways:

» Using RUN_REPORT_OBJECT. If the call specifies a Reports Server cluster name
instead of a Reports Server name, the REPORTS_SERVERMAP environment
variable must be set in the Oracle Forms Services default . env file.

If your Oracle Forms Services application uses multiple Reports Server cluster
names, you can map each of those cluster names to a different Reports Server
using REPORTS_SERVERMAP, as follows:

REPORTS_SERVERMAP=clusterl:repserverl;cluster2:repserver2;cluster3:repserver3

For example, if your Oracle Forms Services application includes 3 clusters with
names dev_cluster, prd_cluster, and ga_cluster in 10g Release 1 (9.0.4),
you can map these cluster names to respective server names in later releases, as
follows:

REPORTS_SERVERMAP=dev_cluster:dev_server;prd_cluster:prd_server;ga_cluster:qga_
server

For more information, see the Oracle Fusion Middleware Forms Services Deployment
Guide.

s Using WEB. SHOW_DOCUMENT. In this case, the request is submitted to rwservlet.
If the call specifies a Reports Server cluster name instead of a Reports Server name,
the reports_servermap element must be set in the rwservlet.properties
file. For example:
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<reports_servermap>
cluster:repserver
</reports_servermap>

where

cluster is the Reports Server cluster name that was present in prior releases
(Oracle Reports 97 and 10g Release 1 (9.0.4)).

repserver is the Reports Server name in later releases.

When reports_servermap is set in rwservlet.properties, any request to
cluster in the Oracle Forms Services application is redirected to repserver.

8.3.1.1.5 cookie
The cookie element is defined in rwservlet .xsd as follows:

<xs:element name="cookie">
<xs:complexType>
<xs:attribute name="cookieexpire" use="required" type="xs:integer"/>
<xs:attribute name="encryptionkey" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Example
In rwservlet.properties, the cookie element may be specified as shown in this
example:

<cookie cookieexpire="30" encryptionkey="reports"/>

Required/Optional
Optional.

Description

The cookie element specifies an expiration time and encryption key for cookies,
which save encrypted user names and passwords on the client-side when users first
authenticate themselves. When the server receives a cookie from the client, the server
compares the time saved in the cookie with the current system time. If the time
difference is longer than the number of minutes defined in cookieexpire, the server
rejects the cookie and returns to the client the authentication form along with an error
message. Users must re-authenticate to run the report.

The cookie element attributes are described in Table 8-26.

Table 8-26 Attributes of the cookie Element

Attribute Valid Values Description

cookieexpire Integer Default: 30

The lifetime (in minutes) of the database and system
authentication cookie.

encryptionkey  any character The encryption key to be used to encrypt the user name
string and password of the database and system
authentication cookies.

8.3.1.1.6 defaultcharset

The defaultcharset sub-element of rwservlet is defined in rwservlet.xsd as
follows:
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<xs:element name="defaultcharset" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example
In rwservlet.properties, the defaultcharset property may be specified as
shown in this example:

<defaultcharset>JA16EUC</defaultcharset>

Description

The defaultcharset element specifies the character encoding for decoding
non-ASCII escaped characters in the request URL or non-ASCII characters in the
Parameter Form input. This ensures that rwservlet uses the required encoding when
decoding the parameter name and value.

You can set the defaultcharset element to either:
»  The database's NLS_CHARACTERSET (for example, JA16EUC).
s The IANA-defined character set (for example, EUC-JP).

Note: To use non-ASCII characters in user parameter names and
values when using the Event-Driven Publishing API, you must ensure
that the defaultcharset element in the rwservlet .properties
file matches the value of the DEFAULTCHARSET parameter in your
parameter list. For more information, see Section 21.1.3, "Including
non-ASCII Characters in Parameter Names and Values".

8.3.1.1.7 webcommandaccess
The webcommandaccess element is defined in rwservlet .xsd as follows:

<xs:element name="webcommandaccess">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="L0"/>
<xs:enumeration value="L1"/>
<xs:enumeration value="L2"/>
<xs:enumeration value="NO"/>
<xs:enumeration value="YES"/>
</xs:restriction>
</xs:simpleType>
</xs:element>

Example
In rwservlet.properties, the webcommandaccess property may be specified as
shown in this example:

<webcommandaccess>L1</webcommandaccess>

Description

The webcommandaccess element specifies access permission for rwservlet
keywords (Web commands) for a non-secure server.

Note: For secure Reports Server, Reports Server verifies the user's
privileges based on the entries in Oracle Internet Directory.
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Valid settings are:
s LO0:no Web commands allowed.

= L1:only end user Web commands allowed (GETJOBID, KILLJOBID,
SHOWAUTH, SHOW]JOBID).

s L2:administrator Web commands (DELAUTH, GETSERVERINFO, KILLENGINE,
PARSEQUERY, SHOWENYV, SHOWJOBS, SHOWMAP, SHOWMYJOBS) are also
allowed. AUTHID is required to run administrator commands.

= NO: for backward compatibility with DIAGNOSTIC=NO in 10g
(rwservlet.properties).

= YES: for backward compatibility with DIAGNOSTIC=YES in 10g
(rwservlet.properties).

For L2 Web command access, you do not need to pass the authid. The authid
parameter is required only for the STOPSERVER command irrespective of the
webcommandaccess value.

8.3.1.1.8 allowhtmltags

The allowhtmltags sub-element of rwservlet is defined in rwservlet.xsd as
follows:

<xs:element name="allowhtmltags" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the allowhtmltags element may be specified as
shown in this example:

<allowhtmltags>yes</allowhtmltags>

Description

The allowhtmltags element specifies whether or not to allow HTML code to be
entered in the URL when running a report:

s no (default): HTML code in the URL is disallowed.
s ves: HTML code in the URL is allowed.

Note: Any HTML code included as part of a report request URL
might lead to a security compromise as it causes certain browsers to
execute any script or code in the URL.

8.3.1.1.9 helpurl
The helpurl sub-element of rwservlet is defined in rwservlet.xsd as follows:

<xs:element name="helpurl" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the helpurl element may be specified as shown in this
example:

<helpurl>http://myserver/help_file/help_topic.htm</helpurl>
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Description
The helpurl element specifies the name of a help file to be used instead of the default
(ORACLE_HOME\reports\templates\help.htm).

The rwservlet HELP keyword (Web command) displays either the default help file,
or the help file specified by the helpurl element.

Note: For more about the HELP keyword, see Section A.6.12,
"HELP".

8.3.1.1.10 imageurl
The imageurl sub-element of rwservlet is defined in rwservlet .xsd as follows:

<xs:element name="imageurl" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the imageurl property may be specified as shown in
this example:

<imageurl>http://machine_name:port/reports/rwservlet</imageurl>

Description

The imageurl element specifies the location of reports' dynamically generated
images.

This element applies to JSPs that do not run through Oracle Reports Servlet
(rwservlet). It ensures that dynamically generated images, such as charts, will be
viewable only by the person who runs the report. JSPs, and other report types, that run
through rwservlet automatically have this protection.

8.3.1.1.11 reloadkeymap

The reloadkeymap sub-element of rwservlet is defined in rwservlet.xsd as
follows:

<xs:element name="reloadkeymap" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the reloadkeymap element may be specified as shown
in this example:

<reloadkeymap>yes</reloadkeymap>

Description

The reloadkeymap element specifies whether the key map file (cgicmd. dat) should
be reloaded each time rwservlet receives a request:

= no (default): Key map file is not reloaded when rwservlet receives a request.
s yes: Keymap file is reloaded when rwservlet receives a request.

This is useful if you frequently make changes to the map file and want the process of
loading your changes to be automatic. Runtime performance will be affected according
to how long it takes to reload the file.

Typically, this element specifies no in a production environment and yes in a testing
environment.
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8.3.1.1.12 dbauth

dbauth is the html template used to enter the database information. If the user does
not enter the database information while giving reports request, the reports servlet
challenges the user to enter the db info in the HTML template.

The dbauth sub-element of rwservlet is defined in rwservlet .xsd as follows:

<xs:element name="dbauth" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the dbauth element may be specified as shown in this
example:

<dbauth>rwdbauth.htm</dbauth>
It is not necessary to enter the path to a template when it is stored in the default
template directory:

ORACLE_HOME\reports\templates

Description

The dbauth element specifies the location and filename of the HTML templates, if you
wish to customize the login dialog boxes with your company logo, linked buttons, or
any other HTML you care to use. By default, the file name is rwdbauth.htm.

8.3.1.1.13 sysauth
sysauth is the HTML template used to enter the authentication information.

The sysauth sub-element of rwservlet is defined in rwservlet.xsd as follows:

<xs:element name="sysauth" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the sysauth element may be specified as shown in this
example:

<sysauth>rwsysauth.htm</sysauth>
It is not necessary to enter the path to a template when it is stored in the default
template directory:

ORACLE_HOME\reports\templates

Description

The sysauth element specifies the location and filename of the HTML templates, if
you wish to customize login dialog boxes for a secure report with your company logo,
linked buttons, or any other HTML you care to use. By default, the file name is
rwsysauth.htm.

8.3.1.1.14 errortemplate

The errortemplate sub-element of rwservlet is defined in rwservlet.xsd as
follows:

<xs:element name="errortemplate" type="xs:string" minOccurs="0" maxOccurs="1"/>

Example

In rwservlet.properties, the errortemplate element may be specified as
shown in this example:

<errortemplate>rwerror.htm</errortemplate>
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It is not necessary to enter the path to the error message template when it is stored in
the default template directory:

ORACLE_HOME\reports\templates

Description

The errortemplate element specifies the name and location of your error message
template. By default, the file name is rwerror.htm.

The error message template provides the visual setting within which the error message
is displayed. You may wish to customize the appearance of error messages, for
example with your company logo, or with an icon you plan to associate with errors.
You may wish to add buttons that link your users to a help system, your company
home page, or back to the last browser window. You can do this by using the
errortemplate element to specify your own HTML framework for automatically
generated error messages.

The character set of the default error message template (rwerror.htm) is
is0-8859-1 to ensure consistency across all platforms.

8.3.1.1.15 diagtags
The diagtags element is defined in rwservlet .xsd as follows:

<xs:element name="diagtags">
<xs:complexType>
<xs:attribute name="diagbodytags" use="required" type="xs:string"/>
<xs:attribute name="diagheadtags" use="required" type="xs:string"/>
</xs:complexType>
</xs:element>

Required/Optional
Optional.

Description

The diagtags element specifies additional HTML encoding in the <body> and
<head> tags in the output files associated with diagnostic and debugging output. You
can use these to include formatting options to make diagnostic and debugging output
easier to read.

The diagtags element attributes are described in Table 8-27.

Table 8-27 Attributes of the diagtags Element

Attribute Valid Values Description

diagbodytags HTML code for HTML code to add between the <body> and </body>
<body> tag tags.

diagheadtags HTML code for HTML code to add between the <head> and </head>
<head> tag tags.

8.3.1.1.16 __ cluster

Note: For information about Oracle Fusion Middleware-level
techniques for high availability, refer to Section 2.5, "Setting Up a
High Availability Environment".

8.3.1.1.17 oidconnection
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The oidconnection element is defined in rwservlet .xsd as follows:

<xs:element name="oidconnection">
<xs:complexType>
<xs:attribute name="oidcon_appentity" use="required" type="xs:string"/>
<xs:attribute name="oidcon_passwdkey" use="required" type="xs:string"/>
<xs:attribute name="oidcon_url" use="required" type="xs:string"/>
<xs:attribute name="oidcon_init" type="xs:integer"/>
<xs:attribute name="oidcon_increment" type="xs:integer"/>
<xs:attribute name="oidcon_timeout">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

In rwservlet.properties, the oldconnection element may be specified as
shown in this example:

<oidconnection>
0id_appentity="reportsapp.idc.oracle.com>
oidcon_init="10"
oidcon_increment="10"
oidcon_timeout="1">

</oidconnection>

Description
The oidconnection element specifies Oracle Internet Directory for rwservlet.

For Reports Server, you can specify Oracle Internet Directory connection pooling
parameters using the oidconnection element in the server configuration file, as
described in Section 8.2.1.16, "oidconnection".

The oidconnection element attributes are described in Table 8-28.

Table 8-28 Attributes of the oidconnection Element

Attribute Valid Values Description

oidcon_appentity N/A Default: Set at install time

Oracle Internet Directory App entity created at
install time for internal use of Reports.

oidcon_passwdkey N/A Default: Set at install time

Random password key created to connect to
Oracle Internet Directory for internal use of
Reports.

oidcon_url N/A Default: Set at install time

Oracle Internet Directory Url to connect to oid
oidcon_init number Default: 10

Initial number of Oracle Internet Directory
connections to be created when rwservlet is
initialized.
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Table 8-28 (Cont.) Attributes of the oidconnection Element

Attribute Valid Values Description

oidcon_increment  number Default: 10

Number of connections to be incremented when all
connections are used up.

oidcon_timeout number Default: 0 (no timeout)

Time in seconds for which a connection can be
idle.

8.3.1.1.18 allowauthid
The allowauthid sub-element of rwservlet is defined in rwservlet.xsd as follows:

<xs:element name="allowauthid" type="xs:string" minOccurs="0" maxOccurs="1"/>

Description

allowauthid is the element to be added in rwservlet.properties either to enable or
disable passing of the authid through an URL.

Example

In rwservlet.properties, the allowauthid element may be specified as shown
in this example:

<allowauthid> yes </allowauthid>

Required/Optional
Optional.

Default
By default the allowauthid is set to Yes. If the authid is set to No, authorization

through an URL is disabled and Single Sign-On should be used to enter the username
and password.

8.3.1.1.19 enabledbproxy

The enabledbproxy sub-element of rwservlet is defined in rwservlet.xsd as follows:

<xs:element name="enabledbproxy" type="xs:string" minOccurs="0" maxOccurs="1"/>

Description

enabledbproxy is the element to be added in the rwservlet .properties file to
make the dbproxy feature work through the rwservlet.

Example

In rwservlet.properties, the enabledbproxy element may be specified as
shown in this example:

<enabledbproxy> yes </enabledbproxy>

Required/Optional
Optional.
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Default
By default, the enabledbproxy is set to Yes.

8.3.2 Specifying an Alternate Oracle Reports Servlet Configuration File

Perform the following steps to specify an alternate Oracle Reports Servlet
Configuration File:

1. Log in to the WebLogic Server Administration Console.

2. Under Domain Structure in the left pane, click Environment. The Summary of
Environment page is displayed.

3. In this page, click Servers. The Summary of Servers page is displayed.

4. From the list of servers, click WLS_REPORTS. The Settings for WLS_ REPORTS
page is displayed.

5. Click the Server Start tab.

6. Add the following entry in the Arguments field:

-DServletPropFile=your_servlet_properties_file

7. Click Save.
8. Restart WLS_REPORTS.

By default, Oracle Reports Servlet (rwservlet) uses the rwservlet.properties
file as the configuration file. If you are running multiple Oracle WebLogic Server
instances with reports installed on the same Oracle Fusion Middleware and wish to
use different configuration files, you can do so by adding the following parameter in
the WLS_REPORTS startup parameter section in the WebLogic Server Administration
Console:

-DServletPropFile=your servlet_properties file

8.4 Oracle Reports Bridge Configuration File

The Oracle Reports Bridge configuration settings for the Reports Server component of
Oracle Reports Services are stored in the XML file rwbridge. conf.

The bridgeconfig.xsd file contains data type definitions for rwbridge.conf
elements and attributes. See Section 8.4.1, "Oracle Reports Bridge Configuration
Elements".

These files are located in the directories specified in Table 8-1.

8.4.1 Oracle Reports Bridge Configuration Elements

The bridgeconfig.xsd contains the data type definitions for the various Oracle
Reports Bridge configuration file (rwbridge.conf) elements and attributes.

The Oracle Reports Bridge acts as a gateway for packets that are broadcast by Reports
Server and Reports Client across Farms. For example, in a sample setup, Oracle
Reports components are installed on different Farms: Oracle Reports Servlet is in Farm
A and Reports Server is in Farm B. To achieve this configuration, the Oracle Reports
Bridge has to be started on each Farm. Bridge configuration will include the host and
port settings. The Oracle Reports Bridge in Farm A will contact the Oracle Reports
Bridge in Farm B through reliable TCP to retrieve the server information on Farm B,
and vice versa. For more information, see Section 2.3.4.1.2, "Server Discovery Across
Subnets".
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To start and stop the Oracle Reports Bridge, refer to Chapter 6, "Starting and Stopping
Oracle Reports Services".

Oracle Reports creates the configuration file rwbridge.conf when the Oracle Reports
Bridge is started for the first time. This file is generated based on the settings in the
rwbridge. template file.

In the configuration file, rwbridge.conf, modify the identifier element to specify
the username/password and set the encrypted attribute to no. This indicates that
the password is not encrypted. This password will be encrypted once the Oracle
Reports Bridge is started.

For example:

<identifier encrypted="no">scott/tiger</identifier>

Usage Notes

» Ifthe identifier elementis commented, then it is possible to stop the Oracle
Reports Bridge without specifying authid.

= Itis not possible to stop the Oracle Reports Bridge remotely.

See Also: Section 8.4.1.2, "identifier"
The bridgecont . xsd file provides the following data type definitions for
configuring rwbridge. conf elements and attributes:
= bridge
s identifier
= remoteBridge

= remoteBridges

Note: The configuration elements described in this section can be
configured in Oracle Enterprise Manager:

= Select Reports > Administration > Bridge Configuration to
display the Reports Bridge Component Configuration page.

8.4.1.1 bridge

The bridge element is defined in bridgeconfig.xsd as follows:

<xs:element name="bridge">
<xs:complexType>
<Xs:sequence>
<xs:element ref="identifier" minOccurs="0" maxOccurs="1"/>
<xs:element ref="remoteBridges" minOccurs="0" maxOccurs="1"/>
</xs:sequence>

<xs:attribute name="version" use="required" type="xs:string"/>

<xs:attribute name="port" default="14011">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="14001"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
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<xs:attribute name="timeout" use="required">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="100"/>
</xs:restriction>
</xs:simpleType>

</xs:attribute>

</xs:complexType>
</xs:element>

Example
<bridge version="11.1.1.1.0" port="14011" timeout="12000">
<!--networkConfig file="rwnetwork.conf" ></networkConfig-->
<l--identifier encrypted="no"
>%USERNAMES /$PASSWORD%</identifier-->
<!--trace traceOpts="trace_all"></trace-->
<!-- Specify one or more remote bridges inside remoteBridges element -->
<!--remoteBridges>
<remoteBridge host="%$HOST%" port="%PORT%"></remoteBridge>
</remoteBridges-->
</bridge>

Required/Optional

Required. You can have a maximum of one open tag and one close tag in the bridge
element in a given configuration file.

Description

The bridge element opens and closes the content area of the bridge configuration file.
In terms of the file's hierarchy, all the other elements are subordinate to the bridge
element.

The bridge element attributes are described in Table 8-29.

Table 8-29 Attributes of the bridge Element

Attributes Valid Values = Description
version 11.1.1.1.0  The bridge version.
port The allotted The port on which
range for the bridge will listen.
Oracle Reports
Bridge
component;
thatis, 14011
t0 14020.
timeout 1000 Value in milliseconds

(ms). The bridge will
wait for this period
for a response from a
remote bridge.
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Note: The default port value for the bridge configuration file is
assigned when you install Oracle Fusion Middleware. The
rwbridge. template file contains this default port, which is used to
generate the configuration file for the bridge. The configuration file
name for a bridge is ORACLE_
INSTANCE/config/ReportsBridgeComponent/<bridge
name>/rwbridge.conf.

If you want to customize the port number for the bridge, you must
specify a valid port range reserved for the Oracle Reports Bridge
bridge (14011 to 14020).

8.4.1.2 identifier

The identifier element is defined in bridgeconfig.xsd as follows:

<xs:element name="identifier">
<xs:complexType mixed="true">
<xs:attribute name="encrypted" default="no">
<xs:simpleType>
<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="yes"/>
<xs:enumeration value="no"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

<identifier
encrypted="yes">fpoiVNFvnlkjRPortn+sneU88=NnN</identifier>

Required / Optional

Optional. If this element is commented, then the Oracle Reports Bridge will not
perform a security check when the bridge shutdown command is issued.

Description
The identifier element ensures that the Oracle Reports Bridge performs a security
check before shutting down.

To set the value of the identifier element:
1. Uncomment the identifier element in the bridge configuration file.

2. Set the value to the administrator username/password, set the attribute
encrypted=no, so that the username/password will be encrypted when the
Oracle Reports Bridge is restarted.

For example:

<identifier encrypted="no">scott/tiger</identifier>

3. Start the Oracle Reports Bridge.

Once this element is set, only the administrator will be able to shut down the bridge by
specifying the username/password in the command line.
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See Also: Section 6.2.1, "Starting, Stopping, and Restarting the
Oracle Reports Bridge from the Oracle Process Manager and
Notification Server"

8.4.1.3 remoteBridge

The remoteBridge element is defined in bridgeconfig.xsd as follows:

<xs:element name="remoteBridge">
<xs:complexType>
<xs:attribute name="host" use="required" type="xs:string"/
<xs:attribute name="port" use="required">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="14001"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example
<remoteBridge host="myhost.mydomain.com" port="14022"></remoteBridge>

Required/Optional

Optional. You can have one or more remoteBridge elements in your bridge
configuration file.

Description

The remoteBridge element specifies the host and port on which remote bridges are
running.

Figure 8—1 Oracle Reports Bridge Configuration (Two-Way)

hosti.dom1.com : host2.dom2.com

registerServerRef Zl

0 <. Z
bridge2 J =

‘ getServerRel

W
o

Reports Client s Reports Server
=
~
=
= ==
o runReport ‘ = / executeReport °
Rnpnnnt Server : Reports Client
lioP |
repbrg_bridgel.conf repbrg_bridge?.conf
<bridge version="11.1.11.0"port="14011" <bridge version="11.11.1.0"port="14012"
timeout="2000"> timeout="2000">
<remoteBridges> <remoteBridges>
<remoteBridge host="host2.dom2] com" <remoteBridge host="hostl.doml|com"
port="14012"></remcteBridge> port="14011"></remoteBridge>
—_—
</remofeBridges> </remoteBridges>
</bridge> </bridge>

If you specify the optional remoteBridge element(s) in the repbrg_
bridgename.conf, then the bridge will act as a two-way bridge. That is, the bridge
can get server references from remote bridges.
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Figure 8-2 Oracle Reports Bridge Configuration (One-Way)
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repbrg_bridgel.conf
<bridge version="111.1.1.0" port="14011"
timeout="2000">
<remoteBridgess>
<remoteBridge host="host2.dom?.com"
port="14012"></remoteBridge>

</remof{eBridges>

repbrg_bridgeZ2.conf
<bridge version="11.1.1.1.0" pgrt="14012"
timeout="2000">

<remoteBridges>

</remoteBridges>
</bridge>

</bridge>

If you do not specify the optional remoteBridge element(s) in the repbrg_
bridgename.conf, then the bridge will act as a one-way bridge. That is, the bridge
can only serve remote bridges. It cannot connect to remote bridges to get the server

reference.

The remoteBridge element attributes are described in Table 8-30.

Table 8-30 Attributes of the remoteBridge Element

Attributes Valid Values = Description
host Host name/IP  The host name
address of the  or the IP address
remote bridge. of the machine
where the
remote bridge is
running.
port Port number of The portnumber
the remote of the remote
bridge. bridge element.

8.4.1.4 remoteBridges

The remoteBridges element is defined in bridgeconfig.xsd as follows:

<xs:element name="remoteBridges">

<xs:complexType>
<XS:sequence>

<xs:element ref="remoteBridge" minOccurs="0" maxOccurs="unbounded"/>

</xs:sequence>
</xs:complexType>
</xs:element>

Example

<remoteBridges>

<remoteBridge host="myhost.mydomain.com" port="14022"></remoteBridge>

</remoteBridges>
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Required/Optional

Optional. If this entry is not specified, then this bridge will not contact any remote
bridge to get a Reports Server reference. However, remote bridges can contact this
bridge to get the references of Reports Servers running in this farm.

Description
The remoteBridges element can contain zero or more remoteBridge elements.

8.5 Network Configuration File

The network configuration settings for the Oracle Reports Bridge component of Oracle
Reports Services are stored in the XML file rwnetwork. conft.

The rwnetworkconf . xsd contains data type definitions for rwnetwork. conf
elements and attributes. See Section 8.5.1, "Network Configuration Elements".

These files are located in the directories specified in Table 8-1.

8.5.1 Network Configuration Elements

The rwnetworkconf . xsd file provides the following data type definitions for
configuring rwnetwork. conf elements and attributes:

= discoveryService
= multicast

= namingService

8.5.1.1 discoveryService
The discoveryService element is defined in rwnetwork.xsd as follows:
<xs:element name="discoveryService">
<xXs:complexType>
<xs:choice>
<xs:element ref="multicast"/>
<xs:element ref="namingService"/>
</xs:choice>
</xs:complexType>
</xs:element>

Required/Optional

Required. You can have a maximum of one open tag and one close tag in the
discoveryService element in a given configuration file.

Description

The discoveryService element opens and closes the content area of the network
configuration file. In terms of the file's hierarchy, all the other elements are subordinate
to the discoveryService element.

The discoveryService element has no attributes. It includes two sub-elements:
m multicast: see Section 8.5.1.2, "multicast”

s namingService: see Section 8.5.1.3, "namingService"

8.5.1.2 multicast

The multicast element is defined in rwnetwork.xsd as follows:
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<xs:element name="multicast">
<xs:complexType>
<xs:attribute name="channel" default="228.5.6.7" type="xs:string"/>
<xs:attribute name="port" default="14021">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="timeout" use="required">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="100"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="retry" default="3">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

<multicast channel="228.5.6.7" port="one of the port in alotted AS ports"
timeout="1000" retry="3"/>

Required/Optional

Conditional. The namingService and multicast elements are mutually exclusive;
that is, only one of these elements can be configured at a time.

Description

The multicast element contains the necessary information to identify where Reports
Server is running the built-in broadcast mechanism. By default, multicast is
specified in rwnetwork. cont.

The multicast element attributes are described in Table 8-31.

Table 8-31 Attributes of the multicast Element

Attributes Valid Values Description

channel  Broadcast channel The broadcast channel
used by the Reports
Server.

port Broadcast port The broadcast port used

by the Reports Server.

timeout  Time (inmilliseconds)it The Reports Client will
should wait for wait for the specified
response. The optimum timeout period for a
value for this setting is  response from the Reports
1000. Server.
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Table 8-31 (Cont.) Attributes of themulticast Element

Attributes Valid Values Description

retry Retry count The Reports Client will
retry for the specified
number of times, if there
is no response from the
Reports Server after the
timeout period.

Note: It is strongly recommended that you do not change the default
channel and port unless it is absolutely necessary. The default port
value for rwnetwork. conf is assigned when you install Oracle
Fusion Middleware.

If you want to customize rwnetwork. conf, you must specify a valid
port range reserved for Reports Server (14021 to 14030). If you are
using the Oracle Reports Bridge for discovering Reports Servers
across subnets, you should set the timeout and retry values
carefully for the bridge to function correctly. Refer to Table 8-31 for
setting the timeout value.

8.5.1.3 namingService
The namingService element is defined in rwnetwork.xsd as follows:

<xs:element name="namingService">
<xXs:complexType>
<xs:attribute name="name" use="required" type="xs:string"/>
<xs:attribute name="host" use="required" type="xs:string"/>
<xs:attribute name="port" use="required">
<xs:simpleType>
<xs:restriction base="xs:integer">
<xs:minInclusive value="1"/>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
</xs:element>

Example

<namingService name="Cos" host="mymachine.mydomain.com" port="14021"/>

Required/Optional
Conditional. The namingService and multicast elements are mutually exclusive;
that is, only one of these elements can be configured at a time.

Description

The namingService element contains the necessary information required to be able
to identify the host name and the port where the COS naming service is running.
Specify this element only when the built-in broadcast mechanism is not suitable for
your environment, as in the following scenarios:

= Oracle Reports is installed on a machine that is connected to a network using
VPN.

= You want to avoid broadcast traffic on your network.
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For more information, see Section 2.3.4.2, "Server Discovery Using the COS Naming
Service'".

The namingService element attributes are described in Table 8-32.

Table 8-32 Attributes of the namingService Element

Attributes Valid Values Description

name Cos The descriptive
name of the
naming service.

host Host name/IP  The host name
of the machine
where the
naming service
is running.

port Port number The port number
of the machine
where the
naming service
is running.

8.6 Configuring the URL Engine

Reports Server includes a URL engine that can take the contents of any URL and
distribute them. The URL engine enables you to leverage the powerful scheduling and
distribution capabilities of Reports Server to distribute content from any publicly
available URL to various destinations such as e-mail, Oracle Portal, and WebDAV.
Since Reports Server's destinations are pluggable, you can also add your own custom
destinations for the URL content.

Furthermore, if you use the URL engine in conjunction with Reports Server's
event-based APIs, database events can trigger the content distribution. For example,
suppose you have created a JSP report for high fidelity Web publishing of data stored
in a table containing employee expense data. You could then use the URL engine and
the event-based API to e-mail that JSP whenever the expense application stores new or
updated employee expense data in the table.

If the URL engine is not activated, you can activate it by doing the following:

1. Add an engine element for the URL engine to the server configuration file. For
example, your engine element might be as follows:

<engine id="rwURLEng"
class="oracle.reports.engine.URLEngineImpl"
initEngine="1"
maxEngine="1"
minEngine="0"
engLife="50"
maxIdle="30"
callbackTimeOut="60000"
/>

2. Add ajob element that associates the appropriate job types with the URL engine to
the server configuration file. For example, your job element might be as follows:

<job jobType="rwurl" engineId="rwURLEng"/>

3. Stop and restart Reports Server.
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Note: When you restart your Reports Server with these new
elements, you should see the number of engines increase
accordingly in the Reports Server status message box. In the
preceding example, the number of engines would increase by one
(the value of initEngine) when you restart Reports Server.

To learn about sending requests to the URL engine, refer to Chapter 18, "Running
Report Requests".

8.7 Entering Proxy Information

Some features of Oracle Reports Services support retrieving or sending information
through a firewall. For example, the URL engine, the XML data source, the Text data
source, and the mail destination features all retrieve or send information through the
firewall. For these features to function properly, Reports Server requires certain proxy
information.

In Oracle Reports 11¢ Release 1 (11.1.1), proxy information is stored in the Reports
Server configuration file (rwserver. conf). You can specify proxy information in
either of the following ways:

s Using Oracle Enterprise Manager (recommended)

» Editing the Server Configuration File

8.7.1 Using Oracle Enterprise Manager

To specify proxy information using Oracle Enterprise Manager, refer to Section 7.14,
"Configuring Proxy Information".

8.7.2 Editing the Server Configuration File

To specify proxy information by editing the server configuration file
(rwserver. conf) directly, add the proxyServer element, as described in
Section 8.2.1.24, "proxyServer".

8.8 Configuring Reports Server with the Oracle Process Manager and
Notification Server and Oracle Enterprise Manager

The best way to start, shut down, monitor, and manage Reports Server is through the
Oracle Process Manager and Notification Server (OPMN) and Oracle Enterprise
Manager.

OPMN provides a centralized mechanism for initializing, maintaining, and shutting
down your Oracle Fusion Middleware components, including Reports Server.
Out-of-the-box, Oracle Reports components are managed with OPMN for death
detection and recovery, providing an enhanced health check mechanism in Oracle
Reports 11g Release 1 (11.1.1).

You can conveniently monitor your Reports Servers through Oracle Enterprise
Manager and, if the process fails for any reason, OPMN restarts Reports Server for you
automatically.

During installation of Oracle Fusion Middleware, Reports Servers are automatically
configured in OPMN and registered with Oracle Enterprise Manager.
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8.8.1 opmn.xml

Components are configured with OPMN in the opmn.xml file located in INSTANCE_
HOME/config/OPMN/opmn/opmn.xml This section describes how to configure the
following components through OPMN:

= Module Specification
= Standalone Reports Server Specification
= Oracle Reports Bridge Specification

s COS Naming Service Specification

See Also: For a detailed description of OPMNconfiguration and
the contents of opmn . xm1:

»  Oracle Fusion Middleware Administrator’s Guide

8.8.1.1 Module Specification

The module tag is included by default in opmn.xml and tells OPMN to load a
particular module. In the case of Reports Server, the OracleAS Reports Services
module must be loaded. This module is loaded with the following information, by
default, in opmn . xm1:

<module path="/private/oraclehome/opmn/lib/libopmnreports">
<module-id id="ReportsServices"/>
</module>

8.8.1.2 Standalone Reports Server Specification

In the case of the standalone Reports Server, the Reports Server is running in its own
component. Therefore, you must specify a separate component for Reports Server to
control the server through OPMN. For example:

<ias-component id="<ServerName>">
<process-type id="ReportsServerComponent" module-id="ReportsServices">
<process-set id="<ServerName>" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="<PATH environment variable> "/>
</environment>
<module-data>
<category id="general-parameters">
<data id="batch" value="yes"/>
</category>
<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
</category>
</module-data>
<start timeout="75" retry="2"/>
<stop timeout="120"/>
<restart timeout="75"/>
<ping timeout="30" interval="30"/>
</process-set>
</process-type>
</ias-component>

Note: The timeout values in the preceding example are all in number
of seconds.
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The key segments of this specification for Oracle Reports are described below.

<ias-component id="<RSName>" ...>
This tag specifies the name of Reports Server. It must match the Reports Server
internal name from targets.xml

See Also: Chapter 19, "Managing and Monitoring OracleAS Reports
Services" for more information on targets .xml.

<process-type id="ReportsServer" module-id="ReportsServices">
This tag defines the process for the named Reports Server and associates it with the
OracleAS Reports Services process module.

<process-set id="<RSName>" restart-on-death="true" numprocs="1">

This tag defines the process characteristics for the named Reports Server. It indicates
whether Reports Server should be restarted when it fails. It also specifies the number
of Reports Servers started for this process set, which has to be 1 because the
process-set id identifies a single Reports Server name.

<variable id="PATH" value="your_shell_path"/>

The first tag specifies the value for the PATH environment variable for the process. This
variable must be set for the start script to find uname. This environment element is
not needed on the Microsoft Windows platform.

<category id="general-parameters">

<data id="batch" value="yes"/>

</category>

This group of tags gathers together all of the data (parameters) common to the process.
In this particular example, it provides a way to specify that the BATCH parameter be
sent to Reports Server. batch=yes |no is an option to the start and stop commands of
Reports Server. If it is not configured, this option is not passed in to Reports Server.

<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
</category>

This group of tags indicates the restart parameters category, which defines parameters
to be used in detecting whether the process has failed and needs to be restarted. If a
notification is not received within the specified reverseping-timeout period, then
the process is considered failed and will be restarted.

See Also: For more information on opmn . xml and its contents:

»  Oracle Application Server Administrator’s Guide

8.8.1.3 Oracle Reports Bridge Specification

The Oracle Reports bridge runs within its own component. Therefore, you must
specify a separate ias-component tag for the Oracle Reports bridge to control the
bridge through OPMN.

For troubleshooting scenarios and diagnosis, see Section D.8, "Diagnosing Oracle
Reports Bridge Problems"

The following are examples for a minimum bridge configuration as well as a full
bridge configuration.

Example 8—1 Minimum Configuration for Oracle Reports Bridge

<ias-component id="your_bridge_name" status="enabled" id-matching="false"
xmlns="http://www.oracle.com/ias-instance">
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<process-type id="ReportsBridge" module-id="ReportsBridgeServices">
<process-set id="your_bridge_name" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="your_oracle_home_directory/jdk/jre/bin"
append="true" />
<variable id="PATH" value="your_shell _path" append="true"/>
<variable id="CLASSPATH" value="your_oracle_home_directory/jlib/zrclient.jar"
append="true" />
<variable id="CLASSPATH" value="your_oracle_home_
directory/reports/jlib/rwrun.jar" append="true"/>
</environment>
</process-set>
</process-type>
</ias-component>

Example 8-2 Full Configuration for Oracle Reports Bridge

<ias-component id="your_bridge_name" status="enabled" id-matching="false">
<process-type id="ReportsBridge"module-id="ReportsBridgeServices">
<process-set id="your_bridge_name" restart-on-death="true" numprocs="1">
<environment>
<variable id="PATH" value="your_shell_path" append="true"/>
<variable id="CLASSPATH" value="your_oracle_home_directory/jlib/zrclient.jar"
append="true" />
<variable id="CLASSPATH" value="your_oracle_home_
directory/reports/jlib/rwrun.jar" append="true"/>
</environment>
<module-data>
<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>

</category>
<category id="start-parameters">>
<data id="jvm-options" value="="-Xmsl28mb -Xmx256mb"/>
<data id="bridge-options" value="start_options_if_any"/>
</category>

<category id="stop-parameters">
<data id="jvm-options" value="-Xms128mb -Xmx256mb"/>
<data id="bridge-options" value="stop_options_if_any"/>
</category>
</module-data>
<start timeout="120" retry="3"/>
<stop timeout="120"/>
<restart timeout="120" retry="0"/>
</process-set>
</process-type>
</las-component>

8.8.1.4 COS Naming Service Specification

By default, Oracle Reports uses the built-in broadcast mechanism for Reports Server
discovery. Alternatively, Oracle Reports clients can use the Common Object Service
(COS) naming service for Reports Server discovery to submit report requests when the
built-in broadcast mechanism is not suitable for your environment, as in the following
scenarios:

= Oracle Reports is installed on a machine that is connected to a network using
VPN.

= You want to avoid broadcast traffic on your network.
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For more information, see Section 2.3.4.2, "Server Discovery Using the COS Naming
Service".

To control the COS naming service through OPMN, the opmn.xml file must include a
custom ias-component tag, as follows:

<ias-component id="namingservice">
<process-type id="namingservice" module-id="CUSTOM">
<environment>
<variable id="PATH" value="ORACLE_HOME\jdk\bin"/>
</environment>
<process-set id="namingservice" numprocs="1">
<module-data>
<category id="start-parameters">
<data id="start-executable" value="ORACLE_HOME\jdk\bin\orbd"/>
<data id="start-args" value="-ORBInitialPort port"/>>
</category>
</module-data>
</process-set>
</process-type>
</ias-component>

Where,
ORACLE_HOME is your Oracle Home directory.

port is the port on which you want to start the COS naming service. This port must
be specified in your rwnetwork. conf file as specified in Section 8.5.1.3,
"namingService".

Additionally, to make sure that OPMN starts the COS naming service before it
attempts to start Reports Server, opmn . xm1 must include the following dependency:

<ias-component id="<reports_server_name>" status="enabled" id-matching="false">
<process-type id="ReportsServer" module-id="ReportsServices">

<managed-process ias-component="namingservice" process-type="namingservice"
process-set="namingservice" autostart="true"/>

</process-type>
</ias-component>
To use OPMN to control the COS naming service, perform the following steps:

1. Stop Reports Server and WLS_REPORTS.

2. Edit the opmn.xml file and add an ias-component tag. For example:

<ias-component id="namingservice">
<process-type id="namingservice" module-id="CUSTOM">
<environment>
<variable i1d="PATH" value="G:\FRHome_2\jdk\bin"/>
</environment>
<process-set id="namingservice" numprocs="1">
<module-data>
<category id="start-parameters">
<data id="start-executable" value="G:\FRHome_2\jdk\bin\orbd"/>
<data id="start-args" value="-ORBInitialPort 8988"/>
</category>
</module-data>
</process-set>
</process-type>
</ias-component>
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3. Add a dependency to the Reports Server ias-component tag. For example:

<category id="general-parameters">
<data id="batch" value="vyes"/>
</category>
<category id="restart-parameters">
<data id="reverseping-timeout" value="120"/>
</category>
</module-data>
<dependencies>
<managed-process ias-component="namingservice"
process-type="namingservice" process-set="namingservice"
autostart="true"/>
</dependencies>
<stop timeout="120"/>
<restart timeout="600"/>
<ping timeout="30" interval="30"/>
</process-set>
</process-type>
</ias-component>

Note: In Reports 11g Release 1 (11.1.1), you cannot add a dependency
on WLS_REPORTS because the in-process server and WLS_REPORTS
are not managed by OPMN.

4. Navigate to your ORACLE_INSTANCE/opmn/bin directory.
5. Run one of the following commands:

= If OPMN is up and running, to reload the changes made to the opmn.xml file:
opmnctl reload

= If OPMN is not running: opmnctl start
6. Start the COS naming service using either of the following commands:
opmnctl startproc ias-component=namingservice
or
opmnctl startproc process-type=namingservice

7. Modify the rwunetwork.conf file to use the COS naming service instead of the
default broadcast mechanism, as described in Section 8.5.1.3, "namingService".

8. Start WLS_REPORTS and Reports Servers.
To stop the COS naming service, use the following command:
opmnctl stopproc ias-component=namingservice
To restart the COS naming service, use the following command:
opmnctl restartproc ias-component=namingservice

Troubleshooting: If a COMM_FAILURE error displays when Reports Server is
started, either the naming service is not started properly or the port is not specified
properly. To resolve this error, check whether the naming service process orbd is
running. If not, start it. If the orbd process is running, check the port specified for
namingService in the rwnetwork.conf file. It should be same as the port on
which orbd is started.
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When you execute the command opmnctl stopall, Reports Server may not
stop gracefully, and may be killed by OPMN. This is because OPMN does not
check the dependency while stopping the process. If OPMN stops the COS naming
service before stopping Reports Server, Reports Server will not shut down
gracefully. This is harmless, and can be ignored.

8.8.2 Creating a New Reports Server
You can use the following OPMN commands to create new Reports Server.

ORACLE_INSTANCE/bin/opmnctl createcomponent
-adminUsername weblogic
-adminHost ${ADMIN_HOST}
-adminPort ${ADMIN_PORT}
-oracleHome ${ORACLE_HOME}
-oracleInstance ${ORACLE_INSTANCE}
-instanceName $INSTANCE_NAME
-componentName <servername>
-componentType ReportsServerComponent

For example, to create a new Server named test_server, run the following
commands on the commandline:

ORACLE_INSTANCE/bin/opmnctl createcomponent
-adminUsername weblogic
-adminHost host.domain.com
-adminPort 7001
-oracleHome /path/oracle_home
-oraclelInstance /path/instance_home
-instanceName myinst
-componentName test_server
-componentType ReportsServerComponent

8.8.3 Creating a New Bridge Component Type
You can use the following OPMN commands to create new Bridge Component Type.

ORACLE_INSTANCE/bin/opmnctl createcomponent
-adminUsername weblogic
-adminHost ${ADMIN_HOST}
-adminPort ${ADMIN_PORT}
-oracleHome ${ORACLE_HOME}
-oracleInstance ${ORACLE_INSTANCE}
-instanceName S$INSTANCE NAME
-componentName <Bridgename>
-componentType ReportsBridgeComponent

For example, to create a new Bridge Component Type named test_bridge, run the
following commands on the commandline:

ORACLE_INSTANCE/bin/opmnctl createcomponent
-adminUsername weblogic
-adminHost host.domain.com
-adminPort 7001
-oracleHome /path/oracle_home
-oracleInstance /path/instance_home
-instanceName myinst -componentName test_bridge
-componentType ReportsBridgeComponent
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Note: After running the command the new server / bridge will be
automatically registered with OPMN.

8.9 Overview of SOA Integration

With 11g Release 1 (11.1.1), Oracle Reports is integrated with the Oracle
Service-Oriented Architecture (SOA) suite, which includes Oracle BPEL Process
Manager to automate and monitor reporting requirements.

8.9.1 About BPEL

Business Process Execution Language (BPEL) is the emerging standard for assembling
a set of discrete services into an end-to-end process flow, radically reducing the cost
and complexity of process integration initiatives. Oracle BPEL Process Manager, a key
component of Oracle Fusion Middleware, enables enterprises to orchestrate disparate
applications and web services into business processes. The ability to quickly build and
deploy these processes in a standards-based manner delivers critical functionality for
developing a Service-Oriented Architecture (SOA).

For more information about Oracle BPEL Process Manager, see Oracle Fusion
Middleware Developer’s Guide for Oracle SOA Suite.

Users can submit Oracle Reports jobs from the Oracle BPEL Process Manager business
process, get the status of report execution, and also invoke an Oracle BPEL Process
Manager business process from reports. For example, submit a report request when an
order gets approved.

Using Oracle Reports with Oracle BPEL Process Manager involves the following steps:
= Define a business process by using Oracle JDeveloper.

= Call the Oracle Reports web service to start executing the report at an appropriate
stage in your business process.

= Submit the reports job synchronously or asynchronously.

= Obtain the status of the report job at any time.

8.10 Configuring Oracle Reports to Communicate with Oracle BPEL
Process Manager

Oracle Reports exposes web service named RWWebService. For more information
about this web service, see Chapter 19, "Using the Oracle Reports Web Service". Oracle
Reports web services, which are synchronous in nature, can be used in a BPEL process
as a Partner link.

To invoke an Oracle Reports web service asynchronously in a BPEL process, do the
following:

»  Create an intermediate asynchronous BPEL process that uses the synchronous
Oracle Reports web service and provides an interface to the caller for making a
callback.

= Deploy this intermediate asynchronous BPEL process as a service in the SOA
suite, which can be used as a Partner link.

You can access the WSDL of the Oracle Reports web service at the following location:

http://yourwebserver:port/reports/rwwebservice?
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WSDL contains information about the different ways of invoking RiwWebservice.
You can access the XSD file at the following location:
http://yourwebserver:port/reports/rwwebservice?xsd=1

You can save the XSD file on your local machine and use it when creating a BPEL
process.

8.10.1 Using RWWebservice to Submit Jobs to the Reports Server

To submit jobs to the Oracle Reports server using RWWebService, perform the
following steps:

1.

o g & 0D

10.

11.

12.

13.
14.

Install Oracle JDeveloper. For more information, see Oracle Fusion Middleware
Installation Guide for Oracle [Developer.

Install OracleAS SOA.

Start the SOA suite.

Create a connection from Oracle JDeveloper to the SOA suite.
Create a new application.

Create a new asynchronous BPEL process project and use the
RWWebservice.xsd file to define the input and output parameters of the BPEL
process.

Create a Partner link that refers to the RiwwebService WSDL:

= When prompted by Oracle JDeveloper, click Yes to create Partner link types.
= Select Partner Role.

Create a scope in your process.

Within the scope, create an Invoke activity and use it to invoke the runJob
operation on the RiWWebService Partner link.

Create input and output variables automatically. The input parameter provides
input to the runJob operation of RWWebService, and the output parameter
contains the output of the runJob operation.

Within the scope, before the Invoke activity, create an Assign activity:

= In this Assign activity, map the user input parameters to the parameters that
RWWebService requires.

s Set Param0 = reports job command (string).

= Set Paraml = true (boolean, specifying that the job submission must be
synchronous).

Within the scope, after the Invoke activity, create an Assign activity. In this Assign
activity, map the output variable of the Invoke activity to the result variable that is
written back to the client.

Compile and deploy the BPEL process on the SOA suite.
Use the Oracle BPEL Process Manager console to run the BPEL process.

You can use this BPEL process in another BPEL process and submit jobs to the reports
server asynchronously from a BPEL process.
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Important: For completing steps from 2 to 11 mentioned in
Section 8.10.1, see the following documents:

»  Oracle Fusion Middleware Installation Guide for Oracle SOA Suite
»  Oracle Fusion Middleware Developer’s Guide for Oracle SOA Suite

»  Oracle Fusion Middleware Tutorial for Running Fusion Order Demo for
Oracle SOA Suite

8.10.2 Submitting Jobs to the Reports Server from a BPEL Process Asynchronously

To submit jobs to the Oracle Reports server from a BPEL process asynchronously, do
the following:

1. Create a new asynchronous BPEL process project and use the
RWWebservice.xsd file to define the input and output parameters of the BPEL
process.

2. Create a Partner link that refers to the WSDL of the newly created BPEL process:
= When prompted by Oracle JDeveloper, click Yes to create Partner link types.
»  Select Partner Role.

3. Create a scope in your process.

4. Within the scope, create an Invoke activity and use it to invoke the runJob
operation on the intermediate process Partner link.

5. Create input variables automatically. The input parameter provides input to the
runjob operation of the intermediate BPEL process.

6. Create a Receive activity to receive the callback from the intermediate process.
7. Within the scope, before the Invoke activity, create an Assign activity:

= In this Assign activity, map the user input parameters to the parameters that
the intermediate BPEL process requires.

= Set Param0 = reports job command (string).

»  Set Paraml = true (boolean, specifying that the job submission must be
synchronous).

8. Within the scope, after the Invoke activity, create a Receive activity.

9. Create input variables automatically. The input parameter receives a response
from the runJobresponse operation of the intermediate BPEL process.

10. Within the scope, after the Invoke activity, create an Assign activity. In this Assign
activity, map the input variable of the Receive activity to the result variable that is
written back to the client.

11. Compile and deploy the BPEL process on the SOA suite.
12. Use the Oracle BPEL Process Manager console to run the BPEL process.

8.11 Optimizing the Deployment of Reports

Before you deploy a report on a machine that is either slow or is running on a load,
you may want to configure the following;:
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= Ping timeout (OPMN-side): Ping timeout is the measure that OPMN uses to
determine the time that it must wait for a callback from an standalone Reports
Server before considering it as a timeout.

The default timeout period is 150. This period is calculated from: ping timeout,
ping interval, and number of retries. The default values for these are:

ping timeout = 30 seconds
ping interval = 20 seconds
number of retries = 3

Note: The number of retries isapplicable only when OPMN
successfully connects to Standalone Reports Serverand receives
regular ONS notifications from the process.

Based on these values, there will be three ping attempts with a timeout of 30
seconds each at 20 second intervals. The first ping is done after the specified ping
interval. Thus, from the time the Standalone Reports Server is started by
OPMN, approximately 150 (20 + 3*30 + 2*20) seconds will elapse before the
process is considered unresponsive and restarted. However, if after OPMN
connects to Standalone Reports Server but server is too slow in sending regular
ONS notifications, then the 30 second timeout applies.

You can configure the ping timeout by adding a ping entry with sufficient timeout
configured to the machine's load in following element in opmn . xm1:

<ias-component id="<reports_server_name>">

<restart timeout="720" retry="2" />

<ping timeout="110" interval="30" />

Note: In 11g, Oracle WebLogic Server is not managed by OPMN,
hence there will be no ping or death detection for In-Process Server
running inside WLS_REPORTS.

»  Reports Server start or restart timeout (OPMN . xm1): Start or restart timeout is the
measure that OPMN uses to determine the time that it must wait for Reports
Server process type to start or restart (process-type id="ReportsServer"in
opmn . xml) before considering it as a timeout.

The default timeout period is 600. The default values for these are:

<start timeout="600" retry="2"/>

<restart timeout="600"/>

When running on a loaded machine, an attempt to start all Reports Servers by
OPMN may result in a start timeout for some Reports Servers as some of them
were not able to finish the start up activities completely. Note that Reports Server
also starts the number of engines specified in the initengine property of the
engine element in the rwserver. conf file. Starting up these engine processes
might take some time in loaded machines. In parallel to finetuning the Reports
Server process start or restart property, you must also finetune the
callbackTimeout property in rwserver.conf, as explained in the next bullet
item.
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= Callback timeout (Reports Server-side): Callback timeout is the measure that
Reports Server uses to determine the time that it must wait for a response from the
engine before timing out. You can specify this value in the rwserver . conf file.
This time out period is in milliseconds.

For example:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"
callbackTimeOut="90000">

Note: Increase the callbackTimeOut value when the machine is
very slow.

8.12 Sample system-jazn-data.xml File

The system-jazn-data.xml is an XML file which is configured by the user to use
as an ID store and/or policy store. The file is located in $DOMAIN_
HOME/config/fmwconfig.

Sample system-jazn-data.xml file:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<jazn-data>
<jazn-realm>
<realm>
<name>jazn.com</name>
<users>
<user>
<name>weblogic</name>
<guid>23AAB190021911DDBF86C74F01C202FB</guid>
<credentials>PN0Qr+/dpDRV+jSWP378EdjxWDS0PuAs=</credentials>
</user>
</users>
</realm>
</jazn-realm>
<policy-store>
<applications>
<application>
<name>reports</name>
<app-roles>
<app-role>
<name>rw_administrator</name>
<display-name>Reports Administrator</display-name>

<class>oracle.security.jps.service.policystore.ApplicationRole</class>
<members>
<member>

<class>oracle.security.jps.internal.core.principals.JpsXmlUserImpl</class>
<name>weblogic</name>
</member>
<member>
<class> weblogic.security.principal .WLSUserImpl </class>
<name>weblogic</name>
</member>
</members>
</app-role>
<app-role>
<name>rw_operator</name>
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<display-name>Reports Operator</display-name>

<class>oracle.security.jps.service.policystore.ApplicationRole</class>
</app-role>
<app-role>
<name>rw_monitor</name>
<display-name>Reports Monitor</display-name>

<class>oracle.security.jps.service.policystore.ApplicationRole</class>
</app-role>
</app-roles>
<jazn-policy>
<grant>
<grantee>
<principals>
<principal>

<class>oracle.security.jps.service.policystore.ApplicationRole</class>
<name>rw_administrator</name>
</principal>
</principals>
</grantee>
<permissions>
<permission>
<class>oracle.reports.server.ReportsPermission</class>
<name>report=* server=* destype=* desformat=*
allowcustomargs=true</name>
<actions>*</actions>
</permission>
<permission>
<class>oracle.reports.server.WebCommandPermission</class>
<name>webcommands=* server=*</name>
<actions>execute</actions>
</permission>
</permissions>
</grant>
<grant>
<grantee>
<principals>
<principal>

<class>oracle.security.jps.service.policystore.ApplicationRole</class>
<name>RW_BASIC_USER</name>
</principal>
</principals>
</grantee>
<permissions>
<permission>
<class>oracle.reports.server.ReportsPermission</class>
<name>report=test.rdf server=* destype=* desformat=*
allowcustomargs=true</name>
<actions>*</actions>
</permission>
<permission>
<class>oracle.reports.server.WebCommandPermission</class>
<name>webcommands=showmyjobs, getjobid, showjobid server=*</name>
<actions>execute</actions>
</permission>
</permissions>
</grant>
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</jazn-policy>
</application>
</applications>
</policy-store>

8.13 Configuring Reports Managed Server
By default, the Oracle Reports application is deployed on a Managed Server.

You can modify the start-up properties of a Reports Managed Server through the
SetDomainEnv. sh file or the WebLogic Server Administration Console. However,
some properties like -Xmx and -Xms, which are already defined in the
setDomainEnv. sh file would take precedence and the changes made through the
WebLogic Server Administration Console do not take effect. Also, the start-up
properties of WLS_REPORTS that are modified using the WebLogic Server
Administration Console do not take effect when WLS_REPORTS is started using
startManagedServer. sh. Hence it is recommended that you use

SetDomainEnv. sh (for UNIX) or SetDomainEnv.bat (for Windows) to modify the
start-up properties for Managed Servers.

You can modify the system or runtime properties for a Managed Server using the
SetDomainEnv. sh (for UNIX) or SetDomainEnv.bat (for Windows) which is
located in $DOMAIN_HOME/bin.

You can modify the runtime properties using the EXTRA_JAVA_PROPERTIES variable
inside the [ "${SERVER_NAME}" = "WLS_REPORTS" ] block.

You must add any new environment variable for WLS_REPORTS Managed Server
inside the if[ "${SERVER _NAME}" = "WLS_REPORTS" ] block in the
SetDomainEnv . sh script.

As the default setting is done for all components that use setDomainEnv. sh, the
-Xmx and -Xms settings are added multiple times to the command line of a
Managed Server. Hence you must add the -Xmx and -Xms settings at the end of
EXTRA_JAVA_PROPERTIES variable in the [ "${SERVER_NAME}" = "WLS_
REPORTS" ] block.

For example, consider the following snippet:

if [ "${SERVER_NAME}" = "WLS_REPORTS" ] ; then
EXTRA_JAVA_PROPERTIES="-Xms256m Xmx512m ... -Doracle.home=/fmwhome/asl ...
${EXTRA_JAVA_ PROPERTIES}"

If you want to add the -Djobid=random property and change the -Xmx and -Xms
settings for WLS_REPORTS to 512m and 1024m, you must modify the snippet as

follows:
if [ "${SERVER_NAME}" = "WLS_REPORTS" ] ; then
EXTRA_JAVA_PROPERTIES=" -Doracle.home=/fmwhome/asl ... ${EXTRA_JAVA_

PROPERTIES} -Xms512m -Xmx1024m -Djobid=random"

Note: WLS_REPORTS is the name of the Managed Server where the
Reports application is deployed during installation. For expand
cluster cases, Managed Servers can be named as WLS_REPORTS]1,
WLS_REPORTS2, and so on.
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Managing Runtime Behavior

Part III contains information that will help you to manage the runtime behavior of
Oracle Reports:

Chapter 9, "Managing Fonts in Oracle Reports"

Chapter 10, "Printing on UNIX with Oracle Reports"

Chapter 11, "Using PDF in Oracle Reports"

Chapter 12, "Font Model and Cross-Platform Deployment"

Chapter 13, "Configuring Destinations for Oracle Reports Services"
Chapter 14, "Configuring and Using the Pluggable Data sources"
Chapter 15, "Securing Oracle Reports Services"

Chapter 17, "Configuring and Administering OracleAS Single Sign-On"
Chapter 16, "Deploying Reports in Oracle Portal"
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Managing Fonts in Oracle Reports

This chapter provides information about fonts in Oracle Reports:
= Using Fonts

= Adding Fonts

= Font Configuration Files

= Font Aliasing

= Font Types

=  Verifying Report Output on Different Platforms

= Running a Unicode Report using TTF/TTC Fonts

s Diagnosing Font Issues

= Troubleshooting Font Issues

9.1 Using Fonts
In Oracle Reports, fonts come into play in several areas:
= Fonts in Oracle Reports Builder (at build time)
= Fonts in Report Output (at runtime)

s Fonts in the User Interface

9.1.1 Fonts in Oracle Reports Builder

Oracle Reports Builder provides a list of fonts that are available on the system in the
font picker box.

Figure 9—1 Font list in Oracle Reports Builder

T Courier New Mwestemn) :j |1 1] ;!

On Windows, the font list is derived from the fonts that are installed on the system
along with the fonts available on the current default printer. A small printer icon
before the font name identifies printer fonts. True Type fonts are associated with a TTF
icon.

On UNIX, the font list is derived by querying the X-server display on which the
application is running for the available fonts. The command is similar to the UNIX
x1lsfonts command, which lists all of the available fonts for the X-server display.
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From this font list, Oracle Reports Builder generates a list of usable fonts with the valid
style, weight, width, size, and encoding characteristics to match the character set. The
character set is driven by the NLS_LANG environment variable. Oracle Reports Builder
includes only those fonts with an encoding of 1s08859-1, unless specified differently
in the toolkit resource file, Tk2Mot1i £ * fontMapCs. For more information on
Tk2Motif*fontMapCs, refer to Section 9.3, "Font Configuration Files".

9.1.2 Fonts in Report Output

During report formatting, fonts associated with the layout objects are first checked
against the font alias file, ui font .ali, (refer to Section 9.3, "Font Configuration
Files"). If an entry in the font alias file is found, the mapped font is used instead of the
original one. The mapped font is then searched for in the list of fonts available on the
system or printer. If a particular font is not found, Oracle Reports will look for the
nearest matching font under the same character set which can be used instead.

With the new font model supported on UNIX in 11g Release 1 (11.1.1), report output is
in most cases the same on UNIX as on Windows, allowing for simplified
cross-platform deployment. Oracle Reports reads the font metrics from the
appropriate TTF files from the font directory to correctly format the report output.
This eliminates the issue of text misalignment due to font metrics mismatches. Fonts
for which TTF files are available are found automatically. Note that if a TTF font file is
not found, then the font lookup mechanism reverts to the pre-11g implementation.
With the new font model, there is no change in the builder. The Font Model does a role
only during the runtime and not at the design time.

9.1.2.1 Font lookup

On Windows, the font lookup mechanism is simple due to the availability of printer
drivers, which have the capability of uploading fonts from the system as needed. Any
output from Oracle Reports running on Windows will contain fonts from either one of
the following:

s The system
s The printer

For this reason, Oracle Reports considers both the printer and the system fonts when
looking for the available fonts.

On UNIX, the fonts available for generating output are either one of the following:

= the fonts available on the printer, specifically the fonts defined in the PPD or TFM
files

= if no printer is specified, the fonts available in ScreenPrinter,
screenprinter.ppd.

s the TTF font used in the layout objects is used to calculate metrics, which prevents
misalignment in the multibyte language report output.

See Also:
= Section 9.3, "Font Configuration Files"
m  Section 10.8.1, "ScreenPrinter"

= Section 12.2.1, "Font Lookup"
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9.1.3 Fonts in the User Interface

Text in the user interface of Oracle Reports Builder, like the window title, menu items,
message boxes, and data model object names, use fonts taken from the system
resource files for the current language. These system resource files are supplied with
Oracle Reports installation. In Oracle Reports, you can map these fonts in the
[rwbuilder] section of uifont.ali. If found, the mapped font is used instead of the
original font. Otherwise, Oracle Reports uses the original font.

On UNIX, these fonts are defined in Tk2Motif.rgb under Tk2Motif*fontList. If
the font is not defined, then the default font (fixed for default character set) is used
instead. The default system font need not be the one defined in Tk2Motif . rgb. If the
defined font does not match the character set on which the application is running,
some other available font will be used following the font lookup algorithm discussed
in the previous section.

In order to maintain the look and feel of the Windows, Oracle Reports makes extensive
use of the system font, which is obtained from the Windows system parameters. For
non-Unicode environments, the font is obtained from the icon objects. You can change
it by modifying the fonts through Display Property > Appearance. Select Icon from
the drop down box and select the desired font name and size. For Japanese Unicode
systems, the font is MS Gothic. For Korean, it's MS Sans Serif. For simplified,
traditional, and Hong Kong it's Arial. For other languages, it's Lucida Sans Unicode.

You can also change the Windows tool tip font by changing the icon font as described
above. This change is not completely reflected across Oracle Reports Builder because
some tool tip fonts are taken from the resource file.

In Oracle Reports, fonts for the Web Source view are selected by making an entry in
the alias file under the [rwbuilder] section. The entry required for this change
should only be aliased to the character set and not to any specific font. For example, if
you want to use Arial Unicode MS when NLS_LANG is set to UTFS, then you should
create an entry like this one:

Refer to Section 9.4, "Font Aliasing” for more information.

The supported styles are: Plain, Italic, Oblique, Underline, Outline, Shadow, Inverted,
Overstrike, and Blink.

The supported weights are: Ultralight, Extralight, Light, Demilight, Medium,
Demibold, Bold, Extrabold, and Ultrabold.

You should not use fonts with a weight of Regular because this weight is not
supported and may cause Oracle Reports Builder to display undesirable results.

9.2 Adding Fonts

In Oracle Reports, fonts can be added for use:
= Atbuild time (in Oracle Reports Builder)
= Atruntime (in the output)

s In the user interface

Note: You must restart the Reports Server after adding fonts to the
Reports font directory.
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9.2.1 Adding Fonts to Oracle Reports Builder

To build a report in a certain font, the font must be available in Oracle Reports Builder
from the font picker when you are designing the report. In order for the fonts to
appear in the font picker, the fonts should be added to the system or the display on
which Oracle Reports Builder is running. Please review your operating system
documentation for adding fonts before attempting this procedure.

To add Type1 fonts on UNIX:

1.

Get the font-related files from the vendor. These include the PFB, PFA, and the
AFM files.

Convert the PFB binary file to PFA ASCII font using one of the available
convertors. Typically, you can get such converters as shareware, for example,
tlascii.

Copy the PFA files to the directory where the fonts have to be installed following
the instructions for our platform.

Verity the installation of the fonts by entering the x1sfonts -ucommand. This
command lists all the fonts that are available for that system.

If you are using a UNIX emulator like reflection X, the fonts installed on the
system may not appear in the x1sfonts command. The reason for this behavior
is that it is taking fonts from the font path or the font server, which is configured
for this emulator. If using a font server, ensure that, after installing the font, you
add the font directory to the font server configuration file and restart the font
server. In the emulator, specify the font path to this font server wherever the fonts
are installed. If you are still not able to see the fonts in x1sfonts, ensure that the
new font directory is the first element of the catalogue in the configuration file.

Figure 9-2 xisfonts sample output
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Start Oracle Reports Builder on the display that points to the font server on which
these fonts are installed or to the display where the fonts are installed.

9.2.2 Adding Fonts for Report Output

For generating output in Oracle Reports, only the fonts that are specified in the printer
definition file are used. To use a newly added font in your output, you should first
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add it to Oracle Reports Builder so that you can assign the font to layout objects when
designing the report. Refer to Section 9.2.1, "Adding Fonts to Oracle Reports Builder"
for further information.

Note: If you use fonts in Oracle Reports Builder that are not
available on your runtime platform, you should alias those fonts on
the runtime platform. Refer to Section 9.4, "Font Aliasing" for more
information.

The process for adding fonts is different on Windows and UNIX:
= Adding fonts on UNIX
= Adding fonts on Windows

9.2.2.1 Adding fonts on UNIX

To add TTF fonts:

1. Copy all the TTF and TTC files, which are used in the report, to the REPORTS_
FONT_DIRECTORY. The default font directory is SORACLE_
INSTANCE/reports/fonts.

2. Remove any unnecessary aliasing from the uifont.ali file. For example, Arial is
aliased to Helvetica, by default. If your report uses the Arial font, you must
remove the aliasing from the uifont.ali file.

To add PostScript fonts:

1. Copy the AFM file for the new font to ORACLE_
HOME/guicommon/tk/admin/AFM.

2. Add the entry for this new font to the *Font information section in the printer
definition (PPD) file:

*Font new_font_name Standard ' (00.1001)" Standard ROM
*Font ...

Ensure that the new_font_name given in the PPD file is the same as the AFM file,
because Oracle Reports searches for this file based on the font name in the PPD
file. Also make sure that the AFM file name does not include the . afm extension.

For example, if the AFM file name is CodedreineunBold, then the PPD file
should contain:

*Font CodedreineunBold: Standard " (00.1001)" Standard ROM

3. If necessary, make changes in the alias file for mapping to this font.

If the layout objects are associated with the same font name as the new font, then
mapping is not required. If the fonts for the layout objects are different and the
new fonts are desired in the output file instead of the original ones, then you must
map the original fonts to the new ones.

For example, if the layout objects' font is Helvetica and you want newly installed
fonts in the output, then you could add the following to the
[Printer:PostScriptl] section:

Helvetica = CodedreineunBold
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Please note the section will be different if you are using a different PostScript level
in your uiprint. txt. Refer to Section 9.4, "Font Aliasing".

To add PCL fonts:

In order to use a new font in Oracle Reports, you must have the HPD (printer
definition) and TFM files for your printer. The HPD file can be copied from an existing
one. You must be sure that the file is suitable for your printer; fonts referenced in this
file should be available on your printer. If the TFM files (fonts) are not available on
Oracle Reports installation, you must contact your font/printer supplier. The new
TFM files must be added to the HPD file under a unique font name.

1. Inthe HPD, you will have to add the new font entry. For example if the new font
is Codedreineun then include a new line such as:

FONT= Codedreineun
/tfm=9nb17035. tfm

2. Copy the associated TFM file into the TFM directory:
ORACLE_HOME/guicommon/tk/admin/TFM
3. Modify the alias file, if necessary, as described in Section 9.2.2.1, "Adding fonts on

UNIX" for the PostScript printers. The section in which the mapping is done
should be [PCL].

9.2.2.2 Adding fonts on Windows

For adding a new font on Windows, refer to your operating system documentation on
adding a new font. If the new font has a character set that is compatible with Oracle
Reports Builder, the new font will appear in the font picker.

9.3 Font Configuration Files

This section describes all of the files associated with font configuration for Oracle
Reports:

=  uiprint.txt (UNIX only)

»  screenprinter.ppd (UNIX only)

» uifont.ali

s PPD and AFM files (UNIX only)
= HPD and TFM files (UNIX only)
s Tk2Motif.rgb (UNIX only)

Note: Beginning in Oracle Reports 11g Release 1 (11.1.1),
configuration of fonts should be done only through Oracle Enterprise
Manager. Refer to Chapter 7, "Administering Oracle Reports Services
Using Oracle Enterprise Manager", Section 7.9.1, "Configuring Fonts"
for information about updating configuration settings through Oracle
Enterprise Manager.

uiprint.txt (UNIX only)

The printer configuration file contains a list of printers installed for the application
along with the type of the printer, its version, and the printer definition file. The list of
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available fonts for runtime is taken from the printer definition file. If no printer is
present, Oracle Reports chooses a PostScript printer as the default and default.ppd
file as the printer definition file.

See Also:

= Section 10.3.1, "Editing uiprint.txt File"

= Section 10.4.6, "uiprint.txt"

Example:

Printer: Printer_driver:Driver_specifying language_and_level:Printer_
description:Printer_definition_file:
Each line contains five fields separated by colons.

If you are using PCL printing, then this entry should contain the name of an HPD file.

screenprinter.ppd (UNIX only)

screenprinter.ppd is used when a printer is not available on UNIX. For more
information, see Section 10.8.1, "ScreenPrinter".

uifont.ali
The uifont.ali file is found in the following location on Windows and UNIX:

On Windows: ORACLE_
INSTANCE\config\FRComponent\ frcommon\tools\common

On UNIX: ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin

This file contains mapping information for fonts that can be substituted for other fonts
at runtime.

Caution: Do not alter the sections as Oracle Reports parses the
uifont.ali file looking for keywords. The sections can be in any
order. Any font configuration should be done only through Oracle
Enterprise Manager. Refer to Chapter 7, "Administering Oracle
Reports Services Using Oracle Enterprise Manager", Section 7.9.1,
"Configuring Fonts"for information about updating configuration
settings through Oracle Enterprise Manager.

Some general rules for the uifont.ali file are:

= Font or character set names require double quotation marks around two or more
words, or spaces.

s Comments are specified using # in the first column.
= Comment out lines instead of deleting them to be able to use them in the future.

» Font aliasing is a font name-to-font name or character set-to-CID font (from Adobe)
only.

= Font subsetting is for TrueType fonts only.

= Font subsetting uses the font name and subsets using the TrueType font file name.
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= Font embedding is for Typel fonts only. These fonts have two files. One for
metrics, containing either . afm or. pfm file extension and the binary containing
the . pfb file extension.

Font embedding uses the font name and embeds using the Type 1 font file names
(both the AFM and PFB files are required in this order).

The general format for aliasing in uifont.ali is:
"original_font"="font_to_be_aliased"

where original_font is the font name or its other attributes that will be mapped to
the font name or attributes of font_to_be_aliased.

The fonts along with their attributes can be described as:

Face.Size.Style.Weight.Width.CharSet=Face.Size.Style.Weight.Width.CharSet

The Face must be the name (string/identifier) of a font face, such as Courier. The
Style, Weight, Width, and CharSet may either be a numeric value or a predefined
identifier or string. For example, both P1ain and 0 are valid Style values and refer
to the same style. The Size dimension must be an explicit size, in points.

These attributes take effect for font aliasing, font subsetting, and font embedding.
For example, in the case of font subsetting it is:

Font_name=font_file name
Face.Size.Style.Weight.Width.CharSet=font_file_name

The following is a list of recognized names and their numeric equivalents:

Table 9-1 Style Names and Their Numeric Equivalents

Style Name Numeric Equivalent
Plain 0

Italic 1

Oblique 2

Underline 4

Outline 8

Shadow 16

Inverted 32

Blink 64

Table 9-2 Weights and Their Numeric Equivalents

Weight Name Numeric Equivalent
Ultralight

1
Extralight 2
Light 3
Demilight 4
Medium 5
Demibold 6
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Table 9-3 Widths and Their Numeric Equivalents

Width Name Numeric Equivalent

Ultradense
Extradense
Dense
Semidense
Normal
Expand

Extraexpand

O o0 N U1 ok W N =

Ultraexpand

Styles may be combined; you can use the plus sign (+) to delimit parts of a style. For
example:

Arial..Italic+Overstrike = Helvetica.l2.Italic.Bold

This mapping indicates that any Arial that has both Italic and Overstrike styles will be
mapped to a 12-point, bold, italic Helvetica font.

For multibyte language support, you must alias a character set with a CID font
(Section 9.5.7, "CID Fonts") from the Asian font pack from Adobe. For example, in your
Japanese report you have aliased a multibyte Shift-JIS characterset be aliased to
HeiseiKakuGo-W5-Acro CID font with the following entry:

JA16SJIS = "HeiseiKakuGo-W5-Acro"

All strings are case-insensitive in mapping. Font faces are likely to be case-sensitive on
lookup, depending on the platform and surface. As a result, take care with the names
used. For example, if the font name arial is used on the left-hand side (the original
font), all layout objects with fonts such as arial or Arial are mapped to the aliased
font.

Refer to Section 9.4, "Font Aliasing” for more information.

PPD and AFM files (UNIX only)

PostScript Printer Definition (PPD) files and Adobe Font Metrics (AFM) files are
supplied by Adobe and by printer vendors. The PPD files contain information about
the printer, and the AFM files contain metrics information of the fonts. Along with
other parameters, these files are read for the information about the available fonts for
the printer, which Oracle Reports will use. For all the fonts listed in the PPD file,
Oracle Reports searches for the corresponding AFM file according to the font name
and loads all of the fonts for which there is an available AFM.

From the fonts perspective, you should modify these files when you add new fonts for
the printer and want these changes reflected in Oracle Reports.

Example:

*% Font Information =====================

*DefaultFont: Error

*Font AvantGarde-Demi: Standard " (001.001)" Standard

*Font AvantGarde-DemiOblique: Standard " (001.001)" Standard
*Font Courier: Standard "(001.004)" Standard

*Font Courier-Bold: Standard "(001.004)" Standard
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The AFM files contain information such as the font attributes (style, weight, width,
encoding scheme), whether the font is fixed pitch or proportional, and how large each
character is.

After looking for the font names from the PPD files, Oracle Reports searches for the
AFM files with the same name as the font according to the search criteria described in
Section 9.3.1, "File Searching". For example, if Oracle Reports finds
AvantGarde-Demi: Standard in the PPD file, it will search for an AFM file named
AvantGarde-Demi in the AFM directory.

Please note that the AFM files are not font files; they are metrics files that provide
Oracle Reports with information on how to properly format the character for the
printer. If you have an AFM file, but the font is not available on the printer, then
Oracle Reports cannot generate the font.

Since the AFM files are NOT fonts themselves, if you wish to have more PostScript
printer fonts available, you must do the following:

1. Purchase the fonts and have them installed on the printer.
2. Obtain revised AFM and PPD files from the font/printer vendor.

3. Obtain matching X Server display fonts (if necessary).

HPD and TFM files (UNIX only)

PCL (Hewlett-Packard Printer Control Language) uses HPD (Hewlett-Packard
Document) and TFM (TEX Font Metrics) files. The HPD files contain a list of fonts
available for the printer and each font refers to a TFM file. The HPD file is an ASCII
file, which can be edited, but the TFM file is a binary file, which cannot be edited. Even
though TFM files are binary and uneditable, you can perform string operations to read
some specific keywords from these files. Oracle Reports recognizes the font name that
is in the TFM files and not the one specified in the HPD file. The font vendor should
provide TFM files and new fonts should be added to the HPD file for your printer
when installed.

Tk2Motif.rgb (UNIX only)

This file contains resource settings for all Oracle Motif tools based on Oracle Toolkit.
For font specific resource settings, Tk2Motif*fontMapCs and
Tk2Motif*fontList are used.

Tk2Motif*fontMapCs governs the base character set of fonts that the application
will use, which are on the X-window display.

If Tk2Motif*fontMapCs: is08859-2=EE8IS08859P2, then NLS_LANG should be
set to EE8IS08859P2 and only fonts with encoding as 1s08859-2 will be used for
the application. If the system does not find any fonts with the above encoding, it will
fail with a REP-3000 error.

Tk2Motif*fontList specifies the default system font that will be used by the
application. The following means that the Helvetica font with medium weight and
normal width of size 12 will be used:

Tk2Motif*fontList: -*-helvetica-medium-r-normal-*-120%*
The syntax for the above entries can be found in Tk2Motif.rgb (ORACLE_

INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin) file as
comments.
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9.3.1 File Searching

The criteria for searching files is dependent upon the type of file and the various
environment variables defined.

Table 9-4 File Information

File Name Type Description

uiprint.txt UNKNOWN Printer configuration file

uifont.ali FONTALIAS Font aliasing file

PPD PPD PostScript printer definition
file

AFM AFM Adobe font metrics file

HPD HPD HP glue file

TFM TFM HP glue file

Oracle Reports will first look for the variable in TK_type, then in the ORACLE_ type,
and then in the global directory. For instance, the PPD files are searched for in the
directory specified by TK_PPD, then in ORACLE_PPD, and then in ORACLE_

HOME /guicommon/tk/admin/PPD, and then in $ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin/PPD.

For example, looking for uiprint. txt, Oracle Reports will first look at the
environment variable TK_UNKNOWN, then look at ORACLE_UNKNOWN, and then in the
default directory.

9.4 Font Aliasing

Font aliasing is a mechanism in Oracle Reports that allows a font or its associated
attributes like style, weight, width, size and character set to be mapped to another
desired font or its associated attributes. Its primary use is when applications are
ported from one platform to another and the font associated with some or all of the
objects in the layout on the source platform do not exist on the target platform. In such
cases font aliasing will be helpful as the nonexistent fonts can be mapped to another
available one producing the required results. For example, when moving from
Windows to Motif one would use font aliasing to map the Windows Arial to a font
available on Motif, such as Helvetica.

The font enhancements introduced in Oracle Reports 11¢ Release 1 (11.1.1) make font
aliasing unnecessary in almost all cases. In prior releases, a report may have been
created with fonts that are readily available on Windows, but not on UNIX (for
example, Arial font). In such cases, it was necessary to alias the Windows fonts to
other fonts with a similar style available on UNIX (for example, Helvetica). Now, with
support for TTF and TTC files on UNIX, a font such as Arial is supported on both
Windows and UNIX, eliminating the need for aliasing.

This section includes the following topics:
= Specifying Aliasing Information

= Font Aliasing Mechanism

= Font Alias File Sections

= Font Aliasing File Verification
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9.4.1 Specifying Aliasing Information

If font aliasing is necessary, use Oracle Enterprise Manager to define the aliasing,
instead of directly editing the uifont.ali file as in prior releases. For information
about using Oracle Enterprise Manager for font configuration, see Section 7.9.1,
"Configuring Fonts".

9.4.2 Font Aliasing Mechanism

For font aliasing, Oracle Reports searches for entries under the related section in the
alias file that matches the original font attributes given in the report. Refer to

Section 9.4.3, "Font Alias File Sections" for more information about the sections of the
font alias file. If an exact match is found, Oracle Reports maps the original font on the
left to the target font on the right.

For example:

Arial.8.Italic.Medium.Normal.WE8IS08859P1=
Helvetica.l2.Plain.Light.Normal .WE8IS08859P1

If an Arial font with all of the attributes listed on the left is found, it will be mapped to
a Helvetica font with all of the attributes listed on the right.

Any field can have a blank entry, which means it will be matched regardless. For
instance:

Arial..... = Helvetica.l2.Plain.Light.Normal.WE8IS08859P1

In this case, all of the Arial fonts, irrespective of size and other attributes, are mapped
to Helvetica with size 12, style Plain, weight Light, having Normal width under
character set WEBISO8859P1.

Another way to specify an aliasing rule is:

Arial = "OCR B"

This method will preserve the other attributes of the present font but will change the
font name to OCR B. You must be certain in such cases about the availability of
mapped fonts with the attributes of other fonts. For example, in this rule the Arial font
with style Italic might be mapped to the OCR B font with Plain style because the OCR
B font does not have the Italic style present.

After a mapped font is read from the uifont.ali file, Oracle Reports looks for the font
following the font lookup procedure, which is described in Section 9.1.2.1, "Font
lookup". If the mapped font is found on the system, then Oracle Reports uses this font.
Otherwise, it looks for the original font in the system.

Font attributes are searched for with the font face, size, style, weight, and width under
the specified character set.

In Oracle Reports, fonts for the Web Source view and PL/SQL editor can be mapped
by providing a mapping specification in the [rwbuilder] section. This feature is
mainly intended for supporting Unicode fonts in these editors.

9.4.3 Font Alias File Sections

The uifont.ali file consists of various sections which contains font mapping
instructions for a particular area, as shown in Table 9-5. Since Oracle Reports looks in
specific sections for specific purposes, it is crucial that you place your mapping entries
in the appropriate section for what you are trying to accomplish.
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Table 9-5 Font Mapping File Sections

Section Name Description
Global Applies everywhere.
Printer Only applies to printer output.

Printer:PostScriptl Applies to PostScript Level 1 printers.

Printer:PostScript2  Applies to PostScript Level 2 printers.

Printer:PCL5 Applies to PCL 5 printers.

Display Only applies to the display (the screen).

Display:Motif Applies only to the Motif display.

Display:CM Applies only to character-mode display.

PDF Used for font aliasing (from Oracle Reports 6i) and multibyte
language support (from Oracle Reports).

PDF : Embed (Oracle Reports only) Used for Type 1 font embedding.

PDF: Subset (Oracle Reports only) Used for True Type font subsetting.

RWBUILDER (Oracle Reports only) Fonts for the Web source and PL/SQL

editor can be mapped in this section.

printer_name A section for a specific printer, such as:

[Printer:PostScriptl:20p813al

See Also: "Repairing Fonts Not Appearing Correctly in Web
Source View" in Section 9.9, "Troubleshooting Font Issues".

If you want to look at the uifont.ali file, it is located in the following directory on
Windows and UNIX:

On Windows: ORACLE_
INSTANCE\config\FRComponent\ frcommon\tools\common

On UNIX: ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin

The section for font aliasing in the uifont .ali fileis [PDF], which defines font
mappings using the following formats:

= Single byte fonts:

[PDF]
"font_name"="font_name"

= Multibyte fonts:

[PDF]

character_set = "font_name"

or

"font_name"..... character_set="font_name"

Here is an example of a font aliasing entry in the uifont.ali file:

[ PDF ]
/*Alias TrueType to available Typel font */
"Kino MT" = UtopiaBold
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/*Alias multibyte to available CID font */
..... SJIS = "HeiseiKakuGo-W5-Acro"

where:

= "Kino MT" = UtopiaBoldsubstitutes every Kino MT character found with the
UtopiaBold equivalent.

T SJIS = "HeiseiKakuGo-W5-Acro" substitutes every multibyte
character set found with the HeiseiKakuGo-W5-Acro (CID) equivalent.

Order of precedence

When aliasing a particular font, only one section is read based upon the context in
which the font is used. Hence, if three sections apply, only one is read. For example,
suppose you have three sections: [Printer], [Printer:PostScript], and
[Printer:PostScript:20op81l3al. When generating output, if the printer is
20p813a, only the mapping rules in section [Printer:PostScript:20p813a] are
read. For printers other than 2o0p813a, Oracle Reports would use the
[Printer:PostScript] section.

The more specific sections of the alias file take precedence over the more general
sections. For example, a specific printer section, such as
[Printer:PostScriptl:20op8l3a] would take precedence over the
[Printer:PostScriptl] section, which would take precedence over the
[Printer] section, which would take precedence over the [Global] section.

Theuifont.ali fileis the configuration file controlling all of the Oracle Reports
PDF font enhancements. The uifont.ali file is text readable; that is, you can edit it
with a standard text editor. Exercise caution when editing the file. The uifont.ali
file should be saved as a text file with no formatting or special characters that may
corrupt the file.

Note: Although you can manually edit the uifont.ali file, it is
recommended that you use Oracle Enterprise Manager for all
font-related configuration tasks.

9.4.4 Font Aliasing File Verification

To verify whether the uifont . ali file is correct, you can run the font check utility,
which can be found in the ORACLE_HOME/bin directory. It is always advisable to run
this utility on the modified uifont.ali file to catch any errors:

On Windows:

fnchk.exe filename

On UNIX:

mfontchk filename

where filename is the name of the modified uifont.ali file. If you don't specify
any file name, it will check the default file based on the environment variables.

If the alias file has errors, the utility returns an error message along with the file on
which the error was found. For example:

Parsing font alias file "$SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin/uifont.ali"
Ms san serif
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Error at line 85: Invalid font specification
Parse of font alias file failed

The above error indicates that there is a syntax error in uifont.ali in the mapping
rule for MS San Serif font on line 85.

9.5 Font Types
This section discusses the fonts and character sets relevant to Oracle Reports:
s Character Sets
= Unicode
= Typel Fonts
s TrueType Fonts
s TrueType Collection
= Barcode Fonts

s CID Fonts

9.5.1 Character Sets

The character set component of the NLS environment variables specifies the character
set in which data is represented in your environment. When data is transferred from a
system using one character set to a system using another character set, it is processed

and displayed correctly on the second system, even though some characters might be

represented by different binary values in the character sets.

If you are designing a multilingual application, or even a single-language application
that runs with multiple character sets, you must determine the character set most
widely used at runtime and then generate with the NLS environment variable (NLS_
LANG) set to that particular character set.

If you design and generate an application in one character set and run it in another
character set, performance can suffer. Furthermore, if the runtime character set does
not contain all the characters in the generate character set, then question marks appear
in place of the unrecognized characters. Portable Document Format (PDF) supports
multibyte character sets. There might be situations where you create an application
with a specific font but find that a different font is being used when you run that
application. You would most likely encounter this when using an English font (such as
MS Sans Serif or Arial) in environments other than Western European. This occurs
because Oracle Reports checks to see if the character set associated with the font
matches the character set specified by the language environment variable (NLS_
LANG). If the two do not match, Oracle Reports automatically substitutes the font
with another font whose associated character set matches the character set specified by
the language environment variable. This automatic substitution assures that the data
being returned from the database gets displayed correctly in the application. Note: If
you enter local characters using an English font, then Windows does an implicit
association with another font. There might be cases, however, where you do not want
this substitution to take place. You can avoid this substitution by mapping all desired
fonts to the WE8T1S08859P1 character set in the font alias file (uifont.ali).
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9.5.2 Unicode

Unicode is a global character set that allows multilingual text to be displayed in a
single application. This enables multinational corporations to develop a single
multilingual application and deploy it worldwide. For information about using
Unicode in your multilingual applications, refer to Section 23.5, "Unicode".

9.5.3 Typel Fonts

PostScript font formats Adobe Type 1 fonts are stored in two common formats:.pfa
(PostScript Font ASCII) and . pfb (PostScript Font Binary). These contain descriptions
of the character shapes, with each character being generated by a small program that
calls on other small programs to compute common parts of the characters in the font.
In both cases, the character descriptions are encrypted. Before such a font can be used,
it must be rendered into dots in a bitmap, either by the PostScript interpreter, or by a
specialized rendering engine, such as Adobe Type Manager, which is used to generate
low-resolution screen fonts on Apple Macintosh and on Microsoft Windows systems.

The Type 1 binary files (. pfa and . pfb) contain character information, while the
metric files (. afm (Adobe Font Metric) and . pfm (Printer Font Metric)) contain the
metric information to form the character. These metrics files are ASCII files with a
well-defined easy-to-parse structure.

9.5.4 TrueType Fonts

The personal computer brought about a need for scalable font technology, thought to
be an important part of any future operating system. TrueType is this scalable font
technology that enables you to view the same output without the jagged aliasing
caused by scaling that is apparent when bitmapped fonts are used.

This technology involves two parts:
s The Rasterizer
s TrueType fonts

The Rasterizer is an application that is included in both Windows and Macintosh
operating systems. It acts as an interpreter and translates the font information into a
form that the video display can render.

The TrueType fonts themselves contain information that describes the outline of each
character in the typeface. Higher quality fonts also contain hinting codes. Hinting is a
process that makes a font that has been scaled down to a small size look its best.
Instead of simply relying on the vector outline, the hinting codes ensure that the
characters line up well with the pixels so that the font looks as smooth and legible as
possible.

Adobe wanted both Apple and Microsoft to license its PostScript code, which was
capable of handling this role, but both companies were concerned about having a third
party control key parts of their operating systems. Apple and Microsoft agreed to a
cross-licensing and product development deal, with Microsoft creating a
PostScript-style graphics engine and Apple creating a font system. Apple developed
what was to become TrueType, which proved superior to other competing
technologies on performance and rendering quality. Apple and Microsoft announced
their strategic alliance against Adobe, where Apple would do the font system,
Microsoft the printing engine. Apple released TrueType in March 1991 and the first
TrueType fonts:

s Times Roman
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s Helvetica
s Courier

Microsoft introduced TrueType into Windows with version 3.1 in early 1992. They
created a core set of fonts:

s Times New Roman
s Arial
s Courier

Both Apple's and Microsoft's TrueType fonts showed that scalable fonts could
generate bitmaps virtually as though each size had been designed by hand.

9.5.5 TrueType Collection

A TrueType Collection (TTC) is an efficient way of sharing common font data, such as
character information and glyphs. This data sharing results in an optimized file size as
the common glyphs are stored in a single file structure, instead of within each font.
The end result is a single file that is a combination of two or more fonts. For example,
certain Japanese fonts in a font family may share a common set of kanji characters.
They can be included in a TTC file.

For example, the TTC file, msgothic. ttc, is a collection file consisting of three fonts.
They are MS Gothic, MS PGothic, and MS UI Gothic.

9.5.6 Barcode Fonts

Barcode fonts can be quite confusing. Some industries have chosen a specific barcode
type. If this is what you need, then using the appropriate barcode font should work.
For example, if you are interested in putting barcode on retail packages or books, the
choice of a barcode is simple. Retail packages in North America use the UPC-A bar
code. European retail articles use the EAN barcode .

All book ISBN numbers use the Bookland barcode (an EAN 13 bar code with a 5 digit
supplement). Fonts are one way to obtain barcode, but not the only way. Oracle
Reports offers another solution for producing barcodes using a Java barcode bean. The
Java barcode bean is capable of creating barcodes based on the most popular barcode

types.

9.5.7 CID Fonts

Character IDentifier (CID) fonts are a format of composite (multibyte) Typel fonts
used to better address the requirements of Far East markets. Adobe developed the
CID-keyed font file format to support large character set fonts for use with PostScript.
It is the ideal format for Chinese, Japanese, or Korean fonts and can also be used for
roman fonts with very large character sets. CID-keyed refers to the character identifier
(CID) numbers used to index and access the characters in the font. A CID (character
identifier) font consists of a large font file containing all the character outlines and a
small CMap file that contains a list of characters, encodings, and character identifiers.
The combination of the font file and the CMap file yields a font that is a specific
character set and encoding information. Each CID font can support many character set
and encoding combinations.
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9.6 Verifying Report Output on Different Platforms

Oracle Reports 11g Release 1 (11.1.1) uses the widely available font formats like TTF
and TTC on both Windows and UNIX to generate report output that in most cases
looks identical on both platforms, with no configuration necessary.

Oracle Reports reads the font metrics from the appropriate TTF files to correctly
format the report output. This eliminates the issue of text misalignment due to font
metrics mismatches. Fonts for which TTF files are available are found automatically.
Note that if a TTF font file is not found, then the font lookup mechanism reverts to the
pre-11g implementation.

Run a sample TTC font type report on Windows:

1. Open the TTC font type report in Reports Builder.

2. Select File > Generate to File > PDF and save the output.
Run the same TTC font type report on UNIX:

1. First check whether the TTC font used by the report is already available on the
UNIX server machine in SORACLE_INSTANCE/reports/fonts (for example,
MSGOTHIC.TTC). If it is not available, copy it from the Windows machine
(C:\WINDOWS\Fonts) .

2. Run the report using the following command line:

http://host:port/report=report_
name.rdf&destype=cache&desformat=pdf&userid=user/passwordedb

Compare the output on UNIX with that on Windows to confirm that they are almost
identical.

Tip: On UNIX, set the DPI as in Windows. For example, if you
change the UNIX DPI from 96 to 600, which is the Windows DPI
value, the PDF and RTF outputs on UNIX will be identical to that of
Windows.

However, the HTML ouput file is large because the DPI value of the screen printer is
changed. This problem occurs only if a valid printer is not set and the screen
resolution (screenprinter.ppd) is used for both PDF and HTML drivers. For example, if
the valid/dummy printer is set to TK_PRINTER with the DPI resolution 600, the same
value as that of Windows, the HTML and PDF outputs on UNIX will be identical to
that of Windows.

Example

Here is an example of how to produce report HTML output that looks the same on
Windows and UNIX if the DPI of Windows is 600:

1. If you do not have a valid printer, add the following entry in the uiprint.txt file:
Font:ASCII: DPI changed PPD file:default.ppd:

2. Change the Default Resolution to 600 in the datap462.ppd file as follows:
*DefaultResolution: 600dpi

Note: Do not change the resolution of screenprinter.ppd.
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3.

4.

If you have a valid printer, configure the printer in the uiprint.txt file and change
the DefaultResolution to 600.

Run the report after placing the fonts in the font folder.

9.7 Running a Unicode Report using TTF/TTC Fonts

Oracle Reports 11g Release 1 (11.1.1) uses the new font mechanism to run a Unicode
report on UNIX using the TTF / TTC fonts, generating report output that in most cases
looks identical on both platforms.

Run a sample Unicode report on Windows (for example, Unicode.rdf in the
sample reports directory):

1.

o ©Dbd

6.

In Oracle Enterprise Manager, select Reports > Administration > Forms/Reports
Common Configuration to display the Forms Reports Common Component
Configuration Page.

= Add the following entry under the [PDF:Subsetting] section:

"Arial Unicode MS"="ARIALUNI.TTF"

= Ensure there is no aliasing defined for Arial in the Global section. If there is,
comment it out:

#Arial=Helvetica

Add the font ARTALUNI . TTF to REPORTS_PATH.
Set NLS_LANG in the Windows registry to AMERICAN_AMERICA.UTFS8.
Open the sample report in Reports Builder.

Select File > Generate to File > PDF (if running the sample Unicode. rdf,
choose P_LANG_ID=JA).

Save the report output.

Run the same Unicode report on UNIX:

1.

Check whether the Unicode font used by the report is already available on the
UNIX server machine in SORACLE_INSTANCE/reports/fonts and in the
REPORTS_PATH (for example, ARTALUNI . TTF). If it is not available, copy it from
the Windows machine to $ORACLE_INSTANCE/reports/fonts.

Set NLS_LANG in reports.sh to AMERICAN AMERICA.UTFS.
Run the report using the following command line:

http://host:port/report=report_
name.rdf&destype=cache&desformat=pdf&userid=user/passwordedb

For example:

http://host:port/report=Unicode.rdf&destype=cache&desformat=pdf&P_LANG_
ID=JA&userid=oe/oe@mydb

Compare the output on UNIX with that on Windows to confirm that they are identical.

9.8 Diagnosing Font Issues

To diagnose font usage and issues, you can view the log files in either of the following
ways:
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s Using the Command Line

s Using Oracle Enterprise Manager

9.8.1 Using the Command Line

To view the log files using the command line:
= Open the diagnostics log file:

SORACLE_INSTANCE/diagnostics/logs/ReportsServerComponent/
server_name/rwEng-id_diagnostics.log

= Notice that the font used for each object in the report is logged without any
ambiguity. If a TTF font file was not found, it is logged and noted that the pre-11g
mechanism was used for finding the appropriate font, which is also logged.

9.8.2 Using Oracle Enterprise Manager

Refer to Section 7.11.1, "Viewing and Searching Log Files" in Chapter 7, "Administering
Oracle Reports Services Using Oracle Enterprise Manager"

9.9 Troubleshooting Font Issues

To help resolve font issues that may occur in your applications, this section provides
the following troubleshooting information:

s Checking Whether the Desired Font Is Used in a PostScript File
s Creating Output

= Reading the Output File

s Verifying the Output File

s Correcting Printed Font

s Checking Environment Variables

= Repairing Fonts Not Appearing Correctly in Web Source View
= Understanding Limitations

= Resolving Common Problems

Checking Whether the Desired Font Is Used in a PostScript File

PostScript files have a list of fonts, which is created after reading the PPD file. If you
examine the PostScript file, you can check the fonts by looking for the following tags:

s DocumentNeededResource has the list of fonts referenced in the PPD file.

= DocumentSuppliedResource has the list of fonts for which the PostScript
driver was able to find the AFM file.

= %%Page paragraph before the field's $IncludeResource: font has the font
name which will be used for the field.

For PCL output files, you can check whether a particular font was used or not.
Depending on this information the font settings in Oracle Reports or the printer can be
modified.

Example:
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The test results below are based on a Lexmark Optra printer. The fonts and their
numbers as well as the control commands are examples and may vary with other
printers.

Font information The Lexmark has a small menu with the option of printing all
available fonts (PCL Emulation Fonts). This includes both resident fonts (defaults) and
Flash fonts (installed on the printer separately)

Table 9-6 Sample Font Information

Font Name Style Weight Example Output

RO Courier 0 0 ... <ESC>(<symset><ESC>(s0p<pitch>h0s0b4099T...
R39 Courier Bold 0 3 ... <ESC>(<symset><ESC>(s0p<pitch>h0s3b4099T...
R40 Courier Italic 1 0 ... <ESC>(<symset><ESC>(s0p<pitch>h1s0b4099T...
R55 Century 0 0 ... <ESC>(<symset><ESC>(s1p<point>v0s0b24703T ...

Schoolbook Roman

Table 9-7 Sample Flash Font Information

Symbol
Font Name Set Style Weight Example Output
F2 OCR-A 00 0 0 ... <ESC>(00<ESC>(s0p<pitch>h0s0b4200T

F3 OCR-B 10 0 3 ... <ESC>(10<ESC>(s0p<pitch>h0s0b4206 T

In these examples, there are many more fonts and each font has its own code. OCRB
for example has code 4206. This number is important later on.

Creating Output

When having problems getting the correct font, simplify the report and thereby the
output. This can be done by creating a straightforward report using select
sysdate from dual as the query and limiting the number of fonts. This will avoid
long runs and create much smaller output files.

Reading the Output File

The resulting PCL-file is a binary file but is reasonably readable in the VI editor. The
first small part and the end part is binary, but the middle part is readable and contains
data that can be interpreted.

Verifying the Output File

The only interesting information is in the readable, middle part of the file. Find the text
(this is the text displayed in the reports output) and check out the part preceding the
text.

It looks like this:

....;SD1,14,2,0,3,10.34,5,0,6,0,7,4099;LB here is your text

In the preceding example, the font is selected with code 4099. For the Lexmark printer,
this is selecting Courier.
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In one example, the font OCR-B (code 4206) was needed. The font did not come out
until that specific code was generated just before the selected text. It looks like this:

....;sDp1,14,2,0,3,8.57,5,0,6,0,7,4206;LBThis is OCRB font....

Correcting Printed Font

If the output file contains the correct code, but the font does not appear on the printer,
the printer probably does not have the font available. This will also occur if the code in
the output file (deduced from TEM file) is not the same as the one the printer is
expecting. On the Lexmark printer, the font was replaced by the default font on the
printer.

If the output file does not contain the code for the font, Oracle Reports did not
generate the code to the output file. Check for the HPD and TFM files.

Checking Environment Variables

DEBUG_SLFIND can help you ascertain which of these files was used. With reference
to the fonts, you can find the list of AFM/TFM files the application looked at after
reading the printer definition file and which font files it read after the aliasing. In this
manner, you can also determine whether a font is mapped or not. Usually the order of
file reading will be as follows.

»  First read the printer definition file.
= Read all the associated font files for the font supplied by this printer definition file.
s Read in the alias file.

= If there is a mapping of file then read in font information files for those fonts and
finally again read the AFM file for the fonts that are used in generating the output.

TK_DEBUG_POSTSCRIPT will affect PostScript output. It can be set to any
combination of these strings:

= Functions list each toolkit function called in comments in the PostScript output.
= Long produces long, slow, intelligible PostScript.
= Memory displays memory usage at the bottom of each page.

Any of the options can appear in the environment variable, abbreviated down to one
letter. You can set it to any combination of these, separated by "/". This variable is case
insensitive. For example, Func/L/Mem would give you all three options.

Note that the output that results from using this variable will not be supported by
Oracle for customer use. It exists for diagnostics purposes only.

Note: Set the environment variable DEBUG_SLFIND to any file name
and run the report. The debug information is written in that particular
file.

Usage: # setenv DEBUG_SLFIND mydebug.txt

For more information, see Appendix B, "Environment Variables".

Repairing Fonts Not Appearing Correctly in Web Source View

Text in the user interface of Oracle Reports Builder, such as the window title, uses
fonts taken from the system resource files for the current language. These system
resource files are supplied with the Oracle Reports installation. In Oracle Reports, you
can map these fonts in the [rwbuilder] section of uifont.ali. If found, the
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mapped font is used instead of the original font; if not, Oracle Reports uses the
original font.

Note: The mapped font needs to be a fixed-width font.

In the Web Source view of the Report Editor, the following languages may appear
garbled: Arabic, Central European languages, Cyrillic, Greek, Hebrew, Japanese, Thai,
and Turkish. To work around this issue, you can set the font names for Oracle Reports
Builder inuifont.ali as follows:

[rwbuilder]

..... ARBMSWIN1256="Courier New"

..... CL8MSWIN1251="Courier New"

..... EESMSWIN1250="Courier New"

..... EL8MSWIN1253="Courier New"

..... IW8MSWIN1255="Courier New"

..... JA16SJIS="MS Gothic"

..... TH8TISASCII="Andale Duospace WT"
..... TR8MSWIN1254="Courier New"

You can download a copy of the Andale Duospace WT (fixed width) font from Oracle
Metalink (http://metalink.oracle.com). The ARU number is 2766564.

Understanding Limitations

On Windows:

s For Unicode, Windows provides True Type Big Fonts. These fonts contain the
characters necessary to display or print text from more than one language. For
example, if you try to type, display, or print Western European, Central European,
and Arabic text on a field and see unexpected characters, then you are probably
not using a Big Font. Big Fonts for single-byte languages provided by Microsoft
Windows are Arial, Courier New, and Times New Roman. For more information,
go to Microsoft's Web site:
http://www.microsoft.com/typography/fonts/default.aspx.

= Wingdings fonts may not appear when NLS_LANG is set to UTF8.

The only Wingdings fonts available when using UTFS8 are the characters between
ASC 32 and 127. ASC 252 would display a blank because it is not supported by
UTES.

Any of the following font sets would provide a reasonable work around.
s Webdings - chr(97)
s Wingdings2 - chr(80)

s Wingdings2 - chr(87)

On UNIX:

= AFM support is only for single byte PostScript file generation except for the
Japanese encoding. The encoding schemes supported for the AFM files are
AdobeStandardEncoding, ExtJIS12-88-CFEncoding, FontSpecific,
HRoman, ISOLatinHebrew, JIS12-88-CFEncoding, and
JIS12e-88-CFEncoding.

AFM version that is supported is 2.0.
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= X11 does not support the underline font attribute. Output to file should work
according to steps given below.

s In]JDK, a bug causes the bold Korean font to appear incorrectly. Oracle Reports
Services uses the JRE and therefore all bold Korean strings in graphs within
reports show up incorrectly.

s PostScript printing will not load the fonts to the printer. So for the desired fonts to
appear in the printed output, it is necessary that those fonts should be installed on
the printer.

s For PCL output, only TEM font formats are supported.

s The display system on UNIX (for example, X11) is totally independent of any
application or printer. There is no direct connection between printing and
displaying. There can be a font displayed on your screen that is not printed.

Display and printer fonts are somewhat similar but have more differences than
similarities.

X fonts (display fonts) are bitmap display glyphs, which are displayed on an X
terminal by an X Server.

Printer fonts are PostScript fonts (mathematical descriptions of fonts, not bitmaps)
that are present in a PostScript printer and are generated by a PostScript
Interpreter on that printer.

= Font size changes after applying a template.

Creating a template with font set to Times New Roman size 10 (for all fields) and
making the report use this template, makes the Paper Design view of the Report
Editor display a different font size.

The reason for this behavior is that defaulting couldn't fit the layout into the
desired area.

First it reduced the size of text fields and then reduced the size of the fonts. This is
much better than wrapping the fields and keeping the template font size.

Also, for templates, the font chosen may be different to that in the template since it
matches first on the character set. So if the template font doesn't support the
current character set, the font will change to one that does. This is mostly visible if
you have an English template, which you use in a Hebrew / Arabic environment.

Resolving Common Problems

Problem: Letters are truncated from the right margin on printed label reports.

You have printed a mailing label report on a Windows machine and notice that the
last letter, or last few letters, on each line are being truncated. The letters are not
missing when you preview the report. You have tried changing the page formatting
and font settings, but this has failed to resolve the problem.

Solution: If the report displays correctly using a DESTYPE of Preview, this is not a
problem with the printer driver. The problem may be occurring due to the frame
properties.

If a frame around the layout objects has a Horizontal Elasticity setting of Fixed and the
data exceeds the frame size, it can cause this truncation of data.

Try testing the results after setting the Horizontal Elasticity property to Expand or
Variable.
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Problem: When generating to file as HTMLCSS, a column is dropped off in the
output.

You are generating a report to an HTMLCSS file format and it appears to be fine in the
Paper Design view of the Report Editor. When you click the newly created file it
comes up in your browser, but the last column is missing from the report output.

If you re-run the report again, it still looks fine in the Paper Design view and the
column is there as it should be. Clicking on the file again appears to have the column
dropped off and missing from the report output. PDF appears fine in Paper Design
view and the Adobe Acrobat reader.

Solution:
1. Close Oracle Reports Builder and other open applications.
2. Choose Windows Control Panel > Display > Settings.

3. Set your fonts to be Small Fonts, click Apply button and then click OK to
reconfigure your Windows font settings.

4. Reboot your computer in order for the new font settings to take effect.

5. You can now go back into Windows Control Panel > Display > Settings to verify
that you have small fonts as a default for your system.

When you click the HTMLCSS file, your browser shows the report correctly with all of
the columns intact.

When viewing HTMLCSS files with your browser, it is recommended to have Small
Fonts as the default setting for your Windows system.

If you have Large Fonts as your default, your HTMLCSS file may not display
correctly.

Problem: How to choose bitmap fonts sizes of less than 8 point in Oracle Reports
Builder.

Solution: There are times when a font size of 6 or less is required for reporting
purposes. Keeping in mind that font mapping and sizing is actually a product of
operating system font files and driver/printer specifications, it is possible to change
many fonts to minimal sizes such as 6 or less.

Oracle Reports typically allows fonts to be downsized to a size of 8. This is
accomplished by opening a report in Oracle Reports Builder, going to the Layout
Model view, and selecting the report objects that you wish to change. Once the object
is selected, go to the font size list next to the font picker and select your font size.

Typically, your size will be limited to a range from 8 to 72 for True Type fonts, less for
other fonts.

You can enter a size smaller or larger than the sizes in the list. To do this, again select
the object, place your cursor in the font size field, press Delete to remove the current
size number, enter the font size you desire, and then press the TAB key. The change
takes effect immediately.

Once again, keep in mind that not all font sizes are possible. Also, some combinations
of fonts and attributes are not practical. Simply having the ability to choose a font size
does not mean that the font will be legible when printed. Fonts that involve small
sizes, combined with bold, italic, or other attributes, may also present legibility
problems when printed or displayed due to the limitations of the printer driver,
printer, font metrics, language, code sets, NL.S_LANG, and, of course, human eyesight.
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Problem: The report output font size is different in Windows and UNIX.

A simple report designed on Windows uses the Arial and a font size of 8. This report
was ported to Sun Solaris and was found to have a different font size in the output on
Solaris. In the UNIX environment, the report is uses the Helvetica font and a font size
of 9. The Arial font has been mapped to the equivalent font, Helvetica, on UNIX using
uifont.ali.

Solution:

1. First look for the font size available for Helvetica on the UNIX system by either
using the x1sfont command or any other UNIX font utility.

2. You should map variable sized fonts on Windows to variable sized fonts on UNIX.
For example, modify the mapping for MS Windows Arial.8 = Helvetica.8
(assuming that size 8 is available for Helvetica on the UNIX system) and ensure
that uifont.ali is in the correct directory.

It's probable that the Helvetica font installed on your machine is bit mapped
(rasterized) and so it doesn't automatically scale to any arbitrary size. If so, you must
install a scalable Type 1 font, which should allow you to choose any point size.

There may always be differences between fonts on different systems even if the fonts
installed are the same because the font configuration files may be different on these
systems.

Problem: When printing, fonts are replaced by non True Type fonts. In the Paper
Design view, the fonts are fine.

Solution: Check the printer settings (advanced) and ensure that it doesn't say:

True Type Font: Substitute with Device Font

UNIX

Problem: While running Oracle Reports on X-windows emulators, fonts installed on
UNIX do not appear in the font lookup box.

Solution: On X-windows emulators, where the font path is usually a font directory
on the local machine, the fonts that were installed on will not be available and only the
fonts in the local font directory will be used by the Oracle Reports font lookup box. In
such cases, you should start a font server on a remote machine where the fonts were
installed and point the font path entry to this font server. For starting the font server
and setting the font path entry, consult the system manual and X-windows emulator
help.

For finding the font path or font server that is currently being used, use the UNIX
command xset -.
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Printing on UNIX with Oracle Reports

Oracle Reports provides a rich set of features out-of-the-box for printing on various
platforms. Printing on UNIX requires some setup and configuration to create the
proper printing environment. This chapter provides information about printing on
UNIX with Oracle Reports. In particular, it covers:

s UNIX Printing Overview

s Setting Up a Printer on UNIX

= Configuring the Printing Environment

= Printer-Related Files

= Enhanced Printing on Linux Using CUPS

= Globalization Support

= Debugging Options

= Removing DISPLAY and Printer Dependencies on UNIX
= Frequently Asked Questions

10.1 UNIX Printing Overview

This section explains how to print from Oracle Reports on UNIX and highlights the
key differences between the UNIX and Windows platforms. It also explains the
operating system requirements for any application to print successfully.

= General Printing Mechanism
s Oracle Reports Printing Mechanism on UNIX and Windows
= Printing Support

10.1.1 General Printing Mechanism

To understand how printing works for Oracle Reports on UNIX, it is useful to have the
Microsoft Windows printing mechanism as a reference point. Microsoft Windows
provides an application level API that supports different types of printers based on the
installed printer drivers. Applications can interact with various printer drivers
through these standard APIs. For example, to change the paper margin, an application
needs to call the appropriate Microsoft Windows API method, which conveys the
desired changes to the printer driver. On Microsoft Windows, printer drivers are
printer specific; that is, you must install a specific printer driver for a printer. These
printer drivers know how to communicate to the printer and provide services to
applications that send output to the printer. Applications can access the printer
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properties, change their properties, and perform printing through these standard
APIs.

Motif and character-based UNIX operating systems do not have their own standard
interface to printers like Microsoft Windows. Individual applications are responsible
for sending their output in a streamed file to the printer and adhering to the
specifications of the printer. On UNIX platforms, Oracle Reports output must be
formatted properly (for example, PostScript or PCL) before sending it as a stream to
the printers. To print on UNIX, Oracle Reports mimics the behavior of the Microsoft
Windows printer drivers internally. The next section describes more precisely how
this mechanism works on UNIX.

10.1.2 Oracle Reports Printing Mechanism on UNIX and Windows

Figure 10-1 and Figure 10-2 depict the differences between Oracle Reports printing on
UNIX and on Microsoft Windows.

Figure 10-1 Oracle Reports printing on UNIX
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To support printing on UNIX, Oracle Reports internally creates logical printer drivers.
A logical printer driver simulates the behavior of Microsoft Windows printer drivers
and provides a printing service interface for Oracle Reports on UNIX. Through the
logical printer driver, Oracle Reports can access the printer properties and perform
printer-related operations. These logical drivers:

= Support PostScript and PCL printing specifications, which are the most popular
printing standards.

= Read the printer description files (for example, PPD or HPD) to get the printer
descriptions.

= Embed the various printer commands in the generated PostScript or PCL output.
For example, to change paper margin, the logical printer driver needs to write the
corresponding printer commands in the generated output. These commands differ
depending on whether you use a PostScript or a PCL printer. When the generated
PostScript or PCL file is sent to the printer through the printing executable (for
example, 1pr), the printer interprets the commands in the file and processes them
accordingly.

To function correctly, the logical printer drivers require the following input:

= The printer queue name that is used to spool the print request.

s The printer description file that contains the printer properties.

s The driver type required by the specified printer queue, PostScript or PCL.

You provide this information in a file called uiprint. txt. Oracle Reports uses this
file to get a list of the printer queue names available for printing. In uiprint. txt,
you must specify the printer queue name, the type of driver needed for the queue, the
version of the driver, and any special printer description file that the print driver
needs for that specific printer (for example, a PPD file for the PostScript driver). Once
this information is available, the internal logical printer drivers are constructed and
they use the definition files provided to access the printer properties.

10.1.3 Printing Support

Oracle Reports supports the following printing standards on UNIX:
»  PostScript Level 1 and 2

s PCLLevel 3

s ASCII (for character mode printing)

The printers you use with Oracle Reports should be compatible with these versions.

10.2 Setting Up a Printer on UNIX

This section describes:
» Installing a Printer on UNIX
= Verifying the Printer Setup for Oracle Reports

10.2.1 Installing a Printer on UNIX

The installation of a printer queue is slightly different depending upon your flavor of
UNIX. Some platforms may have user interface tools to help in the installation. Please
refer to your UNIX platform documentation for the steps on adding a printer queue.
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The following sample script adds a printer queue on the Solaris 2.6 platform. The
domain information expldomain and printer names printerl and printer2 are
hard coded in this example. The printer is a Xerox DCS model.

#!/bin/sh

echo "Please enter the Printer Name Either printerl or printer2\n"
read PRINTER

LOGFILE=/var/adm/config.log

PATH=/usr/bin: /usr/sbin: $PATH

export PRINTER LOGFILE PATH

lpsystem -t bsd expldomain >$LOGFILE 2>&1

lpadmin -p "SPRINTER" -s expldomain!"$PRINTER" -I any >SLOGFILE 2>&1
mkdir -p /usr/Xerox_DCS /usr/Xerox_DCS/original

chown -R 755 /usr/Xerox_DCS /usr/Xerox_DCS/original

cp /usr/bin/lp /usr/Xerox_DCS/original

mv /usr/bin/lp /usr/bin/lp.Xerox

In -s /tmp /usr/Xerox_DCS/tmp

echo "$PRINTER" > /usr/Xerox_DCS/printer.db

cp /usr/local/packages/dc99cc23.txt /usr/Xerox_DCS

In -s /usr/Xerox_DCS/dc99cc23.txt /usr/bin/lp

lpadmin -d "S$SPRINTER"

10.2.2 Verifying the Printer Setup for Oracle Reports

To verify that your printer queue installed correctly:

1. Ensure that the PPD or HPD file used with the installed printer queue is available
in the following location:

ORACLE_INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin/PPD
ORACLE_INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin/HPD

2. Ensure that the font metrics, AFM or TFM files, installed on the printer are
available in the following location:

ORACLE_HOME/guicommon/tk/admin/AFM
ORACLE_HOME/guicommon/tk/admin/TFM

10.3 Configuring the Printing Environment

This section explains the various configuration steps to be performed on UNIX after
printer installation.

=  Editing uiprint.txt File
s Environment Variables

= Print Property Dialog Boxes

10.3.1 Editing uiprint.txt File

As discussed in Section 10.1, "UNIX Printing Overview", Oracle Reports creates logical
printer drivers. To create these internal printer drivers, it needs information from you
like the available printer queue, the type of driver to be used with the queue, the
version of the driver, and the printer description file. uiprint.txt is the main file
for providing this information. It is located in:

INSTANCE_HOME/config/FRComponent/frcommon/guicommon/tk/admin/uiprint. txt
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uiprint.txt is the printer configuration file and Oracle Reports reads it when it
creates the internal printer drivers. You should modify this file for each instance of

Oracle Reports.

The format of entries in uiprint. txt is:

Printer:DriverType:DriverVersion:PrinterDescription:PrinterDescriptionFile:

This one line entry, in prescribed format, in uiprint. txt defines a printer to be used
by Oracle Reports. Each line contains five fields separated by colons. Table 10-1
describes each element of the uiprint. txt entry.

Table 10-1 uiprint.txt Entry Elements

Element

Description

Printer

DriverType

DriverVersion

PrinterDescription

Specifies the name of the printer (or printer queue), as used
with the 1pr or 1p command.

To get a list of all available printers, use the following
command:

Ipstat -a

To check the status of the printer, use the lpstat command:
Solaris

Ipstat -p printername

Linux

Ipstat -p printername

HP-UX

Ipstat -d printername

HP Tru64

Ipstat -p printername

IBM AIX

Ipstat -pprintername

No space is allowed after -p on IBM AIX.

Specifies the type of printer driver used for the printer. The
driver can be PostScript, PCL, or ASCIL

Specifies the version of the driver type that should be used.
This can be 1 or 2 for PostScript printers, and PCL Version 5 for
PCL.

Specifies the description of the printer, for example, the speed
and the location of the printer. This information is used for
display in the printer-related dialog box.
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Table 10-1 (Cont) uiprint.txt Entry Elements

Element Description

PrinterDescriptionFile Specifies the printer description file to be used with the printer.
It can be one of the following types:

= When using a PostScript printer, this entry contains the
name of a PPD file. PPD stands for PostScript Printer
Description. If Oracle Reports cannot find the specified
PPD file, it uses default . ppd. Oracle Reports searches
for PPD files in the following locations serially:

[ ORACLE_
INSTANCE/config/FRCompo
nent/frcommom/guicommon
/tk/admin/PPD

n ORACLE_
HOME/guicommon/tk/admin
/PPD

= When using a PCL printer, this entry contains the name of
an HPD file. If Oracle Reports cannot find the specified
HPD file, it uses ui4 . hpd. Oracle Reports searches for
HPD files in:

ORACLE_HOME/guicommon/tk/admin/HPD

s When using an ASCII printer, this entry would be set to
none. This field is ignored for all ASCII printers.

Usage Note:
s All the fields in the uiprint . txt entry must be filled and every line must end
with a colon.

= Atleast one entry must be defined in uiprint. txt. Alternatively, you can set
the related printer variables (TK_PRINTER and PRINTER). Without these, Oracle
Reports is unable to perform any printer-related task.

See Also: Section 10.3.2, "Environment Variables" for more
information on printer-related environment variables.

The internal printer drivers provide a drawing surface for Oracle Reports. In
addition to using this surface for printing, Oracle Reports uses it internally
whenever output is generated to a file. Hence, you must have a valid entry in
uiprint.txt or to set one of the printer-related environment variables. To
simplify the selection of printers for your users, we recommended that you list all
printers accessible to users in uiprint. txt.

Example:
Following are two example entries for uiprint. txt:

colprtld:PostScript:2:RMSC Atrium HPLaserJet5:default.ppd:
colprtl5PCL:5:RMSC 1st Floor HPLaser4:uid.hpd:

10.3.2 Environment Variables

This section lists the environment variables related to printing:
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See Also: Appendix B, "Environment Variables" for more
information on the environment variables that can be set in Oracle
Reports.

» TK_PRINTER / PRINTER

= TK_PRINTER

» TK_PRINT_STATUS

=  REPORTS_NO_DUMMY_PRINTER

» TK_HPD and ORACLE_HPD

» TK_PPD and ORACLE_PPD

» TK_TFM and ORACLE_TFM

» TK_AFM and ORACLE_AFM

10.3.3 Print Property Dialog Boxes

On UNIX, Oracle Reports Builder provides several dialog boxes for printer-related
operations.

10.3.3.1 Page Setup dialog box

The Page Setup dialog box enables you to specify how the printed page appears. The
available options depend on the type of printer driver being used. The internal printer
drivers use this dialog box to get all the information necessary, (for example, scale,
rotation, width, and height) for formatting a page on a printer.

10.3.3.2 Print Job dialog box

Each print job has unique characteristics depending on the printer driver being used.
The Print Job dialog box displays just prior to print job execution and prompts you for
the print job information required to send the job to the printer.

10.4 Printer-Related Files

This section explains the different printing related files. It gives an overview of these
files and also provides information for editing these files for common printing needs.

s Overview of Files
= PPD Files

= HPD Files

= Font Metrics Files
= uifont.ali

= uiprint.txt

= Editing the Printer-Related Files

10.4.1 Overview of Files
Table 10-2 lists files used by Oracle Reports for printing on UNIX.
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Table 10-2 Printer-Related Files Overview

File Name/Extension Description

.ppd PostScript Printer Definition file
.hpd HP glue file

.afm Adobe font metrics file

.tfm PCL font metrics file
uifont.ali font aliasing file

uiprint.txt printer configuration file

10.4.2 PPD Files

PostScript is Adobe's page description programming language. PPD files define what
capabilities a printer has for applications like Oracle Reports. For example, a PPD file
might define which paper tray to use, what paper sizes are available, what is the
physical dimension of the paper, and what font is available. Currently, Oracle Reports
reads the paper sizes and fonts available on the printer as well as its default resolution
from this file. In the future, more information may be used, such as memory for proper
image partitioning.

The only reason to modify the PPD file is to allow Oracle Reports to recognize newly
added fonts or memory. You can also change the DefaultPageSize to your
preferred page size.

Note: Page sizes, like all PPD entries, are case sensitive. Other
entries in the PPD file should generally be left undisturbed.

When you select a printer that is not listed in uiprint. txt or change the type of
printer to a PostScript type in the Choose Printer dialog box, you are prompted for the
PPD file for the printer. You must choose the PPD file for a printer that most closely
resembles the printer being used. PPD file names typically bear some resemblance to
the printer model name.

In uiprint.txt, a PPD file must be specified for each printer. If an invalid PPD file
is specified for the current printer (for example, no PPD file is found or the PPD file
format is wrong), Oracle Reports will use default.ppd for that printer. You should
make default.ppd a copy of another PPD file that better reflects the most likely
default, local printer.

Oracle Reports includes a common set of PPD files, but sometimes you may need to
get specific PPD files for your printers from the vendor. Table 10-3 shows some
examples of PPD files that are shipped with Oracle Reports:

Table 10-3 Common PPD Files Shipped with Oracle Reports

PPD File Name Corresponding Printer
appl230.ppd Apple LaserWriter v23.0
datap462.ppd Dataproducts LZR-2665
declps32.ppd Digital PrintServer 40
default.ppd Default Level 1 PostScript Printer
hpljet4dl.ppd HP LaserJet 4/4M PostScript 600DPI
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Table 10-3 (Cont.) Common PPD Files Shipped with Oracle Reports

PPD File Name Corresponding Printer

lwntx470.ppd Apple LaserWriter II NTX

nccps801.ppd NEC Colormate PS/80

tkphzr33.ppd Tektronix Phaser III PXi v2011.108

1530_523.ppd Linotronic 530

screenprinter.ppd Bil;%t(ﬂt PPD file to be used when a printer is not available on

If you need a PPD file that is not among those shipped with Oracle Reports, you must
do one of the following (in order of preference):

= Ask the printer vendor for the PPD file.

= Download the PPD file from Adobe's Web site.

= Copy an existing PPD file and edit it.

= Ask Adobe for the PPD specs and write the PPD file.

The PostScript file only has the font information not the font metrics. Oracle Reports
refers to the AFM file installed for the font metrics information. The font vendors
provide these AFM files. Oracle Reports ships AFM files for some of the most
commonly used fonts. The printer must have the required font installed in order to
correctly print the PostScript file generated by Oracle Reports.

10.4.2.1 Local Customization of PPD files

A PPD file is a static representation of the features of a printer. It contains default
factory settings. Once a printer is installed, features such as additional memory, paper
trays, and fonts may be added to the device. The task of managing a device is a
dynamic issue that requires keeping track of fonts downloaded to disk, error handlers,
RAM-based fonts and procedure sets, default device setup, and so forth. This kind of
device management is beyond the scope of PPD files. However, there are some
provisions for customizing the information contained in PPD files to adapt them to
local instances of printers or to specific applications when necessary.

Instead of modifying the original PPD file, another approach would be having a new
file having the local customization of certain parameters and refer to the primary file
for the remaining information. The local customization file must contain a reference to
the primary PPD file in this format:

*Include: "filename"

where filename is the name of the primary PPD file. This referencing allows a
system administrator to later replace the primary PPD file without forcing users to edit
their local customization files. A file referenced by the *Include keyword is treated
as though it were in the including (local customization) file.

For example, suppose that the default .ppd file is defined as:
*PPD-Adobe: "4.0"
*Include: "datap462.ppd"

*% Page definitions
*DefaultPageSize: Letter

*DefaultPageRegion: Letter
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The primary PPD file is datap462 . ppd.

Administrators should change the name of the included file to conform to their site's
default printer type.

When a local customization file includes a primary PPD file, there might be several
instances of the same keyword in the composite file. Hence, the location of the primary
file in the customization file (beginning or end) is important and effects the changes
made by the customization file.

10.4.3 HPD Files

HPD files provide functionality for PCL printers that is similar to what PPD files
provide for PostScript printers. HPD or HP glue files provide information on what
fonts are available for a PCL printer. The HPD file format can be found in the HP PCL5
Developer’s Guide.

Just as PostScript has AFM files, every HP font must have an associated TFM file. The
font vendor should provide TFM files and new fonts should be added to the HPD file
for your printer when installed. For a new font, you should specify the following fields
in the HPD file:

FONT={fontname}
/tfm={tfm-filename}

where
fontname is a descriptive name for the font.
tfm-filename is the base file name for the TFM file.

If the TFM file isn't specific enough, you can also specify the following after the FONT
field:

/ptsize={size {size ...}}

If the specified font is a bit mapped font but is listed in the TFM file as a scalable font,
you can limit the point sizes used by listing the acceptable sizes as follows:
/symset={symset {symset ...}}

This field limits the supported symbol sets to those listed. See the HP PCL
documentation for a list of recognized symbol sets.

Oracle Reports also supports the defaultpaper field for printing to PCL format.
This field can be used to set the defaultpaper to be used by the Toolkit. The format
of this field is:

<defaultpaper={papername}>

For example, the following sets the paper name to A4:

<defaultpaper=A4>

The paper name is case insensitive. If you specify defaultpaper in more than one
place, then the last instance of defaultpaper is used. If you specify a paper name
that is not supported by the printer, defaultpaper is ignored and LETTER is used as
the paper name instead. Similarly, if the paper name is incorrect, then LETTER is used.

10.4.4 Font Metrics Files

Oracle Reports supports two kinds of font metrics files:
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= AFM files
» TEM files

10.4.4.1 AFM files

Each AFM files contains the font-related metrics for a single font. The metrics include
various font attributes such as style, weight, width, and character set. AFM files and a
description of the AFM file format are typically available from the font or printer
vendors.

To install the AFM file, just copy it to the AFM file location, which is listed in
Section 10.2.2, "Verifying the Printer Setup for Oracle Reports". The name of the file
must match name of the font without the . afm extension. For example, if the font
name is CodedreineunBold, the file name must be CodedreineunBold.

To verify the font name, you can look for the fontname string in the AFM file. Please
note that the AFM files are not font files, they are metrics files, which give information
on how to properly format the characters for the printer. If you have an AFM file for a
font, but the font is not present on the printer, Oracle Reports cannot generate the
correct output on the printer because of the font metrics mismatch. You must ensure
that the font used to design the report is also available on the printer.

10.4.4.2 TFM files

PCL uses HPD and TFM files. The HPD file contains the list of available fonts for the
printer and each font refers to a TFM file. TFM files serve the same purpose as Adobe's
AFM files, with each file listing information about a single font. The HPD file is an
ASCII file, which can be edited, but the TFM file is a binary file, which cannot be
edited.

To use a new font in Oracle Reports and have it appear correctly in PCL output, you
need the HPD and TFM files for the printer. You can copy an HPD file from an
existing one, after you ensure it is suitable for your printer. The fonts specified in the
HPD file must be available on the printer.

Oracle Reports includes a common set of TFM files. If you need other font metrics files
for your printer, you should obtain them from your font or printer vendor. To install
the TEM file, just copy it to the TEM file location, which is listed in Section 10.2.2,
"Verifying the Printer Setup for Oracle Reports".

10.4.5 uifont.ali

The uifont.ali file defines the font aliases used by Oracle Reports. It is an
extremely useful tool for cross-platform development because it enables you to define
which fonts to substitute when a particular font is unavailable. uifont.ali is located
in:

On Windows: ORACLE_
INSTANCE\config\FRComponent\ frcommon\tools\common

On UNIX: ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin

To alias a font, use the following syntax:

source_font = destination_font

For each font, you may also specify the following attributes:

face.size.style.weight.width.character_set
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Styles may also be combined using a plus sign + to delimit the styles. For example:
Arial.Italic+Overstrike = Helvetica.l2.Italic.Bold
This entry maps any Arial font that has both Italic and Overstrike styles to a 12-point,

bold, and italic Helvetica font. Font faces can be case sensitive depending on the
platform and the surface; that is, printer or system.

See Also: Chapter 9, "Managing Fonts in Oracle Reports" for
more font-related information.

10.4.6 uiprint.txt

uiprint.txt provides a convenient way for you to provide details about the printer
queue, such as the type of printer driver and the printer description. You should edit
uiprint. txt for each instance of Oracle Reports.

See Also: Section 10.3.1, "Editing uiprint.txt File" for more
information about uiprint. txt.

10.4.7 Editing the Printer-Related Files

This section describes how to edit the various print-related files:
= Editing PPD files
= Editing HPD files for PCL printing

10.4.7.1 Editing PPD files

In some cases, you may need to change certain attributes in your PPD file. The sections
that follow describe some of the attributes that you would commonly want to change:

s Changing the default paper size

s Changing the printer margin settings

= Adding a new font entry to PPD files

= Overriding the printer tray setting

10.4.7.1.1 Changing the default paper size Suppose that you need the page size to be A4
for some of your reports. On UNIX platforms, the printer driver is specified in
uiprint.txt and the default page size is not necessarily set to A4. For example,

hpljet4l.ppdhas LETTER as the default page size. Note that the default page size
setting for each printer queue is taken from the corresponding PPD file.

To set A4 as the default page size, you would do the following:

1. Edituiprint.txt to include a PostScript Printer Description file (extension is
.ppd) that supports the A4 page size. For example, you might include
hpljetdl.ppd.

2. Asabackup, make a copy of hpljet4l.ppd.
3. Addanentry touiprint.txt:

Printer_name: PostScript:1: the printer on floorl:hpljet4l.ppd

4. Edit hpljet4l.ppd and change these settings as follows:

DefaultPageSize: A4
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DefaultPageRegion: A4
DefaultImageableArea: A4
DefaultPaperDimension: A4

10.4.7.1.2 Changing the printer margin settings To change the margins, you must modify
the ImageableArea section in the PPD file. ImageableArea provides the bounding box
of the area in which the printer may print for the page size named mediaOption. There
will be one statement for each named page size supported by the device.
*DefaultimageableArea provides the mediaOption name of the default imageable area.
Since there can be only one default page size, this value should be the same as the
value of *DefaultPageSize, *DefaultPageRegion, and *DefaultPaperDimension.

The syntax for defining imageable area is as follows:

*ImageableArea mediaOption: "llx 1lly urx ury "
*DefaultImageableArea: mediaOption | Unknown

11 stands for lower left corner and ur for upper right corner. The bounding box value
of *ImageableArea is given as four real numbers, representing the x and y coordinates
of the lower left and upper right corners of the region, respectively, in the PostScript
language default user space coordinate system. The x and y axes of a given page size
correspond to the x and y axes of that page size in the *PaperDimension entry.

The imageable area is defined as the part of the page where the printer may actually
make marks. On some printers, the imageable area of a given page size varies as a
result of the current resolution, amount of memory, the direction of paper feed, and
other factors. In PPD files where the imageable area of a given page size can vary, the
imageable area recorded for that page size will be the intersection of all possible
imageable areas for that page size. This formula ensures that the available imageable
area is never smaller than that shown in the PPD file and all marks made within the
imageable area will be visible. It does, however, also mean that the imageable area in
the current configuration might actually be larger than the imageable area shown in
the PPD file.

The following table contains the option keywords currently registered for
mediaOption, which designates a given page size on a device:

Table 10-4 mediaOption Keywords

mediaOption

(Paper Size) Size (pts) Size (mm) Size (inches)
Letter 612 * 792 2159*279.4 8.5*11
Legal 612 * 1008 215.9 * 355.6 85*14
Ledger 1224 * 792 431.8*279.4 17*11
Tabloid 792 %1224 279.4 *431.8 11*17

A3 842 * 1191 297 * 420 11.69 * 16.54
A4 595 * 842 210 * 297 8.27 * 11.69
A5 420 * 595 148 * 210 5.83 *8.27
B4 729 * 1032 257 * 364 10.12 * 14.33
B5 516 * 729 182 * 257 717 *10.12
Example

To change the margins of an A4 page in the default.ppd, you would perform the
following steps:
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1. Modify the default page from Letter to A4 in the following sections:

*% Page definitions
*DefaultPageSize: A4d
*PageSize Ad: " "

*% These entries set up the frame buffer. Usually used with manual feed.
*Defaul tPageRegion: A4
*PageRegion Ad: "A4"

*% These provide the physical dimensions of the paper (by keyword)
*DefaultPaperDimension: A4
*PaperDimension A4: "595 842"

2. Add the margin definition in the following sections:

*% Imageable (writable) areas for each page size, in pixels
*DefaultImageableArea: Ad
*ImageableArea Ad: "2 2 593 840 "

Note: All PPD entries are case sensitive.

10.4.7.1.3 Adding a new font entry to PPD files On PostScript printers, Oracle Reports only
enables you to use fonts known to be available on the printer. Since printers are rarely

available for personal requests on multiprocess operating systems, Oracle Reports gets
a complete list of fonts from the PPD file.

When a new font is installed on the printer, a corresponding font entry needs to be
added to the printer's PPD file. The format for a font entry is:

*Font {fontname}: {encoding} " ({version})" {charset}

where

{fontname} is the Adobe font face name as specified in PostScript.
{encoding} is the PostScript encoding name.

{version} is the FontInfo version number.

{charset} is the Adobe character set.

The encoding value has slightly different meanings depending on the font type. If
the encoding cannot be determined, the value of encoding may be set to unknown.
Fonts are usually re-encoded by applications to provide other encodings; the charset
value for each font indicates which encodings are possible for that font. For more
information, please refer to the PPD specification from Adobe.

When new fonts are added to the printer, the matching AFM files must also be added
to the font metrics directory. Oracle Reports requires the AFM files to get the actual
font attributes and properly place text on the printed page.

Example

Suppose you add a new font, CodedreineunBold, and want to edit the PPD file to
include the new font.

1. In the PPD file, search for:

*$ Font Information

2. For the new font, append the following at the end of the paragraph:
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*Font CodedreineunBold: Standard " (00.1001)" Standard ROM

10.4.7.1.4 Overriding the printer tray setting The PostScript output generated by Oracle
Reports has the tray information embedded into it. The PPD file defines the default
tray to be used and is followed by the definitions of valid trays for the printer. To print
to a different tray, the DefaultInputSlot entry in the PPD file must be updated.

In the PPD file, you should find a section that lists the default tray and the valid input
slots. The section typically starts with a line like this one:

*OpenUI *InputSlot: <PickOne>

The default tray entry looks like the following;:

*DefaultInputSlot: Lower

The defined slots typically follow the default entry and look like the following;:

*InputSlot Upper/Multipurpose Tray: "
*InputSlot Lower/Paper Cassette: "

The section ends with a line like the following:

*CloseUI: *InputSlot

You can set DefaultInputSlot to be any of the values in the list of defined slots.

10.4.7.2 Editing HPD files for PCL printing

In some cases, you may need to change certain attributes in you HPD file. The sections
that follow describe some of the attributes that you would commonly want to change:

= Changing the paper size
= Adding a new font entry
10.4.7.2.1 Changing the paper size For example, to change the papersize to A4, add the
following to the HPD file used:
<defaultpaper=A4>
10.4.7.2.2 Adding a new font entry As with PostScript's AFM files, every HP font must

have a TEM file in order for Oracle Reports to use it. The font vendor should provide
TFM files. You should add new fonts to the HPD file when you install them.

You must specify the following settings in the HPD file for any new font:

FONT={fontname} # {fontname} is a descriptive name for the font
/tfm={tfm-filename} # {tfm-filename} is the base filename for TFM file

Note: The font name entries in HPD files must be unique.

10.5 Enhanced Printing on Linux Using CUPS

Common UNIX Printing System (CUPS) is the default printing system on most Linux
distributions. This section describes how to set up CUPS for printing from Reports
Server.

The primary advantage of CUPS is that it is a standard and modularized printing
system that can process numerous data formats on the print server and also supports
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Internet Printing Protocol (IPP). With this feature, it is possible to directly print PDF
files from Reports Server and it also simplifies network printing.

Figure 10-3 shows how Oracle Reports interacts with CUPS.

Figure 10-3 Interaction Between Oracle Reports and CUPS Server
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With this configuration, printers must be configured on all the CUPS running on all
the machines where Reports Server is running.

Several text files are used to configure CUPS. Refer to the CUPS Software Administrators
Manual athttp://www.cups.org/doc-1.1/sam.html#CONTENTS for complete
configuration information.

By default, CUPS does not allow access from other network machines. To configure
CUPS to allow access from remote machines, perform the following steps:

1. Enter the following command to open a CUPS configuration file:

open /etc/cups/cupsd.conf

2. Add a Listen instruction, as follows:

a. Scroll to the bottom of the configuration file where the other Listen
instructions are declared.

b. CopyListen 127.0.0.1:631 and paste it above or below the original.
c. Replace 127.0.0.1 with the Linux server’s IP address.

3. Configure each printer, as follows:
a. In the configuration file, locate:

<Location /printers/your_printer_queue>

b. Comment the instruction Deny From All.

c. ChangeAllow from 127.0.0.1toAllow from All.

d. Repeat for all printer or fax queues that you wan to make accessible.
4. Save the configuration file and restart CUPS.

= To stop CUPS, enter the following command:

/etc/rc.d/init.d/cups stop
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»  To start CUPS, enter the following command:

/etc/rc.d/init.d/cups start

The Red Hat Advanced Server provides a configuration wizard to help you set up
your printers. To use the configuration wizard for this task, perform the following
steps:

1.

While logged on as the root user, open a command prompt and enter:

redhat-config-printer

to display the Printer configuration window.

Select the New tab to launch the Add a new print queue wizard.

Follow the wizard prompts to:

= Enter a queue name.

»  Select the queue type.

= Select the printer model.

Review your selections and click Apply to create your new print queue.
Test your printer on CUPS, as follows:

s Launch a browser on RedHat with the URL http://localhost:631.
»  Select the Printers tab. The printer you just created will be listed.

»  Click Print Test Page to test your printer setup. If the test page does not print,
repeat the configuration steps. Ensure that your printer type and model
selections are correct.

Note: 1padmin can also be used to add a printer from the command
line. Refer to the Linux man page for this command for more details.

10.5.1 Setting Up a Single Server for Printing

The default CUPS configuration is to use Localhost as the print server. To make the
CUPS use a remote server, you must change the server name in the
/etc/cups/client.conf file.

Figure 104 illustrates adding printers to a single CUPS server, and configuring all
other machines running Reports Server to route their print requests to the remote
CUPS server.
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Figure 10-4 Routing Print Requests to a Single Remote CUPS Server

Reparts
Server

Frinter 2

For information about the various other printing models, refer to the CUPS Software
Administrators Manual at http: //www.cups.org/doc-1.1/sam.html#CONTENTS

Note: When Oracle Reports adds a printer to the CUPS server, it
assigns a printer name, which is the name that must be used when
referring that printer. Internally, the name is translated to the proper
call depending on the device URI used in the configuration.

10.6 Globalization Support

This section explains multibyte character set printing support in Oracle Reports. It also
explains the IX and PASTA utilities, which are supported only for Oracle Reports
when installed and used in conjunction with Oracle Applications.

= Multibyte Character Set Printing
s Overview of IX and PASTA

10.6.1 Multibyte Character Set Printing

Oracle Reports does not currently support Unicode character sets in PostScript output.
As an alternative, you can use Oracle Reports PDF output (desformat=pdf), which
supports multibyte character sets, and print it.

Oracle Reports supports a set of encoding schemes for the AFM files for the multibyte
character sets.

See Also: Chapter 9, "Managing Fonts in Oracle Reports" and

Chapter 11, "Using PDF in Oracle Reports" for more font-related
information.

The fonts must be installed on the printer that prints the PostScript report output.
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Example

Suppose you build a report and its generated PostScript output contains a Chinese
character set. First, you need AFM and PPD files that adhere to the encoding scheme
for multibyte character sets. The destination printer must also have the required
Chinese fonts installed because the PostScript file generated by Oracle Reports on
UNIX does not have fonts embedded in it. The PostScript file contains only the font
name and the font metrics taken from the AFM files. If you try to send the report to a
printer that does not have the Chinese fonts installed, it will not print the Chinese
characters properly.

10.6.2 Overview of IX and PASTA

When installed and used with Oracle Applications, Oracle Reports includes utilities
for font embedding in PostScript output.

For character-mode reports, the utility is called PASTA. For bit-mapped reports, the
utility IX enables you to embed the fonts in the PostScript output, thereby allowing
you to print even if the font is not installed on the printer. Both PASTA and IX are
supported only for Oracle Reports used with Oracle Applications.

When used for character-mode reports, PASTA takes tagged character mode output
(generated through an appropriate prt file) and generates a PostScript rendition of it.
IX enables Oracle Reports to print PostScript bit-mapped reports for all character sets,
including UTF8, on a PostScript printer. With this functionality, PostScript printing in
Unicode as well as all native languages on UNIX is supported. The IX library is turned
off by default with the Oracle Reports patch.

Please refer to your Oracle Applications System Administrator’s Guide for the setup and
usage information for IX and PASTA with Oracle Reports. If you are a member of
Oracle Metalink (http://metalink.oracle.com), you can also get this
information from MetaLink notes 189708.1 and 159225.

If you have problems with PASTA, you can use the following technique to isolate the
problem:

1. Unset the PASTA environment variable.
2. Try to perform the steps that caused the problem again.

3. If the problem reproduces without the environment variable set, then it should be
treated as a normal Oracle Reports printing problem and the diagnostic steps
provided in this document should be applied.

If the problem reproduces only with the PASTA environment variable set, then
follow the diagnostic process given in the Oracle Applications documentation.

10.7 Debugging Options

This section explains the different environment variables and techniques available in
Oracle Reports for the debugging of UNIX printing problems.

» DEBUG_SLFIND
» TK_DEBUG_POSTSCRIPT

10.7.1 DEBUG_SLFIND

If this environment variable is set, the file-finding routine lists what was searched for
and where Oracle Reports searched for it. This information is a tremendous help if
your current configuration does not work. You can send the output to a file, stdout
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(for standard output), or to stderr (for output to standard error). If you try to send
the output to a file and it cannot be written to, Oracle Reports uses stderr instead.

We recommend sending the output to a file because it is faster and the output can be
quite large. Sample output from DEBUG_SLFIND is shown below. Notice how the
debug information generated helps you identify the various setup issues, such as
which PPD and AFM files are being referred to and their location.

You can see all of the following in this output:

s The various environment variables, such as TK_PPD and TK_AFM, and their
values.

s The resource files, such as the PPD and AFM, and their locations, which helps you
to determine if any are the missing.

s The default location of various resource files under ORACLE_HOME.

slsfindfile(): checking environment variable TK_PPD(8).
slsfindfile(): environment variable not set

slsfindfile(): checking environment variable ORACLE_PPD(10).
slsfindfile(): environment variable not set

slfpath(): looking up path

/oraclehome/guicommon/tk/admin/PPD/

slfexist(): testing /oraclehome/guicommon/tk/admin/PPD

slfexist(): testing /oraclehome/guicommon/tk/admin/PPD/default.ppd
slsfindfile() :returned
/oraclehome/guicommon/tk/admin/PPD/default.ppd

slfindfile(): type = 39 (AFM)slfindfile(): name = Courier-Bold

slsfindfile(): checking environment variable TK_AFM(8).
slsfindfile(): environment variable not set

slsfindfile(): checking environment variable ORACLE_AFM(10).
slsfindfile(): checking ORACLE_HOME environment variable.
slsfindfile(): environment variable set to /oraclehome (len=18)
slfpath(): looking up path/oraclehome/guicommon/tk/admin/AFM/
slfexist(): testing /oraclehome/guicommon/tk/admin/AFM

slfexist(): testing /oraclehome/guicommon/tk/admin/AFM/Courier-Bold

slsfindfile() :returned /oraclehome/guicommon/tk/admin/AFM/Courier-Bold

(
slfindfile(): name = uiprint.txt
slsfindfile(): checking ORACLE_HOME environment variable.
slfpath(): looking up path/oraclehome/guicommon/tk/admin/
slfexist(): testing /oraclehome/guicommon/tk/admin
slfexist(): testing /oraclehome/guicommon/tk/admin/uiprint.txt
slsfindfile(): returned /oraclehome/guicommon/tk/admin/uiprint.txt

10.7.2 TK_DEBUG_POSTSCRIPT

This variable effects the PostScript output generated by Oracle Reports. Table 10-5
shows the settings for this variable.

Table 10-5 Settings for TK_DEBUG_POSTSCRIPT

Setting Description

Functions (Func) Function lists each toolkit function called in comments in the
PostScript output.

Long (L) Long produces more intelligible PostScript output but runs

much more slowly than normal PostScript generation.

Memory (Mem) Memory displays memory usage at the bottom of each page.
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Any of the options can appear in the environment variable, abbreviated down to one
letter. You can set it to any combination of these, separated by "/". This variable is case
insensitive. For example, Func/L/Mem would give you all three options.

Note: The PostScript output from this variable is for your own
debugging purposes. You need not provide this output to Oracle
Support for investigation.

10.8 Removing DISPLAY and Printer Dependencies on UNIX

Prior to Oracle Reports 10g Release 1 (9.0.4) on UNIX, you had to set the DISPLAY
environment variable in order for Reports Server to use the windowing system display
surface for creating images and getting pixel resolution. This dependency is removed
with Oracle Reports 10g.

Additionally, earlier releases required a valid printer on UNIX for fonts. When no
valid printer was available, Oracle Reports Services used the screen fonts, which again
required setting the DISPLAY environment variable. Now, Oracle Reports Services
includes a default screen printer surface, ScreenPrinter, that emulates a screen or
printer for fonts in the absence of an available printer. As a result, Oracle Reports
Services no longer requires a printer on UNIX.

By default, the environment variable REPORTS_DEFAULT_DISPLAY is set to YES,
which specifies that Oracle Reports Services should:

= remove the dependency on the DISPLAY environment variable (UNIX only)

= use ScreenPrinter for surface resolution for images and font information (UNIX
only)

= enable the Advanced Imaging Support (all platforms)
If you wish to revert to the dependency on the DISPLAY environment variable as in

releases prior to 10g Release 1 (9.0.4), you can set REPORTS_DEFAULT_DISPLAY=NO.

See Also: Section B.1.41, "REPORTS_DEFAULT_DISPLAY"

10.8.1 ScreenPrinter

The PostScript printer driver screenprinter . ppd provides surface resolution for
images and specifies font information. This driver is the first entry in
uiscreenprint. txt. The file locations (UNIX only) are:

uiscreenprint.txt : ORACLE_INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin
screenprinter.ppd : ORACLE_
INSTANCE/config/FRComponent /frcommon/guicommon/tk/admin/PPD

Note: Beginning in Oracle Reports 11¢ Release 1 (11.1.1),
configuration of screenprinter.ppd should be done only through
Oracle Enterprise Manager. Refer to Chapter 7, "Administering Oracle
Reports Services Using Oracle Enterprise Manager", Section 7.9.1,
"Configuring Fonts"for information about updating configuration
settings through Oracle Enterprise Manager.

ScreenPrinter is used for:

m  Surface resolution when REPORTS_DEFAULT DISPLAY=YES.
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= Removal of the printer dependency.

If, when generating report output, there is no valid printer queue available (not found
from TK_PRINTER, ORACLE_PRINTER, PRINTER, or uiprint. txt), the surface
based on screenprinter.ppd will be created and used to get font information. You
can modify the Fonts section of screenprinter.ppd to include new fonts, and
modify the DefaultResolution field to change the resolution
(DefaultResolution is 96).

Note: If you do add new fonts, ensure that the new AFM metrics
files are placed in the AFM directory.

The font look up algorithm on UNIX is:

if a valid printer available then
look up font information from the printer
else
create a screenPrinter surface
look up font information from ScreenPrinter
if ScreenPrinter creation fails then
REP-1800 : Formatter Error if REPORTS_DEFAULT DISPLAY is set
else
use Screen Fonts

Note: In certain multibyte languages like Chinese, you may want
to use screen fonts. However, this would necessitate setting the
DISPLAY variable for running the report.

To revert to DISPLAY and use screen fonts (old font look up
algorithm):

s Set REPORTS_DEFAULT_DISPLAY=NO

= Remove the screenprinter.ppd entry in the
uiscreenprint.txt file.

See Also:

»  Chapter 9, "Managing Fonts in Oracle Reports"

10.8.2 Advanced Imaging Support

The quality of images contributes considerably to the overall appearance of a report,
particularly for a Web report. You may prefer different image formats in your report
output depending on the needs of your project. For example, an aeronautical firm
might prefer the higher quality of JPEG or PNG images in their Web reports instead of
GIF images. On the other hand, if you are building a Web portal, you might prefer GIF
images because of their smaller size and faster download. Similarly, you may wish to
import images of these various formats into your report.

Depending on the format of your output, you may choose from a variety of formats
for your images.

Table 10-6 Image Format Options by Output Type

Report Output Available Image Format Choices

HTML, HTMLCSS PNG, JPEG, JPG, GIF
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Table 10-6 (Cont.) Image Format Options by Output Type

Report Output Available Image Format Choices
PDF PNG, JPEG, JPG, GIF
RTF PNG, JPEG, JPG, BMP

Note: As you choose your image format, you should take into
account the quality and size considerations. Typically, the higher
the quality of the image format, the greater the size. For example,
PNG and JPEG are higher quality than GIF, but they may also
require more storage space.

To enable advanced imaging, you must set the REPORTS_DEFAULT_DISPLAY
environment variable to YES. The REPORTS_OUTPUTIMAGEFORMAT environment
variable lets you choose the default image type. Users can override the default choice
for images with the OUTPUTIMAGEFORMAT command line keyword. For example:

rwclient server=my_rep_server report=images.rdf destype=file desformat=html

desname=images.html userid=scott/tiger outputimageformat=PNG

Enabling advanced imaging also enables you to import images of these same formats
into your report.

Usage Notes

= UNIX only: Enabling advanced imaging means that you can no longer use the old
Computer Graphics Metafile (CGM) and Oracle Graphics Data (OGD) formats in
HTML or HTMLCSS output. If you require these formats for input sources, you
should set REPORTS_DEFAULT_DISPLAY=NO. This limitation does not apply on
the Windows platform.

= Running a report with JPEG images (REPORTS_OUTPUTIMAGEFORMAT=JPEG) to

RTF output causes an increase in the RTF file size that is not directly proportionate
to the image size. This occurs because the binary image stream is first converted to
HEX characters and then written to RTF. This conversion increases the file size.
This is consistent with the RTF specification and is expected behavior. However,
an RTF file with JPEG images is of a smaller size when compared to an RTF file
with BMP images.

See Also:

= Section A.7.3, "OUTPUTIMAGEFORMAT"

= Section B.1.41, "REPORTS_DEFAULT_DISPLAY"

s Section B.1.57, "REPORTS_OUTPUTIMAGEFORMAT"

10.9 Frequently Asked Questions
This section addresses some commonly encountered problems with UNIX printing.
s Common Printing Error Messages
s PCL Printing Issues
s PostScript Printing Issues

= Font-Related Printing Issues
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»  Printed Output Issues

Note: Reports Server uses rwlpr for submitting a print job. For
rwlpr logging for Windows, when you enable tracing for Reports
Server using either traceModule=all or
traceModule=server, a printing diagnostic log (server._
name-rwlpr-jobid.log)is created in the log directory
($ORACLE_
INSTANCE/diagnostics/logs/ReportsServerComponent /<
reports server name>)for destype=printer. This log file
will contain information regarding the messages that can be used to
diagnose any printing issues, such as spooler problem.

10.9.1 Common Printing Error Messages
REP-00177 - Error while running in remote server
REP-1800 - Formatter error
REP-3300 - Fatal error in component name
UI-9 - This function call is out of context.
REP-3002: Internal error initializing printer information

Cause:
These errors generally indicate a printer configuration issue.

Action:
Check the printer queues that have been defined at the operating system level in your
setup. You can use:

m lpc status

s lpstat -a

If a valid printer queue is installed, check for the following;:

= uiprint.txt musthave a valid entry for the printer.

s Oracle Reports must be able to open and read the uiprint . txt file:

The person running the report must have operating system level read permissions
onuiprint.txt. Oracle Reports must be able to open the uiprint. txt. UNIX
operating systems do have an open file limit. If you are over that limit, Oracle
Reports might not be able to open uiprint. txt.

s The printer description files specified in uiprint. txt must exist in your
installation in:

ORACLE_INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin
»  The printer specified in uiprint. txt must be enabled at the operating system
level. A quick test is to try printing any file from the command line using 1p or

lpr. If you can print using one of these commands and get the output on the
printer, then the printer is enabled.
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s The printer queue and uiprint . txt entry syntax must be valid.

If the printer validation fails, refer to the environment variables TK_PRINT_
STATUS and REPORTS_NO_DUMMY_PRINTER in Appendix B, "Environment
Variables".

REP-00826 - Invalid printer driver xxx specified by parameter desformat.
REP-00177 - Error while running in remote server (When run through CGl)

Cause:

An invalid value was specified for DESFORMAT for the specified report execution
mode.

Action:

The DESFORMAT parameter specifies which output format is needed. Valid formats
are:

= For bitmapped reports, any of the output formats supported by Oracle Reports
(PostScript, PCL, PDF, HTML, XML, HTMLCSS, ENHANCEDSPREADSHEET,
SPREADSHEET) is valid for DESFORMAT. You should not give the PRT file names
here. While running to a file, the DESFORMAT parameter needs to be set to a valid
printer queue. Oracle Reports uses the printer definition file associated with the
printer to format the output.

= For character mode reports, DESFORMAT sets up the output for ASCII printers and
passes escape characters. For running character mode reports, ensure that you
change the MODE parameter to Character and use any valid .PRT file.

Table 10-7 maps the command line options (DESTYPE, DESNAME, and DESFORMAT) to
the printer by what you are trying to achieve.

Table 10-7 DESTYPE, DESNAME, and DESFORMAT Settings By Case

Case DESTYPE DESNAME DESFORMAT
Generating to a file FILE file name.ps printer name
Printing PRINTER printer name

DISTRIBUTE=YES printer_name
MODE=CHARACTER file name.prt

REP-01800 - Formatter error.

REP-00177 - Error while running in remote server
(When run through CGI)

Cause:

The error indicates that a printer configuration issue has occurred on a UNIX server.
Even if there is not a physical printer available on the system, you have to set it up as
if there was one.

Action:
1. Verify that there is a valid entry in uiprint. txt.
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2, If you have multiple printer queue entries in uiprint. txt and you want to set
the default printer, verify that the environment variable is set to a printer that is
listed in uiprint. txt. If the related environment variable is not set, then the first
entry in uiprint. txt is used. For more information on printer-related
environment variables, refer to Appendix B, "Environment Variables".

If there is no printer available for your system, refer to Section 10.3, "Configuring the
Printing Environment" for alternatives.

Error while printing to a printer with spaces in its name

Cause:

If you are on Solaris 2.8 and have printers that have spaces in the names, you may
encounter a bug that causes an error resulting from the 1pr/1p command including
quotes around the printer name.

Action:
To resolve this issue, you must do either one of the following:

= Remove the spaces in the printer's name.

= Install the Solaris 2.8 patch from Sun Microsystems that fixes the 1pr/1p
command so that quotes can be used in printers names.

and

= Modify the section of rwlpr. sh that provides the workaround for including
quotes, in order to make accessible any printer that has a space in the name. The
rwlpr. sh file is located in the SORACLE_INSTANCE/config/reports/bin
directory.

Specifically, make the following changes:

#either LPR or LP Command was found
if [ -x $PRNCMDPATH ]

then
if [ “basename $PRNCMDPATH' = "lpr" ]
then
#if [ " /usr/bin/uname -r' = "5.8" ]
#then
#S$PRNCMDPATH ‘echo $@ | tr -d "\"""
#else
$PRNCMDPATH "$@"
#f1
else
# parse and Fix the command Line as Required by lp
#if [ " /usr/bin/uname -r' = "5.8" ]
#then
#getLpCommandLine ‘echo $@ | tr -d "\""’
#telse
getLpCommandLine "$@"
#f1
$SPRNCMDPATH
fi

# exit with the command's exit code , This will tell the
# server Print module if the command completed successfully
# or not.
exit $?
fi
done
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Printing on Solaris 2.9
If you print a report using the DESTYPE=PRINTER and the DESNAME=printer_name
command line options on Solaris 2.9, you will encounter the following errors:

REP-0069: Internal error
REP-57054: Inprocess job terminated with error
REP-50157: Error while sending file to printer 20p837a.Exit with error code 1

To resolve this issue, you must do the following:

Note: Create a backup of the rwlpr. sh file before proceeding. On
Solaris, rwlpr . shis the printing script file located in the SORACLE_
INSTANCE/config/reports/bin directory. This script file
supports 1p and lpr commands by default.

1. Navigate to the following line at the end of the file:

#either LPR or LP Command was found

2. Add an OR operator to the existing 1 f. . . else condition.

if [ ‘uname -r’ = "5.8" ] || [ ‘uname -r' = "5.9" ] # If Solaris Release 5.8 /
5.9

else
# parse and Fix the command Line as Required by lp

if [ ‘uname -r' = "5.8" ] || [ ‘uname -r' = "5.9" 1# If Solaris Release
5.8/ 5.9

3. Theif...else if condition checks for the Solaris Release version. Based on the
version number, it strips the quotes from the printer name and passes it to the
print command.

10.9.2 PCL Printing Issues

Why do fields that appear as gray on my PC print as white on a UNIX PCL
printer?

PCL color printing is not supported. When the pattern is set to transparent, PCL
printing uses the white pen (in PCL language) to draw. When the pattern is set to a
solid pattern, it uses the black pen. This behavior occurs irrespective of what color is
set for the foreground or background. PostScript printing logic is different. It uses the
foreground color set when the pattern is solid and the background color set when the
pattern is transparent.

What PCL level is supported in Oracle Reports?

The Oracle Reports PCL driver currently supports the features of PCL Level 3. It does
support HPD files for later PCL versions, but it will not honor the additional features
introduced since PCL Level 3.
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10.9.3 PostScript Printing Issues

What is the work around for duplex printing on PostScript printers?
You should have a printer with a duplex option and an appropriate PPD file. The

example that follows was tested with a PPD file for the Kyocera FS-9000 printer. You
also need the UNIX sed tool named to filter the output file.

The problem with duplexing is that it is enabled at the job level, but it gets reset in the
page setup because the paper size and printer tray information are generated for every
page. To work around this problem, you need a script that removes the page level
setup information to avoid resetting the duplex setting. A side effect of this work
around is that you cannot switch the printer tray between pages.

1. Write a sed script with the following three lines:

/~%%BeginPageSetup/,$ {
/~%$%BeginFeature/, /"%%EndFeature/d

}

2. Save the script to a file named duplexsed.
3. Copy duplexsed to an appropriate directory, such as ORACLE_HOME/bin.
4. Set the environment variable TK_PRINT as follows:

TK_PRINT="sed -f SORACLE_HOME/bin/duplexsed | lpr -1 -s -P'%n' -#'%c'"
export TK_PRINT

Note: Print commands differ for various kinds of UNIX. Check
your installation guide and man pages for your platform. Refer to
Appendix B, "Environment Variables" for a description of TK_
PRINT.

The command stored in TK_PRINT is only executed if
DESTYPE=PRINTER. If DESTYPE=FILE, you still get a PostScript
file with page level setup information. You can run the duplexsed
script against the PostScript file to correct it.

What PostScript level is supported in Oracle Reports?
Oracle Reports supports PostScript Level 1 and 2.

How do you dynamically change the printer tray setting in the midst of a
print job?

In some cases, you may want to switch printer trays in the middle of a report. For
example, you might want the first page of a report printed on letterhead stationary
and subsequent pages printed on plain white paper. For character mode reports, you
can achieve this result through a combination of editing the .prt file and changing the
report's properties. For bit-mapped reports, you use the SRW. SET_PRINTER_TRAY
built-in procedure. On UNIX, this functionality is supported for PostScript output but
not PCL output. For PCL, Oracle Reports ignores the commands for changing
orientation and paper tray. Although dynamically changing the orientation and
printer tray for PCL is not supported on UNIX, you can change them at runtime
through the print dialog box for PCL.

By using the Before Report, Between Pages, or format triggers you can switch to
different printer trays as your report formats. This enables you to easily print pages of
the same report on different sheets of paper.
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Note: For a description of the SRW built-in package, including the
SRW.SET_PRINTER_TRAY built-in procedure, see the Oracle
Reports online Help.

Example
From the BEFORE REPORT trigger, you can set the printer tray for the very first page:

function BeforeReport return boolean is
begin
srw.set_printer_tray('UPPER PAPER TRAY');
return (TRUE);
end;

To set the printer tray dynamically for subsequent pages, add a format Trigger to an
item that prints on each page of the report. The following code checks for even pages
and sets the page number accordingly:

function B_tbpFormatTrigger return boolean is
page_num number;

begin
srw.get_page_num(page_num) ;
begin
if mod(page_num, 2) = 0 then
srw.set_printer_tray('UPPER PAPER TRAY');
else
srw.set_printer_tray('LOWER PAPER TRAY');
end if;
return (true);
end;
end;

Why does the external print command ignore the tray select option while
trying to print the PostScript output generated by Oracle Reports?

Suppose that you enter the following print command:

lp -dprinter -oupper S$report_print_filel

In this case, the -~oupper option in the 1p command is ignored. The reason for this
behavior is that Oracle Reports generates tray information in its PostScript output. The
tray selection in the PostScript overrides the specification on the command line. If you
want the tray information on the command line to be respected, you must remove the

tray information from the PostScript file. You can do this by searching for and
removing the following from your PostScript file:

%%BeginFeature: *InputSlot name of printer tray
%$%EndFeature

For more information on switching printer trays, refer to How do you dynamically
change the printer tray setting in the midst of a print job?
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10.9.4 Font-Related Printing Issues

See Also:

s Chapter 9, "Managing Fonts in Oracle Reports" for more
font-related information.

s Chapter 12, "Font Model and Cross-Platform Deployment" for
resolving cross-platform font issues.

How do you check whether a font is used in Oracle Reports printing?

PostScript files have a list of fonts, which is created after reading the PPD file. If you
examine the PostScript file, you can check the fonts by looking for the following tags:

s DocumentNeededResource has the list of fonts referenced in the PPD file.

s DocumentSuppliedResource has the list of fonts for which the PostScript
driver was able to find corresponding AFM files.

m  %%Page before the field's ¥IncludeResource: font has the font name that will
be used for the field.

For PCL output files, you can check whether a particular font was used. Depending on
this information, the font settings in Oracle Reports or the printer can be modified.

What is the real difference between running reports to Screen and
Preview?

Formatting a report to Screen, for screen fonts, guarantees that the report will look
good in the Paper Design view of the Report Editor. If an attempt is made to print a
report formatted with screen fonts, though, it is likely to come out with some
differences because screen fonts typically map very poorly to printer fonts. If Preview
is selected instead of Screen, the report is formatted with printer fonts and the output
on the screen is almost certain to match the printed output.

Will there be any font issues if | do not have a valid printer installed?

Prior to Oracle Reports 10g on UNIX, you had to set the DISPLAY environment
variable in order for Reports Server to use the windowing system display surface for
creating images and getting pixel resolution. This dependency is removed with Oracle
Reports 10g.

Additionally, earlier releases required a valid printer on UNIX for fonts. When no
valid printer was available, Oracle Reports Services used the screen fonts, which again
required setting the DISPLAY environment variable. Now, Oracle Reports Services
includes a default screen printer surface, ScreenPrinter, that emulates a screen or
printer for fonts in the absence of an available printer. As a result, Oracle Reports
Services no longer requires a printer on UNIX.

See Also: Section 10.8, "Removing DISPLAY and Printer
Dependencies on UNIX".

10.9.5 Printed Output Issues

Why does my report look okay on the screen but have truncated data
when printed?
Any one of a number of possible causes may account for the truncation of fields.

»  Check the field and determine if it is allowed to expand.
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1. In Oracle Reports Builder, double-click the field in the Paper Design or Paper
Layout view to display the Property Inspector.

Find the Horizontal Elasticity property.

If it is set to Fixed, you should change it to Variable or Expand.

Run the report to the printer.

If it still truncates, it could be that the field requires multiple lines.

Return to the Property Inspector for the field and check its Vertical Elasticity.
If it is set to Fixed, you should change it to Variable or Expand.
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Run the report to the printer again.

If the right most fields on the page are always the ones truncating, it could be an
issue with the printable area of the printer. If you are using a PCL printer, then
you will have to estimate the size of the printable area and resize your margins
accordingly:

1. Open the report in Oracle Reports Builder.
2. Go to the Paper Layout view.

3. Click the Margin tool on the top tool bar. A thick black line appears indicating
where the body of your report ends and the margin begins.

4. Click and drag the black line to the left approximately 0.5 inches.
5. Save and run the report to the printer again.

6. If necessary, repeat steps 4 and 5 to determine approximately where the
printable area boundary is located and then ensure that your report body fits
within that area.

If you are using a PostScript printer, you can get the printable area boundary to
appear in the Paper Layout view as follows:

1. Open the report in Oracle Reports Builder.

Choose File > Page Setup.

Verify that the margins are small and that the orientation is correct.

Click OK. The Paper Layout view should now be able to read the boundary.
Go to the Paper Layout view.

o g & 0D

Click the Margin tool on the top tool bar. A thick black line appears indicating
where the body of your report ends and the margin begins. A black hashed
line also appears indicating the boundary of the printable area.

7. Ensure that the thick black line is inside of the black hashed line. If it is not,
click and drag the black line inside the printable area.

8. (Click the Margin tool to leave margin mode.
9. If necessary, reposition your fields to fit within the new body boundaries.
10. Save and run the report to the printer.

For PCL, if it is still truncating, try using a fixed space font instead of a
proportional font. Sometimes PCL printers have problems interpreting
proportional space fonts and it leads to truncation. You should try using a fixed
space font, such as Courier, and possibly font aliasing.
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See Also: Chapter 9, "Managing Fonts in Oracle Reports" for
more font-related information.

Note: Default layouts are built against a generic printer. Each
printer has its own printable area. As a result, you may have to
reset the report to fit the printer. Ideally, if you know the various
printers you will be using, you can design the report from the start
to fit the printer with the smallest printable area.
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Using PDF in Oracle Reports

Adobe Portable Document Format (PDF) is a universal file format that preserves all
the fonts, formatting, graphics, and color, of any source document regardless of the

application and platform used to create it. Oracle Reports was one of the first report
generation tools to embrace this technology and generate quality PDF documents.

This chapter contains the following main sections:

What’s New In This Release?

PDF Features Included in Oracle Reports

Generating a Unicode PDF File

Generating a Bidirectional (BiDi) PDF File

Generating a Multibyte PDF File
Generating a Barcode PDF File

11.1 What’s New In This Release?

Oracle Reports 11¢g Release 1 (11.1.1) provides significant font handling enhancements,
as outlined in Table 11-1 (a subset of Table 1-1, " 11g Functionality vs. 10g
Functionality"):

Table 11-1

11g Font Features vs. 10g Functionality

11g New Features

Equivalent 10g Functionality

Cross-platform support for TrueType Fonts (TTF)
and TrueType Collections (TTC). Report output is
in most cases identical on UNIX as on
Windows, allowing for simplified
cross-platform deployment.

Oracle Reports reads the font metrics from the
appropriate TTF files to correctly format the
report output. This eliminates the issue of text
misalignment due to font metrics mismatches.
Fonts for which TTF files are available are found
automatically. Note that if a TTF font file is not
found, then the font lookup mechanism reverts
to the pre-11g implementation.

New environment variables REPORTS_
ENHANCED_FONTHANDLING and
REPORTS_FONT_DIRECTORY.

Possible mismatches between fonts in report output on
UNIX and Windows due to different font mechanisms
on Windows and UNIX. Font aliasing was required,
along with PDF font subsetting.

Support for older font file types (for example, AFM)
supported. Difficult to get these font types for all fonts.
Conversion of TTF to AFM required in many cases, but
even these files did not provide the exact output as on
Windows.
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Table 11-1 (Cont.) 11g Font Features vs.

10g Functionality

11g New Features

Equivalent 10g Functionality

Support for all character sets in PDF. With the new
font model, no misalignment will be seen in the
PDF subsetted report output. Support for
Unicode font subsetting in PDF on UNIX.

Only multibyte reports supported. PEM and PFA files
must be created to resolve text misalignments in UNIX
output. Dependence on AFM files.

Variable width font output was especially problematic,
because Reports was unable to get width of characters
beyond the first 256 characters in the file, and assumed
fixed width for all these characters, resulting in
misalignment.

Simplified font management and configuration
through Oracle Enterprise Manager. Use Oracle
Enterprise Manager to modify aliasing and
subsetting entries in uifont.ali (such as
global aliasing, PDF aliasing, and PDF
subsetting). Defalut Resolution, and Default
Font to modify the PPD file.

Configure fonts in uifont.ali and configuration
files.

PDF, password protection, and security. Specify
new command line arguments to
password-protect PDF reports generated from
Oracle Reports. You can also suppress certain
permissions to provide security for the
generated PDF reports.

No capability to encrypt PDF reports or specify security
permissions.

Font diagnostics. Easy to understand tracing for
diagnosis of font issues. Reporting of fonts used,
and other debugging tools.

Difficult to diagnose issues.

11.2 PDF Features Included in Oracle Reports

Oracle Reports supports PDF 1.4 and is capable of generating high fidelity PDF reports
on all platforms. The PDF features supported by Oracle Reports include:

s Compression
s Font-Related Features

s Precedence of Execution

= Encryption, Password Protection, and Permissions Security

»  Accessibility
s Taxonomy

s Graph Support

11.2.1 Compression

PDF compression decreases the PDF file size, thereby reducing the time spent in

downloading the PDF file.

The amount of space saved using compression varies based on the contents of the
report, for example, the number of images versus the size of the content.

» Images: PDF compression does not significantly affect the size of files containing
images in it, as image files are typically already compressed.

= Formatted data: Highly formatted data can achieve higher compression rates.
However, actual compression rates will vary for each report.

Compressed files are about one fifth the size of the original file. Testing has shown that
the best case compression ratio of one-eighth to the worst case compression ratio of
one-half was achieved based on the contents in the original file.
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11.2.1.1 Setup

By default, PDF output generated by Oracle Reports is compressed. To specify the
level of compression, use PDFCOMP on the command line. For more information, see
Section A.7.24, "PDFCOMP".

Although compressed files download quickly, the time taken to generate a
compressed file is much more when compared to a non-compressed file.

Figure 11-1 Compressed Output Versus Non-Compressed Output

MName | Size | Type | M odified |
E pdf_no_comp.pdf T2 KB Adobe Acrobat Doc...  3431/2003 5:.02 P
ﬂ pdf_ves comp.pdf 119KE  Adobe Acrobat Doc... 44372003 3:.06 PM

Note: Compression rate depends on the report's content; thus, the
time taken to generate the PDF file as well as the PDF file size will
vary from report to report.

11.2.2 Font-Related Features
This section outlines the PDF font-related features supported by Oracle Reports:

= Font Aliasing
= Font Subsetting
= Font Embedding

s Font Feature Summary

11.2.2.1 Font Aliasing

Font aliasing enables you to substitute one font for another; that is, font-to-font
substitution. This font-to-font substitution is usually used when porting applications
(in this case, your PDF file) across platforms. You can alias multibyte fonts as well as
character sets. For font aliasing considerations when designing multilingual
applications, see Section 23.2.1.3.2, "Font Aliasing Considerations".

The font enhancements introduced in Oracle Reports 11g Release 1 (11.1.1) make font
aliasing unnecessary in almost all cases. In prior releases, a report may have been
created with fonts that are readily available on Windows, but not on UNIX (for
example, Arial font). In such cases, it was necessary to alias the Windows fonts to
other fonts with a similar style available on UNIX (for example, Helvetica). Now, with
support for TTF and TTC files on UNIX, a font such as Arial is supported on both
Windows and UNIX, eliminating the need for aliasing.

Font aliasing occurs at the time of generating the PDF file. The PDF file will contain
only the necessary font information required to display the output. The fonts used will
not be embedded in the PDF file.

Note: The fonts must be available on the machine displaying the
PDF output. The fonts need not be available on the machine
generating the PDF file.

At the time of viewing the report, Adobe Acrobat replaces the aliased fonts based on
the following:

Using PDF in Oracle Reports  11-3



PDF Features Included in Oracle Reports

1. If the fonts do not exist on the machine displaying the output, Adobe Acrobat
substitutes it with the Adobe Sans MM font.

2, If the Adobe Sans MM font does not match, the output may display dots for the
data.

Font aliasing will work with any or all of the following:

= Single byte fonts, including Eastern European fonts for both ASCII and IS0-Latin
character sets.

= Adobe multibyte Character ID (CID) fonts listed in Table 11-2, which are available
as a free download from Adobe.

s Typel PostScript fonts.
s TrueType fonts.
Table 11-2 outlines the mapping between Oracle NL.S_ CHARACTERSET, CMap name,

and CID font name used in PDF font aliasing for multibyte fonts.

Table 11-2  CID Font Mapping for PDF Font Aliasing

Oracle
NLS_CHARACTERSET
Language Name CMap Name CID Font Name
JA16SJIS 90ms-RKSJ-H "KozMinPro-Regular-Acro" (¥)
Japanese JAL6EUC EUC-H "HeiseiKakuGo-W5-Acro" (**)
"HeiseiMin-W3-Acro" (**¥)
KO16KSC5601 KSC-EUC-H "HYSMyeongJoStd-Medium-Acro
Korean KO16MSWIN949 KSCms-UHC-H ")
"HYGothic-Medium-Acro" (**)
"HYSMyeongJo-Medium-Acro"
(**)
ZHT32EUC CNS-EUC-H "MSungStd-Light-Acro" (*)
Traditional ZHT16BIGS, ETen-B5-H "MHei-Medium-Acro" (**)
Chinese ZHT16MSWIN950 "MSung-Light-Acro" (*%)
ZHT16HKSCS HKscs-B5-H "MSungStd-Light-Acro" (*)
Simplified ZHS16CGB231280 GB-EUC-H "STSongStd-Light-Acro" (¥)
Chinese ZHS16GBK GBK-EUC-H "STSong-Light-Acro” (*)

(*) These fonts are available in Adobe Acrobat Reader 5.0 and later.
(**) These fonts are available in Adobe Acrobat Reader 4.0 and later.

It is recommended that you use Version 5.0 CID fonts (*) in order to avoid unexpected
font mapping, which results in multibyte characters overlapping. Version 5.0 fonts are
compatible with Adobe Acrobat Reader 5.0 and later.

11.2.21.1 Setup

If font aliasing is necessary, use Oracle Enterprise Manager to define the aliasing,
instead of directly editing the uifont.ali file as in prior releases. For information
about using Oracle Enterprise Manager for font configuration, see Section 7.9.1,
"Configuring Fonts".

For more information about the uifont.ali file, refer to uifont.ali in Section 9.3,
"Font Configuration Files":

11.2.2.1.2 Troubleshooting
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If font aliasing does not work, verify that:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts). Verify that the aliased font has been added to the list. If it is not included,
then font aliasing did not occur. The fonts were not found or the entry in the
uifont.ali file is incorrect.

= The fonts specified for the report are available on the machine where the report
will be viewed.

s The [PDF] section name in the uifont.ali file has not been modified as Oracle
Reports parses the file for the section name.

= The version of the Adobe Acrobat Reader used for viewing is 3.0 or higher, as
required for multibyte character reports to display properly.

11.2.2.2 Font Subsetting

With font subsetting, the PDF file includes the font information needed to render the
PDF, regardless of the availability of that font on the machine used to view the report.
PDF font subsetting works for single byte, multibyte, and Unicode fonts and is the
preferred method of creating multibyte reports.

When you subset a font in a PDF file, the font information is embedded into the PDF
output for only those characters that are needed for the report output.

Note: You can modify the PDF file if you have:

1. The fonts used in the report installed on your machine.
2. A PDF writer.

11.2.2.2.1 Setup
Before using font subsetting, you must:

= Include the font file paths in the REPORTS_PATH environment variable. Oracle
Reports looks for fonts in the path specified in the REPORTS_PATH environment
variable when generating a PDF file.

= Include the font subsetting entries in the uifont.ali file. Oracle Reports subsets
the fonts only when the font entries listed in the uifont.ali file exist in the PDF
file being generated.

Note: Theuifont.ali fileislocated in the following directory:

ORACLE__
INSTANCE\config\FRComponent\frcommon\guicommon\tk\
admin

The section for font subset in the uifont.ali fileis [PDF: Subset] and the entry is:

[PDF: Subset]
font_name = "font_file name"

where

font_name is the font name, which must be enclosed in quotes if it contains more
than one word.
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font_file name is the font file name, which must always be enclosed in quotes, and
is case-sensitive. If it does not exactly match the existing font file name, Oracle Reports
generates a REP-1924 error.

The font files can be saved in any folder; for example, ORACLE_
INSTANCE/reports/font_rfolder. The font file's path is added by default to the
$SREPORTS_ PATH environment variable.

Note: The font_file_name is not the font name displayed in
Oracle Reports Builder.

Example 1

[PDF: Subset]
Arial = "Arial.ttf"

To use TrueType fonts in a TrueType Collection (. ttc) file, the syntax for the entry in
the [PDF: Subset] sectioninuifont.ali is:

[PDF: Subset]
font_name = "ttc_file namel, table_directory number]"

where

font_name is the font name, which must be enclosed in quotes if it contains more
than one word.

ttc_file_nameis a TrueType Collection file name.

table_directory_number is the Table Directory number for the TrueType font in a
TrueType Collection file, using a zero-based index (for example, "MS PGothic" =
"msgothic.ttc, 1" indicates that Oracle Reports should use the second font in the
TrueType Collection file). If the table_directory number is omitted or if you
supply an invalid value, Oracle Reports will always subset the first font program in
the TrueType Collection file.

Example 2

[PDF: Subset]

"MS PGothic" = "msgothic.ttc,1"
"MS UI Gothic" = "msgothic.ttc,2"

Table 11-3 shows the font name and Table Directory number values for common East
Asian TrueType Collection files on the Windows platform.

Table 11-3 Common East Asian TrueType Collection Files on the Windows Platform

TTC File Name Font Name Table Directory Number

batang.ttc Batang
BatangChe
Gungsuh
GungsuhChe

gulim.ttc Gulim
GulimChe

Dotum

w N PO W NN O

DotumChe
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Table 11-3 (Cont.) Common East Asian TrueType Collection Files on the Windows

TTC File Name Font Name Table Directory Number
mingliu.ttc MingLiU 0
PMingLiU 1
msgothic.ttc MS Gothic 0
MS PGothic 1
MS UI Gothic 2
msmincho. ttc MS Mincho 0
MS PMincho 1
simsun.ttc SimSun 0
NSimSun 1

You can view the fonts used in your reports as follows:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts.)

s The Document Font dialog box displays Original Font, Type, Encoding, Actual
Font (or the font used), and Type.

Figure 11-2 Font Subsetting
|

Fonts in:  pdffilename=eula.pdf

Original Fonk Type Encoding Actual Font Type

MSPGathic TrueType (CID) Identity-H Erbeddad Subset TrueType :I

List all Fonts. .. |

Note: In the case of font subsetting:

s The Encoding column will display Identity-H.

s The Actual Font column will display Embedded Subset.
s The Type column will display TrueType.

11.2.2.2.2 Backward Compatibility

Two environment variables allow for backward compatibility with the font
mechanisms of prior releases:

= REPORTS_ENHANCED_FONTHANDLING specifies whether to use the new 11g
Release 1 (11.1.1) font model, or revert to the Toolkit font handling mechanism of
10g Release 2 (10.1.2). By default, REPORTS_ENHANCED_FONTHANDLING=YES.

= REPORTS_ENHANCED_SUBSET specifies whether to include the enhanced TTF
font subsetting feature introduced in Oracle Reports 10g Release 2 (10.1.2). By
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default, REPORTS_ENHANCED_SUBSET=YES to ensure that the PDF file generated
is accessible and searchable.

You can set environment variable REPORTS_ENHANCED_SUBSET=NO to revert to
the implementation of font subsetting used in releases prior to Oracle Reports 10g
Release 2 (10.1.2); that is, Type3 fonts.

If you set REPORTS_ENHANCED_SUBSET=NO, use Adobe Acrobat Reader and
perform the following steps to ensure optimum viewing:

1. Choose Edit > Preferences > Page Display.

2. Select Smooth Text, Smooth Line Art, and Smooth Images.
3. (Laptop/LCD Screens) Select the Use CoolType check box.
4. Click OK.

Note: These steps are valid for Adobe Acrobat Reader 7.0.

11.2.2.2.3 Troubleshooting If font subsetting does not work, verify the following:

= The fonts you use in the report have bold, italic, and bold italic versions. If you
have used italic or bold styles in the report, with PDF font subsetting, and you do
not see italic or bold styles in the output, check the Windows TTF files. On
Windows, there are some fonts that have bold, italic, and bold italic versions. For
example, Arial has arialbd. ttf (Arial bold), ariali. ttf (Arial italic), and
arialbi.ttf (Arial bold italic), while some other fonts, such as Arial Unicode
MS (arialuni. ttf), do not have any bold or italic versions. For fonts that do not
have bold or italic versions, Windows synthesizes bold or italic styles from the
main font file while displaying, as does Oracle Reports on Windows. These styles
are preserved in HTML/HTMLCSS, RTFE, and PDF (without PDF subsetting or
embedding) outputs. However, while doing the PDF subsetting or embedding,
since actual font glyphs are included in the report, Oracle Reports needs the TTF
files that contain styles; that is, to include the bold style for Arial in the report, it
would need arialbd. tt£. But for fonts such as Arial Unicode MS that do not
have such TTF files, PDF subsetted output will not have bold or italic styles.

s The Actual Font value is Embedded Subset and Type is TrueType (in Acrobat
Reader 6.0 and later, choose File > Document Properties > Fonts; in prior releases,
beginning with Acrobat Reader 3.0, choose File > Document Info > Fonts). If this
is not specified, then font subsetting is not implemented. The problem could be
either that the fonts were not found or the entry in the ui font .ali file is
incorrect.

= The font file names are valid.

= The case of the font file name matches the case defined in the file.

s The font types are TrueType; that is, filename. ttf or filename.ttc.

= The font name is enclosed in double quotes if it consists of two or more words.
= The font name does not contain embedded parenthesis.

»  The font files are located in the path specified by the REPORTS_PATH environment
variable. When generating a PDF file, Oracle Reports looks for fonts in the path
specified in the REPORTS_PATH environment variable.

s The font names are correct and are available on the machine where the PDF file is
generated.
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s The [PDF:Subset]section name in the uifont.ali file has not been modified.
Oracle Reports parses the file looking for the section name.

s The version of the Adobe Acrobat Reader used for viewing is 3.0 or higher, as
required for multibyte character reports to display correctly.

s The value of the REPORTS_ENHANCED_SUBSET environment variable is set to
YES. If REPORTS_ENHANCED_SUBSET=NO, Oracle Reports reverts to the earlier
implementation of font subsetting, using Type3 fonts to create a PDF document.
Type3 fonts are imaged characters that look slightly bolder than they would if
expressed as a Typel font. See Section 11.2.2.2.2, "Backward Compatibility" for
more information on improving the viewing quality.

11.2.2.3 Font Embedding

PDF font embedding is the process of including the entire font set along with the data
in the PDF file. PDF font subsetting and font embedding are mutually exclusive.

Note: Font embedding will work only if the fonts are included in
the PDF file. Font embedding increases your PDF file size.

PDF font embedding in Oracle Reports is for Typel fonts only (single byte fonts) and
not for TrueType fonts. Convert TrueType fonts to Typel fonts using available 3rd
party tools in order to include specific Typel fonts in your report.

PDF font embedding with Oracle Reports occurs between a font and a set of font file
names.

Note: You must ensure that you have the necessary font licenses
before embedding any fonts in your output.

11.2.2.3.1 Setup
The setup for PDF embedding includes:
= A command line keyword: PDFEMBED

= A uifont.ali File Entry: [ PDF : Embed]

PDFEMBED

The command line keyword PDFEMBED is used to specify whether Oracle Reports will
embed the Typel PostScript fonts specified in the uifont.ali file into the PDF
output. For more information, see Section A.7.25, "PDFEMBED".

uifont.ali File Entry
The section for font aliasing in the uifont.ali file is [PDF : Embed].

(Windows only) The entry in the uifont.ali file should be:

font_name = "font_name.pfm font_name.pfb"

(UNIX only) The entry in the uifont.ali file should be:

font_name = "font_name.afm font_name.pfa"

Example 11-1 Font Embedding
[PDF : Embed]
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Symbol = "Symbol.pfm Symbol.pfb"

In Example 11-1, the Symbol font is embedded into the PDF file. This ensures
portability by:

1. Creating the report with the Symbol font.

2. Embedding the Symbol font in the PDF file (Figure 11-3).

Figure 11-3 Font Embedding

Document Fonts

Fonts in: embedded. pdf

Original Fonk Type Encoding Actual Font Type

Symbal Type 1 Built-in Erbeddad Twpe 1 J

List all Fonts. ..

11.2.2.3.2 Troubleshooting
If PDF font embedding does not work, verify the following:

= In Acrobat Reader 6.0 and later, choose File > Document Properties > Fonts. (In
prior releases, beginning with Acrobat Reader 3.0, choose File > Document Info >
Fonts). Verify that the embedded font has been added to the list. If the font has not
been added, then font embedding did not occur. The problem could be either that
the fonts were not found or the entry in the uifont.ali file is incorrect.

m  The correct font file name is used.

= The font path specified in the REPORTS_PATH environment variable is correct.
When generating the PDF file, Oracle Reports looks for fonts in the paths specified
in the REPORTS_PATH environment variable.

»  The font type is a Typel font.
»  The font name is enclosed within double quotes if it consists of 2 or more words.

»  The [PDF:Embed] section name in the uifont.ali file has not been modified.
Oracle Reports parses the file looking for the section name.

= The format to specify the embedded font is valid:

font_name="fontfilename.pfm/.afm fontfilename.pfb/.pfa".

For example (Windows):

UtopiaMediumItalic = "UtopiaMediumItalic.pfm UtopiaMediumItalic.pfb"

s The font name is correct and available on the machine where the PDF file is
generated.

11.2.2.4 Font Feature Summary

Table 11-4 summarizes the advantages and disadvantages of font aliasing, font
embedding, and font subsetting.
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Table 11-4 Comparison of PDF Font Features

PDF Type Advantages Disadvantages PDF Type
Font Aliasing Multibyte support. Unicode character set not Font Aliasing
Good display. supported.

Asian Font Packs are
required on the client
machine, if the client's
operating system and
Acrobat Reader are not
the native version.

Small file size (Japanese
example; 23KB for font
aliasing when compared
to 130KB for font
subsetting).

Limited fonts support.
For example, there is no
support for font
emphasis.

Font Embedding Guaranteed display. Only single byte support Font Embedding
provided.

Large file size.

Font Subsetting ~ Unicode support. No styles (Italic and Font Subsetting
Guaranteed display. Bold) support.
Generated file is
searchable and editable
using Adobe Acrobat.

11.2.3 Precedence of Execution

The precedence order for the same font in multiple places within the uifont.ali file
is as follows:

1. Font aliasing takes precedence over font embedding (highest).
2. Font subsetting takes over font embedding (intermediate).
3. Font embedding takes no precedence (lowest).

For example, if you have included the same font entries for both font embedding and
font subsetting, then font subsetting will override font embedding. This is assuming
you have not set the command line option PDFEMBED=NO.

For all font features —font aliasing, font subsetting, and font embedding—include the
specific entries first followed by the generic entries. For example, if you want to subset
Arial Plain, Arial Bold, Arial Italic, and Arial Bold-Italic fonts, your entries should be
in the following order:

[ PDF:Subset ]

Arial..Italic.Bold.. = "Arialbi.ttf"

Arial...Bold.. = "Arialb.ttf"

Arial..Italic... = "Ariali.ttf"

Arial..... = "Arial.ttf"

If the plain Arial.. ... = "Arial.ttf" entry appears first, then all the styles of

the Arial font in the layout will be subset as Arial Plain font. Here is a sample of a
portion of the uifont.ali file for all the PDF entries containing all three PDF
sections:

Sample 1

[ PDF ]
Palatino = "Kino MT.ttf"
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[ PDF:Subset ]

Garmond. .Italic.Bold.. = "Garmacbi.ttf"
Garmond...Bold.. = "Garmacb.ttf"
Garmond..Italic... = "Garmaci.ttf"
Garmond..... = "Garamac.ttf"

[ PDF:Embed ]

Arial = "Arial.pfm Arial.pfb"

Sample 2

[PDF]

Arial.10.Italic = "Times New Roman".12.Italic.Bold
"Courier New" = Symbol

[PDF : Embed]

"Times New Roman".14..Bold = "TimesBold.pfm TimesBold.pfb"
[PDF: Subset]

Verdana...Italic.Bold = "Verdanaz.ttf"

Verdana...Bold = "Verdanab.ttf"

11.2.4 Encryption, Password Protection, and Permissions Security

Beginning with Oracle Reports 11g Release 1 (11.1.1), you can encrypt and
password-protect PDF reports generated by Oracle Reports.

This optional functionality avoids unauthorized reading and changing of PDF reports.
The encrypted PDF reports are readable by Acrobat Reader 5.0 and later, and other
readers supporting PDF 1.4. This functionality is also compatible with reports
developed with prior releases of Oracle Reports.

Oracle Reports uses the Adobe Standard Security Handler to encrypt PDF reports.
This standard security handler allows up to two passwords (owner and user) and 8
types of access permissions to be specified for a document.

To provide encryption, password protection, and permissions security in PDF reports,
Oracle Reports 11g Release 1 (11.1.1) introduces the following command line
keywords:

= PDFUSER
=  PDFOWNER
s PDFSECURITY

Note: To generate PDF encrypted report output using Oracle
Reports Builder (rwbuilder), you must pass at least one of these
command line keywords in the command while starting the
rwbuilder.

In Oracle Reports Builder, select Generate to File>PDF to generate the
PDF encrypted output.

Table 11-5 describes the effect of the possible combinations of the PDFOWNER and
PDFUSER command line keywords.
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Table 11-5 Effect of PDFUSER and PDFOWNER Keyword Combinations

PDFUSER PDFOWNER
specified? specified? Effect

Yes Yes When an end user attempts to open PDF report output in Acrobat
Reader (5.0 or later), a password prompt displays to request the
password specified by PDFUSER or PDFOWNER to open the
document, decrypt it, and display it on the screen. If the end user
attempts to change permissions on the PDF report output in
Acrobat Writer (6.0 or later), a password prompt displays to
request the password specified by PDFOWNER to change the
document’s passwords and permissions.

Yes No When an end user attempts to open PDF report output in Acrobat
Reader (5.0 or later), a password prompt displays to request the
password specified by PDFUSER to open the document, decrypt it,
and display it on the screen. If the end user attempts to change
permissions on the PDF report output in Acrobat Writer (6.0 or
later), a password prompt displays to request the same password
specified by PDFUSER to change the document’s passwords and
permissions.

No Yes When an end user attempts to open PDF report output in Acrobat
Reader (5.0 or later), Oracle Reports opens the document, decrypts
it, and displays it on the screen. If the end user attempts to change
permissions on the PDF report output in Acrobat Writer (6.0 or
later), a password prompt displays to request the password
specified by PDFOWNER to change the document’s passwords and
permissions.

No No Any end user can open PDF report output in Acrobat Reader (5.0
or later), and also change the document’s passwords and
permissions in Acrobat Writer (6.0 or later). No password prompts
display.

For information about suppressing specific permissions for encrypted PDF report
using the PDFSECURITY command line keyword, see Section A.7.27,
"PDFSECURITY".

The encrypted PDF document’s passwords and permissions, as specified by PDFUSER,
PDFOWNER, and PDFSECURITY, are stored with the PDF document. An end user with
authorization to change these values can do so as follows:

1. In Acrobat Writer 6.0 or later, open the PDF document.
2. Select Document > Security > Restrict Opening and Editing.

3. In the password prompt, enter the appropriate password (as specified in
Table 11-5).dialog box that displays, make desired changes to passwords and
permissions.

4. In the dialog box that displays, make desired changes to passwords and
permissions.

Support for PDF Security in Distribution

Oracle Reports 11¢g Release 1 (11.1.1) supports PDF encryption in distribution and
bursting of reports. With this feature, you can set individual passwords and security
permissions for each PDF that you generate.

To use this feature, you must add atleast one property (pdfuser, pdfowner, and
pdfsecurity) in the distribution xml file.

<destinations>
<file id="F1" name="personal_report" format="pdf">
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<property name="pdfsecurity" value="NOCOPY"/>
<property name="pdfuser" value="mypdf"/>
<property name="pdfowner" value="employee"/>
<include src="mainSection"/>
</file>
</destinations>

For more information about the distribution xml file, see Section 20.3, "Introduction to
Distribution XML Files" and Section 20.5, "Distribution XML File Examples".

11.2.5 Accessibility

Oracle Reports provides several ways for you to include accessibility features in your
PDF file. The PDF format file follows the tagged-PDF standard defined in PDF 1.4.
This standard along with Acrobat Reader 5 (or higher) provides you with features for
inclusion in the paper layout.

For information on enabling accessibility-related features offered through Oracle
Reports from the command line, see Section A.5.1, "ACCESSIBLE". For information
about using the Oracle Reports accessibility properties designed to make PDF report
output accessible to the disabled community (Alternative Text, Headers, ID, Report
Language, and Table Caption properties), see the Oracle Reports online Help.

Additionally, refer to Chapter 43, "Building an Accessible JSP-based Web Report" in
the Oracle Reports Building Reports manual, and to the Oracle accessibility site on OTN
(http://www.oracle.com/accessibility/index.html), where you can learn
more about accessibility and find the Creating Accessible Enterprise Reports Using Oracle
Reports white paper.

11.2.6 Taxonomy

A PDF document can include global information about itself such as the document's
title, author, creation and modification dates. This global information proves useful at
the time of cataloging or searching for documents in external databases.

Oracle Reports provides report-level properties to enable such a classification, known
as taxonomy. They are:

n Title
s Author
= Subject

s Keywords

Table 11-6 Taxonomy Properties

Property Name Type Description Default Value

Title String Document title. PDF document name
Author String Document's author. Oracle Reports
Subject String Document's subject. None

Keywords String Specifies keywords that canbe ~ None

used to categorize the document.

Refer to the Oracle Reports online Help for more information on the taxonomy
properties.
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11.2.7 Graph Support

Oracle Reports provides the capability to specify the dots per inch (DPI) value for the
image resolution of the graph in PDF output. This enables you to scale the graph
without compromising on the image quality.

For more information, see Section B.1.49, "REPORTS_GRAPH_IMAGE_DPI" and
Section B.1.51, "REPORTS_JPEG_QUALITY_FACTOR".

11.3 Generating a Unicode PDF File

This section outlines the steps involved in generating a PDF file with a Unicode
character set. Before using the font features covered in this section, refer to Table 11-4
to determine which feature best suits your application needs.

11.3.1 Font Subsetting

The steps involved in generating a Unicode PDF file using the font subsetting feature
are as follows:

1. Set NLS_LANG=AMERICAN_AMERICA.UTFS.

2. Set REPORTS_PATH to the font directory in which the TrueType font exists. For
example, C: \WINNT\ fonts.

3. Openthe uifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileislocated in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example

[ PDF:Subset ]
"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"

The specified font should cover the Unicode range that your report uses.
4. Create a report having MLS data and set its font to the Unicode font.

5. Run areport having MLS data with DESTYPE=FILE DESFORMAT=PDF.

11.4 Generating a Bidirectional (BiDi) PDF File

This section outlines the steps involved in generating a PDF file for bidirectional (BiDi)
languages. Before using the font features covered in this section, refer to Table 114 to
determine which feature best suits your application needs.

Oracle Reports provides two environment variables that resolve font re-shaping and
numeric options with bidirectional (BiDi) languages, such as Hebrew and Arabic.
They are:

1. REPORTS_BIDI ALGORITHM
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This environment variable switches the layout algorithm for bidirectional (BiDi)
languages (for example, Arabic or Hebrew). The valid values for this environment
variable are ORACLE, ENHANCED or UNICODE.

See Also: Section B.1.31, "REPORTS_BIDI_ALGORITHM"

2. REPORTS_ARABIC_NUMERAL

This environment variable specifies the numeric format for Arabic PDF output.

See Also: Section B.1.29, "REPORTS_ARABIC_NUMERAL"

11.4.1 Font Subsetting

The following example assumes you are using Arabic environment. The steps
involved in generating a PDF file for bidirectional (BiDi) languages using the font
subsetting feature are as follows:

1. Set NLS_LANG=ARABIC_EGYPT.AR8MSWIN1256 (or AR8IS08859P6 on UNIX).

2. Set REPORTS_PATH to the font directory in which the TrueType font exists. For
example, C: \WINNT\ fonts.

3. Opentheuifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileis located in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example

[PDF: Subset]
"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"

4. Create a report having Arabic data and set it to the font specified in the example.

5. Run areport with DESTYPE=FILE DESFORMAT=PDF.

11.5 Generating a Multibyte PDF File

This section outlines the steps involved in generating a PDF file with multibyte fonts.
Before using the font features covered in this section, refer to Table 114 to determine
which feature best suits your application needs.

In PDF font subsetting output, you may see a Wave Dash (U+301C) instead of a
Fullwidth Tilde (U+FF5E). This is due to incompatibility in character mapping
between Microsoft and other vendors. To avoid this issue, you can use either
JA16SJISTILDE or JA16EUCTILDE character set for PDF font subsetting. This issue,
however, is not observed with the PDF font aliasing feature.

11.5.1 Font Aliasing

Refer to Table 11-2 for a summary of mapping between Oracle NLS_CHARACTERSET,
CMap name, and its CID font name used in PDF font aliasing for multibyte fonts.
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The steps involved in generating a PDF file for multibyte fonts using font aliasing are
as follows:

1.
2.

Set NL.S_LANG=JAPANESE_JAPAN.JA16SJIS (or JAL6EUC on UNIX).

Open the uifont.ali file located and set the font alias under the [ PDF]section.

Note: Theuifont.ali fileis located in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example

[ PDF ]

..... JA16SJIS = "KozMinPro-Regular-Acro"

"MS UI Gothic"..... JA16SJIS = "KozMinPro-Regular-Acro"

Create a report having Japanese data with the Japanese font (MS UI Gothic).
Run a report with DESTYPE=FILE DESFORMAT=PDF.

If your Acrobat Reader is a non-Japanese version installed on a non-Japanese
operating system, you must install the Japanese font pack from Adobe's site.

If you view the PDF file with the Japanese version of Acrobat Reader 4.0/5.0 on
the Japanese version of Windows, you need not install the Japanese font pack.

11.5.2 Font Subsetting

The steps involved in generating a PDF file for multibyte fonts using the font
subsetting feature are as follows:

1.
2

Set NL.S_LANG=JAPANESE_JAPAN.JA16SJIS (or JA16EUC on UNIX)

Set the REPORTS_PATH environment to the font directory in which the TrueType
font exists. For example, C: \WINNT\Fonts.

Open the uifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileislocated in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example

[ PDF:Subset ]

"Andale Duospace WT J" = "Aduoj.ttf"
"Albany WT J"="AlbanWTJ.ttf"

"MS UI Gothic" = "msgothic.ttc"

Create a report having Japanese data and set it to the font specified in the example.

Run a report with DESTYPE=FILE DESFORMAT=PDF.
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11.6 Generating a Barcode PDF File

This section outlines the steps involved in generating a PDF file with barcode
information. Before using the font features covered in this section, refer to Table 114
to determine which feature best suits your application needs.

11.6.1 Font Embedding

The steps involved in generating a barcode PDF file using the font embedding feature
are as follows:

1. Set the REPORTS_PATH environment variable to the font directory containing the
Typel font.

2. Opentheuifont.ali file and include the following under the font embed
[ PDF : Embed] section.

Note: Theuifont.ali fileis located in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example
[ PDF:Embed ]
SAdHC39a = "SAdHC39a.pfm SAJHC39a.pfb"
3. Create a report having Barcode data and set its font to the one specified in the

example.

4. Runa report with DESTYPE=FILE DESFORMAT=PDF.

11.6.2 Font Subsetting

The steps involved in generating a barcode PDF file using the font subsetting feature
are as follows:

1. Set the REPORTS_PATH environment variable to the directory containing the
TrueType font. For example, C: \WINNT\Fonts.

2. Opentheuifont.ali file and edit the [PDF: Subset] section to specify the
TrueType font name.

Note: Theuifont.ali fileis located in the following directory
on Windows and UNIX:

m ORACLE_INSTANCE\config\FRComponent\
frcommon\guicommon\tk\admin

Example

[ PDF:Subset ]
SAdHC39a = "SAdHC39a.ttf"

3. Create a report having barcode data and set it to the font specified in the example.

4., Runa report with DESTYPE=FILE DESFORMAT=PDF.
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Font Model and Cross-Platform Deployment

Modern business needs warrant a seamless integration and interaction across any
platform and infrastructure. Oracle Reports enables businesses to develop and deploy
information to all levels within and outside of the organization. However, since any
enterprise reporting tool is bound to use some platform-specific functionality like the
system fonts or printer fonts, there exists a possibility that the look-and-feel of the
report changes when the report is ported from one platform to another; for example,
from the development platform (commonly Windows) to the deployment platform
(commonly a UNIX-based platform).

This chapter introduces the new font model and its features. The new font model
offers many new features and benefits. For more information, see Section 12.1, "What's
New In This Release?". a

If the new font model is not used, the user needs to manually configure the font
settings as present in pre-11g and apply a few fixes manually when deploying your
reports on UNIX platforms.

This chapter also covers those scenarios where the choice of platform may affect the
look-and-feel of the report output. Each report output format (for example, PDE,
HTMLCSS, and RTF) that is open to cross-platform issues is covered in a separate
section. These sections provide step-by-step instructions that will ensure that your
report output looks the same on all platforms. These guidelines are followed by
troubleshooting information and FAQs. Since multibyte and Unicode reports involve
some additional steps, separate sections are devoted to those topics. This chapter is
applicable to Oracle9i Reports, Oracle Reports 10g Release 1 (9.0.4), 10g Release 2
(10.1.2), and 11g Release 1 (11.1.1), except as specifically noted.

Before you proceed, it is strongly recommended that you are familiar with the
concepts and terminology outlined in the following chapters:

s Chapter 8, "Configuring Oracle Reports Services"

s Chapter 9, "Managing Fonts in Oracle Reports"

s Chapter 10, "Printing on UNIX with Oracle Reports"
»  Chapter 11, "Using PDF in Oracle Reports"

= Appendix B, "Environment Variables"

This chapter includes the following sections:

= What's New In This Release?

s Overview of the Font Model

s Overview of Cross-Platform Issues

— Font Availability On Different Platforms
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- Fixing Font-Related Issues

s Generating HTMLCSS, RTFE, or Web Output

s Generating Single-Byte PDF Output

s Generating Multibyte PDF Output
= Generating Unicode PDF Output
s Generating PostScript Output

Note:

This chapter lists only those scenarios and guidelines that

need additional work to ensure similar outputs across platforms.

12.1 What’s New In This Release?

Oracle Reports 11g Release 1 (11.1.1) provides significant font handling enhancements,
as outlined in Table 12-1 (a subset of Table 1-1, " 11g Functionality vs. 10g

Functionality") :

Table 12-1

11g Font Features vs. 10g Functionality

11g New Features

Equivalent 10g Functionality

Cross-platform support for TrueType Fonts (TTF)
and TrueType Collections (TTC). Report output is
in most cases identical on UNIX as on
Windows, allowing for simplified
cross-platform deployment.

Oracle Reports reads the font metrics from the
appropriate TTF files to correctly format the
report output. This eliminates the issue of text
misalignment due to font metrics mismatches.
Fonts for which TTF files are available are found
automatically. Note that if a TTF font file is not
found, then the font lookup mechanism reverts
to the pre-11g implementation.

New environment variables REPORTS_
ENHANCED_FONTHANDLING and
REPORTS_FONT_DIRECTORY.

Possible mismatches between fonts in report output on
UNIX and Windows due to different font mechanisms
on Windows and UNIX. Font aliasing was required,
along with PDF font subsetting.

Support for older font file types (for example, AFM)
supported. Difficult to get these font types for all fonts.
Conversion of TTF to AFM required in many cases, but
even these files did not provide the exact output as on
Windows.

Support for all character sets in PDF. With the new
font model, no misalignment will be seen in the
PDF subsetted report output. Support for
Unicode font subsetting in PDF on UNIX.

Only multibyte reports supported. PEM and PFA files
must be created to resolve text misalignments in UNIX
output. Dependence on AFM files.

Variable width font output was especially problematic,
because Reports was unable to get width of characters
beyond the first 256 characters in the file, and assumed
fixed width for all these characters, resulting in
misalignment.

Simplified font management and configuration
through Oracle Enterprise Manager. Use Oracle
Enterprise Manager to modify aliasing and
subsetting entries in uifont.ali (such as
global aliasing, PDF aliasing, and PDF
subsetting), printer resolution, and the default
font used.

Configure fonts in uifont.ali and configuration file.

PDEF, password protection, and security. Specify
new command line arguments to
password-protect PDF reports generated from
Oracle Reports. You can also suppress certain
permissions to provide security for the
generated PDF reports.

No capability to encrypt PDF reports or specify security
permissions.

Font diagnostics. Easy to understand tracing for
diagnosis of font issues. Reporting of fonts
used, and other debugging tools.

Difficult to diagnose issues.
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12.2 Overview of the Font Model

Oracle Reports 11g Release 1 (11.1.1) uses a new font model that supports the TTF and
TTC font types on UNIX platforms. Oracle Reports uses the new font model during
runtime, and it uses the old Motif toolkit during design time. The font model applies
to all destination formats and supports font aliasing and font subsetting. If the
REPORTS_ENHANCED_FONTHANDLING environment variable is set to NO, the
old toolkit mechanism is used.

The new font model offers the following features and benefits:

= Simplifies setup, configuration, and discovery of fonts.

= Supports TrueType Fonts (TTF) and TrueType Collections (TTC) on UNIX.
= Supports Unicode font subsetting in PDF on UNIX.

= Includes a simple font lookup algorithm and an enhanced formatter.

= Automatically recognizes new fonts.

= Supports all character sets in PDF.

= Provides font-related diagnostics and tracing information.

= Supports backward-compatibility with the previous font model based on the motif
toolkit.

= Uses commonly available TTF and TTC fonts as on Windows.

s FEliminates the need to convert TTF to AFM or TFM files.

Note: It is recommended that you use the Windows version of
Oracle Reports Builder to design reports.

12.2.1 Font Lookup

On Windows, the font lookup mechanism is simple due to the availability of printer
drivers, which have the capability of uploading fonts from the system as needed. Any
output from Oracle Reports running on Windows will contain fonts from either one of
the following:

s The system
s The printer

For this reason, Oracle Reports considers both the printer and the system fonts when
looking for the available fonts.

On UNIX, the fonts available for generating output are either one of the following:

= the fonts available on the printer, specifically the fonts defined in the PPD or TFM
files

= if no printer is specified, the fonts available in ScreenPrinter,
screenprinter.ppd.

See Also:
= Section 9.3, "Font Configuration Files"

s Section 10.8.1, "ScreenPrinter"
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12.2.1.1 Font Lookup Algorithm

llustrates the process of determining the available fonts for generating report output

on UNIX.

Figure 12-1 Font Algorithm
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The following steps describe how Oracle Reports generates a list of the available fonts
for generating output (for example, for the screen, printer, or file):

s Oracle Reports checks whether the REPORTS_ENHANCED_FONTHANDLING
environment variable is set.

»  If the variable is set, it checks whether the TTF and TTC fonts used in the layout
objects are present in REPORTS_FONT_DIRECTORY.

» If the TTF and TTC fonts are present in REPORTS_FONT_DIRECTORY, Oracle
Reports uses the TTF font in calculating metrics, which prevents misalignment in
the multibyte language report output.

s If the TTF and TTC fonts are not in the REPORTS_FONT_DIRECTORY, Oracle
Reports reverts to the old toolkit mechanism, which finds the nearest matching
Type 1 font on the machine.

Note:

If the REPORTS_ENHANCED_FONTHANDLING variable is not

set, the old motif toolkit mechanism is used.
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12.2.2 Configuring the New Font Model

To configure the new font model, complete the following steps:

1. Ensure that the REPORTS_ENHANCED_FONTHANDLING environment variable is set
to yes. The default value is yes.

2. Copy all the TTF and TTC files, which are used in the report, to the REPORTS_
FONT_DIRECTORY. The default font directory is SORACLE_
INSTANCE/reports/fonts.

3. Remove any unnecessary aliasing from the uifont.ali file. For example, Arial is
aliased to Helvetica, by default. If your report uses the Arial font, you must
remove the aliasing from the uifont.ali file.

Note: If you choose to use the old motif toolkit, you must consider
cross-platform issues and apply workaround solutions. It is
recommended that you use the new font model for developing and
deploying reports on UNIX.

12.2.3 Font Diagnosis and Tracing

The new font model in Oracle Reports 11¢ Release 1 (11.1.1) provides improved font
diagnosability and tracing.

You can configure log levels for persistent loggers and active runtime loggers. Log
levels allow you to limit the amount of tracing information included in your tracing
output.

For example, if you set Oracle Diagnostic Logging Level (Java Level) = Trace:1
(FINE), the following font-related information is included in your log files and tracing
output:

= Name of the font directory
=  Fonts available in the font directory
= Fonts used by objects in a paper layout that are not available in the font directory

For more information about diagnosing font issues, see Section 9.8, "Diagnosing Font
Issues".

12.3 Overview of Cross-Platform Issues

Oracle Reports is available on many platforms, including Windows, Linux, Sun
Solaris, HP-UX, and IBM AIX. You can use Oracle Reports to develop and deploy
reports on any of these platforms interchangeably. The most common scenario is that
the report is developed on Windows, and is deployed on a UNIX-based environment,
such as Linux (see Figure 12-2). This may result in a slight change in the look-and-feel
of the deployed report. For example, when you are developing the report on Windows,
you allocate enough space to each text object or field in your report. However, when
you deploy and run the report on Linux, you may see that the text does not fit within
the allocated space in the output. Such issues that are the direct result of change in
platform are referred to as cross-platform issues. A possible cause of such issues is that
the fonts available on the development platform are not available on the deployment
platform. As a result, when the report is executed on the deployment platform, a
substitute font needs to be used for formatting the report output. Since any two fonts
are likely to have certain differences, the report output on the development and
deployment platforms looks different.
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Another likely scenario in which you may encounter cross-platform issues is when the
platform on which the report is finally viewed (see Figure 12-2) does not have the
proper fonts installed. Thus, even if the development and deployment platforms
display the report output correctly, the platform on which the end-user views the
report will not display the proper look-and-feel of the report.

Figure 12-2 Sample Cross-Platform Deployment Scenario
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12.3.1 Font Availability On Different Platforms

A font is a set of printable or displayable text characters in a specific style and size.
Fonts are needed for displaying the report on the screen as well as for printing it. The
metrics for these fonts are picked up by Oracle Reports while formatting the report;
that is, while executing the report command. Based on the font metrics, the report is
formatted and the output is produced.

The font metrics are provided by specific files that must be available on the system
where you are running Oracle Reports Services. On Windows, these font metrics are
provided by True Type Font (TTF) files or True Type Collection (TTC) files. On UNIX
platforms, the font metrics are taken from Adobe Font Metrics (AFM) files or TeX Font
Metrics (TFM) files. The font availability and the metrics can vary based on the
operating system used. This difference in fonts used and the rendering can affect the
visual appearance of the generated output.

Example 1: Tahoma, a commonly used font in single-byte regions, is available on
Windows but not on UNIX. For example, a reports developer has used Tahoma font
while designing the report. The output of the report looks good on the development
platform; that is, Windows. The report is then ported to the deployment platform (say
Linux). When you submit a request to the Reports Server to execute this report, the
Reports Server looks for Tahoma font metrics. It will be unable to find the metric file,
since Tahoma is a Windows-specific font. Another font that closely resembles Tahoma
will be used instead. This will affect the report output since a different font has been
used.

Example 2: The development as well as deployment platform is Windows. So Reports
Servers on both the development and deployment platforms are able to access Tahoma
font since both run on Windows. However, suppose an end-user views the output on
Linux. All reports output formats (HTML, HTMLCSS, RTF, and PDF) merely refer to
the fonts and do not embed the fonts in the output unless you specifically use the font
embedding feature in PDF. As a result, the client system will look for the Tahoma font
to display the report output on client machine. Since Tahoma is not available on Linux,
the user will encounter cross-platform issues while viewing the output.
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12.3.2 Fixing Font-Related Issues

As we have seen, many cross-platform issues are caused by the non-availability of
fonts either on the production environment (where the Reports Server is running) or
on the client system. These font availability issues must be resolved by a 3-step
approach:

1.

Development platform: Ensure that you develop the report keeping in mind the
font availability on the deployment platform. All font files that are available on
Windows (TTF files) may not be available on UNIX (AFM or TEM files). If you
have the correct AFM or TFM font file available on the UNIX platform, you can
continue to use it (AFM for PostScript printing and TEM for PCL). For fonts with
AFM files not readily available on UNIX, or if you encounter any font issues in the
report output such as text misalignment, you can convert and generate an AFM
file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce
reliable results.

Deployment platform: Ensure that the fonts used in the report are available. For
PDF output, use font aliasing to substitute the unavailable font with the closest
available font. Global font aliasing can be used for all output formats.

Same comment holds for all the subsequent sections where you have asked to
provide examples.

Client platform: Ensure that you account for font unavailability on the client
system. For example, in the case of PDF output, you can use Font Subsetting or
Font Embedding, as described in Chapter 11, "Using PDF in Oracle Reports". In
the case of HTML, HTMLCSS or RTF output formats it is not possible to embed
the fonts, so it is best to design the report using fonts that are known to be
available on all platforms.

12.4 Generating HTMLCSS, RTF, or Web Output

Table 12-2 shows the cross platform deployment scenario where the destination
format is HTMLCSS, RTF, or the Web.

Table 12-2 Cross Platform Deployment - Scenario 1

Development Platform Deployment Platform Destination Format

Windows UNIX HTMLCSS, RTF, or Web

This section discusses designing and deploying a report for HTMLCSS, RTF, or Web
output in the following subsections:

Designing Your Report
Deploying Your Report
Frequently Asked Questions

12.4.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1.

Create a new report. While creating your report ensure that you leave additional
padding space for boilerplate and field objects. This is to ensure that the box's size
accounts for any possible increase in the text width when the report is run on the
deployment platform.
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2.

Use only those fonts in your report that:

Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

12.4.2 Deploying Your Report

Deploying a Report in 11g that uses the New Font Model

Ensure that the REPORTS_ENHANCED_FONTHANDLING environment variable is set
to yes. The default value is yes.

1.

Copy all the TTF and TTC files, which are used in the report, to the REPORTS_
FONT_DIRECTORY. The default font directory is SORACLE_
INSTANCE/reports/fonts.

Remove any unnecessary aliasing from the uifont.ali file. For example, Arial is
aliased to Helvetica, by default. If your report uses the Arial font, you must
remove the aliasing from the uifont.ali file.

Run the Report.

Deploying Reports in Pre-11g Version that uses Motif Tool Kit Mechanism

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce reliable

results.

To deploy your report on a UNIX platform when AFM font files are not available:

1.

Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.
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Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 12-3 Post Conversion Font File Names

Before Converting After Converting After Renaming
arial.ttf arial.afm Arial
cour.ttf cour.afm CourierNew

3. Copy the converted AFM files to the SORACLE_
HOME/guicommon/tk/admin/AFM directory.

4. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint.txt, you must
add the appropriate entries in the printer's PPD file for a PostScript
printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), if you have not
set up a default printer:

= A default printer surface that mimics the screen
(screenprinter.ppd) is used for formatting.

= You must add the necessary font and resolution entries in the
screenprinter.ppd file.

The PPD and HPD files are located at:

[ ] SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

m SORACLE_HOME/guicommon/tk/admin

Oracle Reports searches for HPD or PPD files initially in the Oracle
Instance location and then in the Oracle Home location.

Refer to Section 10.8.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.
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5. Ensure that the fonts used in your report are not aliased.

For example, edit the uifont.ali file and comment the entries in the [Global]
section, where Arial and Courier New are aliased to Helvetica and Courier,
respectively.

[ Global ] # Put mappings for all surfaces here.
# Mapping from MS Windows

#Arial = helvetica

#"Courier New" = courier

This ensures that Arial and Courier New are not aliased to any other font.

Note: Theuifont.alli fileis located in the following directory on
Windows and UNIX:

s Onwindows: ORACLE
INSTANCE\config\FRComponent\frcommon\tools\common

n On UNIX: $ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the report output and not necessarily on the machine generating the
report output.

6. Run the report.

http://mywebserver.com:reports/rwservlet?server=myserver+report="/home/myreport
s/test.rdf"+authid=hr/hremydb+desformat=htmlcss+destype=cache

The HTMLCSS output of your report will look exactly the same as the one
generated on Windows.

12.4.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the HTMLCSS output, set the environment
variable DEBUG_SLFIND to a log file name, for example, debug. txt, and run the
report. The font files that are looked up while parsing the PPD file as well as the
fonts used will be written to the log file debug . txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 9, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 10, "Printing on UNIX with Oracle Reports" for more information on
DEBUG_SLFIND.
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12.4.3 Frequently Asked Questions

This section covers frequently asked questions (FAQs) pertaining to deploying a
report to HTMLCSS, RTF or the Web.

Question

When I design a report on Windows with font styles such as italic and bold, then run
the report on UNIX, I do not see the output as it appeared on Windows. Why?

Answer

On UNIX, report formatting is done using fonts' corresponding AFM files. By default,
these AFM files are picked from the SORACLE_HOME/guicommon/tk/admin/AFM
directory, provided as part of the installation. If the font style used in report does not
have a corresponding AFM file on UNIX, the closest matching AFM file is used. For
example, if you design a report on Windows with Courier Italic font, then run the
report on UNIX, you may see only plain Courier font in the output. This happens
because there is no AFM file available for Courier Italic font in the SORACLE_
HOME/guicommon/tk/admin/AFM directory, so instead Courier is picked. To work
around this issue, you can alias your font's style to the same style for some other font
that has AFM available. For example, you could alias Courier Italic to Times Italic in
the global section of uifont.ali. Moreover, on Windows, there are some fonts that
have bold, italic, and bold italic versions; for example, Arial has arialbd. ttf (Arial
bold), ariali.ttf (Arial italic), and arialbi . ttf (Arial bold italic). Therefore, if
you are using any font that has bold, italic, and bold italic TTF files available, you can
generate AFM files from these files using tt £2pt1 and use these AFM files on UNIX.

Question

My report was created in Windows and is deployed on HP-UX 11. Although the font
style on HP-UX 11 is correct, the spacing between the lines is inconsistent and some
text is unable to fit in the allocated space. How can I fix the spacing so that my text fits
correctly?

Answer

Ensure that you have set up the corresponding AFM files for all the fonts used in your
document. Refer to Section 12.4.1, "Designing Your Report" for more information.

Question

My report is designed on Windows. When it is deployed on a different platform, it
displays garbled output. For example, some fields display, *** * * instead of the actual
content. Is this a spacing issue?

Answer

Oracle Reports cannot find the AFM files of the font that you have used in your report.
You can verify this by opening the report's HTML source and searching for the font
that you have used.

Oracle Reports then uses the closest matching font whose metrics are bigger than the
original font. Therefore, when the characters cannot fit in the box, a **** is displayed
in the field, instead of the actual output.

Ensure that:

= You have set up the AFM files for all the fonts used in your report. Refer to
Section 12.4.1, "Designing Your Report" for more information.
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= You have left approximately 10% extra padding space for fields and text
boilerplates.

Question

When my report is run on UNIX, the HTML or the HTMLCSS output looks shrunk.
However, the same report run on Windows looks fine. What can I do to ensure that
my report looks the same on UNIX as it did on Windows?

Answer

If you see shrinkage or expansion in your HTMLCSS output and you are on Oracle9i
Reports, then set the environment variable REPORTS_DEFAULT_PIXEL_SIZE to any
value ranging from 72 through 200 in reports. sh and restart the Reports Server.

For example:

REPORTS_DEFAULT_PIXEL_SIZE =72
export REPORTS_DEFAULT_ PIXEL_SIZE

There will not be any HTMLCSS output shrinkage/expansion in Oracle Reports 10g as
a fixed resolution is picked up from screenprinter .ppd. This resolution is editable.

*DefaultResolution: 96dpi (recommended)

Question
Can I use the overstrike property when I deploy a report in Solaris?

Answer
A limitation of AFM files is that it does not support the overstrike property.

Question

My report contains right-aligned fields that displays both positive and negative
numbers. For example, 12345.67, -12345. 67. However, when the report is
generated to HTMLCSS output, the alignment is not correct. How can I fix the
alignment? Is this a platform-specific issue?

Answer

This is not exactly a platform-specific issue. When the spaces in the HTMLCSS output
are replaced by &nbsp; this problem will be resolved. To ensure that you do not face
this issue, you must upgrade to the Oracle Reports 11g Release 1 (11.1.1).

12.5 Generating Single-Byte PDF Output

Table 12—4 shows the cross-platform deployment scenario where the destination
format is single-byte PDF created using PDF font subsetting. For more information on
PDF font features, refer to Chapter 11, "Using PDF in Oracle Reports".

Table 12-4 Cross Platform Deployment - Scenario 2

Development Platform Deployment Platform Destination Format

Windows UNIX PDF (single byte)

This section discusses designing and deploying a report for single-byte PDF output in
the following subsections:

»s  Designing Your Report
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Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism

Frequently Asked Questions

12.5.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:

1.
2.

Create a new report.

Use only those fonts in your report that:

Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

12.5.2 Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable

results.

To deploy your report on a UNIX platform using PDF font subsetting:

1.

2.

Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in

your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, tt f2pt1.

Post-conversion, remove the . afm extension in the AFM file name. For example:
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Table 12-5 Post Conversion Font File Names

Before Converting After Converting After Renaming

arial.ttf arial.afm Arial

cour.ttf cour.afm CourierNew

3. Copy the Windows TTF files that you have used in your report to the fonts
directory on your UNIX machine. For example, SORACLE_
HOME/reports/fonts.

4. Add the path to the TTF files in the REPORTS_PATH environment variable. This
ensures that the font files can be referenced by Reports Runtime.

5. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint.txt, you must
add the appropriate entries in the printer's PPD file for a PostScript
printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), if you have not
set up a default printer:

= A default printer surface that mimics the screen
(screenprinter.ppd) is used for formatting.

= You must add the necessary font and resolution entries in the
screenprinter.ppd file.

The PPD and HPD files are located at:

n SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

m SORACLE_HOME/guicommon/tk/admin

Oracle Reports searches for HPD or PPD files initially in the Oracle
Instance location and then in the Oracle Home location.

Refer to Section 10.8.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.
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10.

Copy the converted AFM files to the SORACLE_
HOME/guicommon/tk/admin/AFM directory.

Ensure that the uiprint. txt has the entry for the appropriate PPD file:

printer name:PostScript:2:test:ppd file

For example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.

Note: Copy the PPD file from ORALCE_
HOME/guicommon/tk/admin /PPD to the following location:

SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/ad
min/PPD

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name is the same as the font name given in the PPD file.
Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the fonts used in your report are not aliased.

For example, edit the uifont.ali and comment the entries in the [Global]
section where Arial and Courier New are aliased, by default, to Helvetica and
Courier respectively.

[ Global ] # Put mappings for all surfaces here.
# Mapping from MS Windows

#Arial = helvetica

#"Courier New" = courier
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Note: Theuifont.ali fileis located in the following directory on
Windows and UNIX:

s  Onwindows: ORACLE_
INSTANCE\config\FRComponent\frcommon\tools\common

s OnUNIX: SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the report output and not necessarily on the machine generating the
report output.

11. Add the appropriate entries in the [PDF: Subset] section to subset the fonts
used in your report.

For example:

[ PDF:Subset ]
"arial" = "arial.ttf"
"courier new" = "cour.ttf"

For PDF file portability, you can use either font subsetting or font embedding. File
portability ensures that the PDF report does not depend on the machine where it is
viewed to have the fonts installed.

12. Run the report to PDF and view it. The PDF should contain the fonts used in your
report. For example, Arial and Courier New fonts.

To verify the fonts used, do the following:
= In Acrobat Reader 6.0, choose File >Document Properties > Fonts.
s In Acrobat Reader 3.0 and above, choose File >Document Info > Fonts.

The Original Font column displays the Arial and Tahoma fonts. The PDF
document should not contain any font alignment issues.

12.5.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name (for example, debug. txt) and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the specified file. Specifically, check for the following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 9, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 10, "Printing on UNIX with Oracle Reports" for more information on
DEBUG_SLFIND.
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12.5.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to single-byte PDF output.

Question

My PDF report page count varies when it is deployed in Windows and UNIX
platforms. What must I do to fix it?

Answer

Your report uses the default printer for formatting. Ensure that the same resolution
and the same fonts used are made available to both the printers. One way of achieving
this would be to generate AFM files from Windows TTF font files and then copy the
Windows TTF files and AFM files to UNIX in the appropriate folders. Also set the
same resolution as Windows in PPD/HPD files. Follow the process specified in the
prior steps.

Question

The page count of my report varies when run on different installations of UNIX. How
can I ensure that the page count of my report is the same regardless of the installation?

Answer

In UNIX, Oracle Reports uses the PPD/HPD file of the default printer in the
installation for formatting. The resolution and list of fonts will be picked up from this
PPD/HPD files. Beginning with Oracle Reports 10g Release 1 (9.0.4), if there is no
default printer setup in the installation, then screenprinter.ppd will be used. This
PPD file emulates the screen. Earlier versions of Oracle Reports used the DISPLAY
environment variable instead. Ensure that the two installations use the same
AFM/TFM files and font files, so that the number of pages of PDF output will be the
same.

12.6 Generating Multibyte PDF Output

Table 12-6 shows the cross platform deployment scenario where the destination
format is multibyte PDF created using PDF font subsetting. For more information on
PDF font features, refer to Chapter 11, "Using PDF in Oracle Reports".

Table 12-6 Cross Platform Deployment - Scenario 4

Development Platform Deployment Platform Destination Format

Windows UNIX PDF (multibyte)

This section discusses designing and deploying a report for multibyte PDF output in
the following subsections:

s Designing Your Reportin Pre-11g Version That Uses Motif Tool Kit Mechanism
= Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism
= Frequently Asked Questions

12.6.1 Designing Your Reportin Pre-11g Version That Uses Motif Tool Kit Mechanism
To prepare your report before you deploy it on a UNIX platform:
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1. Create a new report with a TrueType multibyte font. For example, Simplified
Arabic font with the AR8IS08859P6 character set.

2. Use only those fonts in your report that:

s Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.

12.6.2 Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TFM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1. Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, tt f2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 12-7 Post Conversion Font File Names

Before Converting After Converting After Renaming

simpo.ttf simpo.afm SimplifiedArabic

3. Copy the Windows TTF file used in your report to the fonts directory on your
UNIX machine. For example, SORACLE_HOME/ fonts.
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Add the path to the TTF file in the REPORTS_PATH environment variable.

Copy the AFM file to the SORACLE_HOME/guicommon/tk/admin/AFM
directory.

Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_HOME/guicommon/tk/admin/uiprint.txt, you must
add the appropriate entries in the printer's PPD file for a PostScript
printer or in the HPD file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), if you have not
set up a default printer:

= A default printer surface that mimics the screen
(screenprinter.ppd) is used for formatting.

= You must add the necessary font and resolution entries in the
screenprinter.ppd file.

The PPD and HPD files are located at:

n SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

s SORACLE_HOME/guicommon/tk/admin

Oracle Reports searches for HPD or PPD files initially in the Oracle
Instance location and then in the Oracle Home location.

Refer to Section 10.8.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard "(Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the uiprint. txt has the entry for the appropriate PPD file:
printername: PostScript:2:test:ppd_file.

For example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.
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Note: Copy the PPD file from ORACLE_
HOME/guicommon/tk/admin/PPD to the following location:

$ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/ad
min/PPD

9. Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font SimplifiedArabic: Standard "(001.01)" Standard ROM

10. Ensure that the fonts used in your report are not aliased.

Edit uifont.ali and comment the entries, if any, where Simplified Arabic font
is aliased to some other font. For example: "SimplifiedArabic"="Arial".

Note: Theuifont.ali fileis located in the following directory on
Windows and UNIX:

= Windows: ORACLE_
INSTANCE®\config\FRComponent\ frcommon\tools\commo
n

s  UNIX: ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

Use font aliasing only if you are unable to generate the AFM file for a
particular font. You can then alias the missing font to the closest
match. The fonts must be made available on the machine displaying
the report output and not necessarily on the machine generating the
report output.

11. In the [PDF: Subset] section, add the appropriate entries to subset the fonts.
For example:
[ PDF:Subset ]
"SimplifiedArabic" = "simpo.ttf"

For PDF file portability, you can use either font subsetting or font embedding. File
portability ensures that the PDF report does not depend on the machine where it is
viewed to have the fonts installed.

12. Run the report to PDF and view it.

http://mywebserver.com:reports/rwservlet?server=myserver+report=
"/home/myreports/test.rdf"+authid=hr/hreémydb+desformat=PDF+destype=cache

The PDF should contain the font that you have used in your report. For example,
the David font.
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To verify the fonts used, do the following;:
= In Acrobat Reader 6.0, choose File >Document Properties > Fonts.
s In Acrobat Reader 3.0 and above, choose File >Document Info > Fonts.

The Original Font column should display the David font.

12.6.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name, for example, debug. txt, and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the log file debug. txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 9, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 11, "Using PDF in Oracle Reports" for more information on DEBUG_
SLFIND.

12.6.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to multibyte PDF output.

Question

What are the cross-platform issues for the PDF output when using CID multibyte
fonts?

Answer

To enable multibyte language support in PDF reports with CID multibyte fonts, you
must make sure that the Asian font package is installed for your Acrobat Reader on
the machine where you are going to view these PDF files. The Asian font package is
available at the Adobe Web site.

Question

Why is the formatting of my report not correct when using multibyte fonts on UNIX,
or why do I see misaligned text in the report?

Answer

If you have used ttf2pt1l to create the AFM file, tt£2pt1 has a limitation in that it
creates AFM files with metrics information for only the first 256 characters of the font.
The first 256 characters are for Latin-1 characters. So, if your font contains more than
256 characters, metrics information will not be available for the additional characters.
Oracle Reports uses default metrics information contained in the AFM file when it
encounters characters in the report that are not in the AFM file. These default metrics
may not match the exact metrics of the characters used in the report. For this reason,
formatting will not be correct. To avoid this situation when you are using characters
beyond the first 256 characters of the font, you can use fixed width fonts where all the

Font Model and Cross-Platform Deployment 12-21



Generating Unicode PDF Output

characters have the same width. For example, Miriam Fixed is a fixed width font for
Hebrew and can be used to avoid formatting issues.

12.7 Generating Unicode PDF Output

Table 12-8 shows the cross-platform deployment scenario where the destination
format is Unicode PDF created using PDF font subsetting. For more information on
PDF font features, refer to Chapter 11, "Using PDF in Oracle Reports".

Table 12-8 Cross Platform Deployment - Scenario 5

Development Platform Deployment Platform Destination Format

Windows UNIX PDF (Unicode)

This section discusses designing and deploying a report for Unicode PDF output in the
following subsections:

= Designing Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism
= Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism
= Frequently Asked Questions

12.7.1 Designing Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism
To prepare your report before you deploy it on a UNIX platform:

1. Create a new report using a Unicode font. For example, Arial Unicode MS font.
2. Use only those fonts in your report that:
»  Cover the entire Unicode range that your report uses.

= Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TFM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TEM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

= Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. The reason is that the MS Sans Serif font is a raster
font that does not scale well to any size and usually has rounding issues. On
the other hand, Tahoma font is a TrueType font that is very similar in visual
appearance to the MS Sans Serif font. Additionally, Tahoma is a vector font
that can be scaled to any size and rotated to any angle.
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12.7.2 Deploying Your Report in Pre-11g Version That Uses Motif Tool Kit Mechanism

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1. Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 12-9 Post Conversion Font File Names

Before Converting After Converting After Renaming

arialuni.ttf arialuni.afm ArialUnicodeMS

3. Copy the Windows TTF file used in your report to the fonts directory on your
UNIX machine. For example, SORACLE_HOME/ fonts.

4. Add the path to the TTF file in the REPORTS_PATH environment variable. For
example, arialuni.ttf.

5. Copy the AFM file to the $ORACLE_HOME/guicommon/tk/admin/AFM
directory. For example, ArialUnicodeMS.

6. Edit the screenprinter.ppd file with any text editor.

Note: If you have defined a default printer by including an entry in
ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/ad
min/uiprint. txt, then you will have to make the appropriate
entries in the printer's PPD file for a PostScript printer or in the HPD
file for a PCL printer.

Beginning with Oracle Reports 10g Release 1 (9.0.4), a default printer
surface that mimics the screen (screenprinter.ppd) is used for
formatting if you have not set up a default printer. You will also need
to make the necessary font and resolution entries in the
screenprinter.ppd file, if you have not set up a default printer.

The PPD and HPD files are located at:

n SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk
/admin

s SORACLE_HOME/guicommon/tk/admin

Oracle Reports searches for HPD or PPD files initially in the Oracle
Instance location and then in the Oracle Home location.

Refer to Section 10.8.1, "ScreenPrinter" for more information on the
screenprinter.ppd file.
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10.

11.

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report. PPD/HPD files are configuration files containing
printer driver settings and the list of all the fonts supported by the printer.

Navigate to the to the Font Information section in the PPD file and add the
necessary entries for the font files in the following format:

*FONTNAME : ENCODING : VERSION : LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM
*Font CourierNew: Standard " (Version 2.76)" Standard ROM

Ensure that the AFM file name exactly matches the font name specified in the PPD
file as Oracle Reports searches for this file based on the font name in the PPD file.

Ensure that the uiprint . txt has the entry for the appropriate PPD file.

printer name:PostScript:2:test:ppd file

In this example:

printerl:PostScript:2:test:hpljetd2.ppd

Edit the hpljet42.ppd file with any text editor.

Note: Copy the PPD file from ORACLE_
HOME/guicommon/tk/admin/PPD to the following location:

SORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/ad
min/PPD

Ensure that the PPD/HPD file used contains an entry for each AFM or TFM file
that you use in your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION : LOCATION

For example:

*Font ArialUnicodeMS: Standard " (Version 2.76)" Standard ROM

In the [PDF: Subset] section, add the following entries to subset the fonts used
in your report.

For example:

[ PDF:Subset ]

"Arial Unicode MS" = "arialuni.ttf"

Use the PDF subsetting feature to generate multibyte PDF output from your
reports and to ensure your PDF report is portable. Thus, there is not dependency
on the machine deploying the report to have the fonts installed.

Run the report to PDF and view it.

http://mywebserver.com:reports/rwservlet?server=myserver+report=
" /home/myreports/test.rdf"+authid=hr/hremydb+desformat=PDF+destype=cache
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The PDF should contain the unicode font used in your report. For example, Arial
Unicode MS.

12.7.2.1 Troubleshooting Information

If you encounter deployment issues, review the following troubleshooting
information:

= If you do not get the correct fonts in the PDF output, set the environment variable
DEBUG_SLFIND to a log file name (for example, debug. txt) and run the report.
The font files that are looked up while parsing the PPD file as well as the fonts
used will be written to the log file debug. txt. Specifically, check for the
following:

1. The PPD file that you modified should be picked up. If it is not picked up it is
a configuration issue. Refer to Chapter 9, "Managing Fonts in Oracle Reports".

2. The AFM files that you have copied to AFM directory should be picked up
next.

See Chapter 11, "Using PDF in Oracle Reports" for more information on DEBUG_
SLFIND.

12.7.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to Unicode PDF output.

Question

Why is the formatting of my report not correct when using Unicode on UNIX, or why
do I see misaligned text in the report?

Answer

If you have used ttf2pt1 to create the AFM file, tt£2pt1 has a limitation in that it
creates AFM files with metrics information for only the first 256 characters of the font.
So, if you are using multiple languages in the report with a Unicode font like Arial
Unicode MS, when you create the AFM file for UNIX, there will not be metrics
information for the characters beyond the first 256 characters. Oracle Reports uses
default metrics information contained in the AFM file when it encounters characters in
the report that are not in the AFM file. These default metrics may not match the exact
metrics of the characters used in the report. For this reason, formatting will not be
correct. To avoid formatting issues when you are using characters beyond the first 256
characters of the font, you can use fixed width fonts where all the characters have the
same width.

12.8 Generating PostScript Output

Table 12-10 shows the cross-platform deployment scenario where the destination
format is PostScript.

Table 12-10 Cross Platform Deployment - Scenario 3

Development Platform Deployment Platform Destination Format
Windows UNIX PostScript
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This section discusses designing and deploying a report for PostScript output in the
following subsections:

= Designing Your Report
= Deploying Your Report
= Frequently Asked Questions

12.8.1 Designing Your Report
To prepare your report before you deploy it on a UNIX platform:
1. Create a new report.
2. Use only those fonts in your report that:

s Are available on UNIX. All font files that are available on Windows (TTF files)
may not be available on UNIX (AFM or TEM files). If you have the correct
AFM or TFM font file available on the UNIX platform, you can continue to use
it (AFM for PostScript and TFM for PCL).

Note: AFM support is extended only to single-byte PostScript file
generation, with the exception of Japanese encoding.

The encoding schemes supported for the AFM files are:

AdobeStandardEncoding
ExtJIS12-88-CFEncoding
FontSpecific

HRoman

ISOLatinHebrew
JIS12-88-CFEncoding
JIS12e-88-CFEncoding

s Can scale well. For example, MS Sans Serif does not scale well to a different
size, whereas Tahoma does. This is because MS Sans Serif is a raster font that
does not scale well to any size and usually has rounding issues. On the other
hand, Tahoma is a TrueType font that is very similar in visual appearance to
MS Sans Serif. Additionally, Tahoma is a vector font that can be scaled to any
size and rotated to any angle.

= Do not include Unicode characters. Oracle Reports does not support Unicode
character sets in Post Script output on the UNIX platform. As an alternative,
you can use either of the following:

—  Oracle Reports PDF output (desformat=pdf), which supports multibyte
character sets, as discussed in Section 10.6.1, "Multibyte Character Set
Printing".

— Oracle Reports utilities IX and PASTA for font embedding in PostScript

output when Oracle Reports is installed and used with Oracle
Applications, as discussed in Section 10.6.2, "Overview of IX and PASTA".

3. To have the PostScript output look same on the design platform (Windows) and
deployment platform (Unix), the paper size should be same on both the platforms.
On Windows, if you want to change the default paper size from Letter to any
other size (for example, A4), perform the following steps:
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a. Choose Settings > Control Panel > Printers.

b. Right-click the default printer and select Properties.
c. Click Printing Preferences in the General tab.

d. Click Advanced in the Paper/Quality tab.

e. Select the Paper Size and click OK.
f.  Click OK until the main dialog box displays to set the default paper size.

12.8.2 Deploying Your Report

For fonts with AFM files not readily available on UNIX, or if you encounter any font
issues in the report output such as text misalignment, you can convert and generate an
AFM file from the Windows TTF file using freely available third party utilities, such as
ttf2ptl. Do not attempt to convert to a TEM file, as this may not produce reliable
results.

To deploy your report on a UNIX platform:

1. Locate the TTF files corresponding to the fonts used in your report. Convert these
TTF files to AFM to ensure that you will have the AFM files for the fonts used in
your report.

Use a True Type to Type 1 font converter utility to convert the TTF files to AFM
files. For example, ttf2pt1.

2. Post-conversion, remove the . afm extension in the AFM file name. For example:

Table 12-11 Post Conversion Font File Names

Before Converting After Converting After Renaming

arial.ttf arial.afm Arial

3. Copy the AFM file to the $ORACLE_HOME/guicommon/tk/admin/AFM
directory.

4. Ensure that the TK_PRINTER environment variable or the PRINTER environment
variable is set to the default printer name. For example, printerl.

5. Ensure that uiprint. txt has the entry for the appropriate PPD file in the
format, printer name: PostScript:2:test:ppd file.In this example:

printerl:PostScript:2:test:hpljetd2.ppd
6. Edit the file hpljet42.ppd using any text editor. Specifically, edit the

DefaultPageSize, DefaultPageRegion, and Defaul tPaperDimension to
change the default paper from Letter to A4, in the following way:

*DefaultPageSize: A4
*Defaul tPageRegion: A4

*DefaultPaperDimension: A4
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Note: Copy the PPD file from ORACLE_
HOME/guicommon/tk/admin /PPD to the following location:

$ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/ad
min/PPD

7. Ensure that the PPD file used contains an entry for each AFM file that you use in
your report.

Navigate to the Font Information section and add the necessary entries for the
new AFM files in the following order:

*FONTNAME : ENCODING : VERSION: LOCATION

For example:

*Font Arial: Standard " (Version 2.76)" Standard ROM

8. Run the report to printer and verify that it is printed to A4 Paper.

http://mywebserver.com:reports/rwservlet?server=myserver+report="c:\test.rdf"+a
uthid=hr/hr@mydb+desformat=postscript+destype=cache

12.8.3 Frequently Asked Questions

This section contains frequently asked questions (FAQs) pertaining to deploying a
report to PostScript output.

Question
Does Oracle Reports support Unicode PostScript file generation?

Answer
Currently, Oracle Reports supports Unicode character sets in PostScript output only
on the Windows platform. On UNIX platforms, you can use either of the following:

= Oracle Reports PDF output (desformat=pdf), which supports multibyte
character sets, as discussed in Section 10.6.1, "Multibyte Character Set Printing".

s Oracle Reports utilities IX and PASTA for font embedding in PostScript output
when Oracle Reports is installed and used with Oracle Applications, as discussed
in Section 10.6.2, "Overview of IX and PASTA".

Question
Does Oracle Reports embed the font in the PostScript output file?

Answer

Oracle Reports does not embed the font in the PostScript output file. It writes the font
name and the metrics that were calculated using AFM files. Therefore, for the report to
appear without any font alignment issues, ensure that the necessary fonts are installed
on the printer.

Question

The page count of my report varies when run on different installations of UNIX. How
can I ensure that the page count of my report is the same regardless of the installation?
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Answer

In UNIX, Oracle Reports uses the PPD/HPD file of the default printer in the
installation for formatting. The resolution and list of fonts will be picked up from this
PPD/HPD files. Beginning with Oracle Reports 10g Release 1 (9.0.4), if there is no
default printer setup in the installation, then screenprinter. ppd will be used. This
PPD file emulates the screen. Earlier versions of Oracle Reports used the DISPLAY
environment variable instead. Ensure that the two installations use the same AFM/TFM
files and font files, so that the number of pages of PDF output will be the same.
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Configuring Destinations for Oracle Reports
Services

Two things to consider when you run a report are how the report should be output
(destination) and who should receive it (distribution). Distribution is discussed in
Chapter 20, "Creating Advanced Distributions". This chapter explores how Oracle
Reports Services handles output processing to default and custom destinations. It
provides an overview of output processing and information on registering destination
types with the Oracle Reports Services.

It includes the following sections:

= What's New in this Release

s Overview of Output Processing

= Registering Destination Types with the Server

= Submitting Reports to Pluggable Destinations from Oracle Forms Services

13.1 What’s New in this Release

11g Release 1 (11.1.1) provides the Pluggable Destinations from Oracle Forms Services
enhancement.

13.1.1 Pluggable Destinations from Oracle Forms Services.

In prior releases, a pluggable destination defined for Reports Server cannot be used
when running a report from Oracle Forms Services (specifically from RUN_REPORT_
OBJECT) because the REPORT_DESTYPE property in Oracle Forms Services allows for
only a pre-specified set of values.

In Oracle Reports 11g Release 1 (11.1.1), this limitation is removed: report requests can
be submitted to all destinations, including any Oracle Reports-registered pluggable
destinations from Oracle Forms Services. This enhancement introduces a new Oracle
Forms Services command line parameter: PLUGDESTYPE. Oracle Forms Services
passes the pluggable destination DESTYPE in the PLUGDESTYPE parameter as part of
the REPORT_OTHER property. When this parameter is present, it overrides whatever is
specified in DESTYPE command line argument (or REPORT_DESTYPE for Oracle
Forms Services).

For more information, see Section 13.4, "Submitting Reports to Pluggable Destinations
from Oracle Forms Services"
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13.2 Overview of Output Processing

Report output is controlled by the DESTYPE value that you specify at runtime, which,
in turn, is determined by the destination output types you have registered in your
server configuration file (rwserver.conf) using the destination element. For
more information, see Section A.5.31, "DESTYPE" and Section 8.2.1.6, "destination".

You need not register the following default destinations:

Cache
E-mail
Printer
File

FIP
WebDAV

You may need to register the following default destination:

Oracle Portal: The entry for this destination is created by default in the server
configuration file, but it is commented out. To start using this destination, you
must uncomment the destination entry, and also provide appropriate property
values (for example, the value for the portalUserid property).

You must register any new destination types you create through the Oracle Reports
Services Destinations AP

Note: For more information on the destination API, refer to
the Reports Software Development Kit (RSDK) on the Oracle
Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

Configuring destinations is discussed in detail in Chapter 13,
"Configuring Destinations for Oracle Reports Services".

You can also define custom output types, such as fax, Oracle's Internet File System
(iFS), or any new destination type you define using the Oracle Reports Services
Destinations APIL This API enables you to define new destination types and build
handlers to usher your reports to custom destinations.

Note: For more information on the available APIs for Oracle
Reports, refer to the Reports Software Development Kit (RSDK) on
the Oracle Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

The Oracle Reports Services architecture standardizes the way output is generated and

delivered. It takes responsibility for delivering report output to the appropriate
destination (through the Reports Server), yet generates output independent of its
destination (through the Oracle Reports engine). This provides a significant
improvement in efficiency by allowing one run of a report to be used in a number of
different ways. It also opens up the output processing architecture to allow for any
number of destination types.
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In the past, the Reports Runtime engine was totally responsible for delivering the
output. Consequently, it had to know how to communicate with output destinations.
This resulted in a tight coupling between the engine and the supported destinations.

Oracle Reports Services eliminates this tight coupling and its attendant restrictions.
The runtime engine now treats all destinations alike. It doesn't know the destination
type for which the output is being produced. The server hands output off to
destination handlers that prepare the material for delivery to their associated
destination types. You can use predefined destination types (with predefined
handlers) or create a handler for a custom destination type you intend to support.
Almost any type of destination can be plugged into Oracle Reports.

Figure 13-1 illustrates the main components of the Oracle Reports Services output
processing architecture.

Figure 13-1 Main components of destination/distribution architecture
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Requests flow through the output processing architecture in the following sequence:
1. The user submits a request from a client or browser to the Reports Server.

2. The server passes it along to the runtime engine.

3. The runtime engine creates/processes the destination objects (which include file
lists for specific destinations as well as any properties related to those
destinations) and the report output; the runtime engine sends the destination
objects to the Reports Server and the report output to cache.

4. The Reports Server sends the destination objects to the Reports Server's
destination component.
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5. The destination component of the Reports Server fetches the report output from
cache.

6. The Reports Server destination component sends the report and the destination
objects (which specify how the destination device should handle the output) to the
appropriate destination handler.

13.3 Registering Destination Types with the Server

Before Oracle Reports Services can send a report to a particular destination type, the
type must be a default type (printer, e-mail, cache, or file) or a type registered in the
server configuration file, rwserver.conf. The configuration file contains a
destination element for registering destination types that are valid for your reports.
You can register anywhere from zero to any number of destination types.

Registering a destination type with the server involves:
= Setting Up a Destination Section in the Server Configuration File
»  Entering Valid Values for a Destination

These tasks are described in the following sections.

13.3.1 Setting Up a Destination Section in the Server Configuration File

To set up a destination section in the rwserver.conf file:
1. Open the server configuration file with your preferred text editor.

You'll find the server configuration file in the following directory (Windows and
UNIX use the same path):

ORACLE_INSTANCE\config\ReportsServerComponent\server_name\rwserver.conf
2. If the configuration file does not have a destination section, create one

underneath the element that precedes it in the configuration file's data type
definition file (rwserverconf . dtd) section.

Note: The server configuration file follows the order of elements
defined in the file's related document type definition file (ORACLE_
HOME\reports\dtd\rwserverconf.dtd). Place destination
after the elements that precede it, whichever are present in your
server configuration file.

3. Use the following syntax to register all the destination types you will use for
outputting reports:

<destination destype="output_type 1" class="java_class_1">
<property name="valid_destype_property" value="valid value"/>
<property name="valid destype property" value="valid value"/>
</destination>

<destination destype="output_type 2" class="java_class 2">
<property name="valid destype property" value="valid value"/>
</destination>

The valid values for these tags are discussed in the following sections.
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13.3.2 Entering Valid Values for a Destination

This section outlines the destinations supported by Oracle Reports.

13.3.2.1 Destination destypes and classes

The destype and class attributes are required for valid registration of a nondefault
output type. They specify the destination types and their associated Java classes. The
predefined (default) destination types and classes that come with Oracle Reports
Services are listed in Table 13-1:

Table 13—-1 Standard Destination Types and Classes

Destination destype Class

Oracle Portal content area oraclePortal oracle.reports.server.
DesOraclePortal

SMTP-compliant e-mail mail oracle.reports.server.DesMail

file file oracle.reports.server.DesFile

cache cache oracle.reports.server.DesCache

printer printer oracle.reports.server.DesPrint

FIP ftp oracle.reports.plugin.destination.
ftp.DesFTP

WebDAV WebDAV oracle.reports.plugin.destination.

webdav . DesWebDAV

See Also: Section A.5.31, "DESTYPE" for examples of pushing a
report using the oraclePortal destype.

You are not limited to the predefined destypes and classes provided with the server.
You can register custom destination types, such as a fax, once you have defined a
custom handler (through the Destinations API).

Note: For more information on the available APIs for Oracle
Reports, refer to the Reports Software Development Kit (RSDK) on
the Oracle Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports
/index.html), click SDK.

13.3.2.2 Destination Property name/value Pairs

The server configuration file allows the association of an unlimited number of
properties with a registered destination. Destination properties consist of name/value
pairs that define some aspect of an output type's configuration. They are expressed in
terminology recognized by the destination type. For example, a destination with a
destype of oraclePortal would recognize the name/value pair:

<property name="portalUserid" value="portal_id/portal_password@portal_schema"
encrypted="no"/>

This example defines the values to be associated with a portal user ID. It includes the
encrypted attribute, which indicate that the values within this element should be
encrypted; encrypted="no", which indicates that the values are not yet encrypted.
The next time the Reports Server starts, it will automatically encrypt the values and
reset encrypted to yes.
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Note: Elements and attributes allowable in server configuration
file are determined by the syntax defined in the

rwserverconf .xsd file (ORACLE_
HOME\reports\dtd\rwserverconf .xsd). This is discussed in
detail in Chapter 8, "Configuring Oracle Reports Services".

What is valid for a destination type's properties depends entirely on the destination
type. These values do not come from Oracle Reports and are not put to use by the
Reports Server. They come from the destination type itself and use terms the
destination recognizes. It is up to the developer to understand the requirements of a
custom destination and to know what properties to associate with a given custom
output type.

When we begin to discuss distribution, you may note that within the distribution XML
file, the destype element also allows for the use of property name/value pairs. It is
important to make a distinction between properties entered for a destination
element in the server configuration file and those entered for a destype element in
the distribution XML file:

= Properties entered for a destination element in the server configuration file
should deal only with configuring an output type, for example setting an
allowable number of retries for a destination fax.

»  Properties entered for a destype element in the distribution XML file should deal
only with specifying a runtime parameter, for example the identity of the fax's
intended recipient.

13.3.3 Example Destination

The following example illustrates a destination element for pushing content into
Oracle Portal:

<destination destype="oraclePortal" class="oracle.reports.server.DesOraclePortal">
<property name="portalUserid" value="<username_pwd_tnsname_ for_logon_to_portal>"
encrypted="yes"/>
</destination>

13.4 Submitting Reports to Pluggable Destinations from Oracle Forms
Services

To submit requests to any Oracle Reports-registered pluggable destinations from
Oracle Forms Services:

1. Create or install a pluggable destination for Reports Server (refer to the Oracle
Reports Plugin Exchange on the Oracle Technology Network (OTN) at
http://www.oracle.com/technology/products/reports/pluginxchan
ge/index.html).

2. In Oracle Forms, create a form and set it up to run a report to Reports Server (refer
to Integrating Oracle Reports in Oracle Forms Services white paper at
http://www.oracle.com/technology/products/forms/pdf/10g/frml0
gsrwlOg.pdf).

The parameters to submit the request should be set as follows:

set_report_object_property (report_id, REPORT DESTYPE, PLUGDEST);
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set_report_object_property (report_id, REPORT OTHER, 'PLUGDESTYPE=pluggable
destination’ );

3. Observe in Reports Server that the report output is sent to the pluggable
destination.

When the PLUGDESTYPE parameter is specified, DESTYPE (in Oracle Reports) and
REPORT_DESTYPE (in Oracle Forms) will be ignored and the value of PLUGDESTYPE
will be used.
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Configuring and Using the Pluggable Data
sources

This chapter describes configuring and using several types of pluggable datasources:
Configuring and Using the JDBC PDS

Configuring and Using Text PDS

Configuring and Using XML PDS

14.1 Configuring and Using the JDBC PDS

The JDBC pluggable data source (PDS) enables you to access any JDBC data sources,
such as:

= An RDBMS like Oracle, DB2, Sybase, or SQL Server
= A non-relational data source like Microsoft Excel
= Any ODBC data source through the JDBC-ODBC bridge

The JDBC PDS is installed by default with Oracle Reports to allow access to all of the
JDBC supported data sources.

This chapter contains the following sections:

= JDBC Configuration File

= Defining and Running a JDBC Query

= Running a JDBC Report Using Oracle Reports Services
= TroubleShooting Information

»  Adding Your Own JDBC Driver

14.1.1 JDBC Configuration File

The jdbcpds . conf file is the Oracle Reports JDBC PDS configuration file. It is
located in the following directories:

»  For Reports Server:
ORACLE_INSTANCE\config\ReportsServerComponent\server_name

= For Oracle Reports Builder:
ORACLE_INSTANCE\config\ReportsToolsComponent\ReportsTools

= For Reports Application (in-process Reports Server) deployed in Oracle WebLogic
Server:
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fmw_home/user_projects/domains/domain_name/servers/WLS_
REPORTS/stage/reports/reports/configuration

This file is preconfigured for the:

»  Pre-installed drivers; that is, Oracle JDBC Thin, Oracle JDBC OCI (thick), and
JDBC-ODBC.

= DataDirect Merant drivers available on Oracle Technology Network,
(http://www.oracle.com/technology/index.html).

You must add or modify relevant entries in the jdbcpds . conf file to include any
other JDBC drivers that you want to use.

Oracle Reports Builder displays a list of drivers in the JDBC Query Connection dialog
box based on the entries in the jdbcpds . conf file. Use this list to select specific
drivers for your report's JDBC query.

Oracle Reports Builder reads and caches the entries in the jdbcpds . conf when it is
invoked. Restart Oracle Reports Builder to view the result of any changes made to the
jdbcpds . conf file, for example, adding a new JDBC driver entry.

The jdbcpds . conf file has two sections:

= An Internal DTD section describing the XML format and driver configuration
information

Caution: This section should not be modified.

= An XML section detailing the driver information like driver name, connect string
format, driver class, and so on.

Note: You can modify or add your driver information in this section.

Example
The following sample illustrates the contents of the jdbcpds . conf file:

<!-- Add or modify the following section for your driver information -->
<!-- Following drivers are available out-of-box in OracleAS -->
<jdbcpds>

xmlns="http://xmlns.oracle.com/reports/pdsjdbc"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://xmlns.oracle.com/reports/pdsjdbc
file:c:\orawin/reports/dtd/jdbcpds.xsd"
>
<driverInfo>
<driver name = "oracleThin"
sourceDatabase = "oracle"
subProtocol = "oracle:thin"
connectString = "mainProtocol:subProtocol:@databaseName"
class= "oracle.jdbc.driver.OracleDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">
</driver>

<driver name = "oracle"

sourceDatabase = "oracle"
subProtocol = "oracle:oci8"
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connectString = "mainProtocol:subProtocol:@databaseName"
class = "oracle.jdbc.driver.OracleDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

<driver name = "jdbc-odbc"
sourceDatabase = "odbc"
subProtocol = "odbc"
connectString = "mainProtocol:subProtocol:databaseName"
class = "sun.jdbc.odbc.JdbcOdbcDriver™"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

<driver name = "sqglserver-merant"
sourceDatabase = "sglserver"
subProtocol = "merant:sglserver"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.sqlserver.SQLServerDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

<driver name = "sybase-merant"
sourceDatabase = "sybase"
subProtocol = "merant:sybase"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.sybase.SybaseDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling"
loginTimeout = "0">

</driver>

<driver name = "db2-merant"
sourceDatabase = "db2"
subProtocol = "merant:db2"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.db2.DB2Driver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling"
loginTimeout = "0">
</driver>

<driver name = "informix-merant"
sourceDatabase = "informix"
subProtocol = "merant:informix"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.informix.InformixDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

</driverInfo>

</jdbcpds>
Table 14-1 outlines the various attributes that can be associated with a driver.
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Table 14—1 Driver Attributes

Attribute Name

Description

Sample

name

sourceDatabase

subProtocol

connectString

class

connection

loginTimeout
(Optional)

property

A unique user-defined value used to refer
to a specific JDBC driver in Oracle
Reports.

Database referenced by the driver. The
valid entries are:

oracle
sglserver
sybase
db2
informix
odbc

other

Driver sub protocol added with the
database URL before creating a database
connection. This is driver-specific
information and can be found in the
driver documentation. Example: The sub
protocol used for connecting to the
Merant driver:

Sybase is merant : sybase

SQL Server is merant : sglserver

Format of the driver's connect string
formatis mainProtocol:sub
Protocol://databaseURL. For
example,

jdbc : subProtocol : //databaseName
. Do not specify the actual values for
subProtocol or databaseName, use
the fixed placeholder names instead.

Driver class name used to register to
REPORTS_CLASSPATH and load the
driver. This is driver-specific information
and can be found in the driver
documentation.

Driver's connection handling class. The
JDBC PDS can have different connection
handling classes for each driver. Oracle
Reports' default connection handling
class, which is sufficient for most drivers,
is
oracle.reports.plugin.datasourc
e.jdbcpds.JDBCConnectionHandlin
g

Refer to the Oracle Reports Java API
Reference for more information on how to
extend your JDBC Connection class

Driver-specific parameter. Specify the
value in seconds. Please refer to the driver
documentation for more information.

Specify any additional properties of your
driver as Attribute Name and Value.

sybase-merant

oracle

merant : sybase

mainProtocol: subP
rotocol://databas
eName

com.oracle.ias.jd
bc.informix.Infor
mixDriver

oracle.reports.pl
ugin.datasource. j
dbcpds.
JDBCConnectionHan
dling
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When you submit your report's connection details, the connection information is
combined with the driver's configuration information specified in the jdbcpds . conf
file. The resulting connection information is submitted to the database as a complete
connection URL. Refer to Table 14-3, Table 144, Table 14-5, Table 14-6, and Table 14-7
for more information on sample connection information.

Figure 14-1 shows a list of all drivers configured in the jdbcpds . conf file.

Figure 14-1 JDBC Connect Dialog Box in Oracle Reports Builder

Connect

Enter the connection information for the datasource.
Connection Information : P_JIDBCPDS

User Name: |Rep0rts

EEEEE

Password:

Database: |Server1 dpnuser.com:1 300:5101

Driver Type | aracleThin e

oracle

Comnect | ap e adne

sqlserer-merant
sybase-merant
dbZ-merant
infarmix-merant

14.1.1.1 Verifying Pre-installed Driver Entries

Drivers like SQL Server and Excel with JDBC-ODBC, Oracle JDBC Thin, and Oracle
JDBC OCI (thick) are installed and configured with Oracle Reports. These drivers do
not require any additional JAR files to be installed.

s Oracle JDBC Thin driver
s Oracle JDBC OCI (thick) driver
= JDBC-ODBC driver

You can use SQL Server / Excel with the JDBC-ODBC driver. This entry is
preconfigured in the jdbcpds . conf file. Before you can use SQL Server or Excel
with JDBC-ODBC, you must create an ODBC data source. Refer to Windows help,
for more information on how to create an ODBC data source.

Note: Oracle Fusion Middleware provides Merant DataDirect
drivers which can also be used to access SQL Server.

14.1.1.2 Installing and Configuring Merant DataDirect Drivers

Oracle provides a set of Merant DataDirect drivers (Version 3.2) that can be
downloaded from OTN (http://www.oracle.com/technology/index.html).
The driver configuration file; that is, jdbcpds . conf contains relevant entries for the
Merant DataDirect drivers. Additionally, the JDBC Connect dialog (Table 14-1) lists
the entries for the set of Merant DataDirect drivers provided by Oracle.

However, you must install the appropriate JAR files and specify them in Oracle
Reports specific classpath entries, in order to make them available to Oracle Reports
Builder and Oracle Reports Services
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The drivers provided by Oracle for use with Oracle Fusion Middleware / Oracle
Developer Suite are:

Sybase Driver

DB 2 Driver

SQL Server Driver
Informix Driver

Custom Driver

You can also install and configure a Custom Driver for use with Oracle Fusion
Middleware and Oracle Developer Suite.

The following procedure outlines the generic steps involved in configuring the Merant
DataDirect drivers. To configure specific Merant DataDirect drivers refer to the
appropriate sections.

To configure the Merant DataDirect drivers:

1.

Install the relevant JAR files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.

Include an entry in REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.

Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

Refer to the relevant driver in this section for information on the required JAR
files.

a. Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users. Refer to the relevant driver
in this section for an example.

b. rwbuilder.conf: Append the driver location to the engine classPath
attribute in the rwbuilder. conf configuration file. Refer to the relevant
driver in this section for an example.

c. Reports Server: Append the driver location to the classPath attribute of the
engine, in the Reports Server configuration file. Refer to the relevant driver in
this section for an example

d. jdbcpds.conf: Located in the ORACLE_
INSTANCE\config\ReportsServerComponent\server_name directory.
Refer to Table 14-1 for more information on the parameters. Refer to the
relevant driver in this section for an example.

14.1.1.2.1 Sybase Driver

1.

Install the relevant JAR files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.

Jar files required: YMutil. jar, YMsybase. jar, and YMbase. jar.

Include an entry in the REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.
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Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users.

Example:
D:\sybase_installed\YMutil.jar;D:\sybase_installed\YMsybase.jar;D:\sybase_
installed\YMbase. jar;existing classpath entries

rwbuilder.conf: Append the driver location to the engine classPath
attribute in the rwbuilder.conf configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\sybase_
installed\YMutil.jar;D:\sybase installed\YMsybase.jar;D:\sybase
installed\YMbase.jar;">

</engine>

Reports Server: Append the driver location to the classPath attribute of the
engine in the Reports Server configuration file.

Example:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"
callbackTimeOut="60000" classPath="D:\sybase_

installed\YMutil.jar;D:\sybase installed\YMsybase.jar;D:\sybase
installed\YMbase.jar;">

</engine>

jdbepds.conf: Located in the ORACLE_
INSTANCE\config\ReportsServerComponent\server_name directory.
Refer to Table 14-1 for more information on the required parameters.

Example:
<driver name = "sybase-merant"
sourceDatabase = "sybase"

subProtocol = "merant:sybase"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.sybase.SybaseDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling"
loginTimeout = "0">

</driver>

141.1.2.2 DB 2 Driver

1.

Install the relevant JAR files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.

JAR files required: YMutil. jar, YMdb2.jar, and YMbase.jar

Include an entry in REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.
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Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users.

Example:
D:\db2_installed\YMutil.jar;D:\db2_installed\YMdb2.jar;D:\db2_
installed\YMbase.jar;existing classpath entries

rwbuilder.conf: Append the driver location to the engine classPath
attribute in the rwbuilder.conf configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\db2_installed\YMutil.jar;D:\db2_
installed\YMdb2.jar;D:\db2_installed\YMbase.jar">

</engine>

Reports Server: Append the driver location to the classPath attribute of the
engine in the Reports Server configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\db2_installed\YMutil.jar;D:\db2_
installed\YMdb2.jar;D:\db2_installed\YMbase.jar">

</engine>

jdbepds.conf: Located in the ORACLE_
INSTANCE\config\ReportsServerComponent\server_name directory.
Refer to Table 14-1 for more information on the parameters.

Example:

<driver name = "db2-merant"
sourceDatabase = "db2"
subProtocol = "merant:db2"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.db2.DB2Driver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling"
loginTimeout = "0">

</driver>

14.1.1.2.3 SQL Server Driver

1.

Install the relevant . jar files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.

Jar files required: YMutil. jar, YMsglserver.jar, and YMbase. jar

Include an entry in the REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.
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Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users.

Example:

D:\sglserver_installed\YMutil.jar;D:\sqglserver_
installed\YMsqglserver.jar;D:\sqglserver_installed\YMbase.jar; existing
classpath entries

rwbuilder.conf: Append the driver location to the engine classPath
attribute in the rwbuilder.conf configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\sqlserver_
installed\YMutil.jar;D:\sqlserver_installed\YMsqlserver.jar;D:\sqlserver
installed\YMbase.jar;">

</engine>

Reports Server: Append the driver location to the classPath attribute of the
engine in the Reports Server configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\sqlserver_
installed\YMutil.jar;D:\sqlserver_installed\YMsqlserver.jar;D:\sqglserver
installed\YMbase.jar;">

</engine>
jdbepds.conf: Located in the ORACLE_

INSTANCE\config\ReportsServerComponent\server_name directory.
Refer to Table 14-1 for more information on the parameters.

Example:

<driver name = "sglserver-merant"
sourceDatabase = "sqglserver"
subProtocol = "merant:sqglserver"
connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.sqglserver.SQLServerDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

14.1.1.2.4 Informix Driver

1.

Install the relevant JAR files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.

JAR files required: YMutil.jar, YMinformix. jar, and YMbase. jar

Include an entry in the REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.
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Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

a. Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users.

Example:

D:\informix_installed\YMutil.jar;D:\informix_
installed\YMinformix.jar;D:\informix_installed\YMbase.jar;existing
classpath entries

b. rwbuilder.conf:Append the driver location to the engine classPath
attribute in the rwbuilder . conf configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\informix_
installed\YMutil.jar;D:\informix_ installed\YMinformix.jar;D:\informix
installed\YMbase.jar">

</engine>

c. Reports Server: Append the driver location to the classPath attribute of the
engine in the Reports Server configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="D:\informix_
installed\YMutil.jar;D:\informix_installed\YMinformix.jar;D:\informix
installed\YMbase.jar">

</engine>
d. jdbcpds.conf: Located in the ORACLE_

INSTANCE\config\ReportsServerComponent\server_name directory.
Refer to Table 14-1 for more information on the parameters.

Example:

<driver name = "informix-merant"

sourceDatabase = "informix"

subProtocol = "merant:informix"

connectString = "mainProtocol:subProtocol://databaseName"
class = "com.oracle.ias.jdbc.informix.InformixDriver"
connection = "oracle.reports.plugin.datasource.jdbcpds.
JDBCConnectionHandling">

</driver>

14.1.1.2.5 Custom Driver

Any driver that is not provided by Oracle must be installed and configured. For
example, you can use BEA JDBC drivers if you have license. To install and configure a
custom driver, complete the following steps:

1. Install the relevant JAR files in your Oracle Fusion Middleware and Oracle
Developer Suite directory.
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2. Include an entry in REPORTS_CLASSPATH to make the files available to Oracle
Reports Builder and Oracle Reports Services.

Note: The REPORTS_CLASSPATH variable is located in the
reports. sh file for all UNIX platforms.

Jar files required: Refer to the relevant driver documentation.

a.

Oracle Reports Builder: Prefix the driver location to the existing entries in
REPORTS_CLASSPATH. This variable is located in the registry for Windows
users and in the reports. sh file for UNIX users.

Example:
driver location\lst jar file;driver location\2nd jar file2;existing
classpath entries

rwbuilder.conf: Append the driver location to the engine classPath
attribute in the rwbuilder. conf configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="driver location\lst jar file;driver
location\2nd jar file;">

</engine>

Reports Server: Append the driver location to the classPath attribute of the
engine in the Reports Server configuration file.

Example:
<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"

callbackTimeOut="60000" classPath="driver location\lst jar file;driver
location\2nd jar file;">

</engine>

jdbepds.conf: Located in the ORACLE_
INSTANCE\config\ReportsServerComponent\server_name directory.
Add relevant driver configuration information to the jdbcpds . conf file.
Refer to Table 14-1 for more information on the required parameters.

Example:
<driver name = "<driver name>"
sourceDatabase = "<sourceDatabase>"
subProtocol = "<subProtocol>"
connectString = "mainProtocol:subProtocol://databaseName"
class = "<driver class name>"
connection ="<connection handling class">
</driver>

Note: This value can still be connection =
"oracle.reports.plugin.datasource. jdbcpds.JDBCConn
ectionHandling"for your custom drivers, if you do not want to
implement a custom connection dialog
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14.1.2 Defining and Running a

JDBC Query

After configuring the relevant JDBC drivers, you can define and run a JDBC query

using either SQL or a stored procedure.

To define a JDBC query:

1. Start Oracle Reports Builder.

2. Invoke the Reports Wizard.

3. Select the data source type as JDBC Query and click Next. For more information
on how to work with the Report Wizard, refer to the Oracle Reports online Help.

Figure 14-2 Select a Data Source Type

Report Wizard

Choose a data source type below:

Exprezs Server Duery
JDEC Quem

g OLAP Ouery

fu SOL Query

a0 TestQuery

-"M? HML Query

Al

o

4. In the Data Source Definition window, click Query Definition.

5. Define one of the following;:
= ASQL query:

SELECT * FROM DEPARTMENT;

= A stored procedure:

Enter the complete call syntax of your database's stored procedure. For

example:

TestProc (40)

For more information on the call syntax, refer to your database
documentation.

JDBC PDS submits the calling statement to the driver as specified, to invoke
the stored procedure.
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Figure 14-3 Calling a stored procedure

&JDBC Query

Enter the information for this JOBC Query or Procedure and the connection parameters

for the datasource.
QuergPracedure

Enter the SGL or Stored Procedure to define the data for this query.

apen_tryProceduresi!, 2,1,3,2)

Connection

Define the parameters that the query uses to connect to the datasource.

Selectthe sign-on parameter for this connection:

Connectto the datasource:

QK Cancel

S E3

mysign0n|
Copnect...

Help

Table 14-2 Specifying an Excel Data Source

Query (Single Worksheet)

Query (Muitiple Worksheets)

SELECT * FROM [SHEET1S] or
SELECT COL1l, COL2, ...COLn
FROM [SHEET1S]

Where SHEET1S is the name of a .xls
file

Where the first worksheet row value is

taken as a column name for the query

SELECT * FROM [WORKSHEETNAMES]

Where [WORKSHEETNAMES] is the name of the
worksheet

Where the first worksheet row is taken as a column
name for the query

Note: If a value is not mentioned in any of the
columns in the first row, then the default name is

Note: If a value is not mentioned in any FcolumnNumber. For example, the 8th column will
of the columns in the first row, then the be F8, the ninth column will be F9, and so on.

default name is FcolumnNumber. For

example, the 8th column will be F8, the

ninth column will be F9, and so on.

6. Specify a sign-on parameter name. This sign-on parameter is associated with the

connection information when

run against a database. The default sign-on

parameter name is P_JDBCPDS (see Section A.7.10, "P_JDBCPDS"):

a. Enter a new sign-on name and click Connect. Use this sign-on parameter to
specify a database connection when you are running your report using Oracle

Reports Services.

b. Enter the connection information (user name, password, and database name)
for the driver type. Refer to Table 14-3, Table 14—4, Table 14-5, Table 14-6, and
Table 147 for sample connection information.

c. Select the driver type. The driver list is displayed based on the values entered
in the jdbcpds . conf file.

d. Click Connect to gain access to the database using the new sign-on. The
connect string formed internally is a combination of:

*  The connectString driver attribute (Table 14-1) defined in the

jdbcpds . conf file
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*  The connection information supplied in the Connect dialog will be used to
fill the database name portion of the connect string.

7. Click OK to execute the JDBC query.
8. The Reports Wizard displays the query description (Figure 14-4).

Figure 14-4 Query Description

Diiver Type : syhase-merant.
E_Quer_l,lfF'rotandL-ire: : mpTestwiéhPafamﬂ i
Sign-On Parameter; PLIDBCPOS:

[name: id]

Qe Diefinition Jmprort Duen. Qon_nec:t_...

9. Follow the steps in the wizard to define the layout and to run the report based on
your JDBC query.

14.1.2.1 Sample Connection Information
Table 14-3, Table 14-4, Table 14-5, Table 14-6, Table 14-7,Table 14-8, and Table 14-9
lists sample connection information for use with:

»  Pre-installed drivers; that is, Oracle JDBC Thin, Oracle JDBC OCI (thick), and
JDBC-ODBC.

= DataDirect Merant drivers available on Oracle Technology Network,
(http://www.oracle.com/technology/index.html).

Table 14-3 Oracle Thin Driver

Property Value

Username Reports

Password Welcome

Database hostname: The TCP/IP address or TCP/IP host name of the

server you are connecting to.
port: The TCP/IP port number.

property: The connection properties. Refer to the driver
documentation for a list of connection properties and their
valid values.

Example: serverl.us.oracle.com:1300:sessionl
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Table 14-4 Oracle Thick Driver

Property Value

Username Reports

Password Welcome

Database nl23
where n123 is a tnsname entry in the tnsnames. ora file

Table 14-5 JDBC-ODBC Driver

Property Value

Username N/A

Password This password is set at the time of establishing an ODBC
connection.

Database SQLSVR
where SQLSVR is the ODBC Data entry in the ODBC data
source.

Table 14-6 Sybase

Property Value

Username Reports

Password Welcome

Database hostname: The TCP/IP address or TCP/IP host name of the
server you are connecting to.
port: The number of the TCP/IP port.
Example: serverl.us.oracle.com:1300

Table 14-7 DB2

Property Value

Username Reports

Password Welcome

Database hostname: The TCP/ I_P address or TCP/IP host name of the
server you are connecting to.
port: The TCP/IP port number.
property: The connection properties. Refer to the driver
documentation for a list of connection properties and their
valid values.
Examplel: serverl:1654
Example2: server2:1721; PackageName=pkgl

Table 14-8 SQL Server

Property Value

Username Reports

Password Welcome
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Table 14-8 (Cont.) SQL Server

Property Value

Database hostname: The TCP/IP address or TCP/IP host name of the
server you are connecting to.

port: The TCP/IP port number.

Examplel: server1:1654

Table 14-9 Informix

Property Value

Username Reports

Password Welcome

Database hostname: The TCP/IP address or TCP/IP host name of the

server you are connecting to.

port: The TCP/IP port number.

InformixServer name: The Informix server name.
Database name: The database name you are connected to.

Example2: server_
name:2003; InformixServer=myinformix_
server;DatabaseName=scott/tiger@mydb

14.1.3 Running a JDBC Report Using Oracle Reports Services

When you run a report containing a JDBC query (Reports Server or rwrun engine),
use the sign-on parameter to submit the connection information for the JDBC data
source. This sign-on parameter is defined for your JDBC query in Reports Builder
during design time.

For example, if your report has a JDBC query to a Sybase data source, a JDBC query to
a DB2 data source, and a SQL query to an Oracle data source, then the request could
be defined as:

http://your_ias_
server:port//reports/rwservlet?report=my.rdf&userid=user/pwd@oracledb
&desformat=pdf&destype=cache&p_sybasepds=sybaseuser/pwésybasehost :port
&p_db2pds=db2user/pwd@db2host : port

where:

= useridis the value for connecting the SQL query to the Oracle database. You
need not specify the userid if your report does not have a SQL query or a REF
CURSOR query.

» p_sybasepds is the sign-on parameter associated with the Sybase JDBC query.

= p_db2pds is the sign-on parameter associated with the DB2 JDBC query defined
in the report at design time.

The default sign-on parameter name P_JDBCPDS will be used if you have not
specified a name in the JDBC Query dialog box while designing the report in
Reports Builder.

14.1.4 TroubleShooting Information

This section lists:
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= JDBC PDS error messages (Error Messages)
= JDBC query troubleshooting (Trace Information).

14.1.4.1 Error Messages

Table 14-10, Table 14-11, and Table 14-12 lists troubleshooting information related to
the JDBC PDS.

Table 14-10 Error Messages Related to the Database Connection

Error Message Cause Action

Ensure that the driver
connection class specified in
the jdbcpds . conf file is both
valid and available.

Invalid connection class
specified in the

jdbcpds . conf file for the
selected driver.

Connection class
{0} can't be
loaded

Invalid connection
information.

Failed to connect
to the datasource

Ensure the validity of the
username, password, database,
and driver type.

Invalid sign-on
parameter {0}

Invalid sign-on parameter for
the specified query or
procedure.

Ensure the sign-on parameter
is available and valid for the
report's JDBC query type.

Invalid value is
given to the

Invalid connect string for the
specified sign-on parameter.

Ensure that the specified
connect string for this sign-on

sign-on parameter

{0}

parameter is valid for the
selected driver.

Table 14-11 Error messages Related to Executing the Data Source
Error Message Cause Action
Reference The driver used to connect to Use either:

parameter of type
Date is not
supported by JDBC
driver used.

Invalid lexical
parameter {0} is
used in the query

SQL Error:

Invalid
query/procedure
for the specified
datasource.

Invalid reference
parameter value

No
query/procedure
is entered.

database does not support
the Date data type as a
reference parameter.

Invalid lexical parameter
used in the query or
procedure.

SQL syntax error in the
specified query or procedure.

Invalid query or procedure
syntax.

Invalid reference parameter
value.

The query or procedure text
field is empty.
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The String data type as the
reference parameter.

A different JDBC driver that
supports the Date data type as
a reference parameter.

Ensure that the query or
procedure uses valid lexical
parameters. Create a new
parameter if it is not available.

Ensure that the syntax of the
query or procedure is valid.
Refer to the relevant data
source's documentation.

Ensure that the syntax of the
query or procedure is valid.
Refer to the relevant data
source's documentation.

Verify that the reference
column types and values are
correct.

Enter a valid query or
procedure in the text field.
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Table 14-11 (Cont.) Error messages Related to Executing the Data Source

Error Message

Cause

Action

Database URL:

Either the number
of columns or the
types of columns
does not match
the query
definition

The column type
{0} used in the
query/procedure
is not supported
by Reports JDBC
query.

Invalid database URL.

The data fetched does not
match the number of
columns or column types
specified in the query
definition.

This column type is not
supported by the Oracle
Reports JDBC query
interface.

Verify the validity of the
specified database name and
the selected driver type.

Ensure that the number of
columns and the column types
match the query definition.

Ensure that only column types
supported by the Oracle
Reports JDBC query interface
are used. Refer to the JDBC
specification and Oracle
Reports documentation for a
list of all supported types.

Table 14-12

Isolating Driver / PDS Issues

Error Message

Cause

Action

The inline DTD
section of the
configuration file
jdbcpds.conf has
been modified.

Line Number:

Configuration file
jdbcpds.conf is
not found

Parsing error in

the configuration
file jdbcpds.conf.
Number of

errors: {0}

No entry is
present for the
driver {0} in the

jdbcpds.conf file.

The format of the inline DTD
section in the

jdbcpds . conf file has
been altered.

An error was found on the
specified line of the
jdbcpds . conf file.

The jdbcpds . conf fileis
not found under the
ORACLE_
INSTANCE\config\Repor
tsServerComponent\ser
ver_name directory.

The XML section in the
jdbcpds . conf file does not
conform with its inline DTD.

The driver used in the query
is not specified in the
jdbcpds. conf file.

If the DTD format is modified,
ensure the validity of
configuration file against the
JDBC PDS requirement.

Correct the error on the
specified line.

Ensure that the jdbcpds . conf
file is available in the file

is available in the
ORACLE_
INSTANCE\config\Reports
ServerComponent\server_
name directory.

Ensure that the XML section in
the jdbcpds . conf file refers
to the correct inline DTD.

Ensure that the entry for the
required driver along with the
related driver information is in
the jdbcpds . conf file.

14.1.4.2 Trace Information

Use the detailed trace information generated by Oracle Reports to debug your JDBC

query.

= Design time (building a JDBC query) and run time (running a JDBC query)

The trace information generated is helpful to find out the following:

s Lexical and bind parameters.

= Final connect string formed to connect to the driver.
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= Metadata information received from the driver.

= Final query submitted to the database.

See Example 14-1 for sample design-time trace output.
See Example 14-2 for sample run-time trace output.

For more information on the location of the 1ogging.xml file, see Section 24.3.7,
"Tracing Report Execution”

Sample trace output

Example 14—-1 Building a JDBC Query from JDBC Query Dialog

Connection handling trace showing final connect string

[2003/4/7 5:41:38:686] Debug 50103 (jdbcpds): handleConnectButtonEvent : start
[2003/4/7 5:41:38:686] Debug 50103 (jdbcpds): handleConnectButtonEvent :
subProtocol :sybase-merant

[2003/4/7 5:41:38:686] Debug 50103 (jdbcpds): handleConnectButtonEvent :
connection class :oracle.reports.plugin.datasource.jdbcpds.JDBCConnectionHandling
[2003/4/7 5:41:38:696] Debug 50103 (jdbcpds): handleConnectButtonEvent : combine
string :jdbc:merant:sybase://serverl.us.oracle.com:1300

[2003/4/7 5:41:38:696] Debug 50103 (jdbcpds): JDBCDataSource : setJDBCQueryType:
sybase

[2003/4/7 5:41:41:350] Debug 50103 (jdbcpds): JDBCUIEventHandler :
handleConnectEvent : Valid Connection
com.oracle.ias.jdbc.sybase.SybaseConnection@56fcl6

[2003/4/7 5:41:41:350] Debug 50103 (jdbcpds): JDBCUIEventHandler :
handleConnectEvent : END com.oracle.ias.jdbc.sybase.SybaseConnection@56fcl6

Design time metadata of query

[2003/3/31 6:35:46:363] Debug 50103 (jdbcpds): JDBCUIEventHandler : handleOKEvent
: Serialize XML<jdbcpds DTDVersion="

1.0"><JIDBCQuery>jdbcpdspkyg.proc_with_
param(1,2,3,4,5)</JIDBCQuery><QueryDefinition>1</QueryDefinition><driverType>oracle
</driverType><connectionClass>oracle.reports.plugin.datasource. jdbcpds.JDBCConnect
ionHandling</connectionClass><SignOnParameter>P_
JDBCPDS</SignOnParameter><jdbcElements><elementname = "EMPNO" type = "2"

typeName = "NUMBER" columnSize = "4" columnScale = "0" /><element name = "ENAME"
type = "12" typeName ="VARCHAR2" columnSize = "10" columnScale = "0"
/><element name = "JOB" type = "12" typeName = "VARCHAR2" columnSize = "9"
columnScale ="0" /><element name = "MGR" type = "2" typeName = "NUMBER"
columnSize = "4" columnScale = "0" /><element name = "HIREDATE" type = "93"
typeName = "DATE" columnSize = "16" columnScale = "0" /><element name = "SAL"
type = "2" typeName = "NUMBER" columnSize = "7" columnScale= "2" /><element
name = "COMM" type = "2" typeName = "NUMBER" columnSize = "7" columnScale =
"2" /><element name = "DEPTNO" type = "2" typeName = "NUMBER" columnSize = "2"
columnScale = "0" /></jdbcElements><referenceColumns></referenceColumns></jdbcpds>
[2003/3/31 6:35:46:383] Debug 50103 (jdbcpds): JDBCUIEventHandler :handleOKEvent
END

Example 14-2 Running a JDBC Query

[2003/3/18 5:45:17:707] Debug 50103 (jdbcpds): JDBCDataSource : startRuntime
method : START

Describing the JDBC Query:
[2003/3/18 5:45:17:707] Debug 50103 (jdbcpds): JDBCDataSource : describe : START
[2003/3/18 5:45:17:707] Debug 50103 (jdbcpds): applyXML: Extract the Serilzed XML
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containing Query Meta Data <jdbcpds DTDVersion=" 1.0"><JDBCQuery>select * from
emp</JDBCQuery><QueryDefinition>0</QueryDefinition><driverType>oracle</driverType>
<connectionClass>oracle.reports.plugin.datasource. jdbcpds.JDBCConnectionHandling</
connectionClass>...

ConnectionHandling At Runtime:

[2003/3/18 5:45:17:737] Debug 50103 (jdbcpds): JDBCDataSource : startRuntime :
Create a new connection and handle it

[2003/3/18 5:45:17:737] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
handleConnection : START

[2003/3/18 5:45:17:778] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
handleConnection : set driver

[2003/3/18 5:45:17:778] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
handleConnection : Check if Connection for the sign on parameter is pooled
[2003/3/18 5:45:17:778] Debug 50103 (jdbcpds): JDBCExecuteQuerySource
:handleConnection : connection available in pool

[2003/3/18 5:45:17:778] Debug 50103 (jdbcpds): handleConnection : END
[2003/3/18 5:45:17:778] Debug 50103 (jdbcpds): JDBCDataSource : startRuntime : END

Runtime execution of jdbc query

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCDataSource : execute : run Query
[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : START

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase: start Query stringto be submitted
jdbcpdspkg.proc_with_param(1,2,3,4,5)

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : check connection

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : QSource Id: 1

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:
executeOracleProcedure:Start

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:
executeOracleProcedure:Procedure to be submitted { call
jdbcpdspkg.proc_with_param(?,?,?,?,?,?) }

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:
executeOracleProcedure: Set parameters for the procedure call

[2003/3/31 6:36:2:836] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:
executeOracleProcedure: execute procedure

[2003/3/31 6:36:2:847] Debug 50103 (jdbcpds): JDBCDataSource : execute : query
execution over andresulset object is oracle.jdbc.driver.OracleResultSetImpl@751a9e
[2003/3/31 6:36:2:847] Debug 50103 (jdbcpds): JDBCDataSource : execute : END

Running Report trace with Result set info

2003/4/7 5:26:6:996] Debug 50103 (jdbcpds): JDBCDataSource : execute : replace
lexical columns withactual string for the query

[2003/4/7 5:26:6:996] Debug 50103 (jdbcpds): JDBCDataSource : execute : run Query
[2003/4/7 5:26:6:996] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : START

[2003/4/7 5:26:6:996] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase: start Query stringto be submitted select * from reports
[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : check connection

[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : QSource Id: 4

[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : Query source is SQL query

[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:executeQuery
Start
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[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): executeQuery prepareStatement select *
from reports

[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): executeQuery : bind parameters set for
the query

[2003/4/7 5:26:7:6] Debug 50103 (jdbcpds): executeQuery : JDBC Query executed
[2003/4/7 5:26:7:387] Debug 50103 (jdbcpds): JDBCExecuteQuerySource :
getOutputFromDatabase : Query result col 0 test col 1 10

[2003/4/7 5:26:7:387] Debug 50103 (jdbcpds): JDBCExecuteQuerySource:executeQuery
Start

[2003/4/7 5:26:7:387] Debug 50103 (jdbcpds): executeQuery prepareStatement select
* from reports

[2003/4/7 5:26:7:387] Debug 50103 (jdbcpds): executeQuery : bind parameters set
for the query

[2003/4/7 5:26:7:387] Debug 50103 (jdbcpds): executeQuery : JDBC Query executed
[2003/4/7 5:26:7:767] Debug 50103 (jdbcpds): JDBCDataSource : execute : query
execution over andresulset object is com.oracle.ias.jdbc.base.BaseResultSet@56c3ct
[2003/4/7 5:26:7:767] Debug 50103 (jdbcpds): JDBCDataSource : execute : END

14.1.5 Adding Your Own JDBC Driver

Note: Oracle Reports exposes the PDS API and also contains a
tutorial that describes in detail how to implement or customize your
own PDS. For more information, refer to the Reports Software
Development Kit (RSDK), available on the Oracle Technology
Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports/i
ndex.html), click SDK. Using this API, you can implement an
unlimited number of PDSs to access any kind of data sources that you
have.

The main tasks you must perform to add your JDBC PDS are:
= Configuring the jdbcpds.conf File
» Installing the Driver's JAR Files

14.1.5.1 Configuring the jdbcpds.conf File

For information on how to configure the jdbcpds . conf file, refer to Section 14.1.1,
"JDBC Configuration File".

14.1.5.2 Installing the Driver's JAR Files

For information on how to install the driver's JAR files, refer to Section 14.1.1.2.5,
"Custom Driver" .

14.2 Configuring and Using Text PDS

Text PDS is configured and available out-of-the-box for Oracle Reports.

14.2.1 Text Configuration File

The textpds . conf file is the Oracle Reports Text PDS configuration file which can
be changed, added, or deleted. The file is located at the following directories:

»  For Reports Server:
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ORACLE_INSTANCE\config\ReportsServerComponent\server
name\ textpdf.conf

s For Oracle Reports Builder:

ORACLE__
INSTANCE\config\ReportsToolsComponent\ReportsTools\textpdf.co
nf

s For Reports Application (in-process Reports Server) deployed in Oracle WebLogic
Server:
ORACLE _INSTANCE\
SFMW_HOME/user_projects/domains/<domain_name>/servers/WLS_
REPORTS/stage/reports/reports/configuration

Example
The following example illustrates the contents of textpds . conf file:

<!--XML section.Please edit this section to give your file format information-->
<textPDS
xmlns="http://xmlns.oracle.com/reports/pdstext"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://xmlns.oracle.com/reports/pdstext
file:c:\orawin/reports/dtd/textpds.xsd"
>

<!--Data definition for Apache Log file format-->

<fileFormat name = "Apache Log File" comment = "#" delimiter = "default"
type ="variable" nullValue = "-">
<columnInfo>
<column name = "Remote Host" type = "string" />
<column name = "Remote Log Name" type = "string"/>
<column name = "Remote User" type = "string"/>
<column name = "time" type = "date" cellWrapper = "\[]"
pattern = "dd/MMM/yyyy:hh:mm:ss zzz"/>
<column name = "Request" type = "string" cellWrapper =
"squot; " />
<column name = "status" type = "number"/>
<column name = "bytes" type = "number"/>
</columnInfo>
</fileFormat>

<!--Data definition for Comma Delimited file format-->

<fileFormat name = "Example Variable Width Comma Delimited" comment = "#"
delimiter = "," type = "variable">
<columnInfo>
<column name = "var_cd_coll" type = "string" />
<column name = "var_cd_col2" type = "string"/>
<column name = "var_cd_col3" type = "string"/>
</columnInfo>
</fileFormat>

<!--Data definition for Fixed Width format-->

<fileFormat name = "Example Fixed Width Space Delimited" comment = "#"
delimiter = "" type = "fixed">
<columnInfo>
<column name = "fw_sd_coll" type = "string" startpos = "1" width =
"13"/>
<column name = "fw_sd_col2" type = "number" startpos = "14" width =
"10"/>
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<column name = "fw_sd_col3" type = "date" startpos = "25" width =
"0 />
</columnInfo>
</fileFormat>
</textPDS>

Table 14-13 outlines the various values that can be associated with a File Formats.

Table 14-13 File Format Attributes

Attribute Name Description

name A File Format name, this name appears in the Data Definition
drop down list

Comment A Comment character, this will be used in the DataSource.

Delimiter A Column Delimiter. The Data Source file contains data in rows.

Each row has fields or tokens corresponding to the Columns
specified in the configuration file. Each field or token will be
separated by a Column delimiter (See cellWrapper)

type A File Format Type which can be either a fixed or variable. In
case of variable file format, the column width is variable. In
case of fixed file format, the column width is fixed and is
specified using the attributes startpos and width for each
column.

nullvalue This is a null value character.

Table 14-14 outlines the various values that can be associated with a Column.

Table 14-14 Column Attributes

Attribute Name Description

name This is the name of the Column Heading

type This is the Column Data type. There are three data types that are
supported:
] String

u Number

n Date

cell Wrapper This is an optional attribute. If specified, this character will
override the File Format delimiter for the column for which it is
specified.

pattern This is an optional attribute. Currently it is used only for date
fields. It specifies the pattern in which date field is to be
expected.

14.3 Configuring and Using XML PDS

XML PDS is configured and available out-of-the-box.

14.3.1 XML PDS Configuration File

The xmlpds . conf file is the Oracle Reports XML PDS configuration file. It is located
at the following directories:

»s  For Reports Server:

ORACLE_INSTANCE\config\ReportsServerComponent\server_name
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s For Oracle Reports Builder:
ORACLE_INSTANCE\config\ReportsToolsComponent\ReportsTools

s For Reports Application (in-process Reports Server) deployed in Oracle WebLogic
Server:
ORACLE _INSTANCE\
SFMW_HOME/user_projects/domains/<domain_name>/servers/WLS_
REPORTS/stage/reports/reports/configuration

Note: The only parameter that can be changes is the
columnLength. The default size of the column is 4000 bytes

Example
The following example illustrates the contents of xmlpds . conf file:

<xmlpds
xmlns="http://xmlns.oracle.com/reports/pdsxml"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="http://xmlns.oracle.com/reports/pdsxml
file:c:\orawin/reports/dtd/xmlpds.xsd"
>
<columnInfo>
<columnLength>4000</columnLength>
</columnInfo>
</xmlpds>

14.4 Specifying the encoding of an XML PDS Report

When you create a report against an XML data source, you must ensure that the
encoding of the data source and its DTD matches the encoding of Reports Builder.

For example, when you create an XML report against a table encoded in a Japanese
character set, the group element name is encoded in Japanese. To match the data
source, you should encode the group's element name in the DTD in Japanese. The
XML and DTD files can be in any encoding that supports Japanese, such as Shift_JIS,
EUC-JP, or UTEF-8.

If you do not match the XML data source and DTD encoding to the Reports Builder
encoding, you will see the following error:

ERR-063001 xxx.dtd null

Note: You will not see this error if you use a XML schema instead of
a DTD.

To avoid this problem, ensure that both the XML data source and DTD for your XML
report use the same encoding that you have in the character encoding part of the NLS_
LANG environment variable in effect for your Reports Runtime.

For example, if NLS_LANG=JAPANESE_JAPAN.JA16SJIS for your Reports Runtime,
then both your XML data source and DTD should use Shift_JIS.
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Securing Oracle Reports Services

The celebrated openness of the Internet brings with it concerns about controlling who
has access to what confidential company information. Oracle Reports provides a
number of security options that enable you to ensure that the appropriate users are
getting important data in a secure fashion. This chapter contains the following
sections:

Introduction to Oracle Reports Security

Out-of-the-Box Behavior

Authentication in Oracle Reports

Authorization in Oracle Reports

End-to-End Security Scenarios

Recommended Production Scenario for JPS-Based Security
Recommended Production Scenario for Portal-Based Security
Managing Users and Security Policies

Configuring External Oracle Internet Directory and Reassociating Reports
Forms and Reports Security Recommendations
Intermediate-level Security for Forms and Reports

Database Proxy Authentication

Oracle Portal-Based Security for Backward Compatibility

Security Interfaces

15.1 Introduction to Oracle Reports Security

This section introduces security features and concepts in Oracle Reports. It also
describes the new security features introduced in Oracle Reports 11g Release 1 (11.1.1).

This section discusses the following topics:

Overview
What’s New in This Release?
Resources Protected

Credential Store

Securing Oracle Reports Services 15-1



Introduction to Oracle Reports Security

15.1.1 Overview

Oracle Reports 11g Release 1 (11.1.1) uses a standards-based Java EE security model
through Oracle Platform Security Services. This provides a flexible, simple to
administer security mechanism. It can be used with standalone Oracle Reports install
or any Forms-Reports combination. The policy store and the identity store used for
authentication and authorization can be standard JAZN-XML based or any LDAP
server, including Oracle Internet Directory through JAZN-LDAP, providing flexibility.

Note: JAZN-XML is an XML file which is configured by the user to
use as an id store and/or policy store.

Oracle Reports 11g Release 1 (11.1.1) accomplishes authentication through Single
Sign-On, Oracle Internet Directory, Embedded ID Store, and JAZN-XML File-based ID
Store. For authorization, Oracle Reports 11g Release 1 (11.1.1) supports Oracle Internet
Directory, File-based, and Portal-based methods. In prior releases, Reports Server
authentication was restricted to use only Oracle Internet Directory. If you want to
revert to the security mechanism of prior releases, you can do so in Oracle Enterprise
Manager, as described in Section 7.8.1.1, "Switching to Oracle Portal Security". If you
want to use OracleAS Single Sign-On without implementing data source security or
Oracle Portal, refer to Chapter 17, "Configuring and Administering OracleAS Single
Sign-On".

Alternatively, you might have your own application for launching reports with its
own login mechanism and user/group repository, or have your own mechanism for
protecting data sources (for example, you might choose to use a different LDAP server
to store user and group information). In this case, Oracle Reports Services provides
interfaces that allow you to integrate it with these non-Oracle components, as
described in Section 15.14, "Security Interfaces".

15.1.2 What’s New in This Release?

Oracle Reports 11g Release 1 (11.1.1) uses Oracle Platform Security Services, enabling a
new security mechanism that provides the features and functionality described in
Table 15-1 (a subset of Table 1-1, " 11g Functionality vs. 10g Functionality"):

Table 15-1 11g Security Features vs. 10g Functionality

11g New Features Equivalent 10g Functionality

A standards-based Java EE security model through Reports Server authentication restricted to use only
Oracle Platform Security Services. This provides a | Oracle Internet Directory. Authorization of Reports

flexible, simple to administer security Server required Oracle Portal-based security model
mechanism. (using Portal metadata repository for checking
authorization).

For more information, see Section 15.1,
"Introduction to Oracle Reports Security"

Oracle Enterprise Manager advanced user interface. | Basic Ul in Oracle Portal for defining the policies.

Administrators can use Oracle Enterprise Hard-coded Web command access to the Oracle
Manager to more easily define and manage Reports seeded roles. Access policies at file (report)
granular security policies for reports, level only, not folder level.

directories, Web commands, and read /write
access to directories.

For more information, see Section 7.8, "Securing
Oracle Reports Services" in Chapter 7,
"Administering Oracle Reports Services Using
Oracle Enterprise Manager"
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Table 15-1 (Cont.) 11g Security Features vs. 10g Functionality

11g New Features Equivalent 10g Functionality
Read/write access to directories at Reports Server REPORT_RESTRICT_DIRECTORIES as an interim
level. Administrators can control the input feature.

folders from which reports can be served and
output folders to which the output of reports
servers can be pushed. This ensures there is no
security vulnerability.

For more information, see Section 15.4.6,
"Defining Read /Write Access to Directories"

Database proxy authentication. Support for Not Applicable
database authentication using proxy users:

»  Additional security through control of
users that are allowed to connect to the
database through Oracle Reports.

»  Scalability, through reuse of a single
database connection.

Security check for distribution destinations. Ability | No security check performed for destinations specified
to define security policies for distribution jobs. | in the distribution XML file.

For example, you can define a security policy
that specifies report output may not be burst to
ENHANCEDSPREADSHEET format; if the
distribution XML file specifies
ENHANCEDSPREADSHEET format, the attempt to
generate a report to this output format displays
an error.

Security check for system parameters. A security No security check performed for system parameters.
check is performed for all system parameters,
including those specified in the report definition
as well as on the command line.

Security auditing. Audit authentication and
authorization on the Reports Server.

Security for report output from Oracle Forms Anyone is able to see anyone else’s report output by
Services. With no configuration required, "guessing" the job ID based on sequential job ID
support for intermediate-level security even assignment.

when Oracle Forms Services and Oracle Reports
Services are not secured.

For more information, see Section 15.11,
"Intermediate-level Security for Forms and
Reports", Section 17.6, "Oracle Forms Services
Security Considerations" and Section 18.8.2,
"Generating Random and Non-Sequential Job
IDs".

15.1.3 Resources Protected

Oracle Reports Services encompasses functionality for three main areas of security:

= Application Security (that is, controlling access to the report application, where
users launch report requests)

= Resource Security (that is, controlling access to reports and Reports Servers)

= Data Source Security (that is, for controlling access to a particular database)

15.1.3.1 Application Security

Generally, users must log on to an application or site (for example, your own
corporate Web site, Oracle WebCenter) from which they can access and run their
reports. This launcher application is typically protected by some sort of login facility,
such as OracleAS Single Sign-On. Once they successfully gain entry into the launcher
application, resource security takes over and determines which reports and
destinations a given user or group may request.
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For application security, OracleAS Single Sign-On provides a single point of user log
in and, optionally, data source security. In a typical configuration, the user logs on
through OracleAS Single Sign-On to gain access to a report application, where they
access and run their reports.

15.1.3.2 Resource Security

Resource security ensures that only authorized users or groups execute a specific
report. It also keeps users or groups from accessing particular Reports Servers for the
execution of the report. Certain servers might be reserved for a particular group of
users, or may simply be inaccessible during certain times for maintenance activities.

Once it is determined that a user has the necessary privileges to execute a given report
through the specified Reports Server to the specified destination, then the user's
privileges to the data source accessed by the report must be ascertained.

Optionally, or for backward compatibility, you can configure Oracle Portal to provide
resource security for reports and Reports Servers out of the box. In a typical
configuration, the administrator or developer specifies which users and groups could
access which reports and Reports Servers from Oracle Portal.

15.1.3.3 Data Source Security

Data source security defines the users or roles that can access the data within the given
data source. A report might access multiple data sources and the current user must
have privileges on all of the data sources accessed by the report in order to run it and
view the output. The data source administrator (typically a DBA) grants access to data
sources. Data source security must be established and in place prior to configuring
your reports environment.

You can provide for data source security in two different ways with Oracle Reports
Services:

= You can associate data source connection information with a Single Sign-On user.
In this case, the first time a user attempts to access the data source, Oracle
Delegated Administration Services prompts them to create a resource for their
data source connection. After the user creates this data source resource, OracleAS
Single Sign-On associates it with the user in Oracle Internet Directory. Once the
data source resource is associated with the Single Sign-On user, it becomes part of
their Single Sign-On identity and they can access the data source without having
to log in to it separately. This method has two key advantages. First, it enables
each user to gain access to the data source through their Single Sign-On identity
without having to login separately. Second, it enables a single report URL to be
used by many users because the data source login information is stored with the
user's identity and therefore does not have to be hard coded into the report's URL
or a key mapping.

= Inyour report URLs or key mappings, you can code AUTHID and the necessary
connection parameters (for example, USERID, SSOCONN) for your report. This
functionality is much the same as it was in previous releases of Oracle Reports
Services. For a complete discussion of URL syntax, refer to Section 18.1, "The
Reports URL Syntax". For a complete discussion of key mapping, refer to
Section 18.13, "Using a Key Map File".

See Also: Section 17.3.3, "Enabling and Disabling Data Source
Security"

Section 17.3.3.1, "SSOCONN"

15-4 Publishing Reports to the Web with Oracle Reports Services



Out-of-the-Box Behavior

15.1.4 Credential Store

A Credential Store is the repository of security data that certify the authority of entities
used by Java 2, JavaEE and ADF applications. Applications can use the credential
store, a single, consolidated service provider to store and manage the credentials
securely.

A domain includes one credential store. Application-specific credentials are supported
and migrated to credentials in the domain credential store when the application is
deployed. Thus, all servers and all applications deployed in a domain use a common
credential store, the domain credential store.

Oracle Reports 11g Release 1 (11.1.1) uses credential store to store a password as a key.
You can also use the credential store to configure database connection information for
jobStatusRepository and jobRepository elements.

For example:

Portal password is stored in the reports credential map with key in the following
syntax:

"portalpasswd_DomainName_InstanceName"

Note: You must create credentials under the Reports folder as the
server accesses credentials from this folder in CSF.

15.1.4.1 Credential Types

Oracle Platform Security supports the following types of credentials according to the
data they contain:

» A password Credential encapsulates a user name and a password

» A generic credential encapsulates any customized data or arbitrary token, such as a
symmetric key.

In Credential Store Framework (CSF), a credential is uniquely identified by a map
name and a key name. Typically, the map name corresponds with the name of an
application and all credentials with the same map name define a logical group of
credentials, such as the credentials used by the application. All map names in a
credential store must be distinct. If the credential store is intended to be the repository
of X.509 certificates, it is recommended the use of an Oracle Wallet or a Java keystore.
The credential store does not allow the storage of end-user digital certificates.

Note: CSF keys are stored in rwserver.conf and
rwservlet.properties file.

For more information on how to manage credentials in a domain credential store
through Oracle Enterprise Manager, see Section 7.8.7, "Managing Credentials".

For more information about Wallet-Based and LDAP-Based Credential Stores and
Configuring the Credential Store, see Oracle Fusion Middleware Security Guide.

15.2 Out-of-the-Box Behavior

It is recommended that you specify information about Oracle Internet Directory while
installing Oracle Reports 11g Release 1 (11.1.1). For more information, see Oracle Fusion
Middleware Quick Installation Guide for Oracle Portal, Forms, Reports, and Discoverer.
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If you specified Oracle Internet Directory information during the installation of Oracle
Reports 11g Release 1 (11.1.1), authentication based on Single Sign-On is enabled for
both in-process servers and standalone servers. In addition, Portal-based security is
enabled, so you can use Portal-based authorization if Portal is configured.

Note: If you did not specify Oracle Internet Directory information
during the installation of Oracle Reports 11¢ Release 1 (11.1.1), no
authentication is enabled. Therefore, both in-process servers and
standalone servers are not secure.

15.3 Authentication in Oracle Reports

This section describes authentication features, tasks, and concepts that are specific to
Oracle Reports.

It discusses the following topics:

= OracleAS Single Sign-On Authentication

= Non-550 Authentication

= Authentication Scenarios for JPS-Based Security

= Authentication Scenario for Portal-Based Security

Authentication Methods
Oracle Reports 11g Release 1 (11.1.1) supports the following authentication methods:

= OracleAS Singe Sign-On. For more information, see OracleAS Single Sign-On
Authentication.

= Non-550, including the following:
- Oracle Internet Directory (rwsec, or JPS-OID configured)
— Embedded ID store (in-process servers)

— JAZN-XML File-Based ID store (standalone servers)

Note: For more information about non-SSO authentication methods,
see Non-SSO Authentication.

The following table summarizes the authentication methods for JPS-based security
that Oracle Reports supports.

Table 15-2 Authentication Methods for JPS-Based Security

Oracle
Type of Reports Internet WebLogic Single
Server Directory ID Store  Sign-On File-Based
In-process servers Yes Yes Yes No
Standalone Yes No Yes Yes

servers

The following table summarizes the authentication methods for Portal-based security
that Oracle Reports supports.

15-6 Publishing Reports to the Web with Oracle Reports Services



Authentication in Oracle Reports

Table 15-3 Authentication Methods for Portal-Based Security

Authentication

Based on
Type of Reports Oracle Internet Single
Server Directory Sign-On
In-process servers Yes Yes
Standalone Yes Yes

servers

15.3.1 OracleAS Single Sign-On Authentication

OracleAS Single Sign-On makes use of an encrypted cookie to track authenticated
application users. When rwservlet receives a request to execute a report on a
secured Reports Server, it queries the Oracle HTTP Server (through the
getRemoteUser call) to determine whether the user has already logged on through
OracleAS Single Sign-On (that is, a Single Sign-On cookie exists for the user):

s If the user has logged on already (that is, the cookie exists), then rwservlet gets
the user's identity from the Oracle HTTP Server.

= If the user has not logged on already (that is, the cookie does not exist yet), then
the Oracle HTTP Server redirects the user to OracleAS Single Sign-On, which
prompts the user to login. Once the user is authenticated, the Single Sign-On
cookie is created and the user is redirected back to rwservlet, which then
proceeds as described in the previous bullet item.

15.3.1.1 Report Request Flow with Single Sign-On
In this scenario, a report request is sent to a secured Reports Server with Single
Sign-On enabled.

Figure 15-1 Authentication Process with Single Sign-On
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OracleAS Infrastructure

The following numbered steps map to the numbers in Figure 15-2:
1. User requests the report (through a URL).

The report request is made through one of the following methods:
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s The user chooses a link on a Web page or a bookmark that contains a URL that
requests the report.

Note: The URL may optionally contain or reference (that is,
through the key map file) a Single Sign-On parameter (SSOCONN)
with a value of the form:

key _name/data_source_type/parameter_name

In the case of an Oracle database, the Single Sign-On value would
look something like the following:

mykey/OracleDB/userid

If you do not specify a data source type and parameter name, an
Oracle database is assumed.

s From within Oracle Portal (if configured), the user requests to run the report
object (for example, clicks the Run link). The user must be logged into Oracle
Portal and, consequently, OracleAS Single Sign-On. As part of its security,
Oracle Portal validates that the user has the required security permissions to
see the report object. For example, if the report object is on a page, the user
must have appropriate privileges to see the page and the reports object.
Otherwise, Oracle Portal will not display the page or the report object to the
user.

2. Oracle HTTP Server routes the request to rwservlet deployed on Oracle
WebLogic Server.

The URL redirects the user to either rwservlet or the JSP depending upon
whether this report has been set to execute through rwservlet or a JSP.

3. rwservlet asks OracleAS Single Sign-On to authenticate the user.
4. OracleAS Single Sign-On server requests the user name and password.

5. Oracle HTTP Server displays the login page to the user, and the user provides
user name and password.

6. User name and password are passed on to OracleAS Single Sign-On.

7. OracleAS Single Sign-On verifies the credentials with Oracle Internet
Directory.

8. If the user is authenticated, OracleAS Single Sign-on server passes the "user
authenticated" message to rwservlet.

If you used SSOCONN in your URL, rwservlet checks the Single Sign-On key
against Oracle Internet Directory to see if it already has been mapped to a data
source connection string (for example, scott/tiger@my_or_db).

If you used SSOCONN and Oracle Internet Directory already has a connection
string associated with the key, then rwservlet uses that connection string for the
data source connection of the report.

Note: Because of this feature, many users can use the same report
URL even if they all use different data source connection strings.

If you used SSOCONN but Oracle Internet Directory does not already contain a
connection string for the key, the Oracle Delegated Administration Services Create
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Resource page displays for the user to enter their data source connection string.
See Figure 15-3.

Oracle Delegated Administration Services stores the string in Oracle Internet
Directory for future use and rwservlet uses the newly entered connection string
for the data source connection string of the report.

Figure 15-2 Oracle Delegated Administration Services Create Resource

Resource Access Information

Username iscott

Password i*****

Database aorqa_db|

&

:& Local intranet i

15.3.2 Non-SSO Authentication

If any of the non-SSO authentication methods is used (based on Oracle Internet
Directory, File-based in case of JPS-based security, and Embedded ID store), then any
user accessing a secured instance of the Reports Server is challenged to identify
themselves by rwservlet or Reports clients through their own authentication
mechanism.

Table 15-4 Non-SSO Authentication Methods

ID Store Authentication

Oracle Internet Directory Authentication against Oracle Internet Directory

(rwsec, or JPS-OID

configured)

Embedded ID store Authentication against embedded ID store of WebLogic Server

(in-process servers)

JAZN-XML File-based ID Authentication against file-based ID store
store (standalone servers)

Because the HTTP 1.0 protocol is stateless (that is, each call to the server is effectively
independent of all others), users may want to authenticate themselves for each report
request unless a cookie is maintained. To allow users to authenticate themselves only
once per session, rwservlet has its own client-side cookie, the AUTHID cookie, in
which it stores the required authentication information for the current session. Once
the user is authenticated, an encrypted cookie is created in the browser to enable the
user to submit multiple report jobs without re-authenticating for each request.
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Note: If you want to force users to authenticate themselves for a
specific report, you can use the SHOWAUTH command line keyword.
Alternatively, you can include a %S in the corresponding report
entry in the key map file. This file is usually called cgicmd.dat
and is located in $SDOMAIN
HOME/config/fmwconfig/servers/<WLS_SERVER_
NAME>/applications/reports_
<version>/configuration/cgicmd.dat. %S forces users to
enter their username and password each time the report is called.
For more information, see Section 18.13, "Using a Key Map File".

The AUTHID cookies are terminated when the user closes their browser session, but
you should not rely strictly on this method of terminating the cookie. You should limit
the lifetime of the cookie within a given session. For example, a user might log on and
then go to lunch, leaving the browser session open. To minimize the potential for a
security breach in this situation, the administrator may specify the COOKIEEXPIRE
parameter as an attribute of the element cookie in the rwservlet.properties file.

For example, you can specify the cookie element in the rwservlet .properties file
as follows:

<cookie cookieexpire="30" encryptionkey="reports"/>

When rwservlet receives a job request, it compares the time saved in the cookie
with the current system time. If the time is longer than the number of minutes defined
in the environment variable (for example, 30 minutes), the cookie is rejected and the
user is challenged to provide authentication information.

See Also: Section 8.3, "Oracle Reports Servlet Configuration File"
for more information about the COOKIEEXPIRE parameter and the
rwservlet.properties file.

15.3.2.1 Report Request Flow with Non-SSO (Oracle Internet Directory-Based,
File-Based, or Embedded ID Store)

In this scenario, the report request is sent to a secured Reports Server with Single
Sign-On disabled. Non-SSO authentication methods include Oracle Internet
Directory-based, File-based, and Embedded ID store. In this case, rwservlet or a JSP
report might be called through the use of a bookmark or from an Oracle Portal
component.
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Figure 15-3 Authentication Process Without Single Sign-On
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The following numbered steps map to the numbers in Figure 15-4:
1. User requests the report (through a URL).

The user must somehow gain access to the URL that launches the report request
(for example, through a link on a Web page or a bookmark), and choose the URL.

2. Oracle HTTP Server routes the request to rwservlet deployed on Oracle
WebLogic Server.

3. rwservlet asks for user credentials (that is, user name and password).

rwservlet checks for the AUTHID parameter in the URL or an existing Oracle
Reports AUTHID cookie. If it finds the AUTHID parameter, it uses that to
authenticate the user. If it does not find the AUTHID parameter, it looks for an
existing Oracle Reports AUTHID cookie. (If the report is launched from Oracle
Portal, AUTHID is added to the URL automatically.) If neither the AUTHID
parameter nor an Oracle Reports AUTHID cookie is found, rwservlet sends the
System Authentication page to the Oracle HTTP Server, to display to the user.

4. Oracle HTTP Server displays the login page to the user, and the user provides
user name and password.

On the login page, the user must supply a user name and password. This
information is stored in an Oracle Reports AUTHID cookie for future reference.

5. User name and password are passed on to rwservlet.

If only partial data source credentials are provided in the URL (for example,
USERID=scott@orga), the Database Authentication page displays with the
partial credentials shown. The user must supply the remainder of the data source
credentials before proceeding further. Note that you can control which Database
Authentication page is used through the DBAUTH parameter in the
rwservlet.properties file. If no data source credentials are provided, the
Database Authentication page does not display and it is assumed the report does
not require a data source.

See Also: Section 8.3, "Oracle Reports Servlet Configuration File"
for more information about the DBAUTH parameter and the
rwservlet.properties file.
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The data source credentials are stored in an Oracle Reports USERID cookie for
future reference. Note that pluggable data source (PDS) credentials are not stored
in Oracle Reports USERID cookies.

6. rwservlet forwards user name and password to Reports Server.

rwservlet constructs a command line with the necessary information from the
previous steps and passes it to Reports Server.

7. Reports Server authenticates the user (that is, verifies the user name and
password) against the ID Store.

Reports Server validates the user credentials against the ID store (Oracle Internet
Directory, embedded ID store or file-based Oracle Internet Directory). If the
validation check fails for any reason, then an error condition is returned to the
user and the process terminates.

15.3.3 Authentication Scenarios for JPS-Based Security

This section discusses the following authentication scenarios:

= If Reports is using JPS security, JPS-OID for security policies, and an embedded ID
store

= If Reports is using JPS security and JPS-OID as ID store

Note: By default, an in-process server uses the embedded ID store of
Oracle WebLogic Server as the ID store and the
system-jazn-data.xml file as the policy store. Standalone servers
use the system-jazn-data.xml file as both ID store and policy
store.

15.3.3.1 If Reports is using JPS security, JPS-OID for security policies, and an
embedded ID store

It is recommended that you move users in your current ID store, such as embedded ID
store, to Oracle Internet Directory, which is an LDAP-based ID store. Subsequently,
you can map users to application roles. For information about moving users to Oracle
Internet Directory, see the section "Migrating Identities Manually" in the Oracle Fusion
Middleware Security Guide. For information about mapping users to application roles,
see Mapping Users to Application Roles.

15.3.3.2 If Reports is using JPS security and JPS-OID as ID store

You must map users in Oracle Internet Directory to the default application roles. For
information about mapping users to application roles, see Mapping Users to
Application Roles.

Note: In the above authentication scenarios, if Single Sign-On is
enabled, the Single Sign-On screen is displayed. If Single Sign-On is
disabled, the Reports sysauth screen is displayed. In either case, users
are authenticated against Oracle Internet Directory. If you have not
moved your users to Oracle Internet Directory, then users are
authenticated against the embedded ID store for in-process servers.
For standalone servers, such users are authenticated against the
file-based ID store.
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15.3.4 Authentication Scenario for Portal-Based Security

If you are using Portal-based security, Oracle Internet Directory-based authentication
is used.

You can map users to application roles. For information about mapping users to
application roles, see Mapping Users to Application Roles.

Note: In the above authentication scenarios, if Single Sign-On is
enabled, the Single Sign-On screen is displayed. If Single Sign-On is
disabled, the Reports sysauth screen is displayed. In either case, users
are authenticated against Oracle Internet Directory.

15.4 Authorization in Oracle Reports

If you are using JPS-based security, you can use either Oracle Internet Directory or
JAZN-XML method for authorization. If you are using Portal-based security, the
Portal-based authorization is used.

In the case of JPS-based security, an in-process server uses system-jazn-data.xml
as the policy store, by default. Hence, Reports policies are stored in
system-jazn-data.xml under the reports application entry. Users are authorized
based on this policy store. For standalone servers, all the policies are stored in the
system-jazn-data.xml file and authorization is done against these policies.

Note: The authorization process involves checking whether a
particular user is in the ID store used by JPS. If Single Sign-On is used
for authentication, Ensure that the same users are configured in the ID
store used by JPS. Alternatively, ensure that JPS points to the ID store
used by Single Sign-On. Otherwise, authorization does not work.

The following table summarizes the supported authorization methods if Oracle
Reports uses JPS-based security.

Table 15-5 Authorization Methods for JPS-Based Security

Oracle Internet

Types of Report Server Directory File Based
In-process Yes Yes
Standalone Yes Yes

If Portal-based security is configured, the following authorization methods are used.

Table 15-6 Authorization Method for Portal-Based Security

Types of Report Server Authorization

In-process Portal-based

Standalone Portal-based
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Note: If Oracle Portal is configured to perform authorization, and
the report request is launched from within Oracle Portal rather than
rwservlet, Oracle Reports will similarly validate the user's
privileges on the report before running it. Even for unauthenticated
(PUBLIC) users viewing public pages, Oracle Reports Services
verifies that the PUBLIC user account has appropriate privileges on
the report.

15.4.1 Authorization Process

Authorization occurs after a user is authenticated using Single Sign-On or Non-550
(Oracle Internet Directory-based, File-based in case of JPS-based security, and
Embedded ID store) methods. Once the user is authenticated, the report request must
go through the authorization process, as shown in Figure 15-4.

Figure 15-4 Authorization Process Flow
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The following numbered steps map to the numbers in Figure 15-5:

1. Reports Server validates the user privileges against the policies defined in the
Policy Store.

Reports Server validates the user privileges against the policies defined in Policy
Store (JAZN-XML, LDAP, or Portal repository) by the user.

Reports Server checks whether the user has the necessary privileges to run the
report on the parameters specified in the Policy Store. If the validation check fails
for any reason, then an error condition is returned to the user and the process
terminates.

Note: If the user is executing rwservlet Web commands such as
showjobs and getserverinfo, instead of executing a report,
Reports Server verifies and authorizes the user based on Policy
Store settings.

2, If the user is authorized to execute the report, Reports Server executes the report
request and passes the report output to rwservlet.
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Reports Server delegates the job to an engine that accesses the data source,
retrieves the data, and formats the report.

3. Report output is passed to Oracle HTTP Server.
4. Report output is passed to the user.

The completed output is sent to the specified destination. Depending upon the
destination, the output may be served back to the browser (as shown in

Figure 15-5), sent to a printer, stored in a file for future reference, sent to an FIP
server, and so on.

15.4.2 Additional Step When Using JPS for Authorization

Reports policies are granted to application roles. You must associate all users in your
ID store (embedded ID store of Oracle WebLogic Server or an external Oracle Internet
Directory) with one of the Reports application roles.

You must add the oracle.security.jps.enterprise.user.class property in
the jps-config-jse.xml file.

In Enterprise Manager, you can complete this task as follows:
1. Navigate to the WebLogic Domain menu.
2. Choose Security > Application Roles.

The Application Roles page is displayed. In this page, you can map users to
application roles.

Alternatively, you can complete this task by manually editing the $DOMAIN_
HOME/config/fmwconfig/system-jazn-data.xml file. This step is required if
you want to use JPS to authorize your users in Oracle Internet Directory.

Search for the "reports” application in the XML file and add a user in the members
section. For example, to add a user called orcladmin, add:

<member>

<class>weblogic.security.principal .WLSUserImpl</class>
<name>orcladmin</name>

</member>

15.4.3 Defining Security Policies for Reports

Out-of-the-box, default users, roles, and permissions are already created. As
administrator, you can specify the reports to which a particular user has access by
defining a security policy for each report. In the security policy, you can also specify
the server, destination name (desname), destination type (destype), and other
parameters. The security policy is checked when the user provides the user name and
password.

15.4.3.1 Defining Security Policies for JPS-Based Security

Refer to Section 7.8.2, "Defining Security Policies for Reports" to use Oracle Enterprise
Manager to update the report security policies.

15.4.3.2 Defining Security Policies for Portal-Based Security

For Portal-based security, you can create a security policy in Oracle Portal. For more
information, see the "Securing Oracle Portal" in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Portal.
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15.4.4 Defining Security Policies for Directories for JPS-Based Security

In certain cases, you will want to give a particular user access to multiple related
reports. Rather than specify a security policy for each report, you can collect all the
reports in a single directory, then specify a security policy for the directory. Again, the
security policy is checked when the user provides the user name and password.

Refer to Section 7.8.3, "Defining Security Policies for Directories" to use Oracle
Enterprise Manager to update the directory security policies.

15.4.5 Defining Security Policies for Web Commands for JPS-Based Security

You can also specify the Oracle Reports Servlet (rwservlet) Web commands to
which a particular user/role has access by creating security policies for each Web
command. The security policy is checked when the user provides the user name and
password.

Refer to Section 7.8.4, "Defining Security Policies for Web Commands" to use Oracle
Enterprise Manager to update the Web command security policies.

15.4.6 Defining Read/Write Access to Directories

As administrator, you can specify read /write access for Reports Server, Reports
Application (in-process Reports Server), or Oracle Reports Runtime to directories. This
feature only checks whether the Reports Server, Reports Application (in-process
Reports Server), or Oracle Reports Runtime is authorized to read from or write to a
specified directory, and is unrelated to the security policies for users/roles, which
check the user name and password.

Refer to Section 7.8.5, "Defining Read /Write Access to Directories" to use Oracle
Enterprise Manager to specify the read /write permissions defined in the server
configuration file (rwserver. conf) under the new optional element folderAccess.

15.4.7 Searching Application Policies in Enterprise Manager

Application policies are the authorization policies that an application uses for
controlling access to its resources. You can enter search keyword for principals or
permissions to query application security grants. You can use an application stripe to
search if the application uses a stripe that is differerent from the name of the
application.

To search for application policies in Enterprise Manager, complete the following steps:
1. Log in to Enterprise Manager.

2. Navigate to the Reports Application home page.

3. From the Reports menu, select Security > Application Policies.

The Application Policies page is displayed.

Check the Select Application Stripe to Search option.

In the drop-down menu, select reports.

In the Principal field, enter the name of the principal.

In the Permissions field, enter the permissions.

® N o o &

Click the right arrow button to search application security grants.
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15.4.8 Searching Application Roles in Enterprise Manager

Application roles are the roles used by security-aware applications that are specific to
the application. These roles are seeded by applications in WebLogic Domain policy
store when the applications are registered.

To search for application roles in Enterprise Manager, complete the following steps:

1.
2.

N o a &

Log in to Enterprise Manager.

Navigate to the Reports Application home page.

From the Reports menu, select Security > Application Roles.

The Application Roles page is displayed.

Check the Select Application Stripe to Search option.

In the drop-down menu, select reports.

In the Role Name field, enter the name of the application role to search.

Click the right arrow button to search application roles.

15.5 End-to-End Security Scenarios

This section describes end-to-end security scenarios that involve both authentication
and authorization.

The following table describes JPS-based security scenarios.

Table 15-7 JPS-Based Security Scenarios

Security Scenario ‘Description

JPS-OID Authorization with Single-Sign-On Authentication for Reports Servlet

[This scenario involves the following;: [To use this combination of authentication and authorization,

Single Sign-On for authentication complete the following steps:

JPS-OID for authorization 1.  Enable Single Sign-On. For more information, see

(policies) Enabling and Disabling Single Sign-On.

R.  Enable JPS-based security. On the Reports Server
Advanced Configuration page in Enterprise Manager,
select the Enable Security check box, and then select
the Oracle Platform Security for Java option.

B.  Ensure that all users that are present in the Oracle
Internet Directory used by Single Sign-On are in the ID
store used by JPS. Alternatively, configure JPS to point
to the ID store used by Single Sign-On.

4.  Add the following property in the
jps-config-jse.xml file:

<property
name="oracle.security.jps.enterprise.user
.class"
value="weblogic.security.principal .WLSUse
rImpl"/>

5. Configure JPS Oracle Internet Directory as a policy
store. For more information, see Configuring an
External Oracle Internet Directory as Policy Store When
Using JPS-Based Security.

6. Create security policies. Refer to Section 7.8.2, "Defining
Security Policies for Reports" to use Oracle Enterprise
Manager to update the report security policies defined
in Oracle Internet Directory.

7. Map users to application roles. For more information
about mapping users to application roles, see Mapping
Users to Application Roles.
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Table 15-7 (Cont.) JPS-Based Security Scenarios

Security Scenario Description

JPS-OID Authorization with JPS-OID as ID Store for Other Reports Clients

[This scenario involves the following;: [To use this combination of authentication and authorization,

m  JPS-OID for authentication complete the following steps:

L JPS-OID for authorization 1. Enable ]PS-basec‘l seculfity. On the Reports_ Server
(policies) Advanced Configuration page in Enterprise Manager,

select the Enable Security check box, and then select
the Oracle Platform Security for Java option.

R.  Add the following property in the
jps-config-jse.xml file:

<property
name="oracle.security.jps.enterprise.user
.class"
value="weblogic.security.principal .WLSUse
rImpl"/>

B. Configure JPS-OID as an ID store. For more
information, see Configuring External Oracle Internet
Directory as ID Store When Using JPS-Based Security.

4.  Configure JPS-OID as a policy store. For more
information, see Configuring an External Oracle
Internet Directory as Policy Store When Using
JPS-Based Security.

5.  Create security policies. Refer to Section 7.8.2, "Defining
Security Policies for Reports" to use Oracle Enterprise
Manager to update the report security policies defined
in Oracle Internet Directory.

6. Map users to application roles. For more information
about mapping users to application roles, see Mapping
Users to Application Roles.

JAZN-XML Authorization with Single Sign-On Authentication for Reports Servlet

[This scenario involves the following;: [To use this combination of authentication and authorization,

m Single Sign-On for authentication complete the following steps:

b JAZN-XML for authorization 1.  Enable Single Sign-On. For more information, see

(policies) Enabling and Disabling Single Sign-On.

R.  Enable JPS-based security. On the Reports Server
Advanced Configuration page in Enterprise Manager,
select the Enable Security check box, and then select
the Oracle Platform Security for Java option.

B.  Ensure that all users that are present in the Oracle
Internet Directory used by Single Sign-On are in the ID
store used by JPS. Alternatively, configure JPS to point
to the ID store used by Single Sign-On.

4. Add the following property in the
jps-config-jse.xml file:

<property
name="oracle.security.jps.enterprise.user
.class"
value="weblogic.security.principal.WLSUse
rImpl"/>

5. Create security policies. Refer to Section 7.8.2, "Defining
Security Policies for Reports".

6. Map users to application roles. For more information
about mapping users to application roles, see Mapping
Users to Application Roles.

7. Ifthe system-jazn-data.xml file is used as the
policy store, search for the "reports" application in the
system-jazn-data.xml file. To use JPS to authorize
users in Oracle Internet Directory, add the
corresponding users in the member section of the
system-jazn-data.xml file. For more information,
see Section 15.4.2, "Additional Step When Using JPS for
Authorization".
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Table 15-7 (Cont.) JPS-Based Security Scenarios

Security Scenario Description

JAZN-XML Authorization with JPS-OID Authentication for Other Reports Clients

[This scenario involves the following;: [To use this combination of authentication and authorization,
b JPS-OID for authentication icomplete the following steps:

3 JAZN-XML for authorization
(policies)

1. Enable JPS-based security. On the Reports Server
Advanced Configuration page in Enterprise Manager,
select the Enable Security check box, and then select
the Oracle Platform Security for Java option.

R.  Add the following property in the
jps-config-jse.xml file:

<property
name="oracle.security.jps.enterprise.user
.class"
value="weblogic.security.principal .WLSUse
rImpl"/>

B. Configure JPS-OID as an ID store. For more
information, see Configuring External Oracle Internet
Directory as ID Store When Using JPS-Based Security.

4. Create security policies. Refer to Section 7.8.2, "Defining
Security Policies for Reports" to update the report
security policies defined in Oracle Internet Directory.

5. Map users to application roles. For more information
about mapping users to application roles, see Mapping
Users to Application Roles.

6. Ifthe system-jazn-data.xml file is used as the
policy store, search for the "reports" application in the
system-jazn-data.xml file. To use JPS to authorize
users in Oracle Internet Directory, add the
corresponding users in the member section of the
system-jazn-data.xml. For more information, see
Section 15.4.2, "Additional Step When Using JPS for
Authorization".

The following table describes Portal-based security scenarios.

Table 15-8 Portal-Based Security Scenarios

Security Scenario Description

[Portal-Based Authorization with Single-Sign-On Authentication for Reports Servlet

[This scenario involves the following: [To use this combination of authentication and

L Single Sign-On for authentication authorization, complete the following steps:

1. Enable Single Sign-On. For more information, see

" Portal-based authorization Enabling and Disabling Single Sign-On.

(policies)

2.  Ensure that Portal-based security is enabled. If you
have enabled JPS-based security, switch to
Portal-based security. In the Advanced
Configuration Page in Enterprise Manager, select
the Enable Security check box and then the Security
features available through Oracle Portal option
under the Reports Security section.

B.  Create security policies in Oracle Portal. For more
information about creating security policies in
Oracle Portal, see the Securing Oracle Portal chapter
in the Oracle Fusion Middleware Administrator’s Guide
for Oracle Portal.

4. Map users to application roles. For more
information about mapping users to application
roles, see Section 16.1, "Creating Reports Users and
Named Groups"

[Portal-Based Authorization with Oracle Internet Directory as ID Store for Other Reports Clients
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Table 15-8 (Cont.) Portal-Based Security Scenarios

Security Scenario Description

[This scenario involves the following;: [To use this combination of authentication and

L Oracle Internet Directory for authorization, complete the following steps:

authentication 1.  Configure Oracle Internet Directory as an ID store.
For more information, see Configuring External

r Portal-based for authorization Oracle Internet Directory as ID Store.

(policies)
2.  Ensure that Portal-based security is enabled. If you
have enabled JPS-based security, switch to
Portal-based security. In the Advanced
Configuration Page in Enterprise Manager, select
the Enable Security check box and then the Security
features available through Oracle Portal option
under the Reports Security section.

B.  Create security policies in Oracle Portal. For more
information about creating security policies in
Oracle Portal, see the Securing Oracle Portal chapter
in the Oracle Fusion Middleware Administrator’s Guide
for Oracle Portal.

4. Map users to application roles. For more
information about mapping users to application
roles, see Section 16.1, "Creating Reports Users and
Named Groups"

15.6 Recommended Production Scenario for JPS-Based Security
For JPS-based security, the following production scenario is recommended:
»  For authentication, Oracle Internet Directory as ID store, or Single Sign-On
»  Oracle Internet Directory as Policy store for authorization

If you are not using Single Sign-On, use Oracle Internet Directory for authentication.

15.7 Recommended Production Scenario for Portal-Based Security
For Portal-based security, the following production scenario is recommended:
= Oracle Internet Directory as ID store for authentication, or Single Sign-On
= Portal-based authorization

If you are not using Single Sign-On, use Oracle Internet Directory for authentication.

15.8 Managing Users and Security Policies

This section describes how to manage users and security policies for in-process servers
and standalone servers.

It discusses the following topics:

= Adding Users to WebLogic Embedded ID Store for In-Process Servers
= Adding Policies to Policy Store for In-Process Servers

= Mapping Users to Application Roles

=  Adding Users to system-jazn-data.xml for Standalone Servers

= Adding Policies to Policy Store for Standalone Servers
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Managing Users and Security Policies

15.8.1 Adding Users to WebLogic Embedded ID Store for In-Process Servers

To add users to the ID store for an in-process server, complete the following steps:
1. Navigate to the WebLogic Server Administration Console.

2. From the Domain Structure window on the left pane of the console, select
Security Realms > myrealm.

The Settings for myrealm page is displayed.
3. Click the Users and Groups tab.
4. Click New to add users.

The User Properties page is displayed.

5. Enter the parameters, and select the DefaultAuthenticator from the Provider
drop-down list.

6. Click OK.

15.8.2 Adding Policies to Policy Store for In-Process Servers

To add policies to the policy store for an in-process server, complete the following
steps:

1. Log in to Enterprise Manager
2. Navigate to the Reports Application home page.

3. From the Reports menu, select Administration > Manage Reports Security
Policies.

The Security Policy Configuration page is displayed.
4. Click Create to add or edit Reports policies, Web command policies or both.
The Security Configuration for Reports page is displayed.
5. Enter appropriate values in the Security Configuration for Reports page.
6. Click OK

For more information about security policies, see Section 7.8.2, "Defining Security
Policies for Reports".

15.8.3 Mapping Users to Application Roles

After configuring the users, you must map users present in the ID store to one or more
application roles. You can configure an application role for an in-process server either
through Oracle Enterprise Manager or manually.

In Enterprise Manager, you can complete this task as follows:
1. Navigate to the WebLogic Domain menu.
2. Choose Security > Application Roles.

The Application Roles page is displayed. In this page, you can map users to
application roles.

If the system-jazn-data.xml file is used as the policy store, you can add the
following under the reports entry in the system-jazn-data.xml file to configure
users to application roles manually:

<app-role>
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<name>rw_administrator</name>
<display-name>Reports Administrator</display-name>
<class>oracle.security.jps.service.policystore.ApplicationRole</class>
<members>
<member>
<class>weblogic.security.principal .WLSUserImpl</class>
<name>weblogic</name>
</member>
</members>
</app-role>

For a sample system-jazn-data.xml file, see Sample system-jazn-data.xml File

15.8.4 Adding Users to system-jazn-data.xml for Standalone Servers

If the system-jazn-data.xml file is used as the ID store, you can users to ID store
for a standalone server by completing the following steps:

1. Add users to the system-jazn-data.xml file by replacing <jazn-realm/>
with the following:

<jazn-realm>
<realm>
<name>jazn.com</name>
<users>
<user>
<name><weblogic</name>
<credentials>!passwd</credentials>
</user>
</users>
</realm>
</jazn-realm>

For a sample system-jazn-data.xml file, see Sample system-jazn-data.xml File

15.8.5 Adding Policies to Policy Store for Standalone Servers

You can add policies to a policy store for a standalone server through Oracle
Enterprise Manager.

1. Log in to Oracle Enterprise Manager.

2. Navigate to your Reports Application home page.

3. From the Reports menu, select Administration > Manage Security Policies.
4. Click Create to add reports and web command policies.

5. Assign roles to the application policies.

6. Click OK.

For more information about security policies, see Section 7.8.2, "Defining Security
Policies for Reports".

15.9 Configuring External Oracle Internet Directory and Reassociating
Reports

This section describes how to configure external Oracle Internet Directory for
in-process servers and standalone servers and to reassociate Reports with Oracle
Internet Directory and another Portal.
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It discusses the following topics:

s Configuring External Oracle Internet Directory for In-Process Servers
= Reassociating Reports with Oracle Internet Directory

= Reassociating Oracle Reports to Oracle Portal

= Configuring External Oracle Internet Directory for Standalone Servers

15.9.1 Configuring External Oracle Internet Directory for In-Process Servers

You can migrate from the default embedded ID store of WebLogic Server to an
external Oracle Internet Directory to configure the ID store and Policy store settings.
Note that configuration of an external Oracle Internet Directory is a post-installation
procedure.

15.9.1.1 Configuring External Oracle Internet Directory as ID Store When Using
JPS-Based Security

If you are using JPS-based security, you can configure an external Oracle Internet
Directory as ID store through the Oracle WebLogic Server Administration Console.

To configure an external Oracle Internet Directory as an ID store through Oracle
WebLogic Server, complete the following steps:

1. Navigate to the WebLogic Server Administration Console.
2. From the Domain Structure window, select Security Realms.

The Summary of Security Realms page is displayed.

3. Select a Realm from the Realms table.

4. From the settings for the realm page, click the Providers tab.

5. Select New from the list of Authentication Providers.

6. Enter a name in the Name field. From the Type drop-down list, select
OraclelnternetDirectoryAuthenticator, and click OK.

7. Select the new authenticator, and set the Control Flag to Sufficient.

8. Select the Provider Specific tab, and enter valid values in the appropriate fields.
9. Select the default Authenticator and set the Control Flag to OPTIONAL.

10. Click Save.

11. Restart the Admin Server.

12. Select the Security Realm > Users and Groups. Ensure that all users of external
Oracle Internet Directory are seen on this page.

Now, users trying to access the in-process servers are authenticated based on the users
specified in the external Oracle Internet Directory.

15.9.1.2 Configuring an External Oracle Internet Directory as Policy Store When
Using JPS-Based Security

If you are using JPS-based security, you can configure an external Oracle Internet
Directory as policy store though Oracle Enterprise Manager.

To configure the policy store in Oracle Enterprise Manager, complete the following
steps:
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1. Log in to Oracle Enterprise Manager.
2. Navigate to the WebLogic domain.

3. From the WebLogic Domain menu, select Security > Security Provider
Configuration.

4. Click Configure.
5. Provide the Oracle Internet Directory and JPS root node details and click OK.

Note: If the JPS root node does not exist on Oracle Internet Directory,
you must create it. For more information, see the Oracle Fusion
Middleware Administrator’s Guide for Oracle Internet Directory.

The policies configured in the system-jazn-data.xmnl file are migrated to the
external Oracle Internet Directory.

15.9.2 Reassociating Reports with Oracle Internet Directory

If you have configured an external Oracle Internet Directory, you must reassociate
Reports to map to the new Oracle Internet Directory.

To map Reports to associate with the new Oracle Internet Directory using Oracle
Enterprise Manager, complete the following steps:

1. Log in to Oracle Enterprise Manager.

2. Navigate to your Reports Application home page.

3. From Reports menu select Administration > Reports OID Association.
The Reports OID Association Details Page is displayed.

4. Click the Associate tab.

5. Specify the Oracle Internet Directory Host, Oracle Internet Directory Port,
Username and Password.

6. Click OK.

Note: Associating or deassociating Oracle Internet Directory affects
all the Reports components associated with that particular Oracle
Instance home. If Reports components are associated with different
Oracle Instance homes, you must associate or deassociate Oracle
Internet Directory individually for each Oracle Instance home.

15.9.3 Reassociating Oracle Reports to Oracle Portal

Ensure that you have associated Reports with the Oracle Internet Directory. To
reassociate Oracle Reports to new Oracle Portal, complete the following steps:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the WebLogic Domain Home page.

3. From the WebLogic Domain menu, select Security > Credentials.
4. Add Portal Credentials in the Credential Store.

Add a new key value pair in the reports map. For example, add a key as
hrportalPasswdKey and key value as the portal schema password.
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For more information, see Section 7.8.7, "Managing Credentials".

5. Navigate to the Reports Server home page.

6. From the Reports menu, select Administration > Advanced Configuration.
The Reports Server Advanced Configuration page is displayed.

7. In the Portal Information section, enter valid values for Portal Connection, Portal
Username, and Portal Password Key.

8. Click Apply.

Note: Reassociating Oracle Reports to Oracle Portal affects only the
particular server on which the changes are made. You must repeat the
procedure to reassociate each Reports server in the Oracle Instance
home to an Oracle Portal.

15.9.4 Configuring External Oracle Internet Directory for Standalone Servers

You can migrate from the default ID store (JAZN-XML) to an external Oracle Internet
Directory to configure the ID store and Policy store settings. Note that the
configuration of an external Oracle Internet Directory is a post-installation step.

To configure an external Oracle Internet Directory as an ID store or policy store, you
must modify the SDOMAIN_HOME/config/fmwconfig/jps-config-jse.xml file
manually.

15.9.4.1 Configuring External Oracle Internet Directory as ID Store

To configure an external Oracle Internet Directory as an ID store, modify the
$DOMAIN_HOME/config/fmwconfig/jps-config-jse.xml file as described in
the following procedure.

Note: This is just an example. You must replace the example values
provided in the entries with your install-specific values.

1. Under <jpsContext name="default">, add the following;:

<serviceInstanceRef ref="idstore.oid"/>

Comment out the following:

<!--servicelInstanceRef ref="idstore.xml"/-->

2. Under <serviceInstances>, add the following entries:

<servicelInstance name="idstore.oid" provider="idstore.ldap.provider">
<property name="subscriber.name"
value="dc=us, dc=abc,dc=com" />
<property name="idstore.type" value="OID"/>
<property name="cleartext.ldap.credentials"
value="cn=password" />
<property name="ldap.url"
value="1dap://abc.us.com:389" />
<extendedProperty>
<name>user.search.bases</name>
<values>
<value>cn=users, dc=us, dc=abc,dc=com</value>
</values>
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</extendedProperty>
<extendedProperty>
<name>group.search.bases</name>
<values>
<value>cn=groups, dc=us, dc=abc,dc=com</value>
</values>
</extendedProperty>
<property name="username.attr" value="uid"/>
<propperty name="groupname.attr" value="cn"/>
</servicelnstance>

3. Under < serviceProviders>, add the following:

<serviceProvider type="IDENTITY_ STORE" name="idstore.ldap.provider"
class="oracle.security.jps.internal.idstore.ldap.LdapIdentityStoreProvider">
</serviceProvider>
<description>Prototype LDAP-based ID store</description>

15.9.4.2 Configuring External Oracle Internet Directory as Policy Store

To configure an external Oracle Internet Directory as a policy store, modify the
$DOMAIN_HOME/config/fmwconfig/jps-config-jse.xml file as described in
the following procedure.

Note: This is just an example. You must replace the example values
provided in the entries with your install-specific values.

1. Under <jpsContext name="default"> add the following:

<servicelInstanceRef ref="policystore.ldap"/>

Comment out the following:

<!--gerviceInstanceRef ref="policystore.xml"/-->

2. Under <serviceInstances>, add the following;:

<servicelnstance provider="ldap.policystore.provider" name="policystore.ldap">
<property value="OID" name="policystore.type"/>
<property name="security.principal" value="cn=orcladmin" />
<property name="security.credential" value="password" />
<property value="cn=PRDomain"
name="oracle.security.jps.farm.name" />
<property value="cn=sta796_sa_root"
name="oracle.security.jps.ldap.root.name" />
<property value="ldap://abc.us.com:389" name="ldap.url"/>
</servicelnstance>
3. Under <serviceProviders>, add the following:

<serviceProvider type="POLICY_STORE" name="ldap.policystore.provider"
class="oracle.security.jps.internal.policystore.ldap.LdapPolicyStoreProvider">
<description>Prototype LDAP-based ID store</description>
</serviceProvider>

4. Save and restart WLS_REPORTS.
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15.10 Forms and Reports Security Recommendations

The following security model is recommended for applications using Reports and
Formes.

If Reports is Using Portal-Based Security

It is recommended that Forms and Reports are associated to same Oracle Internet
Directory.

For more information see, Configuring External Oracle Internet Directory for
In-Process Servers, and Configuring External Oracle Internet Directory for
Standalone Servers

It is recommended that you enable Single Sign-On

Perform the following steps to enable Single Sign-On:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Application page.

3. From the Reports menu, select Administration > Advanced Configuration.
The Reports Application Advanced Configuration page is displayed.

4. From the Reports Security window, select the Enable Single Sign-On check
box.

5. Click Apply.

If Reports is using JAZN security

If Reports is using JPS-based security, by default, an in-process server uses the
embedded ID store of WebLogic Server as the ID store and an XML-based Policy store.
A standalone server uses JAZN-XML. Forms uses Oracle Internet Directory based
authentication for security. In this scenario:

It is recommended that you configure Reports to use Oracle Internet
Directory-based ID store. Forms and Reports should use the same Oracle Internet
Directory.

For more information about configuring external Oracle Internet Directory, see,
Configuring External Oracle Internet Directory for In-Process Servers, and
Configuring External Oracle Internet Directory for Standalone Servers

It is recommended that you migrate reports policies from JAZN-XML to
JAZN-OID. Forms and Reports should use the same Oracle Internet Directory.

It is recommended that you enable Single Sign-On

Perform the following steps to enable Single Sign-On:

1. Log in to Oracle Enterprise Manager.

2. Navigate to the Reports Application page.

3. From the Reports menu, select Administration > Advanced Configuration.
The Reports Application Advanced Configuration page is displayed.

4. From the Reports Security window, select the Enable Single Sign-On check
box.

5. Click Apply.
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15.11 Intermediate-level Security for Forms and Reports

Oracle Reports 11g Release 1 (11.1.1) provides new security measures for reports run
from Oracle Forms Services in non-secure mode:

= Oracle Reports allows you to generate random and non-sequential job IDs to make
it impossible to predict the job ID for a particular job. For more information, see
Section 18.8.2, "Generating Random and Non-Sequential Job IDs".

Prior to 11g Release 1 (11.1.1), Oracle Reports generated sequential job IDs, making
it easy to predict the job ID. This meant that unauthorized or malicious users
could potentially view the job output using GETJOBID through rwservlet to
obtain job output that belongs to another user.

s Web commands (rwservlet keywords) are now categorized for added security:

— End user Web commands: GETJOBID, KILLJOBID, SHOWAUTH,
SHOW]JOBID

— Administrator Web commands: DELAUTH, GETSERVERINFO,
KILLENGINE, PARSEQUERY, SHOWENYV, SHOWJOBS, SHOWMAP,
SHOWMY]JOBS. AUTHID is required to run administrator commands

— LO0:no Web commands allowed.

- L1: only end user Web commands allowed (GETJOBID, KILLJOBID,
SHOWAUTH, SHOWJOBID).

— L2:administrator Web commands (DELAUTH, GETSERVERINFO,
KILLENGINE, PARSEQUERY, SHOWENYV, SHOWJOBS, SHOWMAP,
SHOWMY]JOBS) are also allowed. AUTHID is required to run administrator
commands.

- NO (for backward compatibility with DIAGNOSTIC=NO in 10g
rwservlet.properties). No Web commands allowed.

- YES (for backward compatibility with DIAGNOSTIC=YES in 10g
rwservlet.properties). Administrator Web commands (DELAUTH,
GETSERVERINFO, KILLENGINE, PARSEQUERY, SHOWENYV, SHOWJOBS,
SHOWMAP, SHOWMY]JOBS) are also allowed. AUTHID is required to run
administrator commands.

Note: For L2 Web command access, you do not need to pass the
authid. The authid parameter is required only for the STOPSERVER
command irrespective of the webcommandaccess value.

Administrators are allowed to run both end user and administrator Web
commands. For a non-secure Reports Server, the user ID and password for
administrators can be set in the identifier element of the Reports Server
configuration file.

The new webcommandaccess parameter in the Oracle Reports Servlet
(rwservlet) configuration file (rwservlet .properties) defines access levels
for executing rwservlet keywords (Web commands). These values can be set
using Oracle Enterprise Manager, as described in Section 7.8.4, "Defining Security
Policies for Web Commands".
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15.12 Database Proxy Authentication

Oracle Reportsllg Release 1 (11.1.1) provides support for database authentication
using proxy users:

= Additional security through control of users that are allowed to connect to the
database through Oracle Reports.

= Scalability, through reuse of a single database connection.

You can use the pre-11g security mechanism of Oracle Internet Directory integration
for authentication without using Oracle Platform Security Services in either of the
following ways:

15.12.1 Using Oracle Enterprise Manager

In Oracle Enterprise Manager, select Reports > Administration > Manage Reports
Security Policies to display the Reports Security Policies page.

15.12.2 Using DAS and Editing the Server Configuration File
Step 1. Using Delegated Administration Service (DAS)

To define a user in Oracle Internet Directory:

1. Determine the configuration values of Oracle Internet Directory for application
identity store. For example:

host:port: stbpo44.oracle.com:3060
user name: cn=orcladmin
password: welcomel

2. Use the DAS URL if you want to add new users or use the existing users on Oracle
Internet Directory. For example

http://stbpodd.oracle.com:7788/0iddas

Step 2. Configure the standalone Report Server to use the RWSecurity to enable the
non-Oracle Platform Security Services way of using Oracle Internet Directory (as in
10g Release 2 (10.1.2)).

1. Navigate to the Reports Server component.
2. Check out rwserver. conf.

3. Enable the RWSecurity element.

4

Make sure that the security id for the job element reflects the security id of the
RWSecurity element.

Save rwserver.conf.

o

6. Add the following line in rwservlet.properties:
<singlesignon>no</singlesignon>

7. Restart the Reports Server component (see Chapter 6, "Starting and Stopping
Oracle Reports Services").

8. Test authentication using the following URL:

http://host:port/reports/rwservlet/showjobs?server=reports_server_name

Securing Oracle Reports Services 15-29



Database Proxy Authentication

15.12.3 Configuring Proxy User Authentication in the Database

You can configure proxy user authentication in the database as follows:

1.

Create a proxy user in the database. All clients connecting to the middle tier share
this user connection.

Run the following:
CREATE USER proxy_userl IDENTIFIED BY welcomel;
Assign the following minimum privileges to proxy_user1:

GRANT CONNECT, RESOURCE, CREATE ANY DIRECTORY, DROP ANY
DIRECTORY TO proxy_userl

The actual user already exists in the database.

Log in as the actual user, and assign privileges to the proxy user to connect to the
database on behalf of the actual user.

o

ALTER USER scott GRANT CONNECT THROUGH proxy_userl;
b. Or you can define the roles that the proxy user can connect to the database as.

c. ALTER USER scott GRANT CONNECT THROUGH proxy_user WITH
ROLE admin;

d. Repeat Step A or Step C for all actual database users.

The proxy user with minimum privileges is created. However, this proxy user can
connect as the actual user with the assigned role. The middle tier can connect to the
database as the proxy user first, and then connect as an actual user through the proxy
user account.

15.12.4 Obtaining Proxy Access Information

You can configure a new resource in Oracle Internet Directory in the user RAD or
default RAD. You can use this key to obtain proxy access information, including user
name, password , and database information from Oracle Internet Directory. This
information allows you to connect to the database.

To create a key in the default RAD, complete the following steps:

1.

Log in to the Oracle Internet Directory configuration page
(http://oidhost:port/oiddas).

Click the Configuration tab.
Click Preferences.

In the Preferences page, create a new Resource of type OracleDB under
Default Resource Access Information,asshown in the Figure 15-5.
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Figure 15-5 Oracle Internet Directory Configuration
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5. When creating the resource, in the Resource Access Information section,
enter the database proxy user name, database proxy password, and the database
value in the respective fields.

A new key is created, and you can pass this key as a value for the dbproxyConn
parameter. The number of proxy user connections and their access levels are set by
the database administrator.

15.12.5 Configuration Settings in Reports Configuration Files

To use the database proxy feature, you must add and modify configuration settings in
the Reports configuration files.

15.12.5.1 rwserver.conf
In the rwserver. conf file, the dbproxy key is set as follows:
<dbProxyConnKeys>

<dbProxyKey name=keyl database=dbl/>

<dbProxyKey name=key2 database=db2/>
</dbProxyConnKeys>

This configuration is optional. The dbproxy key is taken from the rwserver.conf file if
the dbproxyConn parameter is not passed on the command line. The dbproxykey is
obtained from this configuration, based on the database that you specified in the
userid command-line parameter.

15.12.5.2 rwservlet.properties

To use the database proxy feature through rwservlet, edit the enabledbproxy
setting in the rwservlet.properties file as follows:

<enabledbproxy>yes</enabledbproxy>

By default, enabledbproxy is set to no. For rwclient, this configuration setting is
not required.
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15.13 Oracle Portal-Based Security for Backward Compatibility

Prior to 11g Release 1 (11.1.1), Oracle Internet Directory was used for authentication
and Oracle Portal for authorization. Oracle Reports 11g Release 1 (11.1.1) accomplishes
both authentication and authorization through Oracle Platform Security Services.

For backward compatibility, 11g Release 1 (11.1.1) supports:

= Security with OracleAS Portal 10g and Portal Classic 11g. You can configure Oracle
Portal for authorization using Oracle Enterprise Manager, as described in
Section 7.8.1.1, "Switching to Oracle Portal Security".

= Users and groups created in 10g Release 2 (10.1.2) identity management (IM).

= Non-secured mode of operation with Reports Server.

15.13.1 Security Features Provided by Oracle Portal

Oracle Portal provides a number of security features available to Oracle Reports
Services that enable you to ensure that the appropriate users are getting important
data in a secure fashion. With Oracle Portal security features in place, your users see
only the data they're supposed to see.

Use Oracle Portal to control:

= Who has access to each report

= When a report can be run

= Which servers and printers can be used to run a report

= Which report parameters a user can edit with what range of values

Oracle Portal is a browser-based, data publishing and developing solution that offers
Web-based tools for publishing information on the Web and building Web-based,
data-driven applications.

Oracle Portal is tightly integrated with Oracle Reports Services to create a robust and
secure data publishing environment. Oracle Portal provides easy-to-use wizards for
setting up Oracle Reports Services security. These include wizards for defining user
access to reports, Reports Servers, printers, output formats, and report parameters.

Once you define access control information, it's stored in the Oracle Portal repository.
As an Oracle Portal user, you can then, optionally, publish registered RDFs and JSPs to
an Oracle Portal page. As with all Oracle Portal functionality, using Portal to deliver
your reports is not required. You can deliver reports through command lines, as you
may always have, and still benefit from the access control features available to you
through Oracle Portal.

Access to Oracle Reports Services' security features is not dependent on whether you
also use Portal to publish report links or report content. Even if you don't publish
through Portal, you can still take advantage of the Oracle Reports Services' security
features available in Oracle Portal to control user access to all of your reports.

When you expose a report as a portlet through Oracle Portal, Oracle Reports leverages
OracleAS Single Sign-On, which eliminates the need for users to enter multiple log ins,
first to the portal then to each of the reports exposed through portlets within the
portal. With OracleAS Single Sign-On, when you log in, Oracle Portal automatically
logs you into all registered portlet providers and subsystems.

For more information, refer to Chapter 16, "Deploying Reports in Oracle Portal".
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15.14 Security Interfaces

The Security API of the Reports Software Development Kit (RSDK) enables you to
integrate your own security model with the Reports Server. Oracle Reports Services
enables you to plug in any security you wish, using the provided APL

The Security API can control:

= Who has access to each report

= When a report can be run

= Which servers and printers can be used to run a report

= Which report parameters a user can edit with what range of values

The RSDK includes a tutorial that shows you how to integrate your own security
using an XML file to store the authorization information. At the end of this tutorial,
you will be able to:

= Implement a security class with Oracle Reports Services
= Register a security class with Oracle Reports Services
= Use the security class with Oracle Reports Services

For the tutorial and more information, refer to the Reports Software Development Kit
(RSDK) on the Oracle Technology Network (OTN): on the Oracle Reports page
(http://www.oracle.com/technology/products/reports/index.html),
click SDK.
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Deploying Reports in Oracle Portal

The steps for deploying reports in Oracle Portal is the same in 11¢ Release 1 (11.1.1) as
in prior releases. However, the security mechanism underlying the deployment has
changed. You can continue to use the security features in Oracle Portal from prior
releases for backward compatibility, but you can now also choose to use the new
Oracle Platform Security Services security mechanism. For more information, see
Chapter 15, "Securing Oracle Reports Services".

This chapter describes how to use Oracle Portal to deploy your Oracle Reports
Services reports. It includes the following sections:

s Creating Reports Users and Named Groups

= Registering Oracle Reports Components

»  Publishing Your Report as a Portlet

= Troubleshooting Information

Before you deploy reports, both Oracle Portal and Oracle Reports Services must be
installed and configured.

See also: The following resources for further information:

Chapter 8, "Configuring Oracle Reports Services" for
information on configuring Oracle Reports Services

The Oracle Portal Administrator’s Guide for information on
configuring Oracle Portal

The Oracle Fusion Middleware Installation Planning Guide for
information on installing both components

The Oracle Fusion Middleware documentation CD

The Oracle Technology Network,
(http://www.oracle.com/technology/index.html)

16.1 Creating Reports Users and Named Groups

If you use the security features in Oracle Portal to control access to your reports, you
must register all of your Reports users in Oracle Internet Directory and assign security
privileges to all of them through Oracle Portal.
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Note: If you have a large user population already entered into an
LDAP-compatible directory, you can use Oracle Internet Directory
features to synchronize the directories and save yourself the effort
of entering your users individually. You'll find information about
Oracle Internet Directory's Directory Integration Server in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Internet
Directory.

In Oracle Portal, security privileges can be granted to individual users and to named
groups of users. Named groups are useful for streamlining the process of granting
access privileges. You can assign a set of access privileges to a named group, and grant
the entire set of privileges to an individual simply by adding that person to the group.

Note: When you use features like Oracle Portal Security, Portal
Destination, and Job Status Repository, the JDBC database
connections made by Oracle Reports Services may override the
initial NLS_LANG setting. This change may in turn affect the
behavior of the running report, such as bidirectional output in PDF.
On UNIX platforms, you can work around this issue by using the
environment switching functionality to dynamically set the
environment for reports. Refer to Section 8.2.2, "Dynamic
Environment Switching" for more information.

The next sections provide overview information on how to create users and groups in
Oracle Portal. They include:

»  Default Reports-Related Groups

»s  Creating Users and Groups

16.1.1 Default Reports-Related Groups

When you install Oracle Portal, Reports-related groups are created for you
automatically. These include the following groups:

=  RW_BASIC_USER

=  RW_POWER_USER

= RW_DEVELOPER

»  RW_ADMINISTRATOR

You must assign appropriate privileges to these groups to enable group members to
perform specific functions on reports through Oracle Portal. For example, for each
report object that you want members of a group (for example, RW_BASIC_USER) to be
able to run, you have to grant the Execute privilege to that group from the Access tab
of the report object. Similarly, if you want members of a group (for example, RW_
ADMINISTRATOR) to be able manage Reports Servers, printers, and reports, you have
to grant the Manage privilege to that group from the Access tab of those objects.

While you can assign object privileges to individual users, we recommend that every
person who will access your reports belong to one of these groups or a group that you
create yourself. If users try to run reports without being a member of one of these
groups, by default, they are assigned the privileges of a basic user.
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Note: The RW_ groups are created automatically by configuring
Oracle Portal, or you can create them manually. You can also run
Web commands if they are in the TASADMINS group.

The following commands can be run by members of any group:
s getfile

s showmyjobs

s killmyjobs

m getjobid

s showjobid

s help

Only members of the RW_DEVELOPER group can run the following commands:
s showmap

s showenv

s showjobs

s  parsequery

Members of the RW_ADMINISTRATOR group can run any command.

16.1.1.1 RW_BASIC_USER

Should the security check fail, members of the RW_BASIC_USER group see less
detailed error messages than the users in other Oracle Reports groups, such as:

Security Check Error
Typically, you will want to assign this group minimal privileges. For example, you

probably will want to give RW_BASIC_USER the privilege to execute reports and no
more.

16.1.1.2 RW_POWER_USER

In addition to the privileges of the RW_BASIC_USER group, the RW_POWER_USER
group sees error messages that are more detailed than those displayed to basic users.
For example, if members of this group are not permitted to run to HTML, but they try
anyway, they might get the message:

Cannot run report to HTML

This is more detailed than the message an RW_BASIC_USER would receive for the
same error.

16.1.1.3 RW_DEVELOPER

In addition to the privileges of the RW_POWER_USER group, the RW_DEVELOPER group
can run the following Web commands that show the system environment:

s showmap
s showenv

s showjobs
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m parsequery

Typically, you would assign privileges to this group needed by a developer who is
testing reports. Depending upon your installation, you might even assign them limited
administrative privileges.

16.1.1.4 RW_ADMINISTRATOR

In addition to the privileges of the RW_DEVELOPER group, the RW_ADMINISTRATOR
group has access to the administrator's functionality in the Oracle Reports Queue
Manager, which means members of this group can manage the server queue,
including rescheduling, deleting, reordering jobs in the server, and shutting down a
server. Members of the RW_ADMINISTRATOR group can run any command. The Rw_
ADMINISTRATOR group also has the privilege to run Web commands through
rwservlet.

Typically, you will want to assign to this group some (but probably not all) of the
same privileges assigned to the PORTAL_ADMINISTRATORS group.

Note: Initially, only members of the PORTAL_ADMINISTRATORS
group have MANAGE privileges for Oracle Reports objects. They can
CREATE, UPDATE, and DELETE the registered report definition files,
servers, and printer objects in Oracle Portal. In addition to all the
links activated for the developer user, administrators can navigate
to the Access tab on the Component Management Page, accessible
in Oracle Portal. This is where the administrator can specify who
will have access to this report. People with administrator privileges
can assign security privileges for other people and receive full error
messages from Oracle Reports Services.

16.1.2 Creating Users and Groups

Oracle Portal uses the Delegated Administration Service (DAS) interface to Oracle
Internet Directory to register users for access to Portal. You can enter the DAS
interface through Portal to create new users. The creation of new users and groups is
discussed in the Oracle Portal Administrator’s Guide available on the Oracle Fusion
Middleware documentation CD.

When you create groups, you must assign appropriate privileges to them to enable
group members to perform any desired functions on reports through Oracle Portal.
For example, for each report object that you want members of a group (for example,
RW_BASIC_USER) to be able to run, you have to grant the Execute privilege to that
group from the Access tab of the report object. Similarly, if you want members of a
group (for example, RW_ADMINISTRATOR) to be able manage Reports Servers,
printers, calendars, and reports, you have to grant the Manage privilege to that group
from the Access tab of those objects.

Ideally, you should provide a user with the necessary privileges on objects by
assigning them to a group that has appropriate privileges for their role. For example, if
you are creating a user who needs to be able to run but not manage reports, you could
assign her to RW_BASIC_USER. If need be, you may assign object privileges to
individual users (for example, JSMITH) rather than groups, but this approach is more
difficult and time consuming to manage.
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16.1.3 Portal Password in Credential Store

Oracle Reports 11¢ Release 1 (11.1.1) uses credential store to store Portal password as a
key. You can also use the credential store to configure database connection
information for jobstatusrepository and jobRepository elements.

Portal password is stored in the reports credential map with key in the following
syntax:

"portalpasswd_DomainName_InstanceName"

Note: If you modify the Portal password, you must update the
value of the key in the Reports credential store.

16.2 Registering Oracle Reports Components

Before you begin, you must have a sufficient level of privileges in Oracle Portal to
access the portlets and complete the tasks required for setting access controls. In order
to manage reports in Oracle Portal, you must belong to both the PORTAL_
ADMINISTRATORS and RW_ADMINISTRATOR groups. If you only belong to RW_
ADMINISTRATOR, you will encounter errors when you attempt to create report objects.

For more information on joining privilege groups in Oracle Portal, refer to the Oracle
Portal Administrator’s Guide.

This section outlines the necessary steps to go about:

= Registering a Reports Server

= Registering a Report

= Registering a Printer

s Creating an Availability Calendar

To perform actions on existing Oracle Portal portlets, refer to:

= The Manage Portlet

16.2.1 Registering a Reports Server

Before you can define access controls for a Reports Server, you must register your
server within Oracle Portal. Registration provides Oracle Portal with the information it
needs to identify and locate all available Reports Servers. This becomes particularly
important when you register individual reports; during this process you are required
to choose from a list of Reports Servers, and servers must be registered to appear on
this list.

Table 16-1 Sample Values

Property Sample Value

Name (internal name) myrep_server

Display Name My Reports Server

Portal DB Provider PORTAL_APP

Reports Server Name rep_machine name, for example, rep_
myserverl
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Table 16-1 (Cont.) Sample Values

Property Sample Value

Oracle Reports Web http://myias.mycomp.com:7778/
Gateway URL for JSP

reports

Oracle Reports Web http://myias.mycomp.com:7778/report
Gateway URL for RDF s/rwservlet

reports

Availability Calendar COMCAL

To register a Reports Server:

1. Log in as an administrator to Oracle Portal.
2. Navigate to the Builder page.

3. (Click the Administer tab.
4

Click the Oracle Reports Security Settings link in the Oracle Reports Security
portlet. The Oracle Reports Security portlet enables you to use the security
features in Oracle Portal at the time of defining access to the server, printer,
calendar, and reports definition file.

5. Click the Create Reports Server Access link in the Reports Server Access portlet.

6. On the resulting page, the Name (internal name) and the Portal DB Provider
fields contain default values. To include custom values:

= Enter a unique name in the Name field that will identify the Reports Server
internally in Oracle Portal, for example, MY_REPORTS_SERVER. This name
must follow the Oracle Portal rules for a valid component name; that is:

* It must be no more than 30 characters

* It must contain only alphanumeric characters (no spaces or special
characters allowed).

*  The first character must be a letter (not a number).

= Enter the name you want to display for this server in the Display Name field.
The Display Name is the name that is exposed to your users through Oracle
Portal.

Note: The Display Name, unlike the internal Name, can have
spaces in it.

= Select the Portal DB Provider that will own the Reports Server from the Portal
DB Provider list of values. The Portal DB Providers displayed are those in
which you have privileges to build components.

Note: All the components you add to or create in Oracle Portal
must belong to a Portal DB Provider. Refer to the OracleAS Portal
online Help, for more information on how to create a Portal DB
Provider.

7. Click Next.
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10.

11.
12.

13.

On the Server Definition page:

= Enter the name of the Reports Server in the Reports Server Name field. This is
the unique name assigned to the server at the time of server creation through
OPMN.

= (Optional) Enter a description for the Reports Server in the Description field.

= Enter the URL location of your JSP files in the Oracle Reports Web Gateway
URL for JSP reports field. The URL should be in the following format:

http://your_web_server.domain:port/

For example:
http://myias.mycomp.com: 7779/
= Enter the URL location of Oracle Reports Servlet (rwservlet) in the Oracle

Reports Web Gateway URL for RDF reports field. The URL should be in the
following format:

http://your_web_server.domain:port/virtual_path to_rwservlet/rwservlet

See Also: Chapter 8, "Configuring Oracle Reports Services" for
more information on specifying the virtual path.

For example:

http://myias.mycomp.com:7778/reports/rwservlet

= (Optional) Select the Run Only Registered Report Definition Files check box.
This ensures that only the report definition files registered with Oracle Portal
can be executed on this Reports Server.

Leave this box unchecked if you want this Reports Server to accept any report
definition file, including those not registered in Oracle Portal, as long as the
user who submits the report request has access privileges to this Reports
Server.

= Select the printer(s) that you want to make available to this Reports Server
from the Printers list. Use control-click (Windows) or click (UNIX) to select
multiple printers.

Click Next.

(Optional) Enter a Custom Destination Type, if you have defined a custom
destination type.

See Also: Chapter 13, "Configuring Destinations for Oracle
Reports Services" for more information on custom destination

types.

Click Next.

(Optional) Enter the Availability Calendar name or click the list button to select
the Availability Calendar that determines the days and times this Reports Server is
and is not available to accept report requests.

See Also: Section 16.2.4, "Creating an Availability Calendar"

Click Finish.
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The resulting page summarizes your settings for this Reports Server. On this page,
you can edit your settings, get detailed registration information about the Reports
Server, or delete it altogether.

See Also: Section 16.2.5, "The Manage Portlet" for more
information on the fields and descriptions listed in the Manage
portlet (that is, Develop, Manage, and Access tabs).

14. Click Close to close this page and return to the Oracle Reports Security page.

You have registered a Reports Server. Now you can register a report.

16.2.2 Registering a Report

Registering a report is a required step that enables you to define who can run a report,
when a report is available to run, which server(s) can be used to process report
requests, how a report is delivered, and the printer(s) to which a report can be sent.

In addition to using registration to designate which users have access to a report, you
can also specify, through a Oracle Portal parameter form, how users are to interact
with the report.

User parameters are created in Oracle Reports Builder at the time of designing the
report. You can assign values to these parameters when you run the report in Oracle
Portal.

Note: You can use the parameter settings available through
Oracle Portal to duplicate or create a subset of the parameters
defined in Oracle Reports Builder at design time. At runtime, the
Reports Server disregards any parameters that you set in Oracle
Portal not defined in Oracle Reports Builder at design time.

Registering a report within Oracle Portal creates an Oracle Portal component that can
be deployed as a portlet through Portal. We recommend that you register only one
instance of a report file in Oracle Portal. If you define multiple Oracle Portal report
objects for one report, all are given security checks at runtime. If any of them fail the
security check, then all fail, and the job will not run.

Table 16-2 Sample Values

Property Sample Values
Name (internal name) Employee_Report
Display Name Employee Report
Portal DB Provider PORTAL_APP

Oracle Reports File Name employee_report.jsp

Execute as JSP
Name (Optional userid
Parameters)

Display Name (Optional =~ User Identification
Parameters)

To register a report:

1. Log in as an administrator to Oracle Portal.

16-8 Publishing Reports to the Web with Oracle Reports Services



Registering Oracle Reports Components

2. Navigate to the Builder page.
3. Click the Administer tab.

4. Click the Oracle Reports Security Settings link in the Oracle Reports Security
portlet.

5. Click the Create Reports Definition File Access link in the Reports Definition
File Access portlet.

6. On the resulting page, the Name (internal name) and the Portal DB Provider
fields contain default values. To include custom values:

Enter a unique name in the Name field that will identify the report internally
in Oracle Portal, for example, MY_REPORT. This name must follow the Oracle
Portal rules for a valid component name; that is:

* It must be no more than 30 characters

* It must contain only alphanumeric characters (no spaces or special
characters allowed).

*  The first character must be a letter (not a number).

Enter the name that you want to display for this report in the Display Name
tield. The Display Name is the name that is exposed to your users through
Oracle Portal.

Note: The Display Name, unlike the internal Name, can have
spaces in it.

Select the Portal DB Provider that will own the Reports Server from the Portal
DB Provider list of values. The Portal DB Providers displayed are those in
which you have privileges to build components.

Note: All the components you add to or create in Oracle Portal
must belong to a Portal DB Provider. Refer to the OracleAS Portal
online Help, for more information on how to create a Portal DB
Provider.

7. Click Next.

8. Enter or select information as follows:

Select the Reports Server(s) to be available to run this report from the Reports
Servers list of values. Use control-click (Windows) or click (UNIX) to select
multiple servers.

Enter the report file name, including its extension in the Oracle Reports File
Name field.

The report definition file can be an . rdf, . jsp, or .xml file. If the path to this
file is included in your REPORTS_PATH environment variable, do not enter it
here. If the path is not included in REPORTS_PATH, include it here along with
the filename. Do this for all report definition files except those you will run as
standalone JSPs. For JSPs, you must define the name as virtual
path/reportname. jsp.
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See Also:

= Appendix B, "Environment Variables" for more information on
Oracle Reports-related environment variables.

s Chapter 8, "Configuring Oracle Reports Services" for more
information on specifying the virtual path.

= (Optional) Enter a description for this report in the Description field.

= In the Execute field, select either through servlet or as JSP. The selection you
make here will affect the choices that are available on the next wizard page.

*  through servlet: If you plan to run the report through Oracle Reports
Servlet (rwservlet).

* as JSP: If you will run a deployed JSP report.
9. Click Next.

10. Select the Destination settings on the Required Parameters page.These settings are
only applicable if you run your report through Oracle Reports Servlet
(rwservlet). At runtime, anywhere you have indicated multiple selections using
control-click, a list of values will be offered to your users from which they can set
their own runtime information:

= Types specifies the destination types acceptable for this report. Select the
destination types from among Cache, File, Mail, OraclePortal, OracleWireless,
Printer, FTP, WebDAY, or custom destination types. If the server you
associate with this report supports custom destination types, which you
indicated when you registered the Reports Server in Oracle Portal, the types
you indicated will display on this list.

= Formats defines the acceptable output format(s) for this report. Choose from
HTML, HTMLCSS, PDF, XML, RTF, Delimited, Spreadsheet, PostScript, and
Character.

»  Printers specifies the registered printer(s) to which this report can be sent. The
printers that appear on this list are determined by those you chose when you
set up access to the Reports Server(s) you are associating with this report.
When users choose a Reports Server on the runtime parameter form, only
those printers that are associated with the selected Reports Server and that are
accessible to those users are listed.

11. Select the Parameter Form Template and click Preview Template to see what the
selected template looks like:

s Parameter Form Template specifies the template that will define the look and
feel of the Portal parameter form from which you will run the report. This
value is used only when the report is exposed through the Portal. Choose a
template from the list of values.

Note: For information about adding your own templates to this
list, see the OracleAS Portal online Help.

12. Click Next.

13. Define the limits for the report's existing parameters on the Optional Parameters
page:
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14.
15.

16.
17.

18.

19.

20.

= Enter the name or user parameter to restrict the values available to users in the
Name field. For example, SALES_REGION or COPIES.

= Enter the display name of the system or user parameter. This name will be
used to identify the parameter on the runtime parameter form.

= Enter the name of the list of values, or select the values from a predefined list
of values. The list must already exist. For information on creating a list of
values, see the OracleAS Portal online Help.

= Enter the lowest value that you wish to set for a range of values in the Low
Value field.

= Enter the highest value that you wish to set for a range of values in the High
Value field.

s Click More Parameters if you wish to add more rows for additional
parameters and values.

Click Next.

(Optional) Enter the Availability Calendar name or click the list button to select an
existing Availability Calendar.

Use the availability calendar to limit the days and times this report can be run.

See Also: Section 16.2.4, "Creating an Availability Calendar"

Click Next.
(Optional) Enter a validation trigger to create a programmatic restriction.

Use validation triggers to create conditional restrictions that cannot be defined on
either the Required Parameters page or the Optional Parameters page. Validation
triggers are PL/SQL functions.

The function that you specify as a validation trigger must return a boolean value
(TRUE or FALSE). If the function returns TRUE, the job is run. If the function
returns FALSE, an error message is displayed and the job is not run.

Click Finish to close the wizard and complete report registration.

The resulting page summarizes your registration information and provides the
opportunity to perform additional actions on your report.

See Also: Section 16.3, "Publishing Your Report as a Portlet" for
more information on how to run your report from Oracle Portal.

Click the Access tab and select the Publish as Portlet box. This adds the report to
the Portlet Repository, allowing you to add it to a page and publish your report as
a portlet.

Click Customize to view the report's Runtime Parameter Form.

Table 16-3 summarizes the options available on this page.

Table 16-3 Options on the Runtime Parameter Form

Option Description
Run Report Click to run this report with the specified parameter values.
Save Parameters Click to save the parameter value selections.
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Table 16-3 (Cont.) Options on the Runtime Parameter Form

Option

Description

Server

Printer

Destype

Desformat

Desname

SSOCONN

Visible to user

Servlet Command Key

Portlet Width

Portlet Height

Additional User
Parameters

Select the Oracle Reports Server that you want to receive this
report request. Only the servers that you chose at the time of
registering the Report are displayed in this list box.

Select the printer that you want to print your report output. Only
the printers that you chose at the time of registering the report
are displayed in this list box.

Select the destination type. Only the destination types that you
chose at the time of registering the report are displayed in this list
box.

Select the destination format. Only the destination format that
you chose at the time of registering the report are displayed in
this list box.

Enter the name of the output file when DESTYPE=FILE, or enter
the e-mail addresses when the DESTYPE=MATIL. Separate
multiple addresses with commas. The destination name is
required when you choose FILE or MAIL as the DESTYPE.

Enter one or more Single Sign-On connection strings. Separate
multiple strings with a comma (but no spaces). For more
information on SSOCONN, refer to Section 17.3.3.1, "SSOCONN".

Check each parameter that you want to make available in the
runtime parameter form when users run this report request. If the
box in not checked, then the parameter is not displayed to users.

Optionally, enter the key from the cgicmd. dat key map file (for
more information, see Section 18.13, "Using a Key Map File") that
identifies the command line to run for this report.

Use this field to control the width of the portlet. You can enter the
value as a percentage of the page (for example, 90%) or in pixels
(e.g, 700).

If no value is specified, Oracle Reports Services uses its default
value (640 pixels wide).

Use this field to control the height of the portlet. You can enter
the value as a percentage of the page (for example, 50%) or in
pixels (e.g, 400).

If no value is specified, Oracle Reports Services uses its default
value (320 pixels high).

Use this field to enter additional user parameters. For example,
you can use this field to enter the path and name of the
distribution XML file that defines how this report should be
distributed.

Use the same syntax you would use to specify these values in a
command line request or within the cgicmd. dat key map file
file (for more information, see Section 18.13, "Using a Key Map
File"). If you wish to enter multiple additional parameters, simply
separate each entry with a space.

For more information on the distribution XML file, see
Chapter 20, "Creating Advanced Distributions".

16.2.3 Registering a Printer

It is not required that you register a printer within the security framework of Oracle
Portal. You can run a report on any printer as long as it is available to the Reports
Server. However, you might want to confine Oracle Portal users to a subset of those
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printers, constrain the use of a printer for certain periods of time, or identify a
particular printer to be used for printing output of certain reports.

Printer registration with Oracle Portal is meaningful for reports that you run through
Oracle Portal as well as those you run through a standalone URL.

Once printers are registered within Oracle Portal, you can associate them with a
Reports Server. Many printers can be registered. However, only printers associated
with particular Reports Servers are available to print when you register a report with
Oracle Portal and choose those Reports Servers.

You can choose to restrict even further the registered subset of printers that a
registered report can be sent to. For example, an Reports Server might be connected to
the printer in the office of the CEO, but its selection should not be available to
employees running the general ledger report, unless it is the CEO who is running the
report. A subset of printers can be listed to the Oracle Portal user running a report
request to select where output should be sent.

Table 16-4 Sample Values

Property Sample Value

Name (internal name) myrep_printer
Display Name My Reports Printer
Portal DB Provider PORTAL_APP

OS Printer Name \\mydomain\printerl
Availability Calendar COMCAL

To register a printer:

1. Log in as an administrator to Oracle Portal.
2. Navigate to the Builder page.

3. Click the Administer tab.
4

Click the Oracle Reports Security Settings link in the Oracle Reports Security
portlet. The Oracle Reports Security portlet enables you to use the security
features in Oracle Portal at the time of defining access to the server, printer,
calendar, and reports definition file.

5. Click the Create Reports Printer Access link in the Reports Printer Access
portlet.

6. On the resulting page, the Name (internal name) and Portal DB Provider fields
contain default values. To include custom values:

= Enter a unique name in the Name field that will identify the printer internally
in Oracle Portal, for example, MY_PRINTER. This name must follow the
Oracle Portal rules for a valid component name; that is:

* It must be no more than 30 characters

* It must contain only alphanumeric characters (no spaces or special

characters allowed).
*  The first character must be a letter (not a number).

= Enter the name that you want to display for this printer in the Display Name
field. The Display Name is the name that is exposed to your users through
Oracle Portal.
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Note: The Display Name, unlike the internal Name, can have
spaces in it.

= Select the Portal DB Provider that will own the printer from the Portal DB
Provider list of values. The Portal DB Providers displayed are those in which
you have privileges to build components.

Note: All components you add to or create in Oracle Portal must
belong to a Portal DB Provider. Refer to the OracleAS Portal online
Help, for more information on how to create a Portal DB Provider.

7. Click Next.
8. On the resulting page, fill in desired values:

s In the OS Printer Name field, enter the operating system printer name, for
example:

UNIX: printer_name

Windows: \\printer_ server\printer _name (for a remote printer)
printer_name (for a local printer)

This printer must be available to the Reports Server.

Note: Printer availability is set through the operating system on
the Report Server's host machine.

= (Optional) Enter a description of the Printer in the Description field.
9. Click Next.
10. (Optional) Select an Availability calendar to restrict the days and times the printer

can be used.

See Also: Section 16.2.4, "Creating an Availability Calendar"

11. Click Finish.

The resulting page summarizes your settings for this printer. On this page, you
can edit your settings, get detailed registration information about the printer, or
delete it altogether.

See Also: Section 16.2.5, "The Manage Portlet" for more
information on the fields and descriptions listed in the Manage
portlet (that is, Develop, Manage, and Access tabs).

12. Click Close to close this page and return to Oracle Portal's Oracle Reports
Security page.

You have completed registering a printer with Oracle Portal. This registration is
meaningful for reports that are run through Oracle Portal as well as those run outside
of Oracle Portal.
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16.2.4 Creating an Availability Calendar

Defining availability calendars is an optional step that enables you to further restrict
access to reports, servers, and printers by specifying when they can and cannot be
accessed. Availability calendars are not necessary if the reports, the Reports Servers,
and printers are always available for processing.

This section provides information on:
s Creating a Simple Availability Calendar
s Creating a Combined Availability Calendar

You can associate only one availability calendar with a report, a Reports Server, or a
printer. If your production environment requires more than one availability rule, then
you can combine availability calendars.

16.2.4.1 Creating a Simple Availability Calendar

A simple availability calendar defines a single availability rule (for example, Sunday
through Saturday from 12:00 a.m. to 10:00 p.m.).

To create a simple availability calendar:

1. Log in as an administrator to Oracle Portal.
2. Navigate to the Builder page.

3. Click the Administer tab.
4

Click the Oracle Reports Security Settings link in the Oracle Reports Security
portlet.

5. Click the Create Reports Simple Calendar Access link in the Reports Calendar
Access portlet on the Oracle Reports Security page.

6. On the resulting page, the Name (internal name) and Portal DB Provider fields
contain default values. To include custom values:

= Enter a unique name in the Name field that will identify the availability
calendar internally in Oracle Portal, for example, MY_CALENDAR. This name
must follow the Oracle Portal rules for a valid component name; that is:

* It must be no more than 30 characters

* It must contain only alphanumeric characters (no spaces or special

characters allowed).

*  The first character must be a letter (not a number).

s In the Display Name field, enter the name you want to display for this
availability calendar when it is exposed through Oracle Portal. Unlike the
internal name, the display name can have spaces in it.

= Select a Portal DB Provider from the provider list of values. All components
added to or created in Oracle Portal must belong to a Portal DB Provider. This
list contains the names of only those providers with which you have privileges
to build components.

Note: For information on creating a Portal DB Provider, see the
OracleAS Portal online Help.

7. Click Next.
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8. Optionally, enter a description of the calendar under Description.

9. Click Next.

10. On the Date/Time Availability page, define the parameters for the calendar:

Under Duration, specify the length of time that comprises a unit of duration (or
duration period). For example, if you plan to set this calendar up to allow report
access from 9:00 AM to 5:00 PM on a given day, then both Start and End would be
the same month, day, and year, but the hour and minute setting for Start would be
9:00 AM and for End would be 5:00 PM. In this example, the duration of
availability of a report on a given day is from 9:00 AM to 5:00 PM.

Under Repeat, specify how frequently the duration period is repeated:

Occurs only once indicates that the duration period does not repeat, and
associated components are no longer available when the period expires. For
example, if you select Occurs only once and set a duration period of one year,
then the associated components cease to be available after one year.

Yearly indicates that the duration period restarts each year. If you select
Yearly and have the same start and end date in your Duration setting, but
your Start hour is set to 9:00 AM and your End hour is set to 5:00 PM, then the
Reports components associated with this availability calendar will be available
one day a year between 9:00 and 5:00.

Monthly indicates that the duration period restarts each month between the
Start and End dates specified under Duration. If you select Monthly and have
the same date and year in both Start and End—]July 25, 2001—but set the Start
hour for 9:00 AM and the End hour for 5 PM, then the associated components
will be available between 9:00 AM and 5:00 PM on the 25th of each month.

The by Date/Day setting applies only to Monthly. With by Date/Day, you
specify whether the duration period is set by the particular date (for example,
always on the 25th through the 29th of the month) or by the particular day(s)
(for example, always on Monday through Friday—which happen this month
to fall on the 25th through the 29th).

Weekly indicates that the duration period restarts on a weekly basis between
the days specified under Duration.

Daily indicates that the duration period restarts each day between the hours
specified under Duration.

Frequency fills in the missing value for the phrase: Repeat every n (years,
months, weeks, days—depending on what you selected under Repeat). For
example, if you set the duration period to repeat weekly, then set Frequency
to 2, the duration period restarts every two weeks, or every other week.

Optionally, check Repeat Until and assign a termination date/time for the
calendar. Availability for all associated Reports components ends on the
Repeat Until date/time.

Note: No validation is run on your calendar. If the duration
period exceeds the repetition setting, no error message will be
generated. For example, if you set the duration period for 10 days
and the repetition for weekly, the periods will overlap, but you will
not be notified of the overlap.

11. Click Next.
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12. On the Summary page, click the Show Calendar button to preview your
availability calendar. If you wish to change some settings, click the Previous
button and make your changes.

13. On the Summary page, click Finish to complete the availability calendar.

The resulting page summarizes your settings for this calendar. On this page, you
can edit your settings, get detailed information about the calendar, or delete it.

14. Click Close to close this page and return to Oracle Portal's Oracle Reports
Security page.

You can combine this calendar with other calendars or apply it "as is" to registered
Oracle Reports Services components.

16.2.4.2 Creating a Combined Availability Calendar

A combined availability calendar combines two or more availability calendars into a
single availability calendar. This is useful when you want to set up an availability
period, then exclude specific days, such as holidays, from that period.

When you combine calendars, you can indicate that all the days on one of them be
excluded from all the days on the other. For example, one calendar could describe
availability Monday through Friday; another could describe availability only on
Wednesday. You could combine these, excluding the Wednesday calendar, so that the
combined calendar describes availability Monday, Tuesday, Thursday, Friday.

Conceivably, you could create a simple calendar that covers the weekdays of an entire
year, then multiple additional simple calendars, where one excludes New Years,
another excludes a second holiday, another excludes a third, and so on. You could
combine all these calendars, excluding all the holiday calendars, so that components
were available only on the days your company is open for business, between certain
times of day, throughout the year.

To combine availability calendars:
1. Log in as an administrator to Oracle Portal.
2. Navigate to the Builder page.
3. (Click the Administer tab.
4

Click the Oracle Reports Security Settings link in the Oracle Reports Security
portlet.

5. Click the Create Reports Combined Calendar Access link in the Reports Calendar
Access portlet.

6. Specify an internal name, display name, and Portal DB Provider for the calendar:

= Enter a unique name in the Name field that will identify the combined
availability calendar internally in Oracle Portal, for example, MY_
COMBINED_CALENDAR. This name must follow the Oracle Portal rules for
a valid component name; that is:

* It must be no more than 30 characters

* It must contain only alphanumeric characters (no spaces or special

characters allowed).
*  The first character must be a letter (not a number).

= Enter the name you want to display for this combined availability calendar in
the Display Name field. The Display Name is the name that is exposed to
your users through Oracle Portal.
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10.

11.

12.
13.

14.

15.
16.

17.

Note: The Display Name, unlike the internal Name, can have
spaces in it.

= Select a Portal DB Provider from the provider list of values. All components
that you add to or create in Portal must belong to a Portal DB Provider. This
list contains the names of only those providers with which you have privileges
to build components.

Note: For information on creating a Portal DB Provider, see the
OracleAS Portal online Help.

Click Next.

(Optional) Enter a description of the Availability Calendar in the Description
field.

Click Next.

On the Selection page, highlight the calendars on the Availability Calendars list
that you want to combine. The calendars are listed by their internal names, not
their display names. Use control-click (Windows) or click (UNIX) to select
multiple calendars.

This page lists the availability calendars that have been defined for the same Portal
DB Provider under which you are creating this combined availability calendar.

Click the right arrow to move the selected calendars to the Selected Availability
Calendars list.

Click Next.

On the Exclude page, highlight the calendar(s) on the Availability Calendars list
whose dates you want to exclude. Use control-click (Windows) or click (UNIX) to
select multiple calendars.

These are the calendars with dates on which you wish to withdraw availability.

Click the right arrow to move the selected calendars to the Excluded Availability
Calendars list.

Click Next.
On the Summary page, click the Show Calendar button to preview your calendar.

If your exclusion isn't showing up, select a different view. For example, instead of
the monthly view, select the weekly.

If you want to change the combination, close the calendar and click the Previous
button one or more times to return to the desired page.

Click Finish to complete creation of the combined calendar.

The resulting page summarizes your settings for this calendar. On this page, you
can edit your settings, get detailed information about the calendar, or delete it.

See Also: Section 16.2.5, "The Manage Portlet" for more
information on the fields and descriptions listed in the Manage
portlet (that is, Develop, Manage, and Access tabs).
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18. Click Close to close this page and return to Oracle Portal's Oracle Reports

Security page.

You can combine this calendar with other calendars or apply it "as is" to registered
Oracle Reports Services components.

16.2.5 The Manage Portlet

Use the Manage portlet page to perform actions on existing Oracle Portal portlets; for
example, executing, editing, copying, dropping, or viewing information about the

portlet.

The actions you can perform on the portlet depend on your privileges. Also, not all
actions listed here are available for all portlets. The name of the portlet on which you
can perform these actions appears in the upper left corner of the page.

Table 16-5 details the fields and descriptions listed in the Develop tab.

Table 16-5 The Develop Tab

Field Description
(portlet Type and Name)  Displays the portlet's type and name; for example:
Form (table) my_formfor a form
based on a table called my_form.
Provider Displays the name of the provider in which the portlet was

Version(s) Status (Not
applicable to all portlets)

Last Changed

Run Link (Not applicable
to all portlets)

PL/SQL source (Not
applicable to all portlets)

Call Interface (Not
applicable to all portlets)

Edit Data Link (Not
applicable to all portlets)

created.

Displays all the versions of the portlet and the current status of
each version. Click a status to edit the portlet version.

Note: If there are no hyperlinks, you do not have privileges to
edit the portlet.

Displays the name of the user who created or last edited the
portlet, and the date and time when the portlet was created or
last edited.

Displays the URL for the procedure or procedures that, when
executed, display the portlet. You can copy and paste this URL
into another Web page to create a link to the portlet.

Note: A procedure that executes the portlet without
parameters has the suffix .show. A procedure that executes the
portlet with parameters has the suffix .show_parms.

The portlet builder wizards create a PL/SQL package to
represent each portlet:

Package Spec: Displays the portlet's PL/SQL specification.
Package Body: Displays the portlet's PL/SQL body:.

Click Show to display the arguments that a portlet can accept
that the end user can change at runtime. Also shown are
examples of calling the portlet from a PL/SQL Stored
Procedure and through a URL. When you run the package
containing the portlet in PL/SQL or by calling it from a URL,
you can edit the call interface to accept different arguments.

Note: To view portlet source code, you must have Customize
or Execute privileges on the portlet or the provider that owns
it.

Click to connect to the URL containing the data, and to see and
edit that data.
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Table 16-5 (Cont.) The Develop Tab

Field Description

Edit Click to edit the most recent version of the portlet. For
example, you can reselect any table columns on which the
portlet is based, change any fields or text that appear in the
portlet, or choose a new look and feel.

Edit as New Click to create and then edit a new version of this portlet. The

Edit Data (Not applicable
to all portlets)

Run

Run As Portlet

Customize

Add to Favorites

About
Delete

existing portlet version does not change.

Click to see the spreadsheet and be able to edit the data within
it.
Click to run the current PRODUCTION version of the portlet.

Note: If a valid package for the portlet doesn't exist, the portlet
will not run.

Displays how the portlet will look as a portlet in a portal
window (may look different than a full page display).

Click to display the customization form for the portlet. The
customization form enables you to specify values that will be
used to display the portlet.

Note: If the current portlet is a form, Browse appears instead of
Customize on this page.

Click to add the portlet to the Favorites list on your Oracle
Portal Home page.

Displays stored attributes for the portlet.

Click to drop the portlet from the database.

Table 16-6 details the fields and descriptions listed in the Manage tab.

Table 16-6 The Manage Tab

Field

Description

Show /Hide SQL Query
Info (Not applicable to all
portlets)

Show Locks on this portlet
(Not applicable to all
portlets)

Export
Copy
Rename
Generate

Monitor

Select to display or hide the SQL Query when running the
portlet, for debugging purposes.

Displays any locks currently active on the portlet (for example,
if somebody else is editing it).

Click to export the portlet from the database.

Click to copy the portlet from the database.

Click to rename the portlet (within the same provider).

Click to compile the PL/SQL package.

Click to view a chart of all requests for the portlet and the users
who made the request.

Table 16-7, Table 16-8, Table 16-9, Table 16-10, Table 16-11, Table 16-12, and
Table 16-13 details the fields and descriptions listed in the Access tab.
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Table 16-7 Portal Access

Field

Description

Publish as Portlet (Not
applicable to all portlets)

Click to make the portlet available as a portlet.

Note: To publish the portlet as a portlet, you must have the
Publish Portlet privilege and you must make the provider that
owns the portlet available through Expose as Provider on the
Access provider page (Manage tab).

Table 16-8 Privilege Mode

Field

Description

Inherit Privileges from
Provider

Select to allow the provider access privileges to override the
portlet access privileges.

Clear the check box and click Apply to allow the portlet access
privileges to override the provider access privileges. In the
Grant Access section, you can selectively grant or remove
portlet access privileges for different users or groups (for
example, Manage, Edit, View, Customize, or Execute).

Note: To grant portlet access privileges to a user or group, you
must have Manage access privileges on the portlet or provider
that owns the portlet.

Table 16-9 Grant Access

Field Description

Grantee Enter the user or group to whom you want to grant the
provider access privilege.

Execute Choose the privilege you want to grant.

Add Click to grant the provider access privilege.

Table 16-10 Change Access

Field Description

Grantee Displays the Oracle Portal user or group to whom the privilege
is assigned. Click Error! Unknown switch argument.next to a
grantee to delete all privileges.If you want to grant privileges
to all Oracle Portal users, choose Public as the Grantee.

Type Displays whether the grantee is an Oracle Portal user or group.

Privilege Displays the privilege currently granted. To change a privilege,

choose a new one and click Apply.
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Table 16-11  Cell Privilege Mode

Field Description

Inherit Privileges from Select to allow the portlet access privileges to override cell
portlet access privileges.

(Not applicable to all Clear the checkbox and click Apply to allow cell access
portlets) privileges to override the portlet access privileges. In the Alter

Access section, you can selectively change cell access privileges
for different users or groups (for example, Manage, Edit, View,
Customize, or Execute).

Note: To alter cell access privileges for a grantee, you must
have Manage access privileges on the portlet or provider that
owns the portlet.

Table 16-12 Alter Access

Field Description

Grantee (Not applicable to Enter the user or group to whom you want to grant the cell
all portlets) access privilege.

Alter (Not applicable to all Click to alter cell access privileges.
portlets)

Table 16-13 Cache Invalidation

Field Description

Clear Cache Clears the cached version of the data, so that the next data
request will be filled from the database.

16.3 Publishing Your Report as a Portlet

After you have registered your Oracle Reports, you can expose your report in a portal
by performing the following steps:

1. Create a provider for your reports. This step defines a provider to contain the
reports you wish to make available to users in the portal. Alternatively, you can
use the existing providers included, by default, with Oracle Portal.

Refer to Section 16.3.1, "Creating a Provider for Your Reports".

2. Add the report as an item link! or as a portlet® to a page and optionally customize
it. This makes the report available to users on a page and enables the page
designer to set the report parameters and schedule it to run automatically. You can
also distribute report output to Oracle Portal.

Refer to:
= Section 16.3.2, "Adding the Report Portlet to a Page"
= Section 16.3.3, "Adding the Report as an Item Link to a Page"

= Section 16.3.4, "Running Reports on Oracle Portal as an Item Link on a
Nondefault Installation"

= Section 16.3.5, "Distributing Report Output to Oracle Portal"

1" An individual piece of content (text, hyperlink, image, and so on) that resides on a page in an
item region.

2 A reusable, pluggable Web component that typically displays portions of Web content.
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16.3.1 Creating a Provider for Your Reports

If you do not already have a provider defined to contain your reports, you must create
one. For more information on creating a provider, see the OracleAS Portal online Help.

Note: The provider that contains your reports must be a database
provider and must have the Expose as Provider setting selected on
its Access page.

16.3.2 Adding the Report Portlet to a Page

After you have registered your report with Oracle Portal, you can publish it as a
portlet on your portal page.

Note: You must have enabled the Publish as Portlet box to ensure
that you can publish your report as a portlet.

To publish a report as a portlet:
1. If you are not already on the Builder page, click Builder at the top of the page.
2. C(Click the Build tab.

3. In the Page Groups portlet, choose the name of the page group in which you want
to place your report portlet.

4. Create a new page by clicking Create a Page or edit an existing page by entering
the name of an existing page and clicking Edit.

5. If you are creating a new page, follow the steps in the wizard and click the
question mark in the upper right corner for additional information about the
available settings. Click Finish when you are done.

See Also: Section 16.3.3, "Adding the Report as an Item Link to a
Page" for information on how to add the Oracle Reports item to a

page.
If you are editing an existing page, skip to the next step.

6. In the page region where you wish to add your report portlet, click the Add
Portlet tool.

Tip: Hints for each tool will display when you roll your mouse
over them.

7. Drill down through the Portlet Repository to the provider that contains the report
portlet. The report portlet is listed in the Portlet Repository under the Portal DB
Provider to which it belongs. The location of the provider depends on how the
Portlet Repository has been organized. If the Portal DB Provider is a fairly new
provider, it may be under the New page of the Portlet Repository.

8. Click the name of your report portlet to add it to the Selected Portlets list.
9. Click OK.
10. Click Customize in the upper right corner of your report portlet.

11. Enter parameter values in the Parameter tab and, if desired, schedule the job to
run automatically in the Schedule tab.
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12. You can control the size of the portlet by specifying the Portlet Width and Portlet
Height parameters on the Customize page for the Reports Definition File object.
The value of these parameters may be a percentage (%) or a number of pixels.

For example, you can enter:
Portlet Width: 90%
Portlet Height: 480

If no value is specified, Oracle Reports Services uses its default value (640 pixels
wide and 320 pixels high).

If the Portlet Width and Portlet Height fields are visible to users, then they can
also adjust each portlet's width and height through Customize. The user's value
will override the value set in the Customize page of the Reports Definition File
Object component.

13. You can choose whether to make a report's parameters visible to users on the
Customization page of a Reports Definition File Access component.

To make a report's parameters visible to users:
a. Click Customize at the bottom of the Develop tab for the report.

b. Select Visible to user for each parameter you want to expose.

Note: You can also set the default value of the parameter from this
page.

If the parameter you are exposing has a corresponding Oracle Portal page
parameter, and you leave the parameter value empty in the Customize page,
the portlet inherits the page parameter's value. If the user enters a value for
the report portlet's parameter, that value will override the page parameter
value.

16.3.3 Adding the Report as an Item Link to a Page

You can add an Oracle Reports component to a page as an item link using the Oracle
Reports item type. If you have installed Oracle Portal with the nondefault language
setting, refer to Section 16.3.4, "Running Reports on Oracle Portal as an Item Link on a
Nondefault Installation".

Note: This item type must be included from the hidden list of
item types and can be configured only if you are the page group
administrator.

1. If you are not already on the Builder page, click Builder at the top of the page.
2. Click the Build tab.

3. Inthe Page Groups portlet, choose the name of the page group in which you want
to place your report item link.

4. Create a new page by clicking Create a Page or edit an existing page by entering
the name of an existing page and clicking Edit.
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5. If you are creating a new page, follow the steps in the wizard and click the
question mark in the upper right corner for additional information about the
available settings. Click Finish when you are done.

If you are editing an existing page, skip to the next step.

6. Click the Add Item link. The Oracle Reports item type is available as a hidden
item type. To include it as an available item type, click the configure the list of
available item types link.

7. Select Oracle Reports in the Hidden Item Types list and click the right arrow (>)
to move it to the Visible Item Types list. Alternatively, you can click >> to move
all items in the Hidden Item Types list to the Visible Item Types list.

8. Click OK.

9. Select the Oracle Reports item type in the Content Item Types menu and click
Next to display the Add Oracle Reports page.

10. Enter a Display Name that users of your portal will view when clicking your
report.

11. Select from the list of available default Oracle Reports components.

12. Select Display Parameter Form if your report requires any user inputs before your
report is displayed.

13. Select Link That Displays Item In New Browser Window to ensure that the
report is viewed in a separate page.

14. Click Finish. The Oracle Reports item now displays as a link in your page.

15. Click the link to run the report and provide any parameters required, if Display
Parameter Form is selected.

16.3.4 Running Reports on Oracle Portal as an ltem Link on a Nondefault Installation

When you install Oracle Portal with a nondefault language setting, some entries
required to publish a report as an item link on a portal page are not installed
automatically. You must install the language of your choice by using the rwlang.sgl
script.

Thus, you must run the script rwlang.sqgl (ORACLE_
HOME/portal/admin/plsqgl/wwd/) if both of the following are true:

= You have selected at least one language in addition to the default ("US") at the time
of installing Oracle Portal.

= You want to publish a report as an item link in Oracle Portal.

Note: This is a one time post-installation task and will ensure that
you can publish a report as an item link on Oracle Portal.

To run the script:

1. Change the directory to ORACLE_HOME/portal/admin/plsgl/wwd/.
2. Run sglplus.

3. Log on to Oracle Portal using the portal schema.

4. This is the portal schema used to install Oracle Portal PL/SQL packages.
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Run the rwlang.sql script with the following parameters:

@rwlang.sgl language_list

where
language_list is the list of languages separated by commas.
For example, to install French and Japanese:

@rwlang.sql f,Jja

Usage Note

There should be no space before or after the comma (,) because sqlplus treats the
language list as two parameters, instead of one parameter separated by a comma

()

The header of the rwlang.sql script contains the complete list of all language
abbreviations. Edit the script file using any text editor to find out the various
abbreviations.

16.3.5 Distributing Report Output to Oracle Portal

To distribute to the ORACLEPORTAL destination from Reports Server:

1.

Create a distribution file (for example, distribution.xml) to distribute report
output to Oracle Portal. For example:

<destinations>
<destype id="customforPortal" name="oraclePortal">
<property name="outputpage" value="Test_Reports"/>
<property name="statuspage" value="result"/>
<property name="pagegroup" value="test_reports"/>
<property name="itemtitle" value="TestReport"/>
<include src="report"/>
</destype>
</destinations>

Note: In this example, you must ensure that pagegroup test_
reports exists in Oracle Portal or specify an existing pagegroup
name.

Run a report with the following URL:

http://host:port/reports/rwservliet?server=reports_server
&report=report_name&destination=distribution file
&distribute=yes&userid=user/passwordedb

In Oracle Portal, go to the page specified in the URL and make sure the report is
visible.

16.4 Connecting to Oracle Portal

By default, Reports Server can only use Oracle Portal users to connect to Oracle Portal.
It cannot use an ordinary userid, such as scott/tiger, unless you first assign
appropriate privileges to its schema.

To assign the appropriate privileges to a schema other than the Oracle Portal schema,
you must run the following script from SQL*Plus as an Oracle Portal user:
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ORACLE_HOME/portal/admin/plsqgl/wor/rwgrant.sqgl

Once the script is loaded, it prompts you to enter the connection string for the new
schema (for example, repapp/repapp@orcl). The script then assigns the
appropriate privileges to this new schema. You can then specify this connection string
in the destination element in the Reports Server configuration file to connect to Oracle
Portal.

16.5 Troubleshooting Information

This section contains information on the various steps that you can take to rectify
issues that occur.

16.5.1 Resolving Reports-Portal Integration Error When Attempting Create Resource

In Oracle Portal, when configuring Oracle Reports Security settings for Reports
Definition File Access, you may encounter an error when editing a report definition
file, when you click Run or Run as Portlet.

500 Internal Server Error
Unexpected Error. Please contact Administrator
This error occurs when all of the following conditions are true:

= Running in an Interop deployment (which allows for a mixed 9.0.2/9.0.4
environment), with 9.0.4 MT (mid-tier), 9.0.4 IM (Identity Management), and 9.0.2
MR (metadata repository) configured to run together.

= Running Oracle Reports within Oracle Portal, using the SSOCONN parameter.

s The connection resource specified in the SSOCONN parameter has not been
created in the Oracle Internet Directory server.

To implement the workaround, perform the following steps:
1. Inthe 9.0.4 IM ORACLE_HOME, open the following file in a text editor:

ORACLE_HOME/Apache/Apache/conf/mod_osso.conf

2. Add the following flag:

OssoRedirectByForm on

For example:

<IfModule mod_osso.c>

OssoIpCheck off

OssoIdleTimeout off

OssoConfigFile
/privatel/iasinst/install_setl/904infra/Apache/Apache/conf/osso/osso.conf
OssoRedirectByForm on

</IfModule>
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Configuring and Administering OracleAS
Single Sign-On

Oracle Application Server Single Sign-On (OracleAS Single Sign-On) enables you to
establish a unique identity for each user, and tie that identity to the resources and data
sources unique to that user. For example, a user might log in to an environment such
as Oracle Portal, which enables them to access certain reports and printers for which
they have the necessary privileges. When they choose to run a report from this
environment, they can access the necessary data sources for the report because their
data source credentials are stored with the single user identity used to login to Oracle
Portal. Thus, logging in once provides them access to all of the resources and data
sources they require to run their reports.

Because Oracle Reports Services provides a flexible approach to security, you can
implement many variations of this configuration. For example, you might choose not
to store data source credentials with the single user identity. Or you might prefer to
use direct URLs for launching reports rather than a platform like Oracle Portal. If your
reports are public and do not require any security, then you might choose to turn off
report security altogether.

This chapter describes how you can implement and administer various configurations
of OracleAS Single Sign-On with Oracle Reports Services.

»  Prerequisites

s Configuring Out-of-the-Box OracleAS Single Sign-On

s Administering OracleAS Single Sign-On

s Choosing the Connecting Entity for Oracle Internet Directory

= Changing the Reports Servlet Port to Be Protected by Single Sign-On

= Oracle Forms Services Security Considerations

17.1 Prerequisites

OracleAS Single Sign-On can be implemented only in a secure server environment.
This means that you must have a security policy in place in your Reports Server
configuration file before you can consider implementing OracleAS Single Sign-On
with Oracle Reports Services. For more information, refer to Chapter 15, "Securing
Oracle Reports Services".

With OracleAS Single Sign-On, your administrator establishes a user identity for each
user. The administrator does this in Oracle Internet Directory, through its user
interface, the Oracle Delegated Administration Services. You can access Oracle
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Delegated Administration Services standalone or through Oracle Portal. In either case,
the information is saved to Oracle Internet Directory.

The user identity is comprised of the user name and password. Once users are
established, data source connection strings may be associated with them. At login,
users must enter their user names and passwords (their user identities), which will in
turn give them access to all of the data sources associated with those identities.
OracleAS Single Sign-On issues a session cookie that effectively acts as a key that
opens all authorized doorways for that session.

Note: For detailed information about the requirements and
procedures required for setting up SSO-related components, such
as Oracle Internet Directory, see Oracle Fusion Middleware
Administrator’s Guide for Oracle Internet Directory and the Oracle
Fusion Middleware Administrator’s Guide for Oracle HTTP Server.

17.2 Configuring Out-of-the-Box OracleAS Single Sign-On

To run a report, you must login with a valid OracleAS Single Sign-On userid and
password. The Reports Server is configured by default with the OracleAS Single
Sign-On instance installed as part of Oracle Fusion Middleware. The Oracle Internet
Directory instance installed with Oracle Fusion Middleware is used as the default
repository for user and group information. If you want to configure the Reports Server
to use a different Oracle Internet Directory instance or disable security, refer to

Section 17.3, "Administering OracleAS Single Sign-On". For information on how to
add users to Oracle Internet Directory, refer to Oracle Fusion Middleware Administrator's
Guide for Oracle Internet Directory. In addition, for each Oracle Fusion Middleware
installation, the Reports Server instances connect to Oracle Internet Directory as an
application entity that is unique to the Oracle Fusion Middleware installation. For
more information on this behavior, refer to Section 17.3.4, "Connecting to Oracle
Internet Directory".

If a user is not already logged in to OracleAS Single Sign-On, they are prompted to log
in when they attempt to run a report to the Reports Server through rwservlet. If the
user parameters for a report include SSOCONN, OracleAS Single Sign-On will search
for the user's data source credentials in Oracle Internet Directory. If none are found,
then OracleAS Single Sign-On prompts the user to create a new resource. For more
information on rwservlet, refer to Section A.2.5, "rwservlet". For more information
on SSOCONN, refer to Section 17.3.3.1, "SSOCONN".

The Reports Server is also configured to operate with Oracle Portal by default. You can
optionally add reports to the portal and enable users to launch them from the portal.
Since users must login to the portal in this case, they are not prompted to login again
when they launch their reports because they have already been identified to OracleAS
Single Sign-On by logging in to the portal.

You can also optionally define access controls for resources associated with the
Reports Server (for example, reports, printers, Reports Servers, and calendars) in
Oracle Portal. To control access to resources, you must add them to the portal and
specify their access options. The resource access controls you specify in Oracle Portal
apply to reports that you run outside of the portal as well. For example, if a user tries
to run a report through rwservlet, it will be subject to any access controls you have put
in place through Oracle Portal.
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See Also: Chapter 16, "Deploying Reports in Oracle Portal" for
more information about the integration between Oracle Portal and
Oracle Reports Services.

17.2.1 Oracle Identity Management and OracleAS Single Sign-On Infrastructure

Oracle Reports Services can take advantage of the capabilities in OracleAS Single
Sign-On, which is part of the Oracle Identity Management infrastructure.

17.2.1.1 OracleAS Single Sign-On

With the increasing number of Web-based, e-business applications that companies
deploy for use by their employees, customers, and partners, many businesses must
now consider Single Sign-On functionality. Single Sign-On refers to the ability to log
on to a single security system once, rather than logging on separately to multiple
security systems. With Single Sign-On, each user maintains a single identity and
password for all data and associated resources to which they need access.

Within a given Web application, Oracle Reports Services eases the user's experience
with OracleAS Single Sign-On. OracleAS Single Sign-On ensures that each user
authenticates only once.

Note: Itis recommended that you use Single Sign-on to hide authid
in URLs. For more information see, Section 8.3.1.1.18, "allowauthid".

17.2.1.1.1 Single Sign-On Components Figure 17-1 provides an overview of the Single
Sign-On component architecture.

Figure 17-1 Single Sign-On Architecture
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The components of the Single Sign-On environment include:

s A client Web browser
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s Oracle HTTP Server

The Oracle HTTP Server processes requests from the client browser.

Note: At the highest level, all communication to and from Oracle
HTTP Server may be configured to use SSL. The Oracle HTTP
Server incorporates an OpenSSL module to provide support for
Secure Sockets Layer (SSL) and HTTP Secure Sockets Layer
(HTTPS). Once this is set up in the Oracle HTTP Server (see Oracle
Fusion Middleware Administrator’s Guide for Oracle HTTP Server),
rwservlet automatically detects the SSL port number.

= Reports Servlet

Oracle Reports Servlet (rwservlet) is a component of Oracle Reports Services
that runs inside Oracle WebLogic Server. When a report request comes to the
Oracle HTTP Server, Oracle Reports Servlet (rwservlet) passes the job request to
Reports Server.

= Reports Server

Reports Server (rwserver) processes client requests, which includes ushering
them through authentication and authorization checking, scheduling, caching, and
distribution.

= OracleAS Single Sign-On

OracleAS Single Sign-On is responsible for managing users' Single Sign-On
sessions. It verifies login credentials by looking them up in Oracle Internet
Directory.

s Oracle Internet Directory

Oracle Internet Directory is Oracle's highly scalable, native LDAP version 3 service
and hosts the Oracle common user identity. OracleAS Single Sign-On
authenticates users against the information stored in Oracle Internet Directory. As
noted in earlier sections, when Single Sign-On is enabled for Oracle Reports
Services, it checks Oracle Internet Directory for user and group privilege
information. It also retrieves data source connection information from Oracle
Internet Directory.

= Oracle Delegated Administration Services

The Delegated Administration Service provides a comprehensive interface for
making updates to Oracle Internet Directory. Oracle Reports Services displays
Oracle Delegated Administration Services when it encounters a Single Sign-On
key that does not already have a data source connection string associated with it in
Oracle Internet Directory.

For more information, refer to Chapter 17, "Configuring and Administering OracleAS
Single Sign-On".

17.3 Administering OracleAS Single Sign-On

This section describes some of the administrative tasks you may need to perform as
you maintain security for Oracle Reports Services.

= Enabling and Disabling OracleAS Single Sign-On
= Enabling and Disabling Reports Server Security
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= Enabling and Disabling Data Source Security

= Connecting to Oracle Internet Directory

17.3.1 Enabling and Disabling OracleAS Single Sign-On

To take advantage of OracleAS Single Sign-On out-of-the-box, the SINGLESIGNON
parameter in the Oracle Reports Servlet (rwservlet) configuration file
(rwservlet.properties)is set to YES, which specifies that you will use OracleAS
Single Sign-On to authenticate users. Oracle considers this to be the normal security
deployment model and you should set <singlesignon>no</singlesignon>
only if you plan to run in a completely custom security configuration.

Use Oracle Enterprise Manager to change configuration settings, rather than directly
editing configuration files. To enable or disable OracleAS Single Sign-On, see
Section 7.8.6, "Enabling and Disabling Single Sign-On".

17.3.2 Enabling and Disabling Reports Server Security

In 11g Release 1 (11.1.1), Reports Server is secured out-of-the-box using the
Portal-based security, by default. However, you can enable JPS-based security,
including JAZN-XML authorization. For more information, see Chapter 15, "Securing
Oracle Reports Services".

Use Oracle Enterprise Manager to change configuration settings, rather than directly
editing configuration files. To enable or disable security, see Section 7.8.1, "Enabling
and Disabling Security".

During Oracle Fusion Middleware installation, you are asked to select an identity
store, a policy store, and a credential store. By default, these are file-based stores. After
installation, you can change either of these to LDAP-based stores, such as Oracle
Internet Directory. For more information, see "Understanding Identities, Policies, and
Credentials" in Oracle Fusion Middleware Security Guide.

17.3.3 Enabling and Disabling Data Source Security

To enable data source security through OracleAS Single Sign-On, you must do the
following:

s Include SSOCONN in the URL that launches the report.

= Populate Oracle Internet Directory with data source connection information using
one of three methods.

If you wish to implement data source security through OracleAS Single Sign-On for
your own pluggable data sources, you must perform the following additional task:

= Add a new resource type to Oracle Internet Directory.

The sections that follow explain how to perform these operations.

17.3.3.1 SSOCONN

To enable data source security through OracleAS Single Sign-On, the URL must
contain or reference (that is, through the key map file) an OracleAS Single Sign-On
parameter (SSOCONN) with a value of the form:

key_name/data_source_type/conn_string_parameter

key_name maps to a string stored in Oracle Internet Directory that provides the
necessary information to connect to the database. When Oracle Reports encounters a
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key_name, it checks to see if the current user has a corresponding key stored in Oracle
Internet Directory. If so, Oracle Reports uses the string stored in that key to connect to
the data source. If not, Oracle Reports checks to see if the key._name maps to a
publicly available key. If so, Oracle Reports uses that key. If not, Oracle Delegated
Administration Services prompts the user to create a new resource.

See Also: Section 17.3.3.2, "Populating Oracle Internet Directory"
for more information about populating Oracle Internet Directory
with resources.

data_source_typeis the kind of data source to which you are connecting, to
identify the format in the string associated with key_name. The data_source_type
value must be a valid resource type stored in Oracle Internet Directory. Oracle Reports
provides default resource types for the following:

»  Oracle database (OracleDB)
= JDBC PDS (JDBCPDS)
You can also create additional resource types in Oracle Internet Directory for your

own pluggable data sources.

See Also: Section 17.3.3.3, "Adding a New Resource Type" for
more information about adding resource types.

conn_string parameter specifies the Oracle Reports system or user parameter to
be used to pass the connection string to Oracle Reports. For example, in the case of the
OracleDB data source, Oracle Reports receives the connection string through the
USERID parameter and uses it to connect to the specified Oracle database. Similarly,
for JDBCPDS, P_JDBCPDS is used. If you have your own custom pluggable data
sources, you must define your own user parameter for passing the connection string to
Oracle Reports and specify it as conn_string parameter for SSOCONN.

See Also: Section A.8.16, "SSOCONN"
17.3.3.1.1 Oracle Database Example In the case of an Oracle database, the URL to call a

report with SSOCONN would look something like the following:

http://myhost.mycompany.com:7779/reports/rwservlet?server=rs_cped
&report=my.rdf&destype=cache&ssoconn=mykey/OracleDB/userid&desformat=html

17.3.3.1.2 JDBC Pluggable Data Source Example In the case of a JDBC data source, the
Single Sign-On value would look something like the following;:

http://myhost.mycompany.com:7779/reports/rwservlet?server=rs_cped
&report=Jdbcthin.rdf&destype=cache&desformat=html&ssoconn=jd1/jdbcpds/p_jdbcpds

In this case, jd1 is an Oracle Internet Directory resource name.

See Also: Section 14.1, "Configuring and Using the JDBC PDS" for
more information on how to configure a JDBC data source.

Usage Notes
= When you use SSOCONN in a command line, you cannot:

s Specify AUTHID in the same command line.
= Run against a Reports Server that is not secure.

s Have SINGLESIGNON set to NO in rwservlet.properties.
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Performing any of these actions with SSOCONN in the command line results in an
error.

17.3.3.2 Populating Oracle Internet Directory

For data source security to function with OracleAS Single Sign-On, you must store the
data connection information for each user in Oracle Internet Directory or make the
resource a default one available to every user. You can populate Oracle Internet
Directory with this information in any one of the following ways:

s Oracle Delegated Administration Services

s User Prompt

= Batch Loading

= Making a Resource Available to All Users

17.3.3.2.1 Oracle Delegated Administration Services If you want to enter only the
credentials for a small number of users (for example, for a development environment),

you can use Oracle Delegated Administration Services (DAS) to directly enter
connection string information into Oracle Internet Directory for each user.

Note: Before a user can access Oracle Delegated Administration
Services, an administrator must have already entered a user
identity in Oracle Internet Directory for the user. This step can be
done by batch loading information that is already entered into an
LDAP directory in some other source.

See Oracle Fusion Middleware Administrator’s Guide for Oracle Internet
Directory for information on batch loading.

During Oracle Fusion Middleware installation, you specify the location of Oracle
Delegated Administration Services. You use this URL to access Oracle Delegated
Administration Services for administrative purposes. Once in Oracle Delegated
Administration Services, you enter the information through the Resource Access
Information section of the Preferences tab for the user. See Figure 17-2. Note that, for
the Preferences tab to appear, there must already be a resource in place.
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Figure 17-2 Delegated Administration Services Preferences
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If you want to enter data source information for a large number of users, you should
use either the user prompt or batch methods of populating Oracle Internet Directory.

17.3.3.2.2 User Prompt If you prefer to have users enter their own connection string
information, you do not have to prepopulate Oracle Internet Directory with data
source connection information at all. If you use SSOCONN when launching the report
but Oracle Internet Directory does not already contain a connection string for the key
and the key is not publicly available to all users, the Oracle Delegated Administration
Services Create Resource page is displayed to the user, who must enter their data
source connection string. See Figure 17-3. Oracle Delegated Administration Services
stores the string entered by the user in Oracle Internet Directory for future use and
rwservlet uses the newly entered connection string for the data source connection
string of the report.

Note: Because of this feature, many users can use the same report
URL even if they all use different data source connection strings.
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Figure 17-3 Oracle Delegated Administration Services Create Resource

Resource Access Information

Usernare iscott

Password 3*****

Database [orga_db|

&l [ 5% Localintranet o

Note: In the Create Resource dialog, if you want to enter a JDBC
connection string, you can do so by entering hostname :port:sid
in the Database field.

17.3.3.2.3 Batch Loading Resources for Oracle Reports Services are created in Oracle
Internet Directory under the following entry:

orclresourcename=resource_name, cn=Resource Access Descriptor,
orclownerguid=guid, cn=Extended Properties, cn=OracleContext,
dc:us,dc:oracle,dc:com1

Before You Begin You must create orclownerguid=guid in the Oracle Internet
Directory entry before you can proceed with the batch loading of resources. If you
used Oracle Delegated Administration Services to create your users,
orclownerguid=guid was created automatically and you can proceed to Batch
Loading Resources.

If you seeded users into Oracle Internet Directory with an LDIF file, then, before
following the steps in Batch Loading Resources, you must complete the following
steps:

1. Get the users' GUIDs.

Depending on how your users are created in Oracle Internet Directory, you can
use any number of methods to get their GUIDs. You can get user GUIDs using the
Oracle Internet Directory LDAP API. You can also get it using the 1dapsearch
command:

D:\Oracle\BIN>ldapsearch -h host_name -p port_num -L -D cn=orcladmin
-w orcladmin's_password -b "cn=users,dc=us,dc=oracle,dc=com" -s sub
"objectclass=*" dn orclguid

! dc=us,dc=oracle,dc=com is merely an example in this instance. You would normally enter
your own values for these items.
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Create the user entry orclownerguid=guidunder cn=Extended
Properties, cn=0racleContext, dc=us, dc=oracle, dc=com.

a. Modify the sample script, ORACLE_
HOME\reports\samples\scripts\createuser.1dif by replacing the
place holder with real values.

b. Load createuser.1dif using 1dapadd. For example:

D:\Oracle\BIN>ldapadd -D cn=orcladmin -w welcomel
-h host_name -p port_num -f createuser.ldif

Once you have created orclownerguid=guid, proceed to Batch Loading
Resources.

Batch Loading Resources Follow the steps below to batch load data source
resources for your users:

1.

Create the user's resource entry orclresourcename=resource_name,
cn=Resource Access Descriptor under orclownerguid=guid,
cn=Extended Properties, cn=0OracleContext, dc=us, dc=oracle,
dc=com, where orclownerguid=guidis the GUID created in Before You Begin.

a. Modify the sample script, ORACLE_
HOME\reports\samples\scripts\createresource.ldif by replacing
the place holder with real values.

b. Load createresource.1dif using 1dapadd. For example:

D:\Oracle\BIN>ldapadd -D cn=orcladmin -w orcladmin's_password -h host_name
-p port_num -f createresource.ldif

17.3.3.24 Making a Resource Available to All Users If you want to make a resource
publicly available to all of your users, you can do so by following these steps:

1.
2
3.

Launch Oracle Delegated Administration Services and go to the Home tab.
Login as the administrator (orcladmin).
Click the Configuration tab.

Click the Preferences sub tab and you should see a page similar to the one in
Figure 17-4.
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Figure 17-4 Oracle Internet Directory Configuration Preferences Page
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0 ExpressPDS Oracle Reports Pluggable Data Source
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Default Resource Access Information
For Oracle Reports and Forms based applications

(Create)

1. Under Default Resource Access Information, click Create.

2. In the Create Resource page, enter the resource name and select the Resource type
from the drop-down list. For example, JDBCPDS.

Click Next.

Enter the connection information. For example, scott/tiger@mydb.
Click Submit.

Click OK.

o o & v

That resource should now appear under Default Resource Access Information and
be available to all users.

17.3.3.3 Adding a New Resource Type

If you want to add a new resource type to support your own pluggable data source,
you must perform the following procedure:

1. Launch Oracle Delegated Administration Services and go to the Home tab.
2. Login as the administrator (orcladmin).
3. Click the Configuration tab.

4. Click the Preferences sub tab and you should see a page similar to the one in
Figure 17-4.
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5. Under Configure Resource Type Information, click Create and you should see a
page similar to the one in Figure 17-5.

Figure 17-5 Create Resource Type page

Create Resource Type - Microsoft Internet Explorer
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6. Fill in at least the required fields. Field descriptions are provided in Table 17-1.

Table 17-1 Create Resource Type Properties

Property Description

Resource Type Name Is the name of the new resource type. This name is used
when you want to reference the resource type, for example,
in the data_source_type portion of the SSOCONN string.

Display Name Is the name to be used when the resource type appears in
the user interface.

Description Is a textual description that explains the purpose of the
resource type and any other documentary information you
want to enter for it.

Authentication Class Mandatory field, not used by Oracle Reports Services.
Enter dummy text as a value for this field.
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Table 17-1 (Cont.) Create Resource Type Properties

Property Description

Connection String Format  Defines how Oracle Reports Services should construct the
connection string using the values stored in Oracle Internet
Directory for the resource. For example:

for the Oracle database or a JDBC data source your
connection string format might be:

orclUserIDAttribute/orclPasswordAttribute
@orclFlexAttributel

This string indicates that the user name is followed by a
slash, the password, an at sign (@), and then additional
attribute 1 (for example, for the TNS name of the database).
A connection string that adheres to this format would look
similar to this one:

scott/tiger@dbl
User Name/ID Field Is the display name of the user name field that contains the
Name value for orclUserIDAttribute. The display name

appears on the Create Resource page (Figure 17-3) next to
the field for orc1UserIDAttribute. Typically, you
would enter something like Username or User Name for
this display name.

Password Field Name Is the display name of the password field that contains the
value for orclPasswordAttribute. The display name
appears on the Create Resource page (Figure 17-3) next to
the field for orclPasswordAttribute. Typically, you
would enter something like Password or password for this
display name.

Additional Field 1-3 Is the display name of the additional fields, which contain
the values of orclFlexAttributel,
orclFlexAttribute2,and orclFlexAttribute3. You
must specify these fields for whatever values your
connection string requires beyond user name and
password. For example, you might use one of them to
contain a server or domain name.The display name
appears on the Create Resource page (Figure 17-3) next to
the field for orclFlexAttributel,
orclFlexAttribute2, or orclFlexAttribute3.
Typically, you would enter something descriptive of the
field's contents, such as Server or Domain, for this display
name.

7. Click Submit. Your resource type is created and you can now reference it in the
data_source_type portion of the SSOCONN value.

See Also: Section 17.3.3.1, "SSOCONN".

17.3.4 Connecting to Oracle Internet Directory

As described in Chapter 15, "Securing Oracle Reports Services", Oracle Reports
Services must connect to Oracle Internet Directory to verify user privileges and obtain
existing data source connection information. In connecting to Oracle Internet
Directory, you must consider:

s Choosing the Connecting Entity for Oracle Internet Directory

s Choosing the Oracle Internet Directory Instance
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17.3.4.1 Choosing the Connecting Entity for Oracle Internet Directory

When Oracle Reports Services connects to Oracle Internet Directory, it does so as an
application entity. By default, each Oracle Reports Services application entity is unique
to its Oracle Fusion Middleware installation. Every Reports Server started from the
same Oracle Fusion Middleware installation (that is, ORACLE_HOME) uses the same
application entity to connect to Oracle Internet Directory. This setup ensures that each
Reports Server can only access information in Oracle Internet Directory that is relevant
to its instance of Oracle Fusion Middleware.

For example, suppose you have two instances of Oracle Fusion Middleware, one for
your Finance group and one for your Human Resources group. A Reports Server from
the Finance group's Oracle Fusion Middleware instance would be prevented from
accessing information relevant only to the Human Resources group, and vice versa.
Thus, information stored in Oracle Internet Directory is more secure by default.

In previous releases of Oracle Reports Services, all Reports Servers connected to Oracle
Internet Directory as the same application entity. As a result, it was not possible to
restrict a Reports Server's access to information in Oracle Internet Directory.

To revert to the less restrictive security mode, refer to the Oracle Reports Services
chapter of the Oracle Fusion Middleware Release Notes.

17.3.4.2 Choosing the Oracle Internet Directory Instance

By default, the Reports Server is configured to use the Oracle Internet Directory
instance installed with Oracle Fusion Middleware. If you are building your system
anew, this arrangement is fine. However, if you have an existing Oracle Internet
Directory instance that you want to use for the Reports Server, you have to make some
adjustments to your configuration.

Changing Oracle Internet Directory instances must be done as part of a complete
change of your Oracle Fusion Middleware middle tier. For more information about
this process, refer to the chapter on reconfiguring Application Server instances in the
Oracle Fusion Middleware Administrator's Guide.

17.4 Choosing the Connecting Entity for Oracle Internet Directory

You can merge several application entities so that the Reports Servers installed in
separate ORACLE_HOMEs can share available SSOCONN resources. To achieve this
merge, you must execute an LDIF file with the 1dapmodi fy command. The LDIF file
should contain the following:

dn: dn of the group representing the logical grouping of all report instances
changetype: modify

add: uniquemember

uniquemember: dn of the Reports Application Entity

where:

dn of the group representing the logical grouping of all report instances is
cn=Virtual Application Group, orclApplicationCommonName=reports_application_
entity _name**, cn=Reports, cn=Products, cn=OracleContext

dn of the Reports Application Entity is
orclApplicationCommonName=reports _application_entity name**, cn=Reports,

cn=Products, cn=0racleContext

** reports_application_entity name is in the format reportsApp_hostname GUID. For
example, reportsApp_servl.us.oracle.com C7543D42A9E26726E034080020A46EE
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Example
Entry in the LDIF file:

dn: cn=Virtual Application Group,
orclApplicationCommonName=reportsApp_Group.us.oracle.com_C7543D42A9E26726E0340
80020A46EE2, cn=Reports, cn=Products, cn=OracleContext

changetype: modify

add: uniquemember

unigquemember :
orclApplicationCommonName=reportsApp_servl.us.oracle.com_A8654E53B0F37837F1451
91131B57FF3, cn=Reports, cn=Products, cn=0OracleContext

Corresponding 1dapmodi fy command on the command line:

ldapmodify -D cn=orcladmin -w welcomel -h reportsApp_Group.us.oracle.com -p 389 -f
mergeentity.ldif

17.5 Changing the Reports Servlet Port to Be Protected by Single

Sign-On

After you install Oracle Reports 11g Release 1 (11.1.1), the following ports are
registered, by default:

s If WebCache is installed, the WebCache port is registered.

s If only Oracle HTTP Server (no webcache) is installed, the Oracle HTTP Server
port is registered.

To change the Reports Servlet port that must be protected by Single Sign-On:

1. Navigate to the OracleAS Single Sign-On Partner Application Administration
page: http://oidhost:oidport/pls/orasso

2. In the Oracle Single Sign-On Server Administration home page, click Single
Sign-On Server Administration. The Single Sign-On Server Administration page
is displayed.

3. Click Administer Partner Applications. The Administer Partner Applications
home page is displayed.

4. Select the host and port related to Reports Servlet, and click Edit. The Partner
Application Login page is displayed.

5. Enter new parameters in Name, Home URL, Success URL, Logout URL fields.
6. Click Apply.

Note: If you are using an SSL port, specify HTTPS instead of HTTP.

17.6 Oracle Forms Services Security Considerations

The default configuration for Oracle Fusion Middleware Forms Services does not run
in OracleAS Single Sign-On (SS0O) mode. The default configuration for Oracle Reports
Services does run in SSO mode.

Oracle Forms Services applications calling integrated Oracle Reports Services using
the RUN_REPORT_OBJECT built-in procedure will not experience any problems when
Oracle Forms Services is running in non-SSO mode and Oracle Reports Services is
running in Single Sign-On mode as long as the Reports Server and the requested
report are not registered in Oracle Portal.
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Other Requirements:

s The property Reports Server must be set explicitly for all report objects in the
Oracle Forms Services module.

= If a Reports Server other than the default is being used, that server must be started
(using Oracle Enterprise Manager).

s The system variable REPORTS_PATH must be modified in the file ORACLE
INSTANCE/config/reports/bin/reports. sh to reference the path of the
reports to be run.

s The first time Reports Server is started, it creates a configuration file called
rwserver.conf located in the ORACLE_
INSTANCE\config\ReportsServerComponent \server_name directory.

s The default status of Reports Server is secure. To change the Reports Server status
to non-secure, modify ORACLE_
INSTANCE\config\ReportsServerComponent\server.
name\rwserver.conf by commenting out the <security> tag and removing
securityId from the <job> tags.

= After making these modifications, the Reports Server must be stopped and
restarted (using Oracle Enterprise Manager).

s If Oracle Forms Services is configured to run in Single Sign-On mode, then report
requests are sent with the authid provided, based on the Single Sign-On user
login.

= Protected reports and Reports Servers can be registered in Oracle Portal.

Table 17-2 lists the possible Forms/Reports combinations and expected results:

Table 17-2 Outcome of Forms/ Reports Integration when Forms is running in SSO Mode
or Non-SSO Mode

Registered, Secure

Reports Server Registered, Secure

(runs only Reports Server Non-Secure
Report Type registered reports) (runs any reports) Reports Server
Reports with public  report generated report generated report generated
access
Reports with report generated report generated report generated
specific user access
Reports with no report not generated report not generated report generated
specific user access
Non-registered report not generated report not generated report generated

reports

17.6.1 What’s New In This Release?

As discussed above, a large number of applications use Oracle Reports in a non-secure
mode with Oracle Forms Services. In this mode, the end user need not provide an
AUTHID to run a report from Oracle Forms Services; the URL command needs to
include only JOBID and the Reports Server name. If unauthorized or malicious users
discover the job ID, they can view the job output using GETJOBID through
rwservlet to obtain job output that belongs to another user. Prior to 11g Release 1
(11.1.1), Oracle Reports generated sequential job IDs, making it easy to predict the job
ID. With 11g Release 1 (11.1.1), Oracle Reports allows the users to generate random
and non-sequential job IDs to make it impossible to predict the job ID for a particular
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job. For more information, see Section 18.8.2, "Generating Random and
Non-Sequential Job IDs".

Additionally, 11g Release 1 (11.1.1) provides support for database authentication using
proxy users:

= Additional security through control of Oracle Forms Services connections based
on users and roles.

= Scalability, through reuse of a single database connection.
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Part IV

Sending Requests to the Server

Part IV provides detailed, practical information about publishing reports, including
how to run requests; how to set up sophisticated, automatic report distributions; how
to customize reports at runtime through XML customization files, and how to use
database triggers to automatically invoke reports:

Chapter 18, "Running Report Requests"

Chapter 20, "Creating Advanced Distributions"
Chapter 22, "Customizing Reports with XML"
Chapter 19, "Using the Oracle Reports Web Service"
Chapter 21, "Using Event-Driven Publishing"






18

Running Report Requests

This chapter discusses various ways to send report requests to the Reports Server. It
includes the following sections:

»  The Reports URL Syntax

= Report Request Methods

= Deploying Your Reports

s Publishing a Report in Oracle Portal

= Specifying a Report Request from a Web Browser

= Sending a Request to the URL Engine

= Running Reports Through a Web Service

= Calling Oracle Reports from Oracle Forms Services
= Running Reports Using Oracle BPEL Process Manager
= Scheduling Reports to Run Automatically

= Additional Parameters

= Reusing Report Output from Cache

=  Using a Key Map File

18.1 The Reports URL Syntax

This section provides quick reference information on formulating a URL for
publishing a report. It covers two deployment types:

s Oracle Reports Servlet
= JSP

The information is largely the same for both Windows and UNIX environments.
Differences are noted.

18.1.1 Oracle Reports Servlet

The syntax for the URL to run a report through Oracle Reports Servlet (rwservlet)
is:

http://web_server.domain_name:port/alias/rwservlet?parameters

Table 18-1 lists and describes the components of the URL.
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18.1.2 JSP

Table 18-1 Components of a URL That Calls Oracle Reports Serviet

Component Description

web_server The name you gave the Oracle HTTP Server when you installed
it.

domain_name Your organization's domain name.

port The port number on which the Oracle HTTP Server listens for
requests. When no port is specified, the default is used (80).

alias The virtual path that stands in for the absolute path to the files a
URL will access.

rwservlet Invokes Oracle Reports Servlet.

? Identifies the beginning of the command line options.

parameters All the command line options, or the key to the key map file

where command line options are specified.

The URL that calls Oracle Reports Servlet (rwservlet) could look like this:
http://neptune.world.com:80/reports/rwservlet?keyname

where keyname refers to a command listed under a unique header (the key name) in
the cgicmd. dat key map file (for more information, see Section 18.13, "Using a Key
Map File"). Note that this works differently for JSP files, which use the keyword /value

pair cmdkey=value to specify key names for command lines that are stored in the
cgicmd.dat file.

When you use Oracle Reports Servlet (rwservlet), you can also execute JSP report
files if the JSP files contain paper layouts. When you run the report, specify Oracle
Reports Servlet (rwservlet) in the URL and call the JSP with the command line
option: report=myreport.jsp.

For example:

http://neptune.world.com:80/reports/rwservlet?report=myreport.jsp&destype=caches&de
sformat=html

You'll find more information about command line keywords and values in
Appendix A, "Command Line Keywords".

The syntax for a JSP-based report URL is:

http://web_server.domain_name:port/alias/myreport.jsp?parameters
Table 18-2 lists and describes the components of the JSP-based report URL.

Table 18-2 Components of a JSP-based Report URL

Component Description

web_server The name you gave the Oracle HTTP Server when you installed
it.

domain_name Your organization's domain name.

port The port number on which the Oracle HTTP Server listens for

requests. When no port is specified, the default is used (80).
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Table 18-2 (Cont.) Components of a JSP-based Report URL

Component Description

alias The virtual path that stands in for the absolute path to the files a
URL will access.

myreport.jsp The report * . jsp file that you want this URL to execute.

? Identifies the beginning of the command line options.

parameters All the command line options, or the key to the key map file

where command line options are specified.

The URL used to invoke a JSP-based report could look like this:
http://neptune.world.com:80/jsp/myreport.jsp?

You can specify a key in the URL that refers to a command in the cgicmd. dat file
that contains additional command line parameters. In this case, you must use the

name value pair: cmdkey=keyname. This can appear anywhere in your URL after the
start of the query string (marked by a question mark). For example:

http://neptune.world.com:80/jsp/myreport.jsp?userid=scott/tiger@hrdb&cmdkey=keyl

In your URL, use an ampersand (&) with no spaces to string parameters together.

When you use a JSP, you can also use Oracle Reports Servlet (rwservlet). When you
run the report, specify Oracle Reports Servlet (rwservlet) in the URL and call the
JSP with the command line option: report=myreport. jsp.

For example:

http://neptune.world.com:80/reports/rwservliet?report=myreport.jsp&destype=caches&de
sformat=html

For more information about command line keywords, see Appendix A, "Command
Line Keywords".

18.2 Report Request Methods

There are a number of request methods available to you for running your report
requests. These include:

s The rwclient command line

The rwclient command line (rwclient . sh on UNIX) is available for running
report requests from a command line in a non-Web architecture. It references an
executable file that parses and transfers the command line to the specified Reports
Server. It can use command line options similar to those used with the Reports
Runtime component file, rwrun (rwrun. sh on UNIX).

On Windows, a typical rwclient command line request looks like this:

rwclient report=my_report.rdf userid=username/password@my_db server=server_name
destype=cache desformat=html

On UNIX, the same command would look like this:

rwclient.sh report=my_ report.rdf userid=username/passwordeémy_db server=server.
name destype=cache desformat=html

See Appendix A, "Command Line Keywords" for more information about
command line options.
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A URL

To run a report from a browser, use the URL syntax. Oracle Reports Servlet
(rwservlet) converts the URL syntax into an rwclient command line request
that is processed by Oracle Reports Services. You can give your users the URL
syntax needed to make the report request from their browser, or you can add the
URL syntax to a Web site as a hyperlink. The remainder of this chapter discusses
this method in more detail.

Through Oracle Portal

The Oracle Portal component enables you to add a link to a report in an Oracle
Portal page or portlet, or to output report results directly into a portlet. Each
report link points to a packaged procedure that contains information about the
report request. Oracle Reports Services system administrators use Oracle Portal
wizards to create the packaged procedure making it more convenient and secure
to publish the report through the Web. Authorized users accessing the Oracle
Portal page group simply click the link to run the report. System administrators
can run the report directly from the wizard. See the Oracle Portal online Help for
more information.

Refer to Section 18.4, "Publishing a Report in Oracle Portal" for more information
about how to publish your report as a portlet.

A packaged procedure

SRW.RUN_REPORT is a built-in procedure that runs a Reports Runtime command.
When you specify SRW.RUN_REPORT, set the SERVER option to the Reports Server
name to cause the SRW.RUN_REPORT command to behave as though you executed
a rwclient command.

For more information, see Chapter 21, "Using Event-Driven Publishing". For a
description of SRW.RUN_REPORT, refer to the Oracle Reports online Help.

A Web service

You can expose Oracle Reports Services as a Web service and then call it from any
Web service aware environment (for example, a Java application).

For more information, see Chapter 19, "Using the Oracle Reports Web Service".

18.3 Deploying Your Reports

Once you have created your report, you can deploy it so that end users can view it.
This section describes how to deploy a report with a paper layout (that is, REP, RDF,
XML, or JSP report) and how to deploy a report with a Web layout (that is, a JSP
report).

Note: For an example on building and testing a JSP-based Web
report, refer to the Oracle Reports Tutorial and the "Building a simple
Parameter Form for a JSP-based Web report" in the Oracle Reports
Building Reports manual.

The following table describes which method you can use to deploy your report,
depending on the type of report.

18-4 Publishing Reports to the Web with Oracle Reports Services



Deploying Your Reports

Table 18-3 Methods for Deploying a Report

Type of Report Method Reason for Using
Report with paper Deploying a Report Method for deploying a report
layout (REP, RDF, with a Paper Layout with only a paper layout.
XML)
JSP report with a paper Deploying a Report Simplest method for deploying a
layout with a Paper Layout ~ paper report of any type.
However, if the JSP report has
both a paper and Web layout, we
recommend you refer to
Section 18.3.3, "Deploying a JSP
Report to the Web and to Paper".
JSP report with a paper Deploying a JSP Strongly recommended for those
and Web layout Report to the Web and  who want to publish a report to
to Paper both the Web and to paper.
Note: rwrun and rwclient execute the paper layout of your

report. The report is processed and executed even though your JSP
has only a paper layout. If your JSP has only a web layout but not a
paper layout, running the JSP report using rwrun or rwclient
obtains a blank output. If you have a JSP with paper layout, it is
recommended that you save the JSP as RDF and then run the RDF
using rwrun or rwclient.

18.3.1 Deploying a Report with a Paper Layout

Once you've created your paper report, you can deploy it to the Reports Server so that
users can run the report. The steps in this section show you how to deploy a report of
type RDF, REP, XML or JSP.

Note: ]SP reports can be deployed either to the Web or to paper,
depending on the layout the report designer used for the JSP
report. This section discusses how to deploy a JSP report with a
paper layout. If you want to deploy a JSP report with a paper and
Web layout, follow the steps in Section 18.3.3, "Deploying a JSP
Report to the Web and to Paper".

If your report depends on Java classes (for example, Barcode classes, a Web Service
stub, and so on), you must configure the process to access these classes. That is, if your
JSP report with a paper layout contains a Java class, you must set the classPath
property of the engine element in the server configuration file (SORACLE_
INSTANCE/config/ReportsServerComponent/server_name/rwserver.conf
for Standalone servers and $DOMAIN_HOME/config/fmwconfig/servers/<WLS_
SERVER_NAME>/applications/reports_
<version>/configuration/rwserver.conf for In-process servers).

To deploy your paper report:

1. Transfer the report file (RDF, REP, XML, or JSP) and its associated files (for
example, PLL, PLX or referenced images) to the deployment directory on your
application server.
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Note: To transfer the file, you can use any method available, such
as FTP or WebDAV.

2. Ensure the directory on the application server where you've transferred the file is
listed in the Reports Server access path. If it is not, use the REPORTS_PATH
environment variable, or set the sourceDir property of the Reports engine
element in the server configuration file.

18.3.2 Running a Report with a Paper Layout

Now that you have deployed your paper report, you can run it from a Web browser.

In a browser, for example, you can type the following URL in the Location
field:

http://your_web_server:port_num/reports/rwservlet?server=server_name&report=
myreport.rdf&userid=username/password@my db&desformat=pdf&destype=cache

In this example, your report displays in PDF format (desformat=PDF) in the
browser.

For more information on running a report from the browser, refer to Section 18.5,
"Specifying a Report Request from a Web Browser".

18.3.3 Deploying a JSP Report to the Web and to Paper

There are two ways you can deploy your JSP reports: through the existing Oracle
Reports application, or through a Java EE application you create yourself. Using an
existing application is useful when you are developing and testing your JSP-based
Web reports. When you are ready to deploy your reports, however, we recommend
you use an application you've created yourself.

About JSP reports with both paper and Web layouts

With Oracle Reports Builder, you can create a JSP report with a paper layout, a Web
layout, or both. You execute these reports using different processes:

= JSP reports with paper layouts are executed through the Oracle Reports engine.
= JSP reports with Web layouts are executed through the Java EE container.

If your report depends on Java classes (for example, Barcode classes, a Web Service
stub, and so on), you must configure the process to access these classes. That is, if your
JSP report with a paper layout contains a Java class, you must set the classPath
property of the engine element in the server configuration file (SORACLE_
INSTANCE/config/ReportsServerComponent/server_name/rwserver.conf
for Standalone servers and $DOMAIN_HOME/config/fmwconfig/servers/<WLS_
SERVER_NAME>/applications/reports_
<version>/configuration/rwserver.conf for In-process servers.)

If your JSP report with a Web layout contains a Java class, you can either add the
classes or JAR to the WAR file, or change the Java EE container classpath. For more
information, refer to the Oracle Containers for Java EE documentation.
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Note: For an example on building a report with a paper and Web
layout, see "Building a Report with a Barcode" in the Oracle Reports
Building Reports manual. For a simple JSP-based Web report
example, refer to the Oracle Reports Tutorial.

The steps in this section show you how to deploy a JSP report with a paper and Web
layout using a Java EE application. To deploy your JSP report with a paper and Web
layout, you can create a new Oracle Reports Java EE application. You can create this
application in an existing instance or a new instance of Oracle WebLogic Server.

18.3.3.1 Creating a New Java EE Application

In this section, you will create a new Java EE application for Oracle Reports. You will
create a Web application archive (WAR file) that will contain the application
information, then deploy it as an Enterprise archive (EAR file). To create a new Java
EE application, you can use Oracle JDeveloper, another Java development tool, or you
can create it manually. If you do not use Oracle JDeveloper to create the application,
you must make a few modifications to the application, as well as to your JSP report.

To create a Java EE application:

Note: If you are not familiar with creating a Java EE application,
refer to Sun Microsystem's Web site
(http://java.sun.com/javaee). For more information on
using Oracle JDeveloper, refer to the Oracle JDeveloper online Help.

1. Before you create your EAR file, ensure that your application contains all the
necessary directories, such as WEB-INF and the web.xml file.

Note: The WEB-INF directory must contain the JSP tag library for
Oracle Reports, called reports_t1ld. jar. In Oracle Fusion
Middleware, you can find the tag library here:

SFMW_HOME /user_projects/domains/<domain_
name>/servers/WLS_
REPORTS/stage/reports/reports/web.war/WEB-INF/1lib/
reports_tld.jar

2. Ensure that your JSP-based Web report points to the location of the JSP tag library
for Oracle Reports. Otherwise, the report will not run.

To point to the location of the JSP tag library, include the taglib directive in the
JSP file:

<%@ taglib uri="/WEB-INF/lib/reports_tld.jar" prefix="rw" %>

3. Create a new EAR file, either manually or using a tool such as Oracle JDeveloper.
Ensure you create the WAR file according to the appropriate Java EE format.

4. If your JSP report contains a paper layout and you want to deploy your report to
paper, open the web . xm1 file.
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Note: On Oracle Fusion Middleware, the web . xm1 file is located
here:

SFMW_HOME /user_projects/domains/<domain_
name>/servers/WLS_
REPORTS/stage/reports/reports/web.war/WEB-INF/1lib/
reports_tld.jar

If you are deploying a JSP report that only contains a Web layout, continue to Step
7.

5. Add the following code to the web.xml file.

<servlet>
<servlet-name>rwservlet</servlet-name>
<servlet-class>oracle.reports.rwclient.RWClient</servlet-class>
<load-on-startup>yes</load-on-startup>

</servlet>

<servlet-mapping>
<servlet-name>rwservlet</servlet-name>
<url-pattern>/rwservlet*</url-pattern>

</servlet-mapping>

This new definition will redirect all URLs starting with /rwservlet to the Oracle
Reports Servlet you've defined.

Note: You can change the Oracle Reports Servlet name and URL.

6. Save the web.xml file.

7. Create an EAR file from the WAR file. Once these files are compiled, note where
they are saved.

18.3.3.2 Deploying Java EE Application Using WebLogic Server

After you have created the WAR and EAR files, you can deploy them to the Oracle
Fusion Middleware, which will serve the application to the Web. You can deploy these
files using Oracle Enterprise Manager using either an existing WebLogic Server
instance or a new WebLogic Server instance. For more information about deploying
Java EE application in Oracle WebLogic Server, see Oracle Fusion Middleware Deploying
Applications to Oracle WebLogic Server.

18.3.4 Running a JSP-Based Web Report from a Browser

If your JSP report is a Web report, you can run your JSP-based Web report from a Web
browser. In a browser, type the following URL in the Location field:

http://your_computer_name:port/MyReportApp/JSPreportname. jsp?userid=user
ID/password@database_name

Note: In the above URL, MyReportApp is the name of the
application you created.

If you wish you modify your JSP-based Web report at this point, you can either:

= Replace the report in this location.
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= Re-create the WAR file with the modified JSP-based Web report, then redeploy the
application. For more information, refer to Section 18.3.3.1, "Creating a New Java
EE Application”.

For more information on running a report from a browser, refer to Section 18.5,
"Specifying a Report Request from a Web Browser".

18.3.5 Running a JSP report with a Paper Layout

If your JSP report has a paper layout, you can run your JSP report from a browser
using the following URL:

http://your_web_server :portnum/MyReportApp/rwservlet?report=myreport. jsp&userid=
username/password@my._db&server=server_name&desformat=pdf&destype=cache

In this example, your report displays as a PDF (desformat=PDF) in the browser.

For more information on running a report from a browser, refer to Section 18.5,
"Specifying a Report Request from a Web Browser".

18.3.6 Running with the WEBMSWIN1252 Character Set on UNIX

There are no UNIX fonts built into the WESMSWIN1252 character set. This may cause
Oracle Reports to fail when NLS_ LANG=AMERICAN_AMERICA.WE8MSWIN1252.
Therefore, you must map the code page of the installed fonts (defined in the
Tk2Motif.rgb file) to the WESBMSWIN1252 character set. TK2Motif.rgb islocated
in the ORACLE_
INSTANCE/config/FRComponent/frcommon/guicommon/tk/admin directory.

Note: This mapping is required for Oracle Reports Builder, Reports
Converter in non-batch mode (BATCH=NO), Reports Server and
Reports Runtime with REPORTS_DEFAULT_DISPLAY=NO. Reports
Server and Reports Runtime uses REPORTS_DEFAULT_DISPLAY to
determine the fonts needed.

Examplei

Tk2Motif*fontMapCs: IS08859-1=WESMSWIN1252 (if there are IS08859-1
fonts installed).

18.4 Publishing a Report in Oracle Portal

One of the best ways to publish your report is through the declarative, secure interface
of Oracle Portal. To publish a report in Oracle Portal, refer to Chapter 16, "Deploying
Reports in Oracle Portal". Specifically, you must first register your Oracle Reports
components in Oracle Portal (see Section 16.2, "Registering Oracle Reports
Components"), then expose your report in a portal (see Section 16.3, "Publishing Your
Report as a Portlet").
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Note: When you use features like Oracle Portal Security, Portal
Destination, and Job Status Repository, the JDBC database
connections made by Oracle Reports Services may override the
initial NLS_LANG setting. This change may in turn affect the
behavior of the running report, such as bidirectional output in PDF.
On UNIX platforms, you can work around this issue using the
environment switching functionality to dynamically set the
environment for reports. Refer to Section 8.2.2, "Dynamic
Environment Switching" for more information.

18.5 Specifying a Report Request from a Web Browser

You can provide the user with the URL syntax needed to make a report request, or
you can add the URL syntax to a Web page as a hyperlink.

URL syntax can be presented in the following forms:
»  Full URL request, for example:

http://your_webserver.domain_
name:port/alias/rwservlet?report=myreport.rdf&userid=
username/password@my._db&server=server.name&desformat=html&destype=cache

If you require additional command line keywords, then refer to Appendix A,
"Command Line Keywords" for a list of valid rwservlet command line
keywords.

= Simplified URL request using key mapping, for example:

http://your_webserver.domain name:port/alias/rwservlet?keyl

18.6 Sending a Request to the URL Engine

If you have activated the Reports Server's URL engine, you can send job requests to
the URL engine by using the following command line options:

» urlParameter identifies the URL to be placed in the cache. For example,
http://www.oracle.comor aJSP report.

= JjobType is the name of a job type (for example, rwurl) in the server
configuration file that is associated with a URL engine.

Note: For information on activating the URL engine, refer to
Section 8.6, "Configuring the URL Engine".

For example, a request that specifies an external URL for urlParameter might look
like the following:

http://your_webserver:portnum/reports/rwservliet?server=
ReportsServer+jobType=rwurl+urlParameter=
"http://www.oracle.com"+destype=mail+desname=foo@bar.com+desformat=htmlcss

Alternatively, a request that specifies a JSP report for url1Parameter would look like
the following:
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http://your_webserver:portnum/reports/rwservliet?server=
ReportsServer+jobType=rwurl+destype=cache+urlParameter=
"http%3A%2F%2F1localhost%2Ffoo. jsp%3Fuserid%3Dscott$2Ftiger@oraDB%3Fserver%3Dreport
sServer"

Note: If the URL has special characters, they must be encoded as
per the x-www-form-urlencoded format.

18.7 Running Reports Through a Web Service

In many cases, reports are integrated components of some larger application rather
than a standalone application themselves. Hence, it can be useful to generate report
requests from within an application. We accomplish this goal by exposing Oracle
Reports Services as a Web service. This Web service may then be called from within
any Web service-aware environment (for example, a Java application). For example,
suppose that you have a Java-based expense reporting form and you want to allow
users to generate a PDF version of their expense reports from it each time that they
complete an expense form in your system. By creating a Java proxy Oracle Reports
Web Service, you could then easily reference it from your Java development
environment (for example, Oracle JDeveloper) and add a button that invokes Oracle
Reports Services to generate the PDF file.

See Also: Chapter 19, "Using the Oracle Reports Web Service" for
more information on the Oracle Reports Web service and installing
and using the sample proxy and Java client.

18.8 Calling Oracle Reports from Oracle Forms Services

The tight product integration between Oracle Reports and Oracle Forms Services
enables you to pass blocks of data between the two products and removes the need for
subsequent queries. This technique, referred to as query partitioning, ensures that
Oracle Reports is responsible for formatting data and ignores dynamic alteration of
queries through triggers and lexical parameters.

Oracle Forms Services uses the shared Java Virtual Machine (JVM) controller for all
report requests, reducing memory consumption.

Note: Unless data parameters are unreasonably large or the
queries particularly complicated, the perceived performance
improvements should be negligible. Additionally, only top level
groups in a report can accept data parameters passed from forms.

A typical integration between Oracle Forms Services and Oracle Reports is an
application that provides a form to fill in data, which is used to generate a report. The
steps that occur during this process are similar to the following example:

»  The end user enters values in a form. Some or all of these values are parameter
inputs to the associated report.

»  The end user clicks a button, which generates the report as follows:
—  Oracle Forms Services populates all the parameters to execute the report.

— Oracle Forms Services calls the RUN_REPORT_OBJECT built-in to send a
request to Oracle Reports.
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Oracle Reports returns the job id, and Oracle Forms Services queries on the
status of this job id.

When the job status is FINISHED, Oracle Forms Services calls the WEB . SHOW_
DOCUMENT built-in to submit a request to open the report output.

The WEB . SHOW_DOCUMENT built-in opens the following URL in the browser:

http://host:port/reports/rwservlet/getjobidn?server=server_name

Note: For secure mode, the URL will also include authid=authid

For additional information on calling a report from an Oracle Forms Services
application, refer to the Integrating Oracle Reports Services 11g in Oracle Forms
Services 11g white paper on OTN
(http://www.oracle.com/technology/products/forms/techlisti
ngl0g.html).

18.8.1 Communication Between Reports and Forms When Installed on Different

Instances

Oracle R